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About the Author

Ellen Finkelstein learned AutoCAD in Israel, where she always got to pore over the manual
because it was in English. After returning to the United States, she started consulting and
teaching AutoCAD as well as other computer programs, including Microsoft Word, Excel,

and PowerPoint. She also teaches courses on Web writing and usability. Her Web site, www .
ellenfinkelstein.com, contains tips and techniques for AutoCAD, PowerPoint, and Flash.
Ellen has written many articles on AutoCAD and PowerPoint and has written books on Word,
PowerPoint, OpenOffice.org, and Flash (such as Flash MX 2004 For Dummies, published by
Wiley). Her first book was AutoCAD For Dummies Quick Reference. You're holding the fifth edi-
tion of this book, which previously appeared for AutoCAD releases 14, 2000, 2002, and 2004.
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Foreword

We are delighted to see Wiley’s latest update to the very successful AutoCAD Bible

by Ellen Finkelstein. Autodesk software gives you the tools to manage and deliver
your digital design data and content. Autodesk understands that our value proposition is

to constantly deliver performance and productivity improvements to you, the users of our
products. Fulfilling this proposition requires more than great software — such as the recently
released AutoCAD 2005 and AutoCAD LT 2005. True productivity improvement also means
having available the necessary resources, services, and support. These additional resources
make you more productive as you apply Autodesk products to solve your design challenges.
The new AutoCAD 2005 and AutoCAD LT 2005 Bible is a noteworthy addition to this pool of
resources you will want at your fingertips.

Almost everything we do assumes a collaborative partnership-based approach. Indeed, “none
of us is as smart as all of us” is a principle upon which Autodesk was founded. To augment our
great software products, Autodesk offers Autodesk Consulting to meet your need for training,
eLearning, custom content development, and consulting. Our commitment to further increase
your productivity includes our ongoing work with the “virtual” Autodesk enterprise —including
publishers such as Wiley and experts such as Ellen Finkelstein —to bring you impressive
resources that support your Autodesk software.

AutoCAD is a powerful 2D and 3D design and drafting platform that automates your design
tasks and provides digital tools so you can focus on the design rather than the software itself.
Architects, engineers, drafters, and design-related professionals use AutoCAD to create, view,
manage, plot, share, and reuse accurate, information-rich drawings. To deliver better results,
you need to use the best technology. AutoCAD 2005 automates the process of managing and
delivering an entire set of coordinated drawings. You can quickly output the full set of sheets
as compact, easy-to-view DWF (Design Web Format files or hard-copy plots. The new fields
enable you to mine your data by, for example, filling in table blocks for you. The new tables
make creating schedules a breeze, and enhanced tool palettes simplify drafting tasks. Sharing
design data is now easier with the DWF Composer that allows electronic markup of DWF files.
These new timesaving tools minimize the number of steps you have to take, freeing you and
your team to explore more design options — and create even more outstanding designs.

By providing full coverage of AutoCAD LT in her book for the first time, Ellen Finkelstein makes
the book useful to an even wider range of professionals. Many organizations use both AutoCAD
and AutoCAD LT, and they will find this book to be an invaluable reference. AutoCAD LT 2005
now includes new table objects and enhanced tool palettes. In addition, fields created in
AutoCAD are accurately displayed in AutoCAD LT.

After 20 years we can say, to paraphrase on old marketing line, “This isn’t your father’s
AutoCAD!” Your work today is not just about powering great designs with AutoCAD’s

and AutoCAD LI"s productivity and performance tools. Both programs enable you to collabo-
rate with others to extend the value of your designs — and maximize the value of your design
data across your entire organization. You also need to easily acquire, integrate, deploy, and
manage your software assets to increase workflow and improve your bottom line.
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However, you can only benefit from what you know and use. Introducing these innovations
also poses new challenges, namely learning how to apply these enhancements to the jobs you
face. We have done much to address these challenges within AutoCAD and AutoCAD LT, yet
the full solution must be more than what Autodesk alone can provide — hence, the critical
role of the Autodesk virtual community.

We are, therefore, particularly grateful to Ellen Finkelstein for having written such a compre-
hensive and reliable guide to AutoCAD and AutoCAD LT, and to the people at Wiley for making
it so widely available. Following on the great success of the AutoCAD 2004 Bible, this new ver-
sion draws upon reader feedback. To get maximum value and performance from AutoCAD and
AutoCAD LT, you should have the AutoCAD 2005 and AutoCAD LT 2005 Bible right at your finger-
tips. It will enable you to respond to the unexpected, which is the norm on the job these days.
Use it to augment the digital-learning resources that come with your software: AutoCAD Learning
Assistance, the Help system, the new Info palette, and the online resources of Autodesk, which
are seamlessly integrated into AutoCAD. If you use the AutoCAD 2005 and AutoCAD LT 2005
Bible, you will discover the myriad capabilities of AutoCAD and AutoCAD LT, some that you
probably weren’t aware even existed. However you use it, when you combine the features in
AutoCAD and AutoCAD LT with the support of the AutoCAD 2005 and AutoCAD LT 2005 Bible,
you will discover daily breakthroughs and productivity boosters as you use AutoCAD and
AutoCAD LT to power your designs.

Wayne Hodgins

Strategic Futurist

Director of Worldwide Learning Strategies
Autodesk Consulting
www.autodesk.comand www.discreet.com



Preface

Welcome to the AutoCAD 2005 and AutoCAD LT 2005 Bible. For the first time, this book
also covers AutoCAD LT. Whether you use AutoCAD or AutoCAD LT, you'll find com-

plete explanations of all the powerful features that you need to know. This book is designed
to be your comprehensive guide to both the AutoCAD and AutoCAD LT programs

This book covers every significant AutoCAD and AutoCAD LT feature. If you're a beginning user,
you'll find everything you need to start out; if you're already using AutoCAD or AutoCAD LT
regularly, the book covers advanced material as well. It provides a solid reference base to come
back to again and again, as well as short tutorials on almost every topic to get you drawing
professionally. Finally, the CD-ROM is chock-full of drawings, trial versions of AutoCAD 2005
and AutoCAD LT 2005, and add-in programs (which are mostly for AutoCAD only). This book
should be all you need to make full use of either program.

For AutoCAD 2005 and AutoCAD LT 2005, the emphasis of the new features is on automation
and usability. For AutoCAD, you’ll find exciting new features such as tables, fields, and sheet
sets. The tool palettes have been updated, and numerous minor changes make drawing easier
and faster.

Many of the new features of AutoCAD are in AutoCAD LT too, such as tables and the updated
tool palettes. Most of the usability features, such as trimming to hatches and text background
masks, are in AutoCAD LT as well.

Is This Book for You?

The AutoCAD 2005 and AutoCAD LT 2005 Bible covers all the essential features of AutoCAD
and AutoCAD LT and includes clear, real-life examples and tutorials that you can adapt to
your needs.

Although I fully cover the basics, I have also included material on the many advanced features,
such as external database connectivity, AutoLISP, Visual Basic for Applications (VBA), 3D
modeling, rendering, and customization. (Most of the advanced features apply to AutoCAD
only.) The following categories should help you decide if this book is for you.

If you are a new AutoCAD or AutoCAD LT user

If you are new to AutoCAD or AutoCAD LT, the AutoCAD 2005 and AutoCAD LT 2005 Bible
guides you through all you need to know to start drawing effectively, whatever your field.

If you are upgrading to AutoCAD 2005 or
AutoCAD LT 2005

This book highlights all the new features and helps you make the upgrade transition as seam-
less as possible.
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If you are switching from another CAD program

You already know what CAD is all about. This book clearly explains the AutoCAD and
AutoCAD LT way of drawing the models you have already been drawing. In addition, you'll
find a great deal of essential information about transferring information from other formats.

How This Book Is Organized

This book is divided into eight parts.

Part I: AutoCAD and AutoCAD LT Basics

Part I provides the background information you need to start drawing. It starts with a “quick
tour” that gets you drawing right away, and then covers how to start a drawing, use commands,
specify coordinates, and set up a drawing.

Part II: Drawing in Two Dimensions

Part Il covers all the commands and procedures for drawing and editing in two dimensions.
In addition, I discuss how to control the drawing process with layers, zooming, and panning.
Also included in this part is information about dimensioning, plotting, and printing.

Part 111: Working with Data

Part Il covers many ways to organize and share data, including blocks, attributes, external
references, and external databases.

Part IV: Drawing in Three Dimensions

Part IV explains everything you need to know to draw in three dimensions. It also discusses
how to present 3D drawings using hiding, shading, and rendering techniques.

Part V: Organizing and Managing Drawings

Part V helps you incorporate AutoCAD and AutoCAD LT into your work world by explaining
how to set standards, manage drawings, and work with other applications. It concludes with
a chapter on getting on the Internet. Many new features of AutoCAD 2005 and AutoCAD LT
2005 are explained in this part.

Part VI: Customizing AutoCAD

Part VI introduces the tools you need to customize commands, toolbars, linetypes, hatch pat-
terns, shapes, fonts, and menus. You'll also find a chapter on script files, which you can use
to create macros.

Part VII: Programming AutoCAD

Part VIl introduces you to programming AutoCAD. It includes three chapters on AutoLISP
and Visual LISP and one chapter on Visual Basic for Applications. This part applies to
AutoCAD only.
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Part VIII: Appendixes

Part VIII provides additional information for AutoCAD and AutoCAD LT users. Appendix A
gives instructions for installing and configuring AutoCAD and AutoCAD LT. Appendix B
explains what you’ll find on the CD-ROM.

On the

.,\CD
9
How to Use This Book

You can use this book in two ways: as a reference or as a learning tool or tutorial.

\ The CD-ROM contains a complete copy of this book in nonprintable PDF format.

As a reference

The AutoCAD 2005 and AutoCAD LT 2005 Bible is organized as a reference that you can refer
to whenever you are stuck or when you try to do something for the first time. Each chapter
covers a topic completely, making it easy to find what you’re looking for. Each Step-by-Step
exercise (with a few exceptions) can be done on its own without doing the other exercises in
the chapter. You can easily look up a topic and complete a related exercise without having to
go through the entire chapter. A complete index at the back of the book can also help you
look up features and topics.

As a tutorial

The overall organization of the book goes from simple to complex, and each chapter has sev-

eral Step-by-Step sections. This enables you to use the book as a tutorial — from beginning to

end. You can then go back and redo any exercise when you need to refresh your memory on a
particular feature.

For newcomers to AutoCAD or AutoCAD LT, Parts | and II are essential. After that, you can
refer to chapters that interest you. Parts Ill and V are also useful for beginners. Intermediate
users will probably be familiar with most of the material in Part I and will be more likely to
skip around looking for the specific topics they need. However, don’t forget that many new
features are introduced in Part I. Enough material appears in this book to bring intermediate
users up to a fairly advanced level.

I have designed this book to be comprehensive and to include every significant feature of
AutoCAD and AutoCAD LT. Therefore, do not be concerned if some of the material seems too
advanced. It will be there when you are ready for it.

Doing the Exercises

AutoCAD is a very customizable program. To a lesser extent, AutoCAD LT can also be
customized in many ways. This book assumes that you are working with the default setup.
However, a number of changes may have been made to your system that could result in
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menus, toolbars, and drawings appearing or even functioning differently from those shown in
this book. If you installed AutoCAD or AutoCAD LT yourself and made some adjustments, you
know what changes you made. However, if you are using a computer that was set up by some-
one else, it may help to talk to that person first, to see what changes were made.

In addition, as you work through some of the exercises in this book, you will make certain
changes in the program’s setup. Most of these are minor changes that any user would make
while drawing. For safety, Cautions and Tips accompany all changes that could have serious
consequences, such as customizing the menu. For example, when customizing the menu, you
will be instructed to copy the menu template file under a new name, and you will then work
with the new menu file, not the original one. Nevertheless, if you are working on a network or
sharing your computer with someone else, it is proper computer etiquette to consult with
others who may be affected by the changes you make.

If you do the exercises, | recommend that you do them from the beginning. Important instruc-
tions are given during earlier exercises that may affect your system later. For example, one of
the first exercises is to create a new folder to hold your drawings from the exercises. This folder
keeps your exercise drawings separate from other drawings created in your office. However,
each exercise stands on its own so you can go back and do only the exercise you need.

You can create your own configuration that helps ensure that some changes you make will
not affect others. Instructions for doing this appear in Appendix A under the heading “Creating
Multiple Configurations.”

The exercises in the AutoCAD 2005 and AutoCAD LT 2005 Bible have been carefully checked by
two technical editors (one for AutoCAD and one for AutoCAD LT) to ensure accuracy. However,
we cannot anticipate all situations, due to either varying hardware/software configurations or
customization. If you have a problem with an exercise, contact me at the e-mail address listed
at the end of this Preface so I can correct the problem in the book’s next edition. I will also try
to give you the information you need to complete the exercise.

Conventions Used in This Book

Given all the ways in which you can execute a command in AutoCAD and AutoCAD LT, you'll
find it useful to read this section, which describes this book’s typographical conventions.
You will find this section helpful for doing the Step-by-Step exercises as well.

Using commands

AutoCAD and AutoCAD LT use standard Windows conventions for menus and toolbars. To indi-
cate that you should choose a command from the menu, for example, I say, “Choose View &>
Viewports,” which means that you should click the View menu with your mouse or puck/
stylus and then click the Viewports menu item. A few of the toolbar buttons have flyouts,
which are equivalent to submenus. They are called flyouts because they fly out when you
click and hold the button on the main toolbar, displaying even more buttons. Therefore, to
indicate which button to choose, I may need to tell you to choose (or click) Zoom Extents
from the Zoom flyout of the Standard toolbar. Although I haven’t found a good alternative,
this is not completely satisfactory for two reasons. First, it’s a mouthful! Second, the flyout
names do not appear, making it hard to know which is the Zoom flyout. However, in most
cases, the button icon will make it obvious which flyout I'm talking about.
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Every command also has a command name that you can type on the command line, which
appears at the bottom of your screen. Command names are shown in capital letters, as in
CIRCLE. AutoLISP functions (which apply to AutoCAD only) are shown in small capital letters,
as in COMMAND.

Prompts, your input, and instructions

In the Step-by-Step exercises, most instructions are presented in the same font and style you
are reading now. However, when I reproduce the command line, the prompts appear in a non-
proportionalfont and the input you should type in appears in bold. Other instructions
(such as “Type in the first coordinate™) are shown in italic.

Here’s a sample Step-by-Step section. In this exercise, you click the proper toolbar button,
type the number shown in bold, press Enter where indicated by the bent arrow () symbol,
and follow the instructions that appear in italic.

7. & To create a second rectangle inside the first one, choose Offset from the Modify
toolbar. Follow these prompts:

Specify offset distance or [Through] <Through>: 4 .
Select object to offset or <exit>: Click the rectangle to select it.
Specify point on side to offset: Click anywhere inside the rectangle.
Select object to offset or <exit>: 4 (Press Enter.)

Often I refer to specific elements in a drawing. References to these elements appear in the
text as numbers in circles, such as @@1, @@2, @@3, and so on. You'll find the corresponding
number in the figure to which the text refers.

Mouse and keyboard terms

You can draw using a mouse or a puck. The mouse is familiar to all users. A puck (or some-
times a stylus) is used with a digitizing tablet. Because most users do not have a digitizing
tablet, I do not directly refer to it in this book. If you have one, follow the instructions for using
the mouse in the same way, using your puck.

A mouse can have two or more buttons. Many users like using a mouse with at least three
buttons because you can customize the buttons to suit your needs. However, because many
mice have only two buttons, [ assume only two. The left mouse button is used to choose
commands and toolbar buttons and to pick points in your drawing. For this reason, it is
sometimes called the pick button. The right button usually opens a shortcut menu.

The time-sensitive right-clicking feature enables you to use the right button either to open a
shortcut menu or as the equivalent of pressing Enter. Because this feature is not on by default,
[ do not assume that you have turned it on. I use the term right-click when you need to access
a shortcut menu. If you have time-sensitive right-clicking turned on, you need to hold down
the right mouse button more than 250 milliseconds (by default) to display the shortcut menu.
See Chapter 3 and Appendix A for more details.

If I say one of the following
4 Choose Tools = Options
4 Click Line on the Draw toolbar
4+ Select the circle in your drawing

it means to use the left button of your mouse.
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When [ say to press Enter, it means to press the key that is marked Enter, Return, or 4 on your
keyboard. Often I use the bent arrow symbol () to indicate that you should press Enter.

I also use the mouse terms listed in the following table.

Mouse Terms

Term Description

Cursor The shape on your screen that shows you where the mouse is pointed. It can
take a number of shapes, such as crosshairs, pickbox, or arrow. Also known as
the mouse pointer.

Pickbox A type of cursor consisting of a small box, used to select drawing objects.
Crosshairs A type of cursor consisting of intersecting lines.

Pick Point to a drawing object and click the left mouse button.

Click Press the left mouse button once and release it.

Double-click Press the left mouse button twice in rapid succession.

Click and drag Click the left mouse button and hold it down while you move the mouse,

dragging an object on your screen with it.

Choose Click a menu item, toolbar button, or dialog box item. You can sometimes
choose an item using the keyboard as well.

Right-click Press the right mouse button once and release it. If you have turned on time-
sensitive right-clicking, hold the right mouse button at least 250 milliseconds
(by default) before releasing it.

Shift and click While holding down the Shift key, press the left mouse button once and
release it.

Shift and right-click While holding down the Shift key, press the right mouse button once and
release it.

Select Highlight an object in a drawing by picking it or using another object selection
method, or highlight text in a dialog box or text document.

What the Icons Mean

AutoCAD 2005 and AutoCAD LT 2005 Bible is liberally sprinkled with icons — small symbols in
the left margin that call your attention to noteworthy points.

N\ This icon means that the feature that | am discussing is not available in AutoCAD LT.

AutoCAD
Only

4
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Caution The Caution icon means you should pay special attention to the information or instructions

c

New
Feature

Note

because a possibility exists that you could cause a problem otherwise.

read this book straight through from cover to cover, use cross-references to quickly find just
the information you need.

@ Cross-References refer you to a related topic elsewhere in the book. Because you may not
\ eference

\ The New Feature icon means that a feature is new to AutoCAD 2005 or AutoCAD LT 2005 or
has been significantly changed.

A Note icon alerts you to some important point that requires special attention or additional

— information that may be helpful.

On the |

cn

VS

Tip

\ The On the CD-ROM icon highlights references to related material on the CD-ROM.

A Tip shows you a way to accomplish a task more efficiently or quickly. You'll find plenty of
. practical advice here.

s

About the CD-ROM

The CD-ROM contains all the drawings you need to do the exercises in this book. These draw-
ings are a great resource to help you learn using real-world drawings. In addition, the CD-ROM
includes the drawings that result after you finish an exercise or tutorial. In this way, you can
check what you have done if you want.

The CD-ROM is also chock-full of resource material that I hope you will find useful for many
years to come. Appendix B lists the contents of the CD-ROM. | am especially pleased to include
30-day trial versions of AutoCAD 2005 and AutoCAD LT 2005 on the CD-ROM as well as this
entire book in (nonprintable) PDF format.

Other Information

If you are already an advanced user but need tips and secrets for getting the most out of
AutoCAD or AutoCAD LT, this book will probably not add too much to your already great store
of knowledge. However, few people know everything about these complex programs, so you
may be surprised what you can learn.

This book assumes that you know the basics of Windows, although the instructions you’ll
read here are usually detailed enough to get you through any task.

XVii
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If you do have AutoCAD and want a more basic book, look at AutoCAD 2005 For Dummies,

by Mark Middlebrook. AutoCAD 2005 and AutoCAD LT 2005 Bible covers AutoCAD 2005 and
AutoCAD LT 2005. However, most of the information also applies to Release 2004 of both pro-
grams. | have used AutoCAD in Windows XP Professional, but almost everything also applies
to Windows 2000, although some of the screens will look different. If you are using AutoCAD LT
2005, again, some of the screens will look different. In any case, where there is a significant
difference between AutoCAD and AutoCAD LT, I explain the difference.

In order to create clear images for the figures in the book, I work with a white background.
The default background is black. Therefore, your screen will look quite different from what
you see in the figures, but the only difference is the color.

Contacting the Author

I would be happy to hear any comments you have about this book. The best way to contact
me is by e-mail at el Tenfinkl@bigfoot.com. You can also use the United States postal
service (a.k.a. snail mail) and write to me in care of Wiley. Please note that I can’t provide
technical support for my readers. The publisher maintains a page on its site that includes the
drawings used in the exercises (in case you every lose your CD-ROM) at www.wiley.com/
legacy/compbooks/finkelstein/autocad/index.html.Ihave my own Web site at
www.ellenfinkelstein.com that contains information on my books and on AutoCAD, including
many AutoCAD tips.
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AutoCAD and
AutoCAD LT Basics

The five chapters in Part I provide all the basics you need to know
to start drawing in AutoCAD or AutoCAD LT. These chapters

are essential for the beginner, but even current users can find some

new tips and pointers especially related to features that are new for

AutoCAD 2005 and AutoCAD LT 2005. If you feel you know enough to
skip to Part II, skim this part for New Feature icons to bring yourself

up-to-date.

+ 4+
In This Part

Chapter 1
Starting fo Draw

Chapter 2
Opening a Drawing

Chapter 3
Using Commands

Chapter 4
Specifying Coordinates

Chapter 5
Setting Up a Drawing

+ o+ o+






Starting to Draw

Learning AutoCAD or AutoCAD LT is a bit like trying to decide which
came first —the chicken or the egg. On one hand, you need to
know many basics before you can start drawing. On the other hand,
understanding those basics can be very difficult if you haven’t had
the experience of drawing something. In this chapter, you resolve this
problem by creating a simple drawing in AutoCAD or AutoCAD LT.
The next few chapters then fill you in on basic information you need
to move on to more complex drawings. By experiencing the drawing
process first, the initial learning curve will be easier and smoother.

Getting Acquainted with AutoCAD
and AutoCAD LT

AutoCAD and its younger brother, AutoCAD LT, are both created by
Autodesk. Together they are the most widely used technical drawing
programs anywhere. AutoCAD alone has more than 3,000,000 regis-
tered users. According to Autodesk, CAD stands for computer-aided
design, but can also stand for computer-aided drafting or drawing.

The first version of AutoCAD, running under DOS, came out in 1982.
AutoCAD was the first significant CAD program to run on a desktop
computer. At the time, most other technical drawing programs ran on
high-end workstations or even mainframes. AutoCAD LT was intro-
duced in 1993, as a less expensive alternative to AutoCAD, for people
who didn’t need all of AutoCAD’s advanced features.

AutoCAD'’s advantages

AutoCAD'’s success has been attributed to its famous open
architecture — the flexibility that the end user has to customize the
program using source code files in plain text (ASCII) format — and
programming languages (such as AutoLISP and Visual Basic for
Applications).

As a result, AutoCAD is the most flexible drafting program available,
applicable to all fields. AutoCAD’s support for languages other than
English, including those using other alphabets, is unparalleled, mak-
ing AutoCAD without serious competition abroad. As a result,
AutoCAD is used in all disciplines and in more than 150 countries.
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Through a high level of technical innovation and expertise, Autodesk has created a program
with unequaled features and capabilities, including 3D surface and solid modeling and visual-
ization, access to external databases, intelligent dimensioning, importing and exporting of
other file formats, Internet support, and much more.

The major disciplines that use AutoCAD are
4 Architectural, Engineering, and Construction (AEC)
4 Mechanical
4 Geographic Information Systems (GIS)
4+ Surveying and Civil Engineering
4+ Facilities management
4 Electrical/electronic
4 Multimedia

However, AutoCAD has many other lesser-known uses, such as pattern making in the garment
industry, sign making, and so on. In this book, I try to provide examples from many fields. The
world of AutoCAD is very broad, and you can learn from seeing the many approaches that
AutoCAD makes possible.

AutoCAD LT's features

AutoCAD LT’s advantage is its lower cost and its compatibility with AutoCAD. The programming
code that creates AutoCAD LT is a subset of the code used in AutoCAD. Here are the major dif-
ferences between AutoCAD and AutoCAD LT:

4 AutoCAD includes features that enable CAD managers to hold drawings to certain stan-
dards, such as layer names and text styles. AutoCAD LT doesn’t contain these features.

4 AutoCAD LT is not customizable to the extent that AutoCAD is; AutoCAD is both pro-
grammable and fully customizable.

4 AutoCAD LT includes only minimal 3D options; AutoCAD includes a full-featured 3D
capability.

4 AutoCAD LT has fewer presentation features than AutoCAD, which includes gradient
fills, true color display, and 3D rendering.

4 AutoCAD LT is deployable on a network but does not include AutoCAD’s network
license management feature that includes reporting and flexible licensing.

4+ AutoCAD LT does not offer database connectivity; AutoCAD does.

4 AutoCAD LT does not include AutoCAD’s quick-dimensioning feature, which allows you
to quickly insert a number of dimensions one after the other.

4 AutoCAD LT does not include two of AutoCAD 2005’s new features — sheet sets and
fields.

AutoCAD and AutoCAD LT have a few other minor differences as well. Some of these differ-
ences are only in the user interface, so you can accomplish the same task but the procedure
is slightly different.
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Starting AutoCAD and AutoCAD LT

This section starts the quick tour of AutoCAD and AutoCAD LT. The first step is to start the
program.

On theh"'\ The CD-ROM contains a 30-day trial version of AutoCAD 2005. Look in \Software\AutoCAD
CD 2005. You can order AutoCAD LT 2005 at www.autodesk.com/30day .

S

This book covers AutoCAD 2005 and AutoCAD LT 2005 running on Windows 2000 or Windows
XP Home/Professional. Every computer is set up somewhat differently, so you may need to
adjust the following steps slightly. If you didn’t install the software yourself and are unfamiliar
with the folders (also called directories) on your computer, get help from someone who is
familiar with your computer system.

« Cross- If you need help installing AutoCAD or AutoCAD LT, see Appendix A.
\ Reference

By default, installing AutoCAD or AutoCAD LT places a shortcut on your desktop, as shown in
Figure 1-1. You can double-click one of the shortcuts to launch the program that is installed
on your machine, or you may choose one of the following:

4 For AutoCAD: Start = (All) Programs = Autodesk = AutoCAD 2005 => AutoCAD2005

4 For AutoCAD LT: Start = (All) Programs => Autodesk = AutoCAD LT 2005 => AutoCAD LT
2005

= rey | Figure 1-1: A shortcut on the desktop provides a quick way to open
22l || | AutoCAD or AutoCAD LT.

AutoCAD 2005 | (AutaCaD LT
2005

Creating a New Drawing

After you launch AutoCAD or AutoCAD LT, you are automatically in a new drawing named
Drawingl.dwg. You can see the drawing name on the title bar. You can start drawing immedi-
ately. In Chapter 2, I explain how to start a drawing based on a template and how to open an
existing drawing.
STEP-BY-STEP: Starting AutoCAD or AutoCAD LT
1. Click Start on the taskbar at the bottom of your screen.
2. Choose one of the following:
e For AutoCAD: (All) Programs => Autodesk &> AutoCAD 2005 => AutoCAD 2005
e For AutoCAD LT: (All) Programs => Autodesk => AutoCAD LT 2005 => AutoCAD LT 2005

You see a blank drawing named Drawingl.dwg.
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If you are continuing with this chapter, keep this drawing open. I cover exiting from AutoCAD
and AutoCAD LT later in this chapter.

Using the AutoCAD and AutoCAD LT Interface

You're probably eager to start drawing. First, though, it helps to get the lay of the land.

Figure 1-2 shows the screen that appears when you first open AutoCAD or AutoCAD LT. Your
screen may look somewhat different — remember that AutoCAD and AutoCAD LT can be cus-
tomized in many ways — but the general features will be the same.

« Cross- You may see the Tool Palettes window with some sample office furniture and hatches. You

\ Reference may also see (AutoCAD only) the Sheet Set Manager. | cover the Tools Palettes and Sheet Set
Manager in Chapter 26. For now, you can click the palettes’ close button to get them out of
the way. You may also see the Info Palette, which | cover in Chapter 3. Finally, your screen is
probably black, rather than the white screen you see in Figure 1-2. | explain how to change
the drawing area color in Appendix A. The AutoCAD LT screen is very similar to the AutoCAD
screen.

The AutoCAD/AutoCAD LT screen consists of four important areas. These are discussed in
the next sections.

The drawing area

The blank area in the middle of the screen, the graphics window or drawing area, is where you
draw. You can think of this as a sheet of drafting paper, except that this piece of paper can be
any size — even the size of a huge factory!

At the bottom of the drawing area is a tab labeled Model. You draw on this tab. You use the
layout tabs to lay out your drawing for plotting. (See Chapter 17 for details.)

When you start to draw, you need to specify where to start drawing. One way is to use coordi-
nates. To specify a coordinate, the universally accepted convention is to put the X coordinate
first, followed by a comma, and then the Y coordinate. Figure 1-3 shows some coordinates on
X and Y axes.

« Cross- Chapter 4 is devoted to explaining how to specify coordinates. To create three-dimensional
\ Reference models, you need to add a Z coordinate when specifying a point. Chapter 21 discusses three-

dimensional coordinates.

The UCS icon

Notice the symbol with two arrows at the bottom-left corner of the drawing area in Figure 1-2.
This symbol is called the User Coordinate System (UCS) icon. The arrows point to the posi-
tive directions of the X and Y axes to help you keep your bearings.

¢ Cross- You can change the look of this icon, as | explain in Chapter 8.
\ Reference
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Drawing close button
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Application maximize button
Draw toolbar Properties toolbar Application minimize button
Layers toolbar  Standard toolbar Drawing minimize button
Menu bar Title bar Drawing maximize button
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File Edit’ View Indert Format Toels Draw Dimension Modify |Express Windo Help . 8 xt
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Layout tabs Status bar Crosshairs Modify toolbar
Modeltab  Command line Drawing area Pickbox Status bar menu

User Coordinate System (UCS) icon
Figure 1-2: The AutoCAD and AutoCAD LT screen are almost identical.

The crosshairs

In the drawing area of Figure 1-2, notice the two intersecting lines with a small box at their inter-
section. The small box is called the pickbox because it helps you to pick objects. The lines are
called crosshairs. They show you the location of the mouse cursor in relation to other objects in
your drawing.
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Y axis
-3,5
32
0.0 = X axis
-1,-1 - 6.2

Figure 1-3: Some X,Y coordinates.

As you move your mouse around, the pickbox and crosshairs move with your mouse. At the
bottom of your screen, at the left end of the status bar (described later), you can see the XY
coordinates changing as you move the mouse.

The menus and toolbars

At the top of your screen is the title bar, and directly beneath the title bar is a menu bar. Below
that are two rows of toolbars. In addition, your screen has two more toolbars, the Draw and
Modify toolbars, which are probably docked at the left and right sides of the screen (refer to
Figure 1-2). Use the menus and toolbars together to give AutoCAD or AutoCAD LT commands to
draw, edit, get information, and so on.

Because you can customize the menus and toolbars to suit your needs, your screen may
appear somewhat different. AutoCAD and AutoCAD LT provide many more toolbars that you
can display when you need them. Some examples of the toolbars are Dimension, View, and
Zoom. You learn about these and more, later in this book.

The command line

At the bottom of the screen, you see a separate window showing approximately three lines of
text. (You can change it to show as many lines as you like by dragging the top edge of the win-
dow up or down.) Notice the word Command:. This is the command line. All commands can be
executed by typing them on the command line.

Even if you use a menu item or toolbar button to execute a command, you may need to look at
the command line to see how AutoCAD or AutoCAD LT responds. Often, AutoCAD and AutoCAD
LT provide options that must be typed in from the keyboard. Also, text that you type appears
on the command line. For example, when you type coordinates specifying a point, they appear
on the command line. To see more of the command line, press F2 to open the AutoCAD or
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AutoCAD LT Text window. You can scroll back through previous commands. Press F2 again to
close the window. You can also simply hide the Text window by clicking in the AutoCAD or
AutoCAD LT window for easy access to the Text window later from the Windows taskbar.

The status bar

At the very bottom of the screen is the status bar (refer to Figure 1-2). At the left are the X)Y
coordinates. As you move your mouse, these coordinates change. (If they don’t change, click
them and move your mouse again.) The status bar also sports several buttons that I explain
later in this book.

At the right side of the status bar is a small down arrow. Click it to open the status bar menu.
This menu determines which buttons appear on the status bar. If you don’t use a certain but-
ton, choose it on the menu to remove its checkmark and make it disappear. You can always
go back and choose the item again to redisplay the button. Also at the right side of the status
bar is the new Communication Center icon. (See Chapter 26 for details.)

In AutoCAD only, you can use the Express Tools FULLSCREEN command to hide the title bar,
menu, and status bar, leaving more room for the drawing area. To return to the regular dis-
play, type fullscreen on the command line and press Enter.

« Cross- For information about installing the Express Tools, see Appendix A.
\ Reference

Creating Your First Drawing

Tip

You are now almost ready to draw your first lines. But first take a minute to get accustomed
to using the toolbars to give AutoCAD or AutoCAD LT a command.

Toolbars

On the Draw toolbar, move the mouse cursor over the first button. You see a tooltip that says
Line, as shown in Figure 1-4. Also notice the status bar, which tells you that this button cre-
ates straight-line segments.

If you inadvertently start a command that you don't want, press Esc. The command-line
X prompt (Command:) returns.

]

Creating a new folder

For your work with this book, you should create a new folder so that you can save your exer-
cise drawings where they won’t get mixed up with other drawings. The following directions
leave it up to you where to create this new folder. Each computer system is organized differ-
ently. If you aren’t sure what to do, choose the drive (not the folder) where AutoCAD or
AutoCAD LT is installed and create a new folder there.

Caution I do not recommend creating a subfolder in the AutoCAD 2005 or AutoCAD LT 2005 folder.

This folder contains the files that make up the program. If you keep your drawings here, it is too
easy to make a mistake and delete necessary program files. Many people create a subfolder in
the My Documents folder.
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Figure 1-4: Moving the cursor over the Line button displays a
tooltip.
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[Command

Creates straight line segments: LINE

STEP-BY-STEP: Creating a New Folder

1.

Move the mouse cursor down to the taskbar at the bottom of your screen and right-
click Start.

. Choose Explore.

. On the left pane of Windows Explorer, click the drive where you want to create the new

folder. If you don’t know where to create the folder, choose the drive where AutoCAD or
AutoCAD LT is installed. If you're on a network, choose the drive that represents your
computer.

. If you want to make a subfolder (a folder within a folder), choose the folder where you

want to create the subfolder.

. From the Explorer menu, choose File => New = Folder. A new, highlighted folder, named

New Folder, appears in the right pane. You may have to scroll down to see it.

. Type AutoCAD Bible for the folder name and press Enter. (If you did the exercises from

a previous edition of this book, such as AutoCAD 2004 Bible, and you already have a
folder named AutoCAD BibTe, first rename the original folder to something such as
ACAD2004Bible.)

Save all drawings that you create for this book in your AutoCAD Bib1le folder.

Caution

Creating a folder for your drawings as described in the previous steps is essential before you
go on to exercises in the rest of this book.
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Creating your first drawing

In this Step-by-Step exercise, you draw a window. You use a number of drawing and editing
techniques to give you a feel for how AutoCAD and AutoCAD LT work. These techniques are
explained in detail throughout the book. When you finish drawing the window, you add some
dimensions and then print (or plot) the drawing.

For this exercise, simply follow the instructions exactly. When you type the X and Y coordi-
nates (shown in bold), type the first number, a comma, and then the second number, with no
spaces between them.

Don't worry if you don't understand everything you're doing. It all becomes clear as you
, progress through this book. If you haven't read the Preface, now is a good time to go back

“/# and read the part that explains how to follow the exercises.

Follow the prompts shown next. As explained in the Preface, you type what appears in bold.
Instructions to you in command sections appear in italics.

window, ab01-a.dwt, isin the Drawings folder of the AutoCAD 2005 and AutoCAD LT 2005

\ The drawing (template) that you need for the following Step-by-Step exercise on drawing a
| Bible CD-ROM.

STEP-BY-STEP: Drawing a Window
1. Start AutoCAD or AutoCAD LT.

You see the new drawing. (If you are prompted for a template, skip to Step 2, the third
sentence.)

2. Choose File=> New. The Select Template dialog box opens. Navigate to the Drawings
folder of the CD-ROM of this book, choose ab01-a.dwt, and click Open. You see a blank
drawing. (I explain more about templates and opening drawings in Chapter 2.)

3. To save the drawing, click Save on the Standard toolbar (refer to Figure 1-2 to find
E this toolbar). In the Save Drawing As dialog box, use the Save In drop-down list to
navigate to the AutoCAD Bible folder that you created in the previous exercise. Type
ab01-01 in the File Name text box and click Save. This name means that this is the first
drawing from Chapter 1 of the AutoCAD 2005 and AutoCAD LT 2005 Bible. (1 go into
more detail about saving a drawing in the next section of this chapter.)

4. From the Layer Control drop-down list on the Layers toolbar (refer to Figure 1-2 to find
this toolbar), click the down arrow and choose WINDOW. (Layers allow you to organize
your drawing; I cover them in detail in Chapter 11.) Anything you draw will now be on
the WINDOW layer.

5. — With your left mouse button (also called the pick button), choose Rectangle from
the Draw toolbar (refer to Figure 1-2 to find this toolbar). (Using toolbars is only
one way to give AutoCAD and AutoCAD LT commands. I explain other ways in Chapter 3.
You can find more about drawing lines and rectangles in Chapter 6.)

6. Follow these prompts to draw a rectangle that is 3'8" wide and 6'8" high:

Command: _rectang

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/
Width]: 0,0 J

Specify other corner point or [Dimensions]: 3'8",6'8" 4

11
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7. & To create a second rectangle inside the first one, choose Offset from the Modify

toolbar, (refer to Figure 1-2 to find this toolbar) following these prompts:

Specify offset distance or [Through] <Through>: 4 4
Select object to offset or <exit>: Click the rectangle to select it.
Specify point on side to offset: Click anywhere inside the rectangle.
Select object to offset or <exit>: 4 (Press Enter.)

. You can draw from geometric points on objects such as endpoints and midpoints. (I

explain how to specify coordinates in Chapter 4.) To draw a line between the midpoints
of the inner rectangle, choose Line from the Draw toolbar and follow these prompts:

Specify first point: Press and hold the Shift key and right-click.
From the shortcut menu that opens, choose Midpoint. Then click (with
the left mouse button) the left side of the inner rectangle.

Specify next point or [Undol: Press and hold the Shift key and right-
click. From the shortcut menu that opens, choose Midpoint. Then click
(with the Teft mouse button) the right side of the inner rectangle.
Specify next point or [Undol: 4 (Press Enter.)

Your drawing should now look like Figure 1-5. (Your window should be green.)

Figure 1-5: The beginning of a window.

. / You will now draw a construction line to help you find the starting point for the top

half of the window. From the Draw toolbar, choose Line. Follow these prompts:

Specify first point: Press Shift and right-click. Choose Endpoint from
the shortcut menu. Pick the left endpoint of the last line you drew.
Specify next point or [Undol: @4,4 4. (This notation specifies that
the endpoint of the line is 4 units above and to the right of the
first point. Chapter 4 explains more about specifying coordinates in
this manner.)

Specify next point or [Undo]l: .
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Again choose Rectangle from the Draw toolbar. Follow these prompts:

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/
Widthl: Press Shift and right-click. Choose Endpoint and pick the
final endpoint of the diagonal line you just drew.

Specify other corner point or [Dimensions]: @2'4",2'4"

Choose Erase from the Modify toolbar. At the Select objects: prompt, pick the
& short diagonal construction line that you drew in Step 9. The Select objects:
prompt appears again. Press Enter to end the command. (Chapter 9 explains the ERASE
command as well as other simple editing commands.)

Click the ORTHO button on the status bar at the bottom of the drawing area. The ORTHO
feature constricts drawing to right angles — horizontal or vertical. (You can find more
about ORTHO in Chapter 4.)

To finish the bottom of the window, choose Line from the Draw toolbar. Follow these
prompts:

Specify first point: 8",3'4" 4

Specify next point or [Undol: Move the mouse cursor down from the
start point of the line, which is shown as a temporary drag line.
Then type the following length of the line. 2'8-7/16 J

Specify next point or [Undol: Move the cursor horizontally to the
right and type 28 .

Specify next point or [Close/Undo]: Now try entering the distance
using decimal notation, instead of feet and inches. Move the cursor
up and type 32.4375

Specify next point or [Close/Undo]: 4

To draw shutters, first change the layer. Click the Layer Control drop-down list on the
Layers toolbar, and choose EXWALL.

Choose Line from the Draw toolbar. Follow the prompts:

Specify first point: Press Shift and right-click. Choose Endpoint
from the shortcut menu. Click the upper-left corner of the window.
Specify next point or [Undol: Move the cursor to the left. Type 1'6" J
Specify next point or [Undo]: Move the cursor down. Type 6'8" J
Specify next point or [Close/Undo]: 0,0 4

Specify next point or [Close/Undo]: 4

To draw the opposite shutter, you’ll mirror the first shutter that you just drew. (I cover
the MIRROR command and many other editing commands in Chapter 10.) Choose Mirror
from the Modify toolbar and follow these prompts:

Select objects: Click the three lines that make up the shutter.
Select objects: o

Specify first point of mirror line: _Press Shift and right-click.
Choose Midpoint from the shortcut menu.

mid of Pick the top horizontal line of the window.

Specify second point of mirror line: The ORTHO button should still be
indented. (If not, click it.) Move the cursor downward and pick any
point to specify a vertical mirror line.

Delete source objects? [Yes/No] <N>: 4

Your window is now complete and should look like Figure 1-6.

13
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' Note

17.

18.

19.
20.

21.
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S

Figure 1-6: The completed window.

To add a dimension to the bottom of the window, you should first change the layer.
From the Layer Control drop-down list on the Layers toolbar, choose DIMENSION.
(Chapters 14 and 15 explain how to format and create all types of dimensions.)

To place the dimension, choose Dimension = Linear. Follow the prompts.

Specify first extension line origin or <select object>: 4 (Pressing
Enter lets you select an object to dimension.)

Select object to dimension: Pick the bottom horizontal Tine of the
window (the bottom of the rectangle).

Specify dimension Tine location or
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: Move the cursor down
until the dimension is nicely spaced below the window. Click to place
the dimension Tine.

If you don't have enough room to place the dimension below the window, click the down
arrow of the vertical scrollbar as necessary. | explain additional techniques for changing the
view of your drawing in Chapter 8.

Click Save on the Standard toolbar to save your work.

To prepare for printing, click the layout tab, A Title Block-Landscape. You see the
window inside a title block and border, as shown in Figure 1-7. This title block and bor-
der comes with the template to help you easily prepare the drawing for printing. (Chap-
ter 17 explains how to lay out and print/plot a drawing.)

To set the scale for printing, click the magenta viewport border (labeled in Figure 1-7).
Choose Tools = Properties. In the Properties palette, click the Standard Scale item.
Click the down arrow that appears to the right of this item and choose 1"=1". Click the
Properties palette’s close button at the top of the palette. (I explain more about scales
in Chapter 5.)
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Figure 1-7: The window with a title block as it appears on the
layout tab.

If the window and its dimension are not centered in the viewport window, double-click
inside the viewport border. Then choose View = Pan > Realtime. Click and drag as nec-
essary to center the window in the viewport. Press Esc to exit pan mode. Double-click

outside the viewport border to return to the layout.

'-EL To add some text to the title block, you need to zoom in. (I explain zooming in

4 more detail in Chapter 8.) From the Standard toolbar, choose Zoom Window. If
another Zoom option is displayed, click and hold that button until the Zoom flyout
appears. Then drag down and choose Zoom Window. Follow the prompts:

Specify first corner: Click slightly above and to the left of the
words Project Name.

Specify opposite corner: Click slightly below and to the right of the
words City ST ZIP.

You should now see those words very large in the drawing area. These words are
already placed and formatted, so all you need to do is replace them. (I explain all about
how to create and edit text in Chapter 13.)

Double-click the Project Name text. The text editing window opens, with the Text
Formatting toolbar above it, as shown in Figure 1-8.
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Figure 1-8: The text editing window.

Select the text by dragging from the upper-left corner to the lower-right corner. Type
the following:

Double-hung window
2010 Coral Lane o
Fairfield, IA 12345

Click OK on the Text Formatting toolbar to close the text editing window.

@p\ To return to your previous view, choose Zoom Previous on the Standard toolbar.

% You're ready to print your drawing! Because readers will have varying setups, you

can print directly to your printer. However, if you have a plotter set up, you can
use that. (The layout is set up to fit on an 8%-x-11-inch or A-size paper.) Choose Plot on
the Standard toolbar. The Plot dialog box opens. (I cover printing and plotting in Chap-
ter 17. Appendix A explains how to configure a printer or plotter.)

In the Printer/plotter section of the Plot dialog box, choose the printer or plotter that
you want to use from the Name drop-down list.

Click the Preview button to open the preview window. You should see the window and
its title block laid out as shown in Figure 1-9.

% Make sure your printer or plotter has an 8%-x-11-inch or A-size sheet of paper,
and click the Plot button on the Preview window’s toolbar. Congratulations!
You've just created and printed your first drawings!

Leave the drawing open on your screen. You practice closing a drawing later in this
chapter.

If things don't seem right, click the Close Preview Window button and review the previous
steps to see if you can find the problem. Also see the sidebar, “Help! My drawing doesn't
look like the figure.”
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Figure 1-9: Viewing the window in Preview mode.

In this exercise, you practiced many of the skills that you need to use AutoCAD or AutoCAD
LT effectively. Most of your work in AutoCAD or AutoCAD LT builds on these basic skills. The
rest of the chapters in this book explain these procedures in much more detail as well as
many more features not covered in this beginning exercise.

Help! My drawing doesn’t look like the figure

If your drawing doesn’t look like the image shown in Figure 1-6, there could be several reasons.
To fix the problem, try one of the following solutions:

+ You may have made a mistake. If you think that's the case, start over and follow the
prompts again.

4+ You may have started AutoCAD or AutoCAD LT based on a template with different prop-
erties than the default. Be sure to use the template on the AutoCAD 2005 and AutoCAD
LT 2005 Bible CD-ROM as explained in Step 2 of the previous exercise. Then follow the
prompts again.

+ If your drawing still seems wrong, put the CD-ROM that accompanies this book in your
CD-ROM drive. Choose File => Open and use the Open dialog box to find ab01-01 . dwg
on the CD-ROM. This drawing contains the end result of the exercise. You can try to find
the difference between this drawing and yours. You can also copy ab01-01.dwg from
the CD-ROM to your hard drive and print or plot it.

One of the preceding options should solve your problem. If you began more than one new draw-
ing, you probably have more than one drawing currently open. You can switch from one open
drawing to another by choosing any open drawing from the Window menu.
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Saving a Drawing

Saving a drawing is similar to saving any other file in Windows. You should get in the habit of
saving your work every 10 to 15 minutes to avoid losing your work in case your computer
system crashes.

Saving a drawing for the first time is different from saving it subsequently because you have
to name the drawing the first time you save it.

E To save a drawing, click Save on the Standard toolbar. If you're saving a drawing for the
I first time, the Save Drawing As dialog box appears, as shown in Figure 1-10.

i@ Save Drawing As [B]=]
Savein: | [3)AutoCAD Bible v R @ Xl vew v Tok v
Preview
Y Name Size| Type
D ah8-03.dg 28KB  AutoCAD Drawing
History ah08-04.cing 27KB  AutaCAD Draning
7 2b03-03.dwa FIKE AutaCAD Draning
) &h05-04.dg 30KB  AutoCAD Draning =
ab10-1.dwg 21KB  AutoCAD Drawing
My Documents b1 3-05 dwg FTKE  AutoCAD Drawing
- abi14-03.dvg 51KB  AutaCAD Draning
XY ahi14-08.dwg 56KB  AutoCAD Drawing
Favoites ah14-10.cng 36KB  AutoCAD Draning
. ahi16-07.dwg 53KB  AutaCAD Draning
B ah15-03.dvg 94KB  AutoCAD Draning
ah13-02_recover.dwg 7AKB  AutoCAD Drawing
Desktop ahi19-04.dwg BKE  AutaCAD Draning
13 b20-01 g 124KB  AutoCAD Draning
LJ_ [ER Ah2n-a o 13RKR AutalAN Drawinn Y
Buzzsaw ¢ 2
Update sheet and view thumbnails now
e [#E5 T -
Files of type: | &utoC4D 2004 Drawing [* dwg) ~

Figure 1-10: The Save Drawing As dialog box.

Down the left side of the dialog box are several buttons to help you find a location to save
drawings more quickly. Together, these buttons are called the Places list. Use the Places list as
follows:

4+ History lists shortcuts to recently used drawings.

4+ My Documents lists drawings and folders in the My Documents folder. Some people
store files in this folder. (Your system may call this the Personal folder.)

4+ Favorites lists files and folders in the C: \Documents and Settings\[login name]\
Favorites folder. (This is the location in Windows XP; it may be different on your com-
puter.) You may have an Autodesk subfolder; if so, double-click the Autodesk subfolder
to save a drawing there. Usually, this folder contains only shortcuts to files saved else-
where. To put a shortcut to an already saved drawing in Favorites, choose File=> Save
As and click the Tools drop-down list; then click Add to Favorites. You can later open
the file from the Favorites folder.

4 Desktop shows drawings on your desktop. Some of the Windows icons also appear on
this list.

4 Buzzsaw sends you to www.buzzsaw.com, the Autodesk business-to-business portal for
the building design and construction industry. You can set up a new account or access
existing projects.
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In a nice touch, you can reorder the buttons in the Places list. Just drag any button to a new
location.

Of course, you can also choose a location from the Save In drop-down list to save the file to.
To save a file, type a file name in the File Name text box and click Save to save the file.

Use the Views drop-down list of the dialog box to specify how you want to display files in this
dialog box. List just displays the name; Details adds the file size, type, and date modified; and
Preview adds a preview of the drawing.

Use the Tools drop-down list of the dialog box to do the following:

A

AutoCAD
Only

4

On the )
..\CD\
Y

4 Add or Modify FTP Locations: FTP sites are locations on the Internet for transferring

files. To add or modify FTP locations, choose Tools = Add/Modify FTP Locations from
the menu of the Save Drawing As dialog box. You need to list the name of the FTP site,
choose a logon type (Anonymous or User), and specify your user name and password if
you'’re logging on as a User. You can then save drawings (called uploading) to FTP loca-
tions by clicking the Save In drop-down list and choosing FTP Locations. This feature
makes an intranet or any server with FTP capability as accessible as your own com-
puter system.

Add Current Folder to Places: If you save to a specific folder often, you can navigate to
that folder and then choose Tools => Add Current Folder to Places. The Places Bar then
displays a new button for that folder so that you can easily click the button to go straight
to the folder.

Add to Favorites: When you have navigated to a folder, you can add it to the Favorites
folder by choosing Tools => Add to Favorites. You can also select a file in a folder and
add it to the Favorites folder.

The SAVEALL command of the Express Tools saves all open drawings, without closing them. If
a drawing hasn't been saved, you are prompted for a file name. Choose Express«=> File tools >
Save All Drawings. For information on installing Express Tools, see Appendix A.

The CD-ROM includes a small program, savea . 1sp, that automatically backs up your draw-
ing to the floppy drive after you've saved it on your hard drive. If you like to back up to a
diskette regularly for safety, this program can be useful. Look in \Software\Chap01\
Savea. (AutoCAD only.)

Closing a Drawing and Exiting from
AutoCAD and AutoCAD LT

You can close your drawing and keep AutoCAD or AutoCAD LT open. The simplest way is to
use the drawing Close button just under the application Close button. You can also choose
File> Close.

Tip

You can choose Window = Close All to close all open drawings. If any of the open drawings
have unsaved changes, AutoCAD or AutoCAD LT prompts you to save the changes. If you
have AutoCAD and you installed the Express Tools (see Appendix A for details), you can
choose Express = File tools=> Quick Exit, which closes all open drawings (prompting you to
save if necessary) and then exits the program.
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To exit AutoCAD or AutoCAD LT, click the Close (X) box at the top-right corner of your screen.
You can also exit out of AutoCAD or AutoCAD LT by typing quit on the command line and press-
ing Enter. Another method is to choose File = Exit.

If you've made any changes to your drawing since last saving it, AutoCAD or AutoCAD LT asks
you if you want to save your changes. Choose Yes or No as your situation requires. Choosing
Cancel returns you to your drawing. If you have opened more than one drawing to which you
have made changes, you have a chance to save each drawing in turn so that you don’t exit
AutoCAD or AutoCAD LT without saving all the changes you’ve made in your open drawings.

STEP-BY-STEP: Closing Your Drawing and
Exiting AutoCAD or AutoCAD LT

1. The window of ab01-01.dwg should still be on your screen. Choose File = Close. You
now see a gray screen with no drawing. (Repeat this process if you have other draw-
ings open. Save or cancel the changes to these extra open drawings as you like.)

2. Click the Close button in the upper-right corner to exit AutoCAD or AutoCAD LT. The
program closes immediately.

Summary

Chapter 1 explained how to start AutoCAD and AutoCAD LT and create a new drawing. [ gave
you a tour of the screen and explained how to save a drawing. This chapter provides the basis
for all your work in AutoCAD and AutoCAD LT.

In this chapter, you learned the following:
4 A brief history of AutoCAD and AutoCAD LT
4+ Some of the different disciplines that use AutoCAD and AutoCAD LT
4+ How to start AutoCAD and AutoCAD LT
4+ How to start a new drawing

4+ The user interface and its various sections, including the drawing area, the UCS icon,
the crosshairs, the menus and toolbars, the command line, and the status bar

4+ How to start a command from a toolbar
4+ How to select an object and edit (erase) it
4+ How to draw lines and rectangles

4+ Several ways to specify coordinates, including typing X,Y coordinates and specifying
the endpoint of a line

4+ How to save a drawing for the first time
4+ How to close a drawing
4+ How to exit AutoCAD and AutoCAD LT

You may have several questions at this point, but “well begun is half done.” The next chapter
explains all the ways to start a new drawing as well as how to open an existing drawing.

¢+ ¢



Opening a Drawing

AutoCAD and AutoCAD LT offer a number of options for opening
new and existing drawings. These options create a great deal of
flexibility and save you time as well. You can create complex templates
to avoid doing the same basic setup and drawing over and over.

Creating a New Drawing
from a Template

'Note

A template is a special file that contains settings and often objects
(such as a title block). When you use a template as the basis for a
new drawing, the drawing takes on all the settings and objects con-
tained in the template. Use templates to avoid re-creating settings
and redrawing objects for new drawings. AutoCAD and AutoCAD LT
come with many templates that you can use as is or customize. You
can also create your own templates.

AutoCAD and AutoCAD LT offer a Startup dialog box that offers

- choices for starting a new drawing as well as opening existing draw-

ings. To display the Startup dialog box whenever you open AutoCAD
or AutoCAD LT, choose Tools > Options and click the System tab. In
the General Options section, choose Show Startup Dialog Box from
the Startup drop-down list. Click OK to close the Options dialog box.

To create a new drawing based on a template, choose File=> New to
open the Select Template dialog box, which lists all the available tem-
plates, as shown in Figure 2-1. Click any template to see its preview, if
any. Double-click a template to create a new drawing based on that
template. Because AutoCAD or AutoCAD LT open with Drawingl.dwg,
the new drawing is named Drawing2.dwg. Subsequent drawings that
you open are named Drawing3.dwg and so on. When you save and
name your drawing, the original template file is unaffected.

The QNEW command is useful if you always start a new drawing
D based on the same template. You set a default template and
then click QNew on the Standard toolbar to start a new drawing
immediately, based on that default template. To set the default tem-
plate, follow these steps:

1. Choose Tools = Options and click the Files tab.

2. Double-click the Drawing Template Settings item.

—
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3. Double-click the Default Template File Name for QNEW item.

4. Click the listing under the Default Template File Name for QNEW item (which says None
by default).

5. Click Browse to choose the template that you want.
6. Click OK to close the Options dialog box.

You can specify whether this default template uses metric or imperial measurement by setting
the MEASUREINIT system variable. (System variables are discussed further in Chapter 5.) On
the command line, type measureinit. Enter 0 . for imperial units and 1 . for metric units.

The default template is acad.dwt for AutoCAD and ac1t.dwt for AutoCAD LT. Another default
template is acad-Named Plot Styles.dwtoraclt-Named Plot Sytles.dwt, which refers
to named plot styles. (See Chapter 17.)

iE Select template 3%
Lackin: | IC5) Template vl @ r @ X! Vews v Tooks
" Preview
A Mame Siz ™
Lﬁ’ [ PTWTemplates
Histamy ) SheetSets
[0 acad -Mamed Plot Styles. dwt 3K
_J [0 acad.dwt 33K
@ acadl50 -Named Plat Styles.dwt K
My Documents [0 acadiso. dwt HE
q.j\ @ANS\ A [portrait] -Color Depend, arK
{/\f @ANS\ A [portrait] -Mamed Plat § arK
Favorites @ANS\ A -Color Dependent Plot ... arK
. @ANS\ A -Mamed Plot Styles.dwt arK
B @ANS\ B -Color Dependent Plot ... arK
@ANS\ B -Mamed Plot Styles.dwt arK
Desktop @ANS\ C -Color Dependent Plot ... /K
. |“\.' @A.N?\ F -P:la.me? Plat Slylssflwl ?? K P
Wr < S
Buzzsaw
File name: acad.dwt hd E]
Files of type: | Drawing Template [* dwt] v
Figure 2-1: Choose a template from the Select Template dialog
box.

STEP-BY-STEP: Opening a Drawing
Based on the Default Template

1. Start AutoCAD or AutoCAD LT.

2. Choose File=> New.

3. From the Select Template dialog box, choose acad.dwt (for AutoCAD) or aclt.dwt
(for AutoCAD LT) from the list.

4. Click Open. You now have a blank drawing named Drawing2.dwg, as shown in Figure 2-2.
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Figure 2-2: When you create a drawing based on a template, AutoCAD or AutoCAD LT
opens a drawing called Drawing?.dwg.

Working with Templates

A template contains ready-made settings to get you started drawing quickly. These settings
include the size of the drawing (called limits), the unit type (such as decimal or feet and inches),
and others. An important part of setting standards in an office where people work together on
drawings is the creation of a template so that all users work with an identical setup.

- Cross-

Gr In Chapter 5, | explain more of the options available for setting up a drawing. In Chapter 26,
eference

I cover the process of setting standards for drawings.

A template may contain more than just settings — it often contains a complete title block, for
example, and may include boilerplate (standardized) text as well.

Customizing the default template

Most people customize the default template to create one or more templates that suit their
particular needs. After your templates are created, you don’t have to worry about most set-
tings; they are already available for you and you can quickly start to draw.
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To customize acad.dwt or acl1t.dwt, follow these steps:

1.

Caution

Open a drawing based on the template as described in the previous section.

. Make any changes you want.

2
3.
4

Click Save on the Standard toolbar.

. In the Save Drawing As dialog box, click the Files of Type drop-down list box. Choose

AutoCAD Drawing Template or AutoCAD LT Drawing Template (*.dwt). In the list of
template files, choose the template that you want to customize. Click Save.

. When asked if you want to replace it, click Yes.

. In the Template Description dialog box, revise the description as you like and click OK.

If you're using someone else’s computer, don't change templates that come with AutoCAD
or AutoCAD LT without first checking with the computer’s owner. It can be a frustrating expe-
rience to start a drawing based on a template and find that all the settings have been
changed. Also, if you create new templates, put them in their own folder to avoid losing
them when you upgrade or reinstall AutoCAD.

Creating your own templates

You may want several templates to choose from on a regular basis. For example, you may cre-
ate drawings of several sizes. AutoCAD and AutoCAD LT let you create as many templates as
you want. To create your own templates, either start a drawing based on a template and make
the changes you want, or open an existing drawing that already has some of the settings you
want and make any further changes you need. Follow these steps:

1.

If you start a new drawing based on a template, choose Save from the Standard toolbar.
If you open an existing drawing, choose File=> Save As from the menu.

. In the Save Drawing As dialog box, click the Files of Type drop-down list box. Choose

AutoCAD Drawing Template or AutoCAD LT Drawing Template.

3. In the File Name text box, type a name for your template. Click Save.

Tip

]

. In the Template Description dialog box, enter the description as you want. Click OK.

Name your templates in a way that clearly differentiates them from regular drawings. You may
want drawings set up for each of the standard paper sizes (A through E), with a title block in
each. Useful names might be th-a.dwt, tb-b.dwt (tb meaning title block), and so on.

Most AutoCAD and AutoCAD LT users take advantage of these techniques as a standard prac-
tice. You can usually make profitable use of a template as the basis for a new drawing.

Opening a Drawing with Default Settings

Occasionally, you want to open a drawing without any settings. It is actually impossible for a
drawing to have no settings at all, but you can open a drawing with the minimum possible
presets. You might want to do this if you’re working on someone else’s computer and don’t
want to take the time to get rid of a large number of complex settings that aren’t helpful for
your work.
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To open a drawing with the fewest possible settings, choose File => New. Instead of choosing a
template, click the arrow to the right of the Open button (see Figure 2-1). Choose one of the
following options:

4 Open with no template —Imperial

4 Open with no template — Metric

Opening an Existing Drawing

Often you need to open an existing drawing, either to complete it or to make changes.
Opening a drawing in AutoCAD or AutoCAD LT is like opening a file in any Windows program.
You can find existing drawings by name or by viewing a thumbnail image of the drawing.

Choose Open from the Standard toolbar. The Select File dialog box appears, as shown

in Figure 2-3. In the Look In drop-down list box, choose the drive where your drawing
resides. In the main box, double-click the folder you need. Then choose your drawing. The
Preview box enables you to quickly look at the drawing to see if it’s the one you want. Click
Open. The drawing opens.

New '\ If you open more than one drawing, each drawing has its own button on the Windows

Feature taskbar. (You can still switch between drawings using the Window menu.) If you want to turn
off this feature, type taskbar on the command line and press Enter. At the Enter new
value for TaskBar <1>: prompt, type 0 and press Enter.

If you have Windows 2000 or XP, you can view thumbnail images of all the drawings in a folder
in the Select File dialog box (and other dialog boxes that enable you to choose a file) by click-
ing the Views button and choosing Thumbnails. In all operating systems, you can view thumb-
nails in Windows Explorer in the same way — by clicking the Views button and choosing

Thumbnails.
i Select File =
Lock ire | [ Drawings o] & @ @ XN @ Views v Tk -
Y 3D blocks. dwg Preview
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Figure 2-3: The Select File dialog box is equivalent to the Open
dialog box in most Windows programs.
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; To look for a file to open on the Web, click the Search the Web button in the dialog box.
‘-1 You can also use the Places list at the left side of the dialog box to find drawings. The
Places list is described in Chapter 1.

You can double-click a drawing in Windows Explorer to open it. If AutoCAD or AutoCAD LT is
not running, Windows loads the program and the drawing as well. If AutoCAD or AutoCAD LT is
running and a drawing is active, the drawing opens as a second drawing within the program.

You can also open a drawing from the DesignCenter —a feature for managing both draw-

ing files and many of their components. First, choose DesignCenter from the Standard
toolbar. The DesignCenter palette opens, displaying an Explorer-like list of drawings in the left
pane. If necessary, choose Desktop from the DesignCenter toolbar. Navigate to the folder con-
taining the drawing and choose the drawing’s folder in the left pane. The drawings in the folder
are listed in the right pane. Right-click the drawing of your choice and choose Open in Appli-
cation Window. For more information on the DesignCenter, see Chapter 26.

You can open a drawing using the new Sheet Set Manager (AutoCAD only). I cover sheet sets
in Chapter 26.

You can use several shortcuts when working in dialog boxes that open or save files, as follows:
4+ Double-click the drawing file to open it immediately without clicking Open.

4 Click the Views drop-down list. Choose List to see a simple list. Choose Details to see
the file size and the last date and time the file was saved.

4+ Right-click inside the dialog box to open a shortcut menu with more options.

4 Click the name of a drawing to highlight it and then click it once more to rename it (but
don’t double-click it —that opens the drawing).

dwg, is in the Results folder of the AutoCAD 2005 and AutoCAD LT 2005 Bible CD-ROM.

\ The drawing used in the following Step-by-Step exercise on opening a drawing, ab01-01.
Place the CD-ROM in your CD-ROM drive.

STEP-BY-STEP: Opening a Drawing
1. If AutoCAD or AutoCAD LT is not open, start the program.
2. il Click Open on the Standard toolbar.

3. In the Select File dialog box, choose the drive for your CD-ROM in the Look In drop-down
list box.

4. In the main box, double-click the Results folder.
5. In the main box, click ab01-01.dwg.

6. Click Open. The drawing opens. Keep this drawing open for the next exercise.

Using an Existing Drawing as a Prototype

Although a template can be very useful, if you plan to use the objects and settings in a drawing
only a few times, you can simply use one drawing as a prototype for other drawings. You often
need to draw a series of related drawings — perhaps several related electrical schematics or a
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group of similar apartments in an apartment complex. When a significant part of the first draw-
ing is applicable to subsequent drawings, don’t start over —open an existing drawing, and
immediately save it under a new name, as described in the next section. Make the necessary
changes and resave the drawing.

Saving a Drawing Under a New Name

Whether you want to use an existing drawing as a prototype or simply make a copy of a draw-
ing, you need to save the drawing under a new name. First open the drawing and then choose
File=> Save As.

In the Save Drawing As dialog box, type a new name in the File Name text box. Then click Save.
You may also want to change the location of the new drawing by changing the folder in the
Save In drop-down list box.

\ In the following exercise, you practice making changes in a drawing as well as saving the
CD drawing under a new name. If you did the previous exercise, you have drawing ab01-01.

/ dwg on your screen. If you didn't do that exercise, open ab01-01.dwg from the Results
&7 folder of the CD-ROM.

On the

STEP-BY-STEP: Saving a Drawing Under a New Name
1. Choose File> Save As. The Save Drawing As dialog box opens.

2. In the File Name text box, change the filename to ab02-01.dwg. Choose your AutoCAD
Bible folder and click Save.

3. At the bottom of the drawing area, click the Model tab.

4. From the Layer Control drop-down list on the Layers toolbar, choose the DETAILING
layer.

5. Choose Rectangle from the Draw toolbar. Follow the prompts:

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/
Width]: -15,3 4
Specify other corner point or [Dimensions]: -3,6'4

6. Again choose Rectangle from the Draw toolbar. Follow the prompts:

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/
Width]: 3'11,3 J
Specify other corner point or [Dimensions]: 4'11,6'4 4

Your drawing should look like Figure 2-4.
7. Click the drawing Close box, which is just below the application Close box.

8. Because you haven’t saved the changes to the drawing, a message asks if you want to
save them, as shown in Figure 2-5.

9. Click Yes. AutoCAD or AutoCAD LT saves and closes the drawing.
10. Click the application’s Close box (X) to close AutoCAD or AutoCAD LT.
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Figure 2-4: The window with added detailing.

AutoCAD Figure 2-5: If you try to exit AutoCAD or
AutoCAD LT without saving the changes you
Q Save changes to C:\AutoCAD Biblevab02-01. dwy? made to a drawing, you first have a chance to
save the changes.
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Summary

In this chapter, you explored the various ways of opening a drawing. You learned the following:
4 Starting a new drawing based on a template
4 Customizing a template
4 Creating your own templates
4 Starting a new drawing with no template
4+ Opening an existing drawing
4+ Using an existing drawing as a prototype for a new drawing
4 Saving a drawing under a new name
In the next chapter, you read about using commands.
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Using Commands

AutoCAD and AutoCAD LT have been around for a long time. As
a result, the way you give the program commands — called the
user interface — is somewhat unique. You can give the same com-
mand in several ways. In this chapter, you read about the various
possibilities and start to get acquainted with all of them.

Commands are important. In a word processing program, you can sim-
ply start typing; in a spreadsheet program, you can begin by entering
data; but nothing happens in AutoCAD or AutoCAD LT until you give it
a command.

The AutoCAD and AutoCAD LT
Interface

Many new commands have been added to AutoCAD and AutoCAD LT
over the years. Often, older commands that were no longer necessary
were kept to maintain compatibility with earlier versions. A number
of these older commands, as well as certain rarely used commands,
are not found in the menus. Other than this idiosyncrasy, the menus
are similar to those of other Windows programs.

Using menus

A menu item can do three things —execute a command, open a sub-
menu, or open a dialog box. As in all Windows programs, the menu
provides clues to let you know what is going to occur after you click a
menu item. Figure 3-1 shows how this works.

Looking at the command line whenever you click a menu option is
worthwhile. Any command that you choose on a menu is repeated on
the command line, and a list of options may appear. See the section
“Responding to command options” later in this chapter for more
information on using options.

+ 0+ 0+
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The Screen Menu

In early releases, AutoCAD provided a menu on the right side of the screen, called the screen
menu. If you're still used to the screen menu, | suggest that you adjust to the new interface. You'll
find its consistency with other Windows programs to be an advantage.

If you must have the screen menu, you can easily display it. Choose Tools = Options. Click the
Display tab. In the Window Elements section, choose Display screen menu. Click OK.

AutoCAD's current default is to not show the screen menu, so | don't use it in this book.
Therefore, the word menu always means the pull-down menu at the top of the AutoCAD screen.
AutoCAD LT doesn't offer a screen menu.

Using shortcut menus

Shortcut menus appear when you right-click your mouse. The purpose of shortcut menus is
to speed up your work; they can be faster than using the command line because you don’t
have to take your eyes off the screen. The shortcut menus try to anticipate the most common
tasks you might want to complete. As a result, the menu that appears when you right-click
depends on the situation:

4+ If you have neither started a command nor selected any objects, you get the default
menu when you right-click in the drawing area. Here you can cut, copy, paste, undo,
pan, zoom, and so on.

4+ If you've selected any objects, you see the edit-mode menu, which lists the most com-
mon editing commands.

4+ If you've started a command, the command-mode menu opens, letting you choose an
option for that command. I explain this in more detail later in this chapter.

4+ When a dialog box is open, you can right-click active sections to see the dialog-mode
menu, which varies with the dialog box.

4 Other menus include the toolbar list you get when you right-click a toolbar and the
command-line history you see when you right-click the command line and choose
Recent Commands.

These menus are explained as appropriate throughout this book. You also have an opportu-
nity to use many of them in the exercises.

In earlier releases, right-clicking was equivalent to pressing Enter. You can customize how right-
clicking works —and that includes changing it back to the way it worked in earlier releases.
Choose Tools = Options and choose the User Preferences tab. Then click Right-Click Cus-
tomization. For complete details, see Appendix A.

Tip When you set right-click customization, you can turn on time-sensitive right-clicking. Time-

sensitive right-click is a great feature that gives you the best of two worlds — the right mouse
button can be used both as an equivalent to pressing Enter and to open the shortcut menus. If
you turn on time-sensitive right-clicking, a quick right-click is equivalent to pressing Enter and
will repeat the last command or end any commands that require Enter to end). A longer right-
click (hold your finger on the mouse slightly longer) opens the shortcut menu. You can specify
the length of time required for the longer right-click, which is 250 milliseconds by default.

W
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Displays submenu with more options

Redraw

Regen

Regen All

Zoom 4
Pan »

Aerial View

Clean Screen  Ctrl+0

Viewports 4
Named Views...

3D Views 4
3D Orbit

Hide

Shade 4
Render 4
Display 4

Toolbars... |

Opens a dialog box

Executes a command

Figure 3-1: The View
menu in AutoCAD. The
AutoCAD LT menu is
very similar.

Using dialog boxes

Dialog boxes offer the user a simple way to control AutoCAD or AutoCAD LT without memo-
rizing a lot of technical commands and option names. They guide you through a task by
clearly laying out all the choices.

If you're familiar with any other Windows program, you’re familiar with dialog boxes. As a
brief example, look at the Advanced tab of the Boundary Hatch and Fill dialog box (choose
Hatch from the Draw toolbar and click the Advanced tab), which enables you to specify how
you fill enclosed areas. This dialog box has most of the common features of a dialog box and
is shown in Figure 3-2. (I cover this dialog box in detail in Chapter 16.)

Throughout the book, I refer to the items in Figure 3-2 to explain how to specify settings in a
dialog box.

Tip If a dialog box has a question mark (?) icon in the top-right corner, click it to change the cur-
., sortoa question mark. Then click any item in the dialog box to display a brief explanation of
4 thatitem.
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Option button Help on dialog box
Tab  Checkbox Button
i@ Boundary|Hatch and Fill 3[%]
Hatch | Advanced | Gradient
Is)and detection sty @ Pick Paints
@ (:) % Select Objects
A Yy
Mormnal O Ouper O lgnore X
Obiject twpe Q

m Retain boundaries

Inherit Properties

Boundary set Draw Order
Current viewport v Mew Send behind boundary |+
k. Composition
Island detection method| L
(®) Associative
(®) Fland

() Monassociative
) Ray casting

Gap tolerance

0.0o00 units

Drop-down list

Text box

Figure 3-2: The Advanced tab of the Boundary
Hatch and Fill dialog box is typical of many AutoCAD
and AutoCAD LT dialog boxes.

When you've finished using a dialog box, click OK to accept any settings you specified or
click Cancel to discard any changes.

Using toolbars

Toolbars provide a quick way to execute a command with one click of the mouse. On the other
hand, those little pictures on the toolbar buttons are not always self-explanatory. Until you get
used to the location of the buttons, you may find yourself wandering (with the mouse cursor)
from button to button, reading tooltips. However, once you are familiar with the location of fre-
quently used toolbar buttons, toolbars may become a favorite way to execute commands.

Normally, you have the Standard, Styles, Layers, Properties, Draw, and Modify toolbars show-
ing. You can open other toolbars as you need them.

You can customize toolbars to suit your needs. You can also create your own toolbars from

scratch, perhaps containing your favorite command combinations. Toolbar customization is
covered in Chapter 29.
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When you click a toolbar button, in order to complete the command, you usually need to
look at the command line to follow the prompts there. [ explain the command line later in
this chapter.

A few of the toolbars have flyouts, an attached toolbar containing additional buttons. For exam-
ple, on the Standard toolbar, the Zoom button has a tiny arrow on its lower-right corner. Click
and hold a second and the flyout flies out, revealing several other buttons all related to zoom in
and out. Drag down and choose any one of the options.

To display a toolbar, right-click any toolbar and choose the toolbar you want to display.
Displayed toolbars have a checkmark next to their name. To hide a toolbar, follow the same
procedure — choose the toolbar. You can also choose View => Toolbars to open the Toolbars
dialog box. Check or clear a toolbar and click OK.

As soon as a toolbar is open, you can close it by clicking the Close button at the upper-right
corner, as long as it is not docked—that is, parked at one edge of the screen. Toolbars can
also float within the drawing area or even outside the application window (when it is not max-
imized). You can move them by dragging them and reshape them by dragging any edge. To
prevent a toolbar from docking as you move it to the edge of the screen, press Ctrl as you
drag. Docked toolbars have grab bars (which look like a double line) at one end; grab bars
enable you to easily undock and move the toolbars.

To close all the toolbars and palettes, press Ctrl+0. You now have more space to draw. To get
, back your toolbars and palettes, press Ctrl+0 again.

s

In this exercise, you practice manipulating toolbars. You can do it with any drawing on-screen.

STEP-BY-STEP: Manipulating Toolbars

1. Point to the grab bar at the top (or left) edge of the Draw toolbar. With the mouse
pointer, click, hold down the mouse button, and drag the toolbar until its outline is
under the left side of the Layers toolbar (the leftmost toolbar under the Standard tool-
bar) and it changes to a straight horizontal line. After you release the mouse button,
the toolbar docks under the Layers toolbar.

2. Click the Modify toolbar’s grab bar and drag it in the same way you did the Draw tool-
bar until it is docked under the Properties toolbar (which is to the right of the Layers
toolbar). Your screen should look something like Figure 3-3. (If your screen resolution is
800x600, the toolbar won’t be completely visible. Instead, you can dock it under the
Draw toolbar.)

iEl AutoCAD 2005 - ing1.dwg] =)
[E3 File Edit View Insert Format Tools Draw Dimension Modify Express Window Help =

DWHE &R =B »2 - e X BERSD B A Stendd v | | Standard ~| B | Standad ~
= 0@ Hmo v|3z € || mByLayer o

A0 @8 ooRe - HoBAA| | FBAEBSOLID A -OILIF
Figure 3-3: Docking the Draw and Modify toolbars at the top of the screen.

o]
X

ByLayer || —— Braper v

3. Now click the grab bar at the left edge of the Draw toolbar. Drag the toolbar to the left
side of the screen until the dotted shape shows a one-column vertical toolbar.

4. In the same way, drag the Modify toolbar to the right of the Draw toolbar so that the
toolbars are side by side.
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5. Right-click any open toolbar. Choose Dimension to display the Dimension toolbar, which

provides tools to enable you to show measurements in your drawing. It may be a single
line of icons or a rectangular arrangement. If it’s docked, click the grab bar and drag it
to the drawing area.

6. Point to the fourth button. The tooltip says Radius Dimension. This button enables you

to create a dimension showing the measurement of the radius of a circle.

7. With the mouse, point to the bottom edge of the toolbar until the mouse cursor takes

the shape of a double-headed arrow.

8. Click and drag upward and/or downward. The toolbar changes shape.

9. Drag the Dimension toolbar by its title bar down to the bottom edge of the drawing

area until its outline becomes a dotted horizontal bar. The Dimension toolbar docks at
the lower edge of the screen. You don’t have as much screen space as before, but the
toolbar is off the drawing area.

10. To close the Dimension toolbar (which you do after you finish placing dimensions in

your drawing), drag it by its grab bar onto the drawing area and click the Close button
at the right of its title bar.

11. You may leave the Draw and Modify toolbars where they are or return them to their

original positions; it’s up to you.

As you can see, learning how to move, dock, display, and hide toolbars is worth your time.
This small effort can greatly increase your comfort level as you draw.

Using tool palettes

Tool palettes are a new way to give AutoCAD and AutoCAD LT commands. To open the
tool palettes, choose Tool Palettes from the Standard toolbar or press Ctrl+3. The palette

has several tabs. Click the Command Tools tab, shown in Figure 3-4. The AutoCAD and
AutoCAD LT tool palettes are slightly different.

Sam...

Impe... ab

IS0 ...

Com...

|

x

] Figure 3-4: The Command Tools tab of the tool palette, shown in
/ » Line AutoCAD (The AutoCAD LT tab contains fewer items.)

Linear
Dimension

A MText

. Curved

P Hemispheric
al

Table -
Imperial

E5 Table - 150
VisualLisp
Lise | Expression

TOOL PALETTES - ALL PALETTES

Each of the items on the tool palette is a tool. The tools on the Command Tools tab contain
commands that you can use. For example, you can draw a line by clicking the Line tool. The
effect is exactly the same as clicking the Line button on the Draw toolbar.
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Some of the tools have flyouts, which are like toolbar flyouts. Click the small arrow and the
flyout appears, containing other command buttons. Click the command button that you want
in order to start that command.

- Cross-

You can use tool palettes to insert objects, fill in closed areas, and add other content. For more
Reference

information, see Chapter 26. | also explain how to customize tool palettes in Chapter 29.

The Command Line

Every command that you choose from a toolbar button, menu, or tool palette is echoed on the
command line. You can also execute a command by typing it directly on the command line.

Understanding command names

All commands have a special one-word command name. This may or may not be the same as
the wording that appears on the toolbar’s tooltip or on the menu. But you can be sure of one
thing —every command can be executed by typing its name on the command line. Fast typ-
ists often prefer to use the command line because they find it faster than searching for a com-
mand on a menu or toolbar. Most users use a combination of command line, menu, and
toolbar commands.

Some of the commands are easy to type, such as LINE or ARC. Others are long and harder to
remember, such as HATCHEDIT, DDPTYPE, or IMAGEATTACH. Command names such as these
can quickly drive you to use a menu or toolbar.

- Cross-

If you like typing commands, you can create short versions of the command names, called
Reference

aliases. Many are already included with AutoCAD and AutoCAD LT. Aliases are covered in
Chapter 29.

You can edit what you have typed on the command line. If you type a long command and make
a mistake, you can backspace up to the mistake and retype the last part correctly. Table 3-1
shows how to use the keyboard edit keys to edit the command line.

Table 3-1: Command-Line Editing Keys

Key Function

Backspace Backspaces through the text on the command line, erasing each letter as it backspaces.
Left arrow Moves backward through the text of the command, without erasing.

Right arrow Moves forward through the text of the command, without erasing.

Home Moves the command-line cursor to the beginning of the text.

End Moves the command-line cursor to the end of the text.

Insert Toggles between Insert/Overwrite mode. Insert mode inserts text. Overwrite mode types

over existing text. Note that there is no visual confirmation of which mode you are in.
Delete Deletes the character to the right of the cursor on the command line.

Ctrl+V Pastes text from the Windows Clipboard.
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Tip

You can scroll through and reuse previous command-line entries. To repeat the last line you
entered, press the up arrow. Press Enter to execute it. To see more of the command-line entries,
press F2 on your keyboard to open the Text Window. Scroll until you find the entry you want,
highlight it, and then right-click and choose Paste To CmdLine from the shortcut menu. You
now see the highlighted text on the current command line. You can also copy selected text from
the command-line history or the entire history to the Clipboard. Or choose Recent Commands
on the shortcut menu and choose one of the commands from the submenu that appears.

Switching from the mouse to the keyboard and back is time-consuming. In general, if you're
) picking points using the mouse (covered in Chapter 4), using menus and toolbars to give

“74 commands is faster. If you're typing coordinates as you did in Chapter 1, your hands are

already at the keyboard, so typing commands at the keyboard is easier.

Responding to command options

Many commands have options from which you need to choose. The format for command
options is as follows:

current instruction or [options] <current value>:

The current instruction explains what you need to do. For example, if you choose an editing
command, the prompt usually instructs you to “Select objects.” The text in the square brackets
lists the various options available for the command. The angled brackets tell you the current or
default value for the command, if any.

Choosing an option is easy:

4+ To choose an option on the command line, type the one or two letters that are capital-
ized in the option name — usually (but not always) the first letter(s) of the option. You
can type the letter(s) in lowercase. Press Enter.

4+ To choose a default option or current value on the command line, which appears in
angled brackets, as in <Real time>, simply press Enter or provide the point or value
required.

4+ To choose an option without going to the command line, right-click in the drawing area
and choose one of the options from the shortcut menu. This works best for options that
won’t need any numerical input on the command line. Choosing options from a short-
cut menu on the screen is an example of heads-up drawing, which increases efficiency
because you don’t need to stop to look down at the keyboard.

At this point, additional options may appear, or you may be prompted to select a point or an
object.

In the following exercise, you practice using command options. In Chapter 1, you typed coor-
dinates to specify points. Here you pick points on the screen directly with the mouse.

STEP-BY-STEP: Using Command Options
1. Open a new drawing using the acad.dwt template.

2. "ﬁ Choose Arc on the Draw toolbar.

3. Look at the command line. You see the following prompt:

Specify start point of arc or [Center]:



' Note

-l
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Specifying the start point is the main instruction, but you have an option to specify the
center of the arc. Move the mouse cursor anywhere in the middle of the screen, and
click to specify the start point. This is called picking a point.

. Now you see the following prompt:

Specify second point of arc or [Center/End]:

Say that you want to specify the end of the arc. Because specifying the second point is
the main instruction, right-click to display the shortcut menu, shown in Figure 3-5, and
choose End, one of the options. The program responds with the Specify end point
of arc: prompt.

Enter Figure 3-5: Using the shortcut menu to choose the End option of the
el ARC command.

Center
End

Snap Overrides »

Pan
Zoom

. Pick another point on the screen fairly close to the first one.

6. At the Specify center point of arc or [Angle/Direction/Radius]: prompt,

typer .

. At the Specify radius of arc: prompt, type 2 . The arc is drawn and the command

ends. Don’t worry at this point if the arc is partly off the screen or doesn’t appear as
you expect. (It’s possible to pick two endpoints for the arc that can’t have a radius of 2.
If this happens, try again with two different points.)

Do not save this drawing.

You may have noticed an underscore (_) before each command. This mark allows translation
to foreign languages and can be ignored.

Sometimes a command has so many options that AutoCAD or AutoCAD LT opens a dialog
box. This method offers a more structured way of letting you choose command options.

Command Techniques

To make working with commands easier, AutoCAD and AutoCAD LT offer shortcuts for repeat-
ing and canceling commands as well as sophisticated undo and redo options. You can also
use certain commands after you have started another command.

You can have more than one command in process concurrently, one in each open drawing.
You can switch from one open drawing to another without interrupting your commands. For
example, if you're in the middle of drawing a circle in one drawing, you can open a new draw-
ing and start another command to get some information you need for the circle. Then you can
return to the first drawing and complete the circle.
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Tip

Tip

Repeating commands

The most common way to repeat a command you have just used is to press Enter at the
Command: prompt. The most recent command appears again.

You can also press the Spacebar at the Command: prompt to repeat a command you just
), used. This technique works well if you want to keep one hand on the mouse and use the

/7 other hand to press the Spacebar.

If you know in advance that you’ll be using a command several times, you can use another
technique —type multiple .. At the Enter command name to repeat: prompt, type the
command name on the command line. The command automatically reappears on the com-
mand line until you press the Esc key. For example, you could type multiple and then arc if
you knew you were going to draw several arcs in a row. To stop repeating the command,
press Esc.

If you create a toolbar button that executes a customized set of actions, right-click and
)\, choose the top option of the shortcut menu to repeat the action of the toolbar button. You
/ cannot press Enter to get this effect.

Canceling commands

Sometimes you start a command and then realize you don’t need it. In this situation, you can
cancel the command and then choose a different command. Press Esc to cancel a command
that you've already started. The Command: prompt reappears.

In the following exercise, you practice the techniques for repeating and canceling commands.

STEP-BY-STEP: Repeating and Canceling Commands
1. Start a new drawing using the acad.dwt or ac1t.dwt template.
2. Choose Circle on the Draw toolbar.

3. At the Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:
prompt, pick a center point anywhere near the center of the screen.

4. At the Specify radius of circle or [Diameter]: prompt, move the mouse cur-
sor and click the pick button when you see a medium-sized circle. The circle appears in
the drawing area.

5. Press Enter. The CIRCLE command appears again on the command line.
6. Follow these prompts:

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:
Right-click and choose 2P from the shortcut menu.

Specify first end point of circle's diameter: Pick any point on the
screen.

Specify second end point of circle's diameter: Press Esc.

AutoCAD or AutoCAD LT responds with *Cancel* and returns you to the Command:
prompt without finishing the command that was in progress.

Do not save this drawing.
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Undoing a command

Most Windows applications offer Undo and Redo commands on the Standard toolbar. AutoCAD
and AutoCAD LT are no different. Some applications remember a list of your last few actions so
that you can undo them one by one. AutoCAD and AutoCAD LT remember every command you
execute starting from the time you open a drawing. You can therefore undo every action and
return your drawing to its condition when you opened it.

Tip The Undo button on the Standard toolbar lists the commands you've executed so that you
,,  can quickly see how many commands you want to undo.
)
Actually, there are a few obvious exceptions. For example, if you print a drawing, you can’t
unprint it, and you can’t unsave a drawing, either. Similarly, commands that provide you with

information, such as the coordinates of a point, cannot be undone.

' Note Some commands have their own undo options. | explain these undo options when I discuss
~  these commands throughout the book.

_ Each time you click Undo on the Standard toolbar, you undo one command. If you
f click the down arrow to the right of the Undo button and choose the bottom-most
command, you undo all the commands and get the message:

Everything has been undone
When you start UNDO, you see the following options on the command line:

Enter the number of operations to undo or
[Auto/Control/BEgin/End/Mark/Back] <1>:

Enter the number of operations to undo is the default instruction. If you type a num-
ber, such as 3, you undo your last three commands. This action is equivalent to choosing the
third command on the Undo button’s drop-down list. Table 3-2 explains the other options:

Table 3-2: Options of the UNDO Command

Option How to Use It

Auto Can be On or Off. Applies to a menu item that executes more than one command at a
time. When Auto is On (the default), the entire menu item is undone in one step. When
Auto is Off, UNDO undoes each step one at a time.

Control Offers three sub-options. All, the default, gives you the full UNDO capability. None disables
the UNDO command. One enables you to undo only one step at a time, effectively turning
the UNDO command into the U command.

Begin Works with the End option. This starts a group at the current point of the list of
commands. Then, when you use the End option, UNDO undoes all the commands in the
group. The U command also undoes everything within a group.

End Marks the end of all commands in the group created by using the Begin option.

Mark This option works with the Back option. It is somewhat similar to the Begin option, but
you can place several marks as you work.

Back When you use this option, AutoCAD or AutoCAD LT undoes only to the most recent Mark
point. The next Back option you use undoes to the Mark point before that.
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Note The word Group means that a group of commands is being undone. However, the word
~"  Group is sometimes used even for a single command. This use of the word Group is not sig-
nificant and can be ignored.

Using the Back option when no Mark has been created undoes everything you have done in a
drawing session! Luckily, you get the following warning message:
This will undo everything. 0K? <Y>
Type n J if you do not want to undo everything.
Tip The Begin/End and Mark/Back options are useful when you're trying something new and

, want to be able to undo a whole series of commands in one UNDO command, in case things
+ don't work out as planned.

Redoing a command

If you undo a command, you might realize that you want to undo the undo. This is called
redoing a command. Don’t confuse redoing a command with repeating a command. Redoing
only applies when you have just undone a command.

_ The MREDO command on the Standard toolbar redoes the effect of the previous
1 UNDO commands. You can also redo multiple UNDO commands. You can choose
recently undone commands from the Redo drop-down list.

Note The old REDO command that only redoes one command still exists, but the Redo button on
~—  the Standard toolbar executes the MREDO command that redoes multiple UNDO commands.

In the following exercise, you practice using the UNDO and MREDO commands.

STEP-BY-STEP: Undoing and Redoing Commands
1. Start a new drawing using acad.dwt or aclt.dwt as the template.

2. Choose Line on the Command Tools tab of the tool palette. (If necessary, press Ctrl+3
to display the tool palette and click the Command Tools tab.)

3. Follow the prompts to draw one line, and press Enter to end the command.

4. On the Command Tools tab of the tool palette, click the right arrow to the right of the
Line button to open the flyout. Choose Arc.

5. Using the default options, pick any three points to draw an arc.

6. On the Command Tools tab of the tool palette, click the right arrow to the right of the
Arc button to open the flyout. Choose Circle.

7. Pick one point to be the center of the circle and another nearby point to specify the
radius. Your drawing now contains a line, an arc, and a circle, and looks something like
Figure 3-6. Of course, your objects will look different because you picked different
points.

8. r _ Click the Undo button on the Standard toolbar. The circle disappears.
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9. Click the down arrow to the right of the Undo button on the Standard toolbar. Choose
Line. The arc and the line disappear.

10. _ Click the down arrow to the right of the Redo button on the Standard toolbar.
'.l Choose Circle. All three objects reappear because they were undone by the pre-
vious UNDO commands.

Do not save this drawing. If you are continuing, keep the drawing on the screen for the
next exercise.

Figure 3-6: Your drawing should contain a line, an
/O\ arc, and a circle.

 Cross- The OOPS command restores the most recently erased object or set of objects, even if you
\ Reference have used other commands in the meantime. See Chapter 18 for further information.

.,\CD |
A

Using one command within another command

Certain commands can be used within another command. These are called transparent com-
mands. After a transparent command is completed, the original command continues its regu-
lar operation. Many transparent commands help you display the drawing differently so that
you can complete the original command easily. Other transparent commands change settings.
In fact, almost any command that doesn’t select objects, create new objects, cause regenera-
tion, or end the drawing session can be used transparently. When you start transparent com-
mands from toolbars or menus, they are automatically transparent. If you want to type a
transparent command on the command line, you need to type an apostrophe (*) before the
command name.

In this exercise, you practice using transparent commands and two commands concurrently.

\ The drawing used in the following Step-by-Step exercise on using transparent commands
and two commands concurrently, ab01-01.dwg, is in the Results folder on the CD-ROM.

STEP-BY-STEP: Using Transparent Commands and Two
Commands Concurrently

1. From the previous exercise, you have a line, an arc, and a circle on the screen. If not,
begin a new drawing using acad.dwt as the template and draw a line and an arc any-
where on the screen. (You don’t need the circle.)

2. Choose View = Zoom => Out. The drawing zooms out, appearing smaller.

3. Choose Open from the Standard toolbar and open ab01-01.dwg from the Results
folder on the CD-ROM. This is a drawing of a window.

4. From the Windows taskbar, choose your original drawing.
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11.

. Choose Circle from the Draw toolbar. The following prompt appears:

Command: Specify center point for circle or [3P/2P/Ttr (tan tan
radius)]: Pick any point at the center of your screen.
Specify radius of circle or [Diameter]:

. At this point, say that you want to see the drawing closer up to properly decide where

to place the radius of the circle. Type 'zoom .. The following appears on the command
line. (You may need to press F2 to see the entire prompt.) Follow the prompts.

>>Specify corner of window, enter a scale factor (nX or nXP), or
[A11/Center/Dynamic/Extents/Previous/Scale/Window] <real time>: 2x
Resuming CIRCLE command.

Specify radius of circle or [Diameter]:

. Now suppose that you want the radius to be equal to the width of the window in your

other drawing. Choose ab01-01.dwg from the Windows taskbar.

. The dimension text clearly states that the window is 3'8" wide, which is 42 inches.
. Click the taskbar button for your original drawing.

10.

Type 42 . to create the circle. If necessary, choose View > Zoom = Out until you can
see the entire drawing.

Close ab01-01.dwg. Do not save the other drawing.

Looking at the prompts for the transparent use of the ZOOM command carefully, note three
features:

4 The ZOOM command is preceded by an apostrophe. This is the sign of a transparent

command.

4 The prompt for the transparent command is preceded by >>. This helps you distin-

guish between the prompts of the original command and the transparent command
that is embedded in it.

4+ When the transparent command is complete, the prompt tells you. In this case, you see

Resuming CIRCLE command.

Experiment using transparent commands, and you’ll soon find them indispensable.

Of Mice and Pucks

For the sake of simplicity, this book assumes that you're using a mouse, but many people use
a digitizing tablet and a puck (or a stylus). A typical digitizing tablet and puck are shown in
Figure 3-7. A puck often has more buttons than a mouse and also has crosshairs on a trans-
parent area that you can use for accurately picking points from a paper drawing.

The digitizing tablet is generally configured to include an area that represents the screen you
draw on as well as a customizable command area that you use for commands. This command
area of the tablet functions as another menu. Figure 3-8 shows the default tablet provided with
AutoCAD. (AutoCAD LT has a similar one.) The tablet is generally customized to suit individual
needs. Each square is equivalent to a toolbar button and executes a command when you click
it. The top area is left blank for you to include your own commands. This area is often used to
insert parts from a library of standardized parts. Examples would be gaskets and valves in a
mechanical drawing environment or doors and windows in an architectural environment.
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Figure 3-7: A digitizer and puck.

The standard tablet
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The square area in the right-center represents the drawing area. In this area, the puck func-
tions like a mouse to draw, as well as to access menus and dialog box options. The tablet can
also be used for a process called digitizing, which means transferring data from paper into
AutoCAD or AutoCAD LT. This transference is often done by putting a paper document directly
on the tablet and using the entire tablet as a drawing area. Because the puck has crosshairs on
a transparent surface, you can pick points on the drawing, which then become endpoints of
lines, for example.

Getting Help

AutoCAD and AutoCAD LT have so many commands with so many options that every user
needs help at some time. AutoCAD and AutoCAD LT come with a very complete Help system.
A complete set of links and tabs makes navigating through the topics and finding related
material easy.

; See Bonus Chapter 2 on the CD-ROM for help available on the Internet and other resources.
Reference

Getting help on a command

The easiest way to get help on a command is to start the command and press F1. The help
screen for that command opens up. Figure 3-9 shows the screen that opens when you type
zoom .! and then press F1.

Aote After you have opened the Help window one time, when you press F1 it may only cause the
~  window to blink on the Windows task bar. Go to the task bar and click the blinking button to
open the Help window.

ZOOM Command

Concepts Procedures Reference

Increases or decreases the apparent size of objects in the

eurrent viewport

o
8 standard toolbar:

View menu: Zoom

Shorteut menu: With no objects selected, right-click in the
drawving area and choose Toom to zoom in real time

EE Command line: zoom (or *zoom for transparent use)

Bpecify corner of window, enter a scale factor (nX or nkP), or
[AIC enter Dy i i J0bject

=real time =

Dizplay all hidden text on this page. Commerts?

Figure 3-9: The help screen for the
ZOOM command.
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Using the main help system

When you have a question, try the Help system. AutoCAD and AutoCAD LT come with the
most complete Help documentation [ have ever seen in a program.

Clicking F1 (with no command active) or choosing Help => Help opens the User Documentation
window, shown in Figure 3-10 with the Contents tab on top. Double-clicking Command Refer-
ence on the Contents tab leads you to help on commands and system variables. Double-click
User’s Guide for the “how-to” manual. You can also click the plus sign to the left to expand
the display of topics. If you click any topic on the left, you see it in the right panel.

AutoCAD 2005 Help

{

Welcome to AutoCAD

2005 Help! Type your question here Q 351“1

AutoCAD 2005 Help provides
complete infarmation for using
AutoCAD. Click the links on the New Features Workshop

General Information

right or use the Contents tab to Use the Help em Efficient]
browse Help topics Obtain Documentation Updates
The Mew Features Warkshop View the Product Readine
helps you quickly learm what's

news in AutoCAD 2005, To Help Files

access the Mew Features .. .
yworkshap, click the link on the User’s Giide

right. You can also access the WG id
Mew Features Warkshop from Driver and Peripheral buide

the Heln menu. Installation and Licensing Guides
Customization Guide

AutoL ISP, Visual LISP, and DXF
ActiveX Autornation and VBA

My Help

Resources onthe Web
anodesk.com
AutoCAD
Support
Training Resources
Consulting
Developer Center

Figure 3-10: The User Documentation window
showing the Contents tab and the screen on
AutoCAD 2005 Help.

The Help system has five tabs that offer five different ways of finding the help you need. You
might need to drag the border between the tabs and the right panel to see the rightmost tab.

The Contents tab

The Contents tabs displays help organized by topic. It’s like the table of contents of a book.
Click the icon of a book to open that topic and see subtopics. Click a topic to see it displayed
in the right panel.

The Index tab

If you have an idea in your head but don’t know the command name, you may want to use the
index. The index is an alphabetical listing of topics. In the text box, type the first few letters of
the word or words for which you want help. As you type, the list jumps to the closest match.
When you'’ve found the topic you want, highlight it and click Display (or double-click it).
Sometimes subtopics appear from which you can choose.
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The Search tab

The Search tab enables you to find keywords from all the words in the Help screens. Type a
word in the text box and click List Topics. Choose a topic and click Display (or double-click
the topic) to display it on the right.

The Favorites tab

Collect your favorite Help topics on the Favorites tab. First, display the topic by using one of
the other tabs. Then click the Favorites tab and click Add. To display a Help topic from the
Favorites list, double-click it.

The Ask Me tab

The Ask Me tab enables you to ask a question in real English and get the answer you want —
hopefully. Type a question or phrase and press Enter. Then click one of the suggested links to
see the topic displayed in the right pane.

Working with Help screens

The Help screens have several features that you should know so you can make the best use of
them. Many of the topics displayed on the right have three tabs:

4+ Concepts: The overall description
4 Procedures: How to do it
4+ Reference: Related commands
After you arrive at the Help screen you want, look for links to related topics.

At the top of most screens are several buttons. The selection of buttons depends on which
aspect of Help you're accessing. These buttons help you navigate the Help system quickly
and easily:

4+ Hide/Show: Hides the left pane so that you can work and look at a Help screen at the
same time. When hidden, the button becomes a Show button that displays the left pane.

4 Back: Returns you to the previous Help screen you viewed.
4 Print: Prints the topic.

4+ Options: Offers further options such as going to the Home Help page and refreshing the
screen.

Using the Info palette

The Info palette offers you context-sensitive Quick Help as you work. It’s great for beginners,
but you’ll eventually find it a nuisance because it pops up in front of your work. The Info palette
may be on by default when you install the program.

To open the Info palette, choose Help = Info Palette or press Ctrl+5. As you use commands, a
brief explanation appears. Figure 3-11 shows the screen that appears when you start the ARC
command.
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. G d B Figure 3-11: The Info palette displays Help for the command
2 = you're using.
e
5
(=}
To draw an arc by
specifying three
points
1. Onthe Draw m
menu, click Arc > ':
3 Points. L
2. Specify the start E‘
paint. e
3. Specify a paint on =
the arc, =
4, Specify the
endpaint. hd ‘_"
B

You can close the Info palette by clicking its Close box at the top of the palette title bar or
pressing Ctrl+5.

Getting more help

The Help menu has some additional options that provide more specialized assistance. When
you choose Help from the menu bar, choose one of these four other items:

4+ Info Palette: Opens the Info palette with the Quick Help feature, explained in the previ-
ous section.

4+ Developer Help: Opens the Help system for topics relating to programming AutoCAD
(see Part VII of this book). (AutoCAD only.)

4+ New Features Workshop: Provides a combination of explanation and tutorials on new
AutoCAD 2005 and AutoCAD LT 2005 features. For those upgrading from 2002 or prior,
the New Features Workshop also outlines the changes made in AutoCAD and AutoCAD
LT 2004.

4 Online Resources: Connects you to various support and training options on
Autodesk’s Web site.

In this exercise, you practice using the Help system.

STEP-BY-STEP: Using AutoCAD Help

1. If AutoCAD or AutoCAD LT is not open, start the program with the acad.dwt template. If
the program is already open, you can do this exercise with any drawing on the screen.

2. Choose Circle from the Draw toolbar. At the prompt, press F1 on the keyboard. The
Circle Help screen opens. (If it doesn’t open, click the Help window’s button on the
Windows task bar.)

3. Click 2P (Two Points), which appears underlined. The 2P description appears. Read the
description of the 2P option.

4. Click the Close button at the top-right corner of the Help screen. Click anywhere in the
application window to activate the window and press Esc to exit the CIRCLE command.

5. Choose Help = Help.
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6. Click the Contents tab if it is not on top. Double-click User’s Guide. From the list,
double-click The User Interface and then click the plus sign next to Menus, Toolbars,
and Tool Palettes.

7. Click Shortcut Menus. Read the text in the right pane.
8. Click the Procedures tab. Click To Display a Shortcut Menu and read the text.
9. On the left side of the Help window, click the Index tab.

10. In the text box at the top, type transparent commands and click Display.
11. From the Topics Found list, double-click Enter Commands on the Command Line.

12. In the right pane, scroll down until you see the heading Interrupt a Command with

Another Command or System Variable.

13. Read the text. After you're done, click the Close button of the Help window.

Summary

In this chapter, you read all you need to know about how to use AutoCAD and AutoCAD LT
commands. Specifically, you read about:

4+ Using the menus

4+ Using shortcut menus

4+ Using a dialog box

4+ Working with toolbars

4+ Using the tool palette

4 Understanding command names

4+ Using and editing the command line

4+ Responding to command options and using the command line and shortcut menus
4+ Repeating commands

4+ Canceling commands

4+ Undoing and redoing commands

4 Using transparent commands

4+ Using a puck and digitizing tablet to enter commands

4+ Getting help

In the next chapter, I explain how to specify coordinates, an essential skill before you start to
draw.

+ 0+ 0+



Specifying
Coordinates

Specifying points on the screen is one of the most fundamental
tasks in AutoCAD and AutoCAD LT. Unless you know how to spec-
ify a point, you can’t draw anything real, whether a house or a gasket.
Most objects you draw have a specific size, and you need to specify
that information. Drawing lines, arcs, and circles is accomplished by
specifying the coordinates of points on the screen. As with most
tasks, AutoCAD and AutoCAD LT offer many ways to accomplish this.

Understanding the X,Y
Coordinate System

Remember when you studied geometry and trigonometry in high
school? You created graphs by drawing X and Y axes. Then you plot-
ted coordinates on graph paper. AutoCAD and AutoCAD LT work the
same way.

Look at the User Coordinate System (UCS) icon, as shown in Figure 4-1.

 Cross- ‘\ The UCS icon can take on different appearances. See Chapter 8 for
Reference \ details.

= el

Figure 4-1: The UCS icon shows the direction
! of the X and Y axes.

x

The arrow marked X points along the X axis in the positive direction.
This means that as you go in the direction of the arrow, the X coordi-
nates increase. The arrow marked Y points along the Y axis in the
positive direction.

CHIP E R
=_r

¢+ 4+ 0+
In This Chapter

Working with absolute,
relative, and polar
coordinates

Using direct distance
entry, orthogonal mode,
and polar tracking

Using snap settings

Working with object
snaps (OSNAPS)

Locating points

¢+ 0+ o+
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- Cross-

Note

Reference

Using this system, every point on the screen can be specified using X and Y coordinates. This
is called a Cartesian coordinate system.

As explained in Chapter 1, the universal convention is to place the X coordinate first, then a
comma (but no space), and then the Y coordinate. Refer to Figure 1-4 in Chapter 1 for some
sample coordinates.

By default, the intersection of the XY axes is 0,0. Use negative numbers for points to the left
of the X axis or below the Y axis.

Drawing units

What do the coordinates measure? When you draw in AutoCAD or AutoCAD LT, you draw in
undefined units. A line from point 3,0 to point 6,0 is three units long. While you’re drawing,
these units can be anything— a millimeter, a centimeter, a meter, an inch, a foot, or a mile.
In reality, you should know exactly what the units represent. After all, you don’t want your
36-foot-wide house to end up 36 inches wide!

When you set up a drawing, you specify how units are displayed — for example, whether par-
tial units show as decimal points or fractions. (I cover units in Chapter 5.) However, you don’t
actually specify what the units represent until you print or plot your drawing — covered in
Chapter 17.

In general, you should draw full size. If you're drawing a plan for a factory that will be 120 feet
long, for example, you create lines with those measurements. On the screen, you can zoom in
to see small details or zoom out to see the whole factory, so that you have no reason not to
use the actual line lengths. It’s only when you need to print those 120-foot-long lines on a real
sheet of paper that you have to specify how to plot out your drawing at a reduced scale.

Types of measurement notation

Users are typically familiar only with the type of notation used in their own field of specialty,
whether scientific, architectural, engineering, or whatever. However, you should be at least
somewhat familiar with all the major forms of measurement notation.

If you are using engineering or architectural units, AutoCAD and AutoCAD LT display parts of

- inches (fractions) differently than the format you must use to type them in. You must type in

coordinates without any spaces because in AutoCAD a space is equivalent to pressing Enter
and that ends your input. Use a hyphen between whole and partial inches—for example,
3'2-1/2". (You can omit the " after the inches because inches are assumed in engineering
and architectural units if no symbol follows a number.) However, this appears on the status
bar as 3'-2 1/2". This can be confusing because the hyphen is in a different place, and you
see a space between the whole and partial inches.

Typing Coordinates

One of the more basic ways to specify the location of an object is to type its coordinates
using the keyboard. You can enter several types of coordinates. Use the type of coordinates
that suit your specific situation.
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Absolute Cartesian coordinates

When you type a line and enter the actual coordinates, such as a line from point 3,2 to 6,9,
you are using absolute Cartesian coordinates. Absolute coordinates are measured from 0,0.
These coordinates are probably familiar to you from high-school geometry class.

In this exercise, you practice entering absolute Cartesian coordinates.

STEP-BY-STEP: Entering Absolute Cartesian Coordinates

1. Start a new drawing using the acad.dwt or ac1t.dwt template.

2. Choose Line from the Draw toolbar. Follow these prompts:

Specify first point: -10,-5 4

Specify next
Specify next
Specify next
Specify next
Specify next

point
point
point
point
point

or [Undo]: 21,-5 d

or [Undo]: 21,49 4

or [Close/Undo]l: -10,49 4

or [Close/Undo]: -10,-5 J

or [Close/Undol: 4 to end the command.

Most of the lines are off the screen. By default, a new drawing starts with 0,0 at the
lower-left corner of your screen; therefore, negative coordinates do not show.

3. Choose Zoom Out from the Zoom flyout on the Standard toolbar. If you still can’t
a see the entire rectangle, choose Zoom Out again until you can see it. Your picture
should look like Figure 4-2.

Figure 4-2: A rectangle drawn by using absolute coordinates.

Note If the prompt responds with Invalid Point or Point or option keyword required,
~  you have entered a coordinate incorrectly. Try typing the coordinate again. Also, don't forget
that you can UNDO a command if you make a mistake. (See Chapter 3 for details.)
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4. Start the LINE command again and follow these prompts:

Specify first point: -8,-2 4

Specify next point or [Undo]: 19,-2 4

Specify next point or [Undol: 19,21.5 4

Specify next point or [Close/Undo]: -8,21.5 J

Specify next point or [Close/Undo]: -8,-2 J

Specify next point or [Close/Undo]: 4 to end the command.

5. Once more, start the LINE command and follow these prompts:

Specify first point: -8,22.5 4

Specify next point or [Undol: 19, 22.5 4

Specify next point or [Undo]l: 19,46 4

Specify next point or [Close/Undo]: -8,46 J

Specify next point or [Close/Undo]: -8,22.5 4

Specify next point or [Close/Undol: J to end the command.

6. Save this drawing in your AutoCAD Bible folder as ab04-01.dwg.

You can now see that you've drawn a simple window, as shown in Figure 4-3.

Figure 4-3: A window drawn with absolute coordinates.

Two questions may have occurred to you during this exercise. First, isn’t there a better way
of entering absolute coordinates? Typing them in is slow and prone to error. Second, how do
you know the absolute coordinates for what you're drawing? Read on for the answers.

Relative Cartesian coordinates

In practice, you usually don’t know the absolute coordinates of the points you need to specify
in order to draw an object. Whether you're drawing an architectural layout, a physical object
(as in mechanical drawing), or an electrical schematic, you don’t have X,Y coordinates to
work from. However, you often do have the measurements of what you're drawing. Usually,
you start from any suitable point and work from there. In this situation, you know only the
length of the lines you're drawing (if you’re drawing lines). Real life doesn’t have a 0,0 point.
Relative coordinates were developed for these situations.
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Relative coordinates specify the X and Y distance from a previous point. They are called rela-
tive coordinates because they only have meaning relative to a point previously specified. Sup-
pose that you need to draw a window. You can start the window from any point. From there,
you have the measurements you need. (The measurements may be shown on a piece of paper
you're working from, or you may have the actual window sitting next to you so you can mea-
sure it.)

You specify that the coordinates are relative by using the @ symbol. For example, if you start
a line by picking any point with the mouse, and you know it should be two units long, you can
specify the next point as @2,0. The result is a line starting with the first point you picked and
ending two units along the X axis, as shown in Figure 4-4. The line is horizontal because the Y
coordinate is 0. In a relative coordinate, this means that the Y distance does not change.

Start point End point=@2,0 Figure 4-4: A line whose start point could
be anywhere and whose endpoint is
specified with the relative point @2,0 is a
horizontal line two units long.

Relative Cartesian coordinates are often used for lines drawn at 90-degree angles (that is, they
are either horizontal or vertical). These are called orthogonal lines. When you create a diago-
nal line from point 3,3 to point @2,5 you don’t know how long the line is.

When you specify a positive number such as the 2 in @2,0, the direction is positive. However,
if you want to draw a line in the negative direction of an axis, type a minus sign before the
number. Figure 4-5 shows how to draw lines in four directions using relative coordinates.

Figure 4-5: Drawing lines in the four
@p-2 Orthogonal directions with relative
J/ ! coordinates. The arrow on each line
. . . shows the direction of the line.

@-2,0
/

I @0,2

T T

I

Polar coordinates

Another common situation is to know the distance and angle of a point from either 0,0 or a
previous point. In this case, you can use polar coordinates, which can be either absolute or
relative. Most commonly, you use relative polar coordinates.

Polar coordinates take the form distance<angle. (To type the angle symbol, use the less
than symbol on your keyboard.) Relative polar coordinates must have the @ sign before the
coordinate.
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« Cross- Chapter 21 explains more about coordinates in 3D drawings.
\ Reference

By default, angles are measured according to the diagram in Figure 4-6, although you can
change this system. The positive and negative angles shown next to each other are inter-
changeable. Use whichever is more meaningful to you.

90 Figure 4-6: The standard angle measurement
-210 system.
180 0
-180 -360
270
-90

In the following series of steps, you draw part of a portico, the decorative molding above a
door or window. Because it is an architectural design, you use architectural units. In this
case, only inches are used, which don’t need to be specified. You can specify feet by using an
apostrophe (also called a prime) after any number.

When typing architectural units, partial inches are indicated by fractions in the form 3/4. You
need to separate the fraction from the whole inches by a hyphen. This can be a little confus-
ing because the hyphen is also used for negative numbers. For example, to draw a horizontal
line of 5% inches in the negative direction of the X axis, you would type @-5-1/4,0. (The 0 indi-
cates no change in the Y axis because it is a horizontal line.)

On the The drawing used in this Step-by-Step exercise on using relative and polar coordinates,
CD ab04-a.dwg, is in the Drawings folder on the CD-ROM.
L

y.

STEP-BY-STEP: Using Relative and Polar Coordinates

1. Open ab04-a.dwg from the CD-ROM. As you move your mouse around, notice that the
coordinates displayed on the status bar are in architectural units (that is, in feet and
inches). If the coordinates are grayed out, click them or press the F6 key.

2. Choose File=> Save As and save the drawing in your AutoCAD Bib1e folder as
ab04-02.dwg.

' Note The next steps involve some complex typing. If you get an error message, try typing the coor-
~  dinate again. If you realize you made a mistake after ending the command, click Undo on the
Standard toolbar.
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3. Start the LINE command. Follow these prompts:

Specify first point: Pick any point at the lower-left corner of your
screen.

Specify next point or [Undo]l: @0,-3/4 4

Specify next point or [Undo]l: @75-1/4,0 4

Specify next point or [Close/Undo]: @0,3/4 4

Specify next point or [Close/Undo]: @-75-1/4,0 4

Specify next point or [Close/Undol: J to end the command.

4. Start the LINE command again. Follow the prompts:

Specify first point: 4. This starts the line at the last endpoint you
specified.

Specify next point or [Undo]: @4-3/4,0 J

Specify next point or [Undo]: @43<40 4

Specify next point or [Close/Undo]: @43<320 J

Specify next point or [Close/Undo]: @-2-1/4,0 4

Specify next point or [Close/Undo]: @39-7/8<140 4

Specify next point or [Close/Undo]: @39-7/8<220 J

Specify next point or [Close/Undo]: J to end the command.

In this exercise, you draw a line on top of a line, which is not good drawing practice. Later in

~ this chapter and in coming chapters, you learn techniques to avoid this.

5. Save your drawing. You have created a portion of a portico, which goes over a window
of a house, as shown in Figure 4-7.

Figure 4-7: Part of a portico over a window,
drawn using relative Cartesian and polar
coordinates in architectural notation.

You can type @ . at the first prompt of any drawing command to indicate the most recent
. coordinate specified.
/
Notice that using relative coordinates, both Cartesian and polar, is much more realistic than
using absolute coordinates. However, typing in all those coordinates is still awkward. Typing
in coordinates is often the only way to get exactly what you want. Nevertheless, several other
techniques for specifying coordinates are easier in many circumstances.

Direct distance entry

One shortcut for entering coordinates is direct distance entry. After you specify the start
point of a line, at the Specify next point or [Undo]: prompt, simply move the mouse
cursor in the direction you want the line to go and type in the line’s length. It works best in
orthogonal mode or with polar tracking (discussed in the following section), which makes
specifying exact angles easy.
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" Note You can use direct distance entry for any command that requires you to specify a distance
- and a direction, including both drawing and editing commands.

Orthogonal mode

Lines drawn at 0, 90, 180, and 270 degrees are called orthogonal lines. When in orthogonal
mode — ortho for short —you can only draw orthogonal lines with the mouse. Ortho mode
also affects editing. For example, with ortho mode on, you can only move objects vertically or
horizontally. Combined with snap and grid, ortho mode makes drawing easier and more effi-
cient. Ortho mode is also great for direct distance entry.

Click ORTHO on the status bar to toggle ortho mode on and off. You cannot have polar track-
ing on at the same time that ortho mode is on. Polar tracking is discussed next.

Note Orthogonal mode only affects points picked directly on the screen by using your mouse. Any
- relative or absolute coordinates that you type on the command line override orthogonal
mode.
Polar tracking

Polar tracking guides you, using a tooltip and vector line, when you want to draw (or edit) at an
angle other than the four orthogonal angles, as shown in Figure 4-8. You can use polar tracking
for orthogonal angles as well.

@

—Polar tracking vector

[Polar: 30387 < 45d«— Polar tracking tooltip

Figure 4-8: When polar tracking is on, a tooltip
appears when you move the cursor close to one of
the polar angles. Here you see a tooltip indicating an
angle of 45 degrees.

Polar tracking makes it easy to use direct distance entry to specify distances for many angles.
To use polar tracking, you first set the angles that you want to use.
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Setting polar tracking angles

To set the angles, choose Tools = Drafting Settings or right-click the POLAR button on the sta-
tus bar and choose Settings. The Drafting Settings dialog box opens. If necessary, click the
Polar Tracking tab, which you can see in Figure 4-9.

i Drafting Settings g

Shap and Grid | Polar Tracking | Object Snap

] Palar Tracking On (F10)
Polar &ingle Settings Object Snap Tracking Settings
Increment angle: (%) Track orthoganally only

4 h () Track using 4l polar angle settings

[ Additional angles

Palar Angle measurement
() &bsolute

) Relative to last segment

l oK H Cancel ][ Help ]

Figure 4-9: The Polar Tracking tab of the Drafting
Settings dialog box.

To set polar tracking, you define an increment angle. Polar tracking will then apply to that angle
and its multiples. To set the increment angle, click the Increment Angle drop-down arrow, where
you can pick from angles that range from every 90 degrees to every 5 degrees. You can also
type your own incremental angle in the text box. To add additional angles that you think you’ll
need, check Additional Angles, click New, and then type in an angle. You can add up to ten addi-
tional angles. Note that additional angles you add are not incremental angles —if you type 35,
only 35 degrees will be marked, not 70 degrees or other multiples of 35. To delete an additional
angle, select it and click Delete.

On the right side of the dialog box, you can choose how polar tracking works with object
snap tracking (covered later in this chapter). You can set object snap tracking to use all the
polar angle settings or limit it to orthogonal angles only. You can also set whether polar angles
are measured absolutely (relative to 0 degrees) or relative to the segment drawn most recently.
By default, absolute angles are used. (AutoCAD LT includes polar tracking but not object snap
tracking.)

To turn on polar tracking, check Polar Tracking On on the Polar Tracking tab of the Drafting
Settings dialog box. If you are not in the dialog box, press F10 or click the POLAR button on
the status bar.

To customize how polar tracking works, click Options in the Drafting Settings dialog box to
open the Options dialog box with the Drafting tab on top. The following settings in the
AutoTracking Settings section apply to polar tracking:
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Tip

+ Display polar tracking vector turns on and off the polar tracking vector, which is the
faint dotted line that extends to the end of the screen.

4+ Display AutoTracking tooltip turns on and off the tooltip that tells you the distance
and angle. This item in AutoCAD LT is called Display Tracking tooltip.)

Using polar tracking

To use polar tracking, you need to move the cursor slowly through the angles to allow time
for the calculation and display of the vector and tooltip. Suppose that you’re drawing a line.
Specify the start point. To specify the second point, move the cursor in the approximate
angle of the line you want to draw. When you see the polar tracking vector and tooltip, leave
the mouse where it is and type the length of the line. Then press Enter to create the line with
the proper length and angle. You'll find this method easier than typing polar coordinates for
lines with angles specified in your polar tracking settings.

Turn on NumLock on your keyboard and use the numerical pad for typing in lengths. Use the
,,  Enter key on the numerical pad as well.

%

You can specify a polar angle for just one command. If you're drawing a line, after specifying
the first point, for example, type the angle preceded by the angle symbol (<). The next seg-
ment is then locked to that angle while you type its length. A polar angle specified in this way
is called a polar override angle because it overrides the current polar angles in effect. Of
course, a polar override is not faster than simply typing a polar coordinate, but it does let
you see the angle of the line segment before you type its length.

In the following exercise, you practice using direct distance entry with ortho mode and polar
tracking. Before beginning, check that Polar Tracking is set for 45 degrees, as described previ-
ously.

tance with ortho mode and polar tracking is in the Drawings folder on the CD-ROM.

On theq"'\ The drawing (ab04-b.dwg) used in the following Step-by-Step exercise on using direct dis-

.,\CD
A

STEP-BY-STEP: Using Direct Distance Entry with Ortho Mode
and Polar Tracking
1. Open drawing ab04-b.dwg from the CD-ROM.

2. Choose Filew> Save As to save the drawing in your AutoCAD Bible folder as
ab04-03.dwg. If ORTHO is not on (that is, if the ORTHO button on the status bar
doesn’t look pushed in), click ORTHO.

. Start the LINE command and, at the Specify first point: prompt, type 2,2 ..
. Move the mouse horizontally to the right and then type .5 .

. Move the mouse up vertically (in the 90-degree direction) and then type .5 .

S U AW

. Move the mouse horizontally to the right and then type 2 . Your drawing should look
like Figure 4-10.

N

. Move the mouse up in the 90-degree direction and then type .5 .

8. Move the mouse to the left in the 180-degree direction and then type 2 ..



12.
13.

14.

15.

16.

17.
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Figure 4-10: Drawing with direct distance entry enables you to
specify coordinates by typing in a length after you move the pointer in
_ the desired direction.

. Move the mouse up in the 90-degree direction and then type .5 .
10.
11.

Move the mouse to the left in the 180-degree direction and then type .5 .

Move the mouse down in the 270-degree direction and then type 1.5 . Press Enter
again to end the command.

Click POLAR on the status bar. The ORTHO button pops out.

With your cursor in the drawing area, right-click with your mouse and choose Repeat
Line from the shortcut menu.

Press Enter to start the new line from the most recent point. At the Specify next
point or [Undo]: prompt, move the cursor diagonally up and to the left so the line is
approximately in the 135-degree direction. When you see the tooltip confirming the
angle, release the mouse button and type .7071 .

Move the cursor up until you see the polar tracking tooltip confirming a 90-degree
angle. Type .5 .

Move the cursor diagonally in the 45-degree direction until you see the tooltip. Type
.7071 .. Press Enter again to end the LINE command.

Save your drawing. It should look like Figure 4-11.

Figure 4-11: The completed drawing of a bolt.

Displaying Coordinates

As you work, you can refer to the coordinate display on the status bar. This display helps you
know where your cursor and objects are when you draw and is also helpful when editing, by
informing you how far and in what direction you are moving or copying objects.

AutoCAD and AutoCAD LT have three coordinate display modes:

4+ Dynamic absolute coordinates (absolute): Absolute coordinates that change as you

move the mouse, as shown in Figure 4-12.

07409, 27450, 00000  Figure 4-12: Dynamic absolute coordinates.
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4 Static absolute coordinates (off): Absolute coordinates that change only when you

specify a point, as shown in Figure 4-13. The coordinate display is dimmed.

Figure 4-13: Static absolute coordinates.

4+ Dynamic polar coordinates (relative): Polar coordinates that change continuously as

you move the mouse, as shown in Figure 4-14. They appear after you've already specified
a point and are ready to specify a new point, as when you're in the process of drawing
a line.

1.4580¢ 29 . 00000]  Figure 4-14: Dynamic polar coordinates.

You can change the coordinate display in three ways:

4 Press the F6 key.

4+ Click the coordinates area on the status bar.

4 Press Ctrl+D.

For purposes of this chapter, | ignore the Z coordinate that follows the X and Y coordinates
(in AutoCAD only). In two-dimensional drawings, the Z coordinate is always zero.

In the following exercise, you practice using the coordinate display options. You can do this
exercise with any new or existing drawing open on the screen.

STEP-BY-STEP: Using Coordinate Display Options

1

. Look at the coordinate display on the status bar. It should be shown in black. If the

coordinates are shown in gray, press F6 on your keyboard.

. Move the mouse around in a few directions. Notice how the coordinates constantly

change with the mouse movement.

. Press F6. The coordinate display is grayed out. The command line shows <Coords off>.

. Move the mouse around again. The coordinate display does not change with the move-

ment of the mouse.

. Start the LINE command and pick any point on the screen.

. Watch the coordinate display as you pick any point at the Specify next point or

[Undo]: prompt.

. Pick several other points and watch as the coordinate display changes only when you

pick a point. This is the static coordinate display.

. Press F6 again without ending the LINE command.

9. Move the mouse to another point that you would like to pick but watch the coordinate

display before you pick the point. This time, the length and angle of the new line seg-
ment is shown. These are dynamic polar coordinates.
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10. Pick a few more points, watching the polar coordinates.
11. Press F6 again to return to dynamic absolute coordinates.

12. Press Enter to end the LINE command. Do not save your drawing.

Picking Coordinates on the Screen

The easiest and quickest way to specify coordinates is to pick them directly on the screen
with the mouse. Several techniques are available to help you do so accurately.

You can adjust the size of the crosshairs that cross the cursor. By default, they are 5 percent
of screen size. To change the crosshair size, choose Tools &> Options and click the Display tab.
In the Crosshair size text box, you can type a new percentage or drag the bar to increase or
decrease the percentage. Choose OK.

Snap settings

The SNAP command is often an alternative to tedious entry of coordinates. This command
restricts the cursor to an incremental distance that you choose, such as 0.5 units. You can set
the snap size to anything you want. For example, if all your measurements are rounded off to
the nearest 0.25 units, you can set your snap to 0.25.

The snap technique is not very useful when you need to draw to three or more decimal places
of accuracy. And when you’re zoomed out in a large drawing, the snap points may be so close
together that you cannot easily find the one you want. But in the right situation, snap is one
of the quickest, most accurate drawing techniques available.

AutoCAD and AutoCAD LT provide two types of snap settings — grid snap and polar snap.

Snapping to a grid

When you snap to a grid, an invisible grid becomes active (which you can make visible using
the GRID command, discussed in the next section). As soon as you turn on snap, the mouse
cursor can move only to the snap grid points.

To set the snap size, choose Tools => Drafting Settings or right-click the SNAP button on the
status bar and choose Settings. The Drafting Settings dialog box opens, as shown in Figure
4-15. (If necessary, click the Snap and Grid tab.) In the Snap X Spacing text box of the Snap
section, type the spacing you want between snap points. Make sure that Grid Snap and

Rectangular Snap are checked in the Snap Type & Style section of the dialog box. Click OK.

« Cross- Note that you can change the angle of the snap spacing. In Chapter 8, | discuss rotating the
\Reference angle of the snap and grid. Chapter 8 also discusses Isometric snap, used for isometric

drawing.

Usually you want the X spacing (going across) to be the same as the Y spacing (going up and
down). You need to specify only the X spacing, and the Y spacing changes automatically to
equal the X spacing. X and Y spacing will be different only if you type a different number in
the Snap Y spacing box.
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i Drafting Settings
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Figure 4-15: The Drafting Settings dialog box.

You can also turn snap on in this dialog box by clicking the On check box. However, the most
common way to turn snap on, after you've set the spacing, is to click SNAP on the status bar
(or press the F9 key). Click it again to turn snap off.

Snapping at polar angles

After you set polar tracking settings, discussed earlier in this chapter in the “Polar tracking”
section, you can snap to increments along the polar angles you have set. When PolarSnap is
on, the polar tooltip only shows distances in increments of the snap setting. When you see

the distance you want, just click. PolarSnap makes it easy to draw accurately without having
to type coordinates.

To use PolarSnap, follow these steps:

1. Right-click the SNAP button on the status bar and click Settings to open the Drafting
Settings dialog box with the Snap and Grid tab displayed, as just explained.

. Check PolarSnap in the Snap Type & Style section of the dialog box (refer to Figure 4-15).

2
3. Type a number in the Polar Distance text box.
4

. Click OK to close the dialog box.
5. Click SNAP on the status bar.

Note that PolarSnap and Grid Snap are mutually exclusive. If PolarSnap is on, the cursor will
not snap to the grid. Used with polar tracking, PolarSnap is a powerful tool. Remember that
you can polar track along orthogonal as well as other angles.

Tip You can choose either polar snap or grid snap (switch between them) by right-clicking SNAP
), on the status bar. A shortcut menu lets you choose the type of snap you want, or turn both off.
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The grid

Sometimes you may find it helpful to see a grid of dots to help get your bearings while you
draw, as shown in Figure 4-16. If the dot grid is not visible, click GRID on the status bar or press
the F7 key. Notice how you can quickly judge the approximate width of a windowpane, knowing
that the grid dots are half a foot apart. If you turn on snap, the grid helps you visualize the snap
points. However, the grid dots do not have to be set to the same spacing as the snap points.

Figure 4-16: A portion of a drawing with the grid turned on and set to 6 inches.
Thanks to Henry Dearborn, AlA, Fairfield, lowa, for this drawing.

The smaller the grid size and the farther out you zoom, the denser the grid and the longer it
takes to display. At a certain point, you get a message, Grid too dense to display.

Some users find the grid annoying, but when you first start to use AutoCAD or AutoCAD LT,
you may find it helpful. Even accomplished users can take advantage of the grid, especially
when starting a new drawing.

If you're working with a small snap spacing and the dot grid is too dense, set the dot grid to
two or more times the size of the snap spacing.

s

To set the grid size, choose Tools = Drafting Settings to open the Drafting Settings dialog box
(refer to Figure 4-15). If necessary, click the Snap and Grid tab. In the X Spacing text box of the
Grid section, type the spacing you want between grid points. Click OK.

As with the snap feature, you usually want the X spacing (going across) to be the same as the
Y spacing (going up and down). You only need to specify the X spacing; the Y spacing auto-
matically changes to be the same. X and Y spacing will only be different if you type a different
number in the Y Spacing box.

You can turn on Grid in this dialog box by clicking the On check box, but the most common
way to turn the grid on, after you’ve set the spacing, is to click GRID on the status bar (or
press F7).

In the following exercise, you practice using polar and grid snap points as well as grid dots.
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On the""'\ The drawing used in the following Step-by-Step exercise on using snap points and grid dots,
. ab04-b.dwg, is in the Drawings folder on the CD-ROM.
L y

o,

VS
STEP-BY-STEP: Using Snap Points and Grid Dots
1. Open ab04-b.dwg from the CD-ROM.

2. Choose File> Save As to save the drawing in your AutoCAD Bib1le folder as
ab04-04.dwg.

3. Choose Tools = Drafting Settings. The Drafting Settings dialog box opens. Click the
Snap and Grid tab if it is not displayed. In the Snap Type & Style section, make sure that
you check Grid Snap and Rectangular Snap.

4. In the Snap section, change the Snap X Spacing to 0.5.

5. Click in the Grid section, in the Grid X spacing text box. Change the Grid X spacing to 0.5.
Click OK. The Grid Y spacing automatically changes to match the Grid X spacing of 0.5.

6. On the status bar, click SNAP, GRID, and ORTHO. The grid appears. Make sure that the
OSNAP and OTRACK buttons on the status bar are off. (AutoCAD LT doesn’t have the
OTRACK button.)

7. Choose View= Zoom = All.

8. Move the mouse around and watch the coordinates on the status bar. (Press F6 if they
are in static mode.) They show halves of units because you have set the snap to 0.5.

9. Start the LINE command. At the Specify first point: prompt, click when the coor-
dinates on the status bar show 2.000, 2.000. (AutoCAD users can ignore the third Z
coordinate, which is always 0.0000 in 2D drawings.)

10. Move the mouse around and watch the coordinates. If you don’t see polar coordinates
(for example 3.0000<0), press F6 until you see them.

11. Move the mouse to the right until the coordinates read 8.5000<0 and click the pick (left)
button. You have drawn a horizontal line with a length of 8.5 units.

12. Click the right mouse button and choose Enter to end the LINE command.

13. Move the mouse cursor away from the end of the new line and back to it again, and the
absolute coordinates appear. They should be 10.5000,2.0000.

14. Right-click and choose Repeat Line to start the LINE command again. Use the coordi-
nate display to start the line at 1.5000,1.5000. Continue to pick points (rather than type
them) and draw the following line segments, as shown in the coordinate display:

.5<0
3.0<90
.5<180
3.0<270

15. End the LINE command.
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Start the LINE command and pick points, drawing the following line segments (as shown
in the coordinate display) starting from 10.5,1.5. Then end the LINE command:

.5<0
3.0<90
.5<180
3.0<270

Starting from 2,4 draw an 8.5-unit line at 0 degrees. End the LINE command.

Start the LINE command again. At the first prompt, pick 11,2. Right-click SNAP on the
status bar and choose Settings. In the Snap Type & Style section, choose PolarSnap.
(This is equivalent to choosing the PolarSnap On feature on the SNAP button shortcut
menu.) In the Polar Spacing section, change the Polar Distance to .5. Choose the Polar
Tracking tab and (if necessary) set the Increment Angle to 45.0 degrees. Click OK. Click
POLAR on the status bar.

Move the cursor in a 45-degree direction from 11,2 until you see the tooltip. Move
along the polar tracking vector until the tooltip says 3.5000 < 45° and click. End the
LINE command.

Right-click the SNAP button and choose Grid Snap On. Start the LINE command and, at
the Specify first point: prompt, choose 11,4.

Right-click the SNAP button and choose PolarSnap On. Move the cursor in a 45-degree
direction until the tooltip says 3.5000 < 45° and click. End the LINE command.

. Save your drawing. Your drawing should look like Figure 4-17.

As you no doubt experienced, this is a much easier way to draw compared to typing in coor-
dinates. Note that drawing with snap on works better when you're drawing small objects.
However, even when drawing an office building, you spend a great deal of time working on
small details that may be easier to draw with snap on.

Ej; ﬁﬁﬁﬁﬁﬁﬁﬁ L %P

]

Figure 4-17: The completed pipe section.
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Object snaps

Often you need to draw an object relative to an existing object. For example, you may need to
start a line from the endpoint or midpoint of an existing line. Object snaps (OSNAPS for short)
enable you to specify a point by snapping to a geometrically defined point on an existing
object. This is a very precise and efficient way to draw.

You can start an object snap in one of four ways:

4 Open the Object Snap toolbar and choose the object snap that you want.

4+ Right-click, choose Snap Overrides from the shortcut menu, and then choose the object
snap that you want from the menu.

4 Access the object snap shortcut menu by holding down the Shift key and right-clicking.
Choose the object snap that you want from the shortcut menu.

4+ Type the object snap’s abbreviation on the command line.

- Cross-
Reference

On multibutton mice, you can customize one of the buttons to show the Object Snap menu.
Displaying the Object Snap menu with the click of a mouse button is very convenient.
Customizing the mouse is discussed in Chapter 33.

Table 4-1 lists the object snaps. Use the abbreviation to type the object snap from the keyboard.

Table 4-1: Object Snaps

Object Snap Abbreviation  Uses

Endpoint End Lines, arcs, and so on.

Midpoint Mid Lines, arcs, and so on.

Intersection Int Intersection of lines, circles, arcs.

Apparent Intersection*  App The intersection that would be created if two objects were
extended until they met.

Extension Ext Extends lines, arcs, and so on past their endpoints but in the
same direction. After choosing this object snap, pause over
the endpoint of a line or arc until you see a small plus sign.
As you move the mouse cursor along the extension path, a
temporary extension path appears so that you can draw to or
from points on the extension path. (AutoCAD only.)

Center Cen Circles, arcs, ellipses.

Quadrant Qua Nearest quadrant (0-, 90-, 180-, or 270-degree point) of a
circle, arc, or ellipse.

Perpendicular Per Arg, circles, ellipses, lines, multilines, polylines, rays, splines, or

construction lines. The Deferred Perpendicular mode lets you
draw a line perpendicular from one of these objects.
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Object Snap Abbreviation  Uses

Parallel Par Continues a line, polyline, and so on so that it's parallel to an
existing line or other straight-line segment. After you choose
this object snap, pause over the line you want to draw
parallel to until you see a small parallel line symbol. As you
move the mouse cursor parallel to the object, a temporary
parallel path appears to help you create the parallel segment.
(AutoCAD only.)

Tangent Tan Starts or continues a line from or to a point tangent with an
arg, circle, or ellipse (see Figure 4-18).

Node Nod Point objects (discussed in Chapter 7).

Insertion Ins Insertion point of text (see Chapter 13) or a block (see
Chapter 18).

Nearest Nea Nearest point on any object.

None Non Turns off any object snap modes.

* Apparent Intersection also applies to 3D objects that appear to intersect due to the angle of view.

Figure 4-18: A line drawn tangent to an arc.

When drawing a line, we think of it as having a starting point and an ending point. After the
line is drawn, however, both of these points are considered endpoints in terms of object snaps.
When picking the endpoint of a line for the endpoint object snap, pick a point on the line
closer to the endpoint that you want. The same applies to arcs. Although the arc prompts
read Start point and End, both are considered endpoints for purposes of object snaps.

AutoSnap is a feature that helps you work with object snaps. When you move the cursor near
the geometric point you have specified, such as an endpoint, you are notified in three ways:

4+ Marker: An object snap shape appears. Each object snap has a differently shaped
marker.

4+ AutoSnap tooltip: A label displays the name of the object snap.
4+ Magnet: A pull gently moves the cursor toward the geometric point.

Figure 4-19 shows an endpoint marker and AutoSnap tooltip.
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= Marker

[Endpoint—Tooltip

Figure 4-19: AutoSnap shows
you the endpoint of the line.

You can customize the AutoSnap feature to suit your needs or make it go away completely if
you want. Choose Tools = Options and click the Drafting tab. Here you can individually turn
on and off the marker, AutoSnap tooltip, and the magnet. You can also change the marker size

and color.
New '\ The Deferred Perpendicular mode has been enhanced to give you a more visual cue to pos-
Feature sible perpendicular lines. This mode enables you to draw perpendicular lines from an object.

Start the line command and choose the Perpendicular object snap. Click the object that you
want to draw perpendicular from and then move the cursor away from that object. You see
the Deferred Perpendicular tooltip and a temporary perpendicular line that follows your cur-
sor along the original object. Pick another object or use another object snap to complete the
perpendicular line.

In the following exercise, you practice using object snaps.

STEP-BY-STEP: Using Object Snaps
1. Start a new drawing using the acad.dwt or ac1t.dwt template.
2. Save the drawing in your AutoCAD Bible folder as ab04-05.dwg.

3. Click ORTHO on the status bar to turn on ortho mode. If the OSNAP button is on, click
OSNAP on the status bar to turn off running object snaps (covered in the next section).

4. Start the LINE command. Follow the prompts:

Specify first point: 2,7 4. Move the cursor downward.

Specify next point or [Undol: 4 4. Move the cursor to the right.
Specify next point or [Undol: 4 4. Move the cursor up.

Specify next point or [Close/Undo]l: 4 4

Specify next point or [Close/Undo]l: Press Enter to end the command.

Your drawing should look like Figure 4-20. The circled numbers are reference points for
this exercise.

5. Choose Arc from the Draw toolbar. Follow these prompts:

Specify start point of arc or [Center]: Press Shift and right-click.
From the shortcut menu, choose Endpoint, as shown in Figure 4-21.

_endpt of Move the cursor to 1) in Figure 4-20. When you see the
endpoint marker and AutoSnap tooltip, click.



Chapter 4 + Specifying Coordinates

Specify second point of arc or [Center/End]: Right-click and choose

Center.

Specify center point of arc: Right-click. Choose Snap Overridesw
Midpoint from the shortcut menu.

_mid of Move the cursor to @ and pick.

Specify end point of arc or [Angle/chord Length]: end 4. Move the
cursor to @ and pick.

Figure 4-20: These three lines are the

start of a mounting bracket.

Temporary track point
Tracking

From

Mid Between 2 Points
Point Filters

Endpoint

Midpoint
Intersection
Apparent Intersect
Extension

Center
Quadrant
Tangent

Perpendicular
Parallel

Node

Insert

Nearest

Osnap Settings...

13

Figure 4-21: Choosing the Endpoint object snap from the

shortcut menu.
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Note

Tip

6. Choose Circle from the Draw menu. Follow the prompts:

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:
Choose Snap to Center from the Object Snap shortcut menu.

_cen of Move the cursor over the arc until you see the Center marker
and tooltip, and then click.
Specify radius of circle or [Diameter]: .75 J

. Start the LINE command and use any method you want to draw a line from the end-

point at @ to the endpoint at @. End the LINE command.

When you press Shift and right-click to get the object snap menu, the mouse pointer must be
in the drawing area. If it is on a toolbar, you get the Toolbars list. If that happens, press the
Esc key, or hold down the Shift button and right-click again in the drawing area.

8. Save your drawing. It should look like Figure 4-22.

Figure 4-22: The start of a drawing
of a mounting bracket (including a
construction line that would later be
erased). It was created by using the
endpoint, midpoint, and center object
snaps.

Running object snaps and OSNAP mode

The endpoint object snap is probably the most commonly used of all the object snaps. You
might have a drawing project in which you need to use the endpoint object snap often. You can
set a running object snap, which keeps one or more object snaps on until you turn them off.

Many users like to work with three or four running object snaps on at once, such as end-
point, midpoint, center, and intersection. If you can't find the object snap you want because
you have several object snaps near each other, press the Tab key to cycle through the object
snaps, one by one, until you find the one that you want.

To set running object snaps, choose Tools = Drafting Settings (or right-click the OSNAP button
on the status bar and choose Settings) to open the Drafting Settings dialog box, as shown in
Figure 4-23. (If necessary, click the Object Snap tab.) Choose the object snaps that you want and
click OK. To clear a checked object snap, click it. Click Clear All to clear all running snaps.
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Figure 4-23: Use the Object Snap tab of the

Draft

ing Settings dialog box to set running object

snaps.

You use the OSNAP button on the status bar to turn on your running object snaps. If you want
to turn them off temporarily, just click the OSNAP button or press F3. This capability to toggle

runn

ing object snaps on and off makes it easy to work with running object snaps on almost

all the time because you can turn them off at the click of a button.

In the following exercise, you practice using running object snaps with OSNAP mode.

STEP-BY-STEP: Using Running Object Snaps with OSNAP Mode

1.

Start a new drawing using the acad.dwt or ac1t.dwt template. Save the file in your
AutoCAD Bible folder as ab04-06.dwg.

. Choose Tools = Drafting Settings and click the Object Snap tab. Choose Endpoint.
Uncheck all other object snaps and click OK.

. Start the LINE command and start the line at 2,2.

. Turn on ortho mode by clicking ORTHO on the status bar. If OSNAP is not on, click it on
the status bar.

. Move the mouse in the 0-degree direction and type 6 .
. Move the mouse up in the 90-degree direction, type 3 ., and end the LINE command.

. Start the ARC command. At the Specify start point of arc or [Center]:
prompt, pick the endpoint at ), shown in Figure 4-24. (Look for the marker and
AutoSnap tooltip.)

. At the Specify second point of arc or [Center/End]: prompt, right-click and
choose End. Pick the endpoint at @), shown in Figure 4-24.
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' Note

10.

11.

12.
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16.

10 !

Figure 4-24: Drawing a steam boiler
with an endpoint running object snap.

. At the Specify center point of arc or [Angle/Direction/Radius]: prompt,

right-click and choose Angle, and then type 180 .

Start the LINE command and at the Specify first point: prompt, pick the endpoint
at @ in Figure 4-24.

Move the mouse to the left in the 180-degree direction, type 6 -, and end the LINE
command.

Right-click the SNAP button on the status bar and choose Settings. Click Grid Snap in
the Snap Type & Style section. Set the Snap X spacing to 0.25. Check the Snap On check
box. Click OK.

Start the LINE command. At the Specify first point: prompt, place the cursor 0.25
units above @ in Figure 4-24 (at 2,5.25). You may need to turn off the running OSNAP
temporarily. Pick point 2,5.25.

At the Specify next point or [Undo]: prompt, pick point 2,1.75. (If necessary, press
F6 to get absolute coordinates.)

Press F6 twice to get polar coordinates. Follow the prompts:

Specify next point or [Undol: Pick .5<180.

Specify next point or [Close/Undol: Pick 3.5<90.

Specify next point or [Close/Undo]: Pick the endpoint at @ in
Figure 4-24. (If you turned off OSNAP in Step 13, turn it on again.)
Specify next point or [Close/Undo]: 4

Save your drawing.
Even if you have running object snaps, if you specify an object snap during a command, it

overrides the running object snap. For example, having a running endpoint object snap does
not mean you can't use a midpoint object snap for any specific drawing command.

By default, if you type absolute or relative coordinates, they take precedence over any run-
ning object snaps. This lets you leave running object snaps on but override them with key-
board entry of typed coordinates whenever you want. In general, the default gives you the



Chapter 4 + Specifying Coordinates

most control and flexibility. However, you can change this default to give running object
snaps precedence. To change the default, choose Tools > Options, click the User Preferences
tab, and use the Priority for Coordinate Data Entry section of the dialog box.

Locating Points

Sometimes you need to locate a point that is not on an existing object. For example, you may
need a point a certain distance and angle from an existing object. This section explains three
techniques that enable you to locate points that are not on objects — object snap tracking,
point filters, and the From feature.

Object snap tracking

The purpose of tracking is to let you specify a point based on the object snaps of existing
objects. Temporary tracking lines are drawn from points you specify, and you can use
PolarSnap or direct distance entry to easily specify new points. Object snap tracking is not
available in AutoCAD LT.

Object snap tracking significantly changes the way you draw, offering increased ease and
speed of drawing, because it provides visual confirmation of your tracking points. You need
to use the keyboard less often, and thus you can do more heads-up drawing. Use the OTRACK
button on the status bar to turn object snap tracking on and off.

Object snap tracking can easily handle all of the following tasks and many more:

4+ You're drawing a line and have specified the start point. You want the endpoint to be
exactly vertical to the endpoint of an existing line.

4+ You're drawing a line and have specified the start point. You want the line to be 3 units
long and parallel to an existing line.

4+ You're drawing a circle inside a rectangle (which could be a hole inside a sheet-metal
plate). You want the center of the circle to be exactly centered inside the rectangle, at
the intersection of the midpoints of the rectangle’s two sides.

4 You want to start a line at the point where two existing lines would intersect if they
were extended.

To start using object snap tracking, at least one object snap must be active. You can specify
an object snap for just that command or turn on a running object snap, as explained in the
previous sections. Then click OTRACK on the status bar.

After object snap tracking is on, follow these steps:
1. Start a command that requires you to specify a point.

2. Place the cursor briefly over an object snap, such as the endpoint of a line, to tem-
porarily acquire it. You can acquire more than one point. These acquired points are
used to calculate the tracking paths. You see a small plus sign (+) over the object snap
as confirmation, as shown in Figure 4-25.

3. Move the cursor away from the object snap toward your desired point. You see the
temporary alignment paths as you move the cursor over available drawing paths, as
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shown in Figure 4-26. If ORTHO is on, you see only horizontal and vertical paths. If
POLAR is on, you see polar paths based on the polar angle settings, as explained earlier
in this chapter.

4. When you see a tooltip and a small x, click. You can now continue or complete the com-
mand using this point.

Acquired point

l Figure 4-25: When you pause over an object snap and

then move the cursor slightly, you see a plus sign (+) at
the acquired point to show that the point has been
~ |

acquired and can now be used for object snap tracking.

Cursor

Acquired endpoint of existing arc

VN

Temporary
alignment path

/ Cursor
Desired endpoint of S]Eart pol!nt
i "X of new line

new line (at the "X’} Evdport SSTSME 0T 1o 010

Figure 4-26: With the endpoint object snap active and ORTHO on,
AutoCAD displays temporary alignment paths based on the
acquired point.
After you acquire a point, you can clear it in any one of three ways:
4+ Move the cursor back over the point’s plus sign.
4 Click OTRACK off using the status bar.
4 Start any new command.

/Note Tracking is intended for use in two dimensions only. For 3D point location, use point filters,
- covered later in this chapter.
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You can customize the following features of object snap tracking on the Drafting tab of the
Options dialog box (choose Tools => Options):

4+ Uncheck Display Polar Tracking Vector to eliminate the tracking paths.

4+ Uncheck Display Full Screen Tracking Vector to display the tracking paths only from
the cursor to the object snap point.

4+ Uncheck Display AutoTrack Tooltip to eliminate the tooltips.

4+ In the Alignment Point Acquisition section, choose Shift to Acquire, which will require
you to press Shift to acquire a point when the cursor is over an object snap point.

In the following exercise, you practice locating points with object snap tracking. If you are
using AutoCAD LT, skip this exercise, because AutoCAD LT doesn’t have this feature.

\ The drawing used in the following Step-by-Step exercise on locating points with object snap
tracking, ab04-c.dwg, is in the Drawings folder on the CD-ROM.

STEP-BY-STEP: Locating Points with Object Snap Tracking
1. Open ab04-c.dwg from the CD-ROM.

2. Save the drawing as ab04-07.dwg in your AutoCAD Bib1e folder. This drawing is a sec-
tion of a simple plan layout of an apartment. Set endpoint and midpoint running object
snaps only. Make sure that OSNAP and OTRACK are on and that POLAR is off. ORTHO
should also be off.

3. Start the LINE command. At the Specify first point: prompt, pick the endpoint
at @ in Figure 4-27. Be sure to pick on the endpoint itself, in order to acquire it.

SHENE N
SEEN

'

—

Figure 4-27: The tub, door, and sink to be completed in this plan layout.
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10.

11.

12.

13.

. At the Specify next point or [Undo]: prompt, pass the cursor over @. Move the

cursor down a little, and you see the small plus sign showing that this endpoint has
been acquired.

. Move the cursor down until it is to the left of @ and vertical to @. When you see the

tooltip (reading Endpoint: < 270°, Endpoint: < 180°) and the small x marking the inter-
section of the two points, click to end the line segment.

. At the Specify next point or [Undo]: prompt, click at @ and end the LINE

command.

. Start the LINE command again. At the Specify first point: prompt, pick the end-

point of the arc at @ in Figure 4-27. If you're not sure that you found the right endpoint,
press Tab until the arc is highlighted. Make sure that you've acquired the endpoint by
clicking the endpoint itself or passing the crosshairs over it.

. At the Specify next point or [Undo]: prompt, pass the cursor over @ until you

see the small plus sign. Move the cursor to the left until you see the tooltip (reading
Endpoint: < 90°, Endpoint: < 180°) and click.

. At the Specify next point or [Undo]: prompt, pick the endpoint at ) and end the

LINE command.

Start the CIRCLE command. At the Specify center point for circle or [3P/2P/
Ttr (tan tan radius)]: prompt, pass the cursor over @ and then over @ to acquire
both midpoints.

Move the cursor to the middle of the sink, where lines from both midpoints would
intersect until you see the tooltip (reading Midpoint: < 270° Midpoint: < 180°) and click.

At the Specify radius of circle or [Diameter]: prompt, type 7.5 . to complete
the sink.

Save your drawing. It should look like Figure 4-28.

O

O
o)

)

Figure 4-28: The completed drawing.
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Point filters

Point filters enable you to specify a coordinate using the X coordinate of one existing object
snap and the Y coordinate of another. You construct an X,Y coordinate based on coordinates
of existing objects. If this sounds complicated, it is. Object snap tracking should mostly elimi-
nate the need to go back to the old point filter way of doing things if you are using AutoCAD.
Because object snap tracking isn’t available in AutoCAD LT, you need to use point filters
instead. (Point filters have been around for a long time.)

Point filters are often used in 3D drawings where object snap tracking doesn’t work. See
Chapter 21 for more details.

Here’s how to use point filters:

s

On the

L

e

1.
2.

Start a command to draw an object.

To specify a coordinate, type .x or .y on the command line. You can also find point fil-
ters on the object snap shortcut menu (Shift+right-click).

3. The prompt requests a point. Generally, you specify the point by using an object snap.

. The prompt requests the other coordinate value, which you generally provide by using

an object snap. (If you'’re working in 2D, ignore the request for a Z coordinate.)

. Continue your command.

You don't need to use existing coordinates for both the X and Y portions of the coordinate.
For example, you can construct an XY coordinate by using the Y coordinate of an existing line
and picking the X coordinate anywhere on the screen.

In the following exercise, you practice using 2D point filters on the same drawing you used in
the previous exercise.

| cn?

The drawing used in this Step-by-Step exercise on using 2D point filters, ab04 -c.dwg, is in
the Drawing folder of the CD-ROM.

STEP-BY-STEP: Using 2D Point Filters

1.
2.

Open ab04-c.dwg from the CD-ROM.

Save the file as ab04-08.dwg in your AutoCAD Bible folder. Make sure that ORTHO
and OSNAP are on. If you are using AutoCAD, make sure that OTRACK is off. Set a run-
ning object snap for endpoint and midpoint.

3. Start the LINE command.

4. At the Specify first point: prompt, pick the endpoint at @ in Figure 4-29.

5. At the Specify next point or [Undo]: prompt, type .x . At the of prompt, pick

the endpoint at @) in Figure 4-29.

. You see the (need YZ): prompt. (Because you're drawing in 2D, you can ignore the Z.)

Choose the endpoint at @ in Figure 4-29. AutoCAD or AutoCAD LT draws the line seg-
ment to the point defined by the X coordinate of @ and the Y coordinate of @.
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10.
11.

12.

13.
14.

SN

'

]

Figure 4-29: Using point filters to specify the start of a line.

. At the Specify next point or [Undo]: prompt, pick the endpoint at @. End the

LINE command.

. Start the LINE command again. At the Specify first point: prompt, pick the end-

point at €. If necessary, press Tab until you see the arc highlighted so you know you
have the endpoint of the arc.

. At the Specify next point or [Undo]: prompt, type.y . At the of prompt, pick

the endpoint at @ in Figure 4-29.
At the (need XZ): prompt, pick the endpoint at €.

At the Specify next point or [Undo]: prompt, pick the endpoint at @). End the
LINE command.

Start the CIRCLE command. At the Specify center point for circle or [3P/2P/
Ttr (tan tan radius)]: prompt, type.y . At the of prompt, pick the midpoint at
@©. At the (need XZ): prompt, pick the midpoint at @ to place the center of the circle.

At the Specify radius of circle or [Diameter]: prompt, type 7.5 .

Save your drawing.

From feature

The From feature enables you to create a new object starting at a known distance and direc-
tion from an existing object. It’s like creating one or more invisible lines between the existing
object and the new object, helping you start the new object in the proper place. Use From
when no object snaps are available to help you determine a new point.
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Here’s how to use the From feature:
1. Start a command to draw an object, such as LINE.

2. Press Shift, right-click, and choose From on the shortcut menu. You can also type from
on the command line.

3. The prompt requests a base point, which you usually provide by using an object snap,
such as an endpoint.

4. The prompt requests an Offset, which you provide by using relative or polar coordinates.
5. Continue the command you started (in Step 1).
In the following exercise, you practice using the From feature.

On theh"\ The drawing used in the following Step-by-Step exercise on using the From feature,
,  ab04-06.dwg, is in the Results folder on the CD-ROM.
L y

CD-
A
STEP-BY-STEP: Using the From Feature

1. Open ab04-06.dwg, which you created in an earlier exercise. If you did not do the pre-
vious exercise, open the drawing from the Results folder of the CD-ROM. Make sure
ortho mode is on and SNAP is off. OSNAP should be on. Set a running object snap for
endpoint.

. Save the drawing as ab04-09.dwg in your AutoCAD Bible folder.
. Start the LINE command.

. From the Object Snap shortcut menu, choose From.

U1 e W N

. The prompt asks you for a base point. Pick the endpoint at ) in Figure 4-30.

Figure 4-30: Using the From feature to
complete the steam boiler.

6. At the <Offset>: prompt, type @-1,.5.1.

7. You are now ready to continue the line at the Specify next point or [Undo]:
prompt. Press F3 to turn off OSNAP. Move the cursor in the 90-degree direction and
type 2 .

8. Move the mouse in the 180-degree direction and type 1 .

9. Move the mouse in the 270-degree direction and type 2 .



80 Part| 4+ AutoCAD and AutoCAD LT Basics

10. Right-click and choose Close from the shortcut menu to close the rectangle and end the
LINE command.

11. Save your drawing. It should look like Figure 4-31.

I

Figure 4-31: The completed steam boiler.

Summary

This chapter covered a great deal about specifying coordinates. These skills form the basis
for all your future work with AutoCAD and AutoCAD LT. You read about:

4 The XY coordinate system
4+ Using absolute Cartesian coordinates
4+ When and how to use relative Cartesian coordinates
4+ Absolute and relative polar coordinates
4+ Direct distance entry
4 The orthogonal (ORTHO) mode
4+ Using polar tracking
4+ Controlling the display of coordinates on the status bar
4 Grid and PolarSnap settings
4+ Using the visible grid
4+ Using object snaps (OSNAPS) to specify geometric points on objects
4+ Running object snaps and turning OSNAP on and off
4+ Using object snap tracking to locate points (AutoCAD only)
4 Using point filters to locate points
4 The From feature for locating points not on an object
The next chapter introduces you to the basics of setting up a drawing.

+ s+



Setting Up
a Drawing

+ 0+ 0+
In This Chapter

Often, the first step after you start a new drawing is to set its size Setting the unit type

and unit type. These and other setup options are discussed in
this chapter. The entire process of setting up a drawing is essential Setting drawing limits
for ensuring accurate results.
Presetting the
drawing scale

Unit Types

One of the first tasks in setting up a drawing is to choose the unit

Inserting a title block

type. Units define how objects are measured. You can save the unit Understonding
type in a template. system variables
The coordinates you use in AutoCAD or AutoCAD LT are measured in Automating setup
units that can represent any real-world measurement, such as inches

or millimeters. A surveyor or city planner might even use miles or <+ <+ <+

kilometers as the base unit. However, different disciplines customar-
ily express units differently, and you should use the unit type appro-
priate for the type of drawing you're creating. AutoCAD and AutoCAD
LT offer five types of units, as shown in Table 5-1. The sample mea-
surement column shows how a line 32.5 inches long would be dis-
played in the various unit types.

Table 5-1: Unit Types

Unit Type Sample Measurement  Description

Decimal 32.50 Number of units, partial units in
decimals

Engineering  2'-8.50" Feet and inches, partial inches in
decimals

Architectural 2'-8 12" Feet and inches, partial inches in
fractions

Fractional 3212 Number of units, partial units in
fractions

Scientific 3.25E+01 Base number + exponent
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Note

Notice how the engineering and architectural units translate a line of 32.5 units into feet and
inches. Engineering and architectural units assume a unit of 1 inch, unlike the other unit
types, which can represent any measurement.

The unit type affects how coordinates are shown on the status bar and how information
about objects is listed. You generally input coordinates by using the type of units you've cho-
sen, although in some cases you can input coordinates in another unit type.

If you're using engineering or architectural units, AutoCAD and AutoCAD LT display partial

- inches differently than the format you must use to type them in. You must type coordinates

without any spaces, because a space is equivalent to pressing Enter, and that ends your
input. Use a hyphen between whole and partial inches, for example, 3'2-1/2". (You can omit
the " after the inches because inches are assumed in engineering and architectural units if
no symbol follows a number.) However, this appears on the status line as 3'-2 1/2". This can
be confusing because the hyphen is in a different place, and you see a space between the
whole and partial inches.

Setting the drawing units

When you know the units you want to use, you set them in the Drawing Units dialog box. To
set the units, choose Format => Units to open the Drawing Units dialog box, shown in Figure
5-1. The left side of the Drawing Units dialog box enables you to choose which unit type you
want to use. In the Precision box in the Length section, click the arrow and a list of precision
options drops down. Click the one you want.

il Drawing Units =&
Lenath Angle
Tupe: Type:
- Decimal Degrees A
Precision: Precision:
0.0000 L4 a A
[ Clockwise
[Crrag-and-diop scale
Units to scale drag-and-drop content:
Inches w
Sample Dutput
1.5000.2.0033,0.0000
3.0000<45,0,0000
[ oK ] [ Cancel ] [ Directian, ] [ Help ]

Figure 5-1: The Drawing Units dialog
box.

Caution AutoCAD and AutoCAD LT round off measurements to the nearest precision value you

choose. Say that you choose a precision of two decimal places, using decimal units. You
want to draw a line so that it is 3.25 units long, but when you type the coordinate, by acci-
dent you press the 4 key at the end, resulting in a line 3.254 units long. This line is displayed
as 3.25 units long, making it difficult for you to spot the error. Therefore, setting a higher pre-
cision than you need to show is a good idea.
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Setting the angle type

As with units, your choice of angle type depends on your profession and work environment.
Decimal Degrees is the default. Table 5-2 lists the types of angles.

Table 5-2: Angle Types

Angle Type Name Sample Measurement Description

Decimal Degrees 325 Degrees, partial degrees in decimals
Deg/Min/Sec 32°30'0" Degrees, minutes, and seconds
Grads (gradians) 36.1111g Gradians

Radians 0.5672r Radians

Surveyor N 57d30' E Surveyor (directional) units

Note A minute is '/so degree and a second is /eo minute. Gradians and radians are simply alternate
~  ways of measuring angles. A gradian is a metric measurement equal to 100 of a right angle.
Radians measure an angle by placing a length, equal to the radius, along the circle’s circum-
ference. Radians range from 0 to 2 x = instead of from O to 360 as degrees do. A radian is
approximately 57.30 degrees. Surveyor units measure angles in directions, starting with
north or south and adding an angle in degrees, minutes, seconds format that shows how far

the angle is from north or south and in which direction (east or west).

To set the angle type, choose the option you want from the Type drop-down list of the Angle
section of the Drawing Units dialog box (shown in Figure 5-1).

« Cross- Changing these angle settings does not automatically change the way your dimensions
Reference appear. Use the Dimension Style Manager, which is discussed in Chapter 15, to change

dimensions.

Setting the angle measure and direction

By convention, degrees increase in a counterclockwise direction, and you measure angles so
that 0 degrees starts to the right, in the East direction. To change the angle direction, click
Clockwise in the Drawing Units dialog box.

To change the direction of 0 degrees, click Direction to open the Direction Control dialog box,
shown in Figure 5-2.

Here you can choose to have 0 degrees start in a direction other than East. You can also
choose Other and type any other angle or click the Pick an Angle button to pick two points on
your screen that specify an angle. Choose OK to close the Direction Control dialog box. Click
OK to control the Drawing Units dialog box.
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iid Direction Control @i Figure 5-2: The Direction Control dialog box.
Base Angle
Ot 0.0
) North 30.00
O west 180.00
O South 270,00
) Other Pick / Type
i

' Note
)

Changing the angle direction affects what happens when you input angles and what you see
in the coordinate display. It does not change the absolute coordinates, which are set accord-
ing to the User Coordinate System (UCS). Chapter 8 covers using and customizing UCSs.

STEP-BY-STEP: Setting Drawing Units

1.

U1 = W N

e X N &

10.

11.
12.

' Note

Begin a new drawing using the acad.dwt or ac1t.dwt template.

. Save the drawing as ab05-01.dwg in your AutoCAD Bible folder.
. Choose Format = Units to open the Drawing Units dialog box.
. In the Length section, choose Architectural.

. Click the arrow to the right of the Precision drop-down list box in the Length section.

Choose 0'-0 1/8".

. In the Angle section, choose Deg/Min/Sec.
. In the Precision box, choose 0d00'.
. In the Units to Scale Drag-and-Drop Content drop-down list, set the units to Inches.

. Click OK.

Start the LINE command. Follow the prompts:

Specify first point: 2,2 4

Specify next point or [Undo]: @'<0 J
Specify next point or [Undo]l: @6-3/4<153 4
Specify next point or [Close/Undo]l: 2,2 4

End the LINE command.
Choose View = Zoom = All to zoom to the entire drawing. Save your drawing. If you're

continuing through the chapter, keep it open.

You would not actually use Deg/Min/Sec for angles in an architectural drawing, but the exer-
cise gives you the opportunity to set the angular units.
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Drawing Limits

You can specify the area of your drawing, also called the limits. The drawing limits are the
outer edges of the drawing, specified in X,Y units. You need to set only the width and length
of the drawing. Together, these two measurements create an invisible bounding rectangle for
your drawing.

Almost universally, the lower-left limit is 0,0, which is the default. Therefore, the upper-right
corner really defines the drawing size. Remember that you typically draw at life size (full scale).
Therefore, the size of your drawing should be equal to the size of the outer extents of what
you're drawing, plus a margin for a title block (if you plan to add one) and perhaps for anno-
tation and dimensioning. If you want to show more than one view of an object, as is common
in both architectural and mechanical drawings, you need to take this into account.

To decide on the upper-right corner of your drawing limits (the width and length of your draw-
ing), you need to consider what the drawing units mean for you. Generally, the smallest com-
monly used unit is used, often inches or millimeters. Therefore, if you're drawing a plan view of
a house that is approximately 40-feet across (in the X direction) by 30-feet deep (in the Y direc-
tion), this translates to a top-right corner of 480,360. Adding room for a title block brings you to
about 500,380.

The limits define an artificial and invisible boundary to your drawing. You can draw outside
the limits. The limits affect the size of the grid, when displayed. (See Chapter 4 for a discus-
sion of the grid.) The ZOOM command with the All option also uses the limits, but only if no
objects are outside the limits. (See Chapter 8 for a discussion of the ZOOM command.)

To set the drawing limits, choose Format = Drawing Limits to start the LIMITS command.
Press Enter to accept the lower-left corner default of 0,0 that appears on the command line.
Then type the upper-right corner coordinate that you want and press Enter.

On theh"'\ The drawing used in the following Step-by-Step exercise on setting the drawing limits,
,  ab05-01.dwg, is in the Results folder on the CD-ROM.
L y

o,
A
STEP-BY-STEP: Setting the Drawing Limits

1. If you did the previous exercise, continue to use ab05-01.dwg. Otherwise, open
ab05-01.dwg from the Results folder of the CD-ROM.

. Save the drawing as ab05-02.dwg in your AutoCAD Bible folder.
. Choose Format = Drawing Limits.
. Press Enter to accept the lower-left default of 0,0.

. Type 16,10 .

S U e W N

. Start the LINE command. Follow the prompts:

Specify first point: 0,0 4

Specify next point or [Undo]l: 16,0 4
Specify next point or [Undo]: 16,10 J
Specify next point or [Close/Undo]: 0,10 4
Specify next point or [Close/Undo]l: 0,0 4
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7. End the LINE command.
8. Choose View > Zoom > All.

9. Save your drawing. If you're continuing through the chapter, keep it open.

Understanding Scales

You need to consider the fact that your drawing will most likely be plotted onto a standard
paper (sheet) size. The standard orientation for drafting (and the default for most plotters) is
landscape orientation, meaning that as you look at the drawing, the paper is wider than it is tall.
Figure 5-3 shows an example. These conventions have carried over from the days of hand draft-
ing. (In a computer program, this is not really necessary, because you can rotate the drawing
when you plot it.) To scale a drawing onto a piece of paper in a pleasing manner requires a rect-
angular shape that somewhat resembles the proportions of standard paper sizes.

IO

Figure 5-3: Drawings are usually oriented horizontally, as
in this example.

Thanks to Henry Dearborn, AlA, Fairfield, lowa, for this drawing, which
I have altered somewhat.

In addition, although you specify the scale at plotting time, it helps to be aware of the scale
you’ll use when plotting your drawing at the outset. The scales used for Geographic
Information Systems (GIS), where you might be drawing an entire county, will be different
from those used when drawing a house. The scales used in mechanical drafting are again
totally different. In fact, in mechanical drafting, if you're drawing a very small object, such as
a 2-inch screw-plate, you might scale up (that is, enlarge the drawing when plotting).

One important reason for establishing the scale at the beginning is to ensure that text,
whether annotations or dimensions, is readable in its final plotted form. Applying a scale
ensures that text remains a reasonable size even as the rest of the drawing is scaled up or
down. Scale also affects linetypes that contain dots or dashes.
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Some drawings are not scaled. Examples are electrical or electronic schematics, piping dia-
grams, and railroad schematics. These drawings are representations of electrical or electronic
connections but do not resemble the actual physical object that will eventually be created
from the drawing. These drawings can be any size as long as they are clear and organized.

« Cross- You can lay out various views of your drawing on an imaginary piece of paper, called a paper
Reference space layout, to prepare it for plotting. See Chapter 17 for more on layouts and plotting.

When determining your scale to fit a drawing on a sheet of paper, be aware that a plotter can-
not print on the entire sheet. A certain amount of the margin around the edge is not available
for drawing. Plotters differ in this respect. The plotter’s manual can let you know the width of
this unprintable margin. On average, you can assume a half-inch margin on each side; thus
you should subtract 1 inch from both the length and width sheet measurements to determine
the actual drawing space. Table 5-3 shows standard U.S. sheet sizes.

Table 5-3: Standard Paper Sheet Sizes in the United States (in inches)

Size Width Height Size Width Height
A 11 8> D 34 22

B 17 11 E 44 34

C 22 17

Table 5-4 lists standard metric sheet sizes.

Table 5-4: Standard Metric Paper Sheet Sizes (in millimeters)

Size Width Height Size Width Height
A4 297 210 Al 841 594

A3 420 297 AO 1,189 841

A2 594 420

Scale formats

A scale is often indicated in the format plotted size=actual size. Because you draw at actual size,
the actual size is also the drawing size. For example, a scale of ¥4"=1"' means that Y inch on the
drawing, when plotted out on a sheet of paper, represents 1 foot in actual life—and in the draw-
ing. This is a typical architectural scale. A windowpane one foot wide would appear Y-inch
wide on paper.
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From the scale, you can calculate the scale factor. You use the factor when you set the size for
text (see Chapter 13) or for dimensions (see Chapter 15). To do this, the left side of the scale
equation must equal 1, and the two numbers must be in the same measurement (for example,
both in inches). This requires some simple math. For ¥4=1', you would calculate as follows:

W"=1'
1"=4' Both sides of the equation multiplied by 4
1"=48" 4’ converted to 48"
Therefore, the scale factor is 48. This means that the paper plot is s of real size.

In mechanical drawing, you might draw a metal joint that is actually 4 inches long. To fit it on
an 8%-x-11-inch sheet of paper, you could use a 2"=1" scale, which means that 2" on the paper
drawing equals 1" in actual life and the drawing. Calculate the scale factor:

o 1"
1"21y"
The scale factor is %. This means that the paper plot is twice the real size.

Most professions use certain standard scales. Therefore, you do not usually have a choice to
pick any scale you want, such as 1":27". Instead, the conventions of your profession, client, or
office dictate a choice of only a few scales. Table 5-5 lists some standard architectural scales.

Table 5-5: Typical Architectural Scales

Scale Factor Plotted Size Drawing/Actual Size
480 1/40" 1
240 1/20" 1
192 1/16" 1
96 1/8" 1
48 1/4" 1
24 1/2" 1
16 3/4" 1
12 1" 1
4 3" 1
2 6" 1

1 1 1

Civil engineering scales are somewhat different and range to larger sizes —a bridge is bigger
than a house —as shown in Table 5-6.
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Table 5-6: Typical Civil Engineering Scales

Scale Factor Plotted Size Drawing/Actual Size
120 1" 10'
240 1" 20'
360 1" 30'
480 1" 40'
600 1" 50'
720 1" 60'
960 1" 80'
1,200 1" 100'

Table 5-7 shows some typical metric scales that can be used for any purpose. You would most
typically work in millimeters, but these could represent any metric measurement.

Table 5-7: Typical Metric Scales

Scale Factor Plotted Size Drawing/Actual Size
5,000 1 5,000
2,000 1 2,000
1,000 1 1,000
500 1 500
200 1 200
100 1 100
75 1 75
50 1 50
20 1 20
10 1 10
5 1 5

1

Deciding on a scale and sheet size

As soon as you know the size of your drawing and the scale appropriate for your situation,
you need to consider the sheet size of the paper that you’ll plot on. Again, you often find that
certain factors limit your choices. Your plotter or printer may be limited to certain sheet
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sizes. The conventions used in your discipline or working environment also affect your deci-
sion. You may be working on a series of drawings that are all to be plotted on the same size
sheet of paper.

As an example, the architectural drawing in Figure 5-3 is 175-feet wide by 120-feet high. The
two most typical scales for a drawing of a house are %"=1" and }4"=1". On a small plotter, you
might have a choice of sheet sizes A, B, or C. The following steps show the calculations you
need to do in order to decide on a scale, obtain the scale factor, and determine the appropri-
ate sheet size.

In this exercise, you practice determining the scale and sheet size. You need only a sheet of
paper and a pencil. Use Figure 5-3 as a reference.

STEP-BY-STEP: Determining the Scale and Sheet Size

1. To calculate the plotted size of the drawing at ¥4"=1", you can start with the width, which
is 175'. Take one-quarter of 175 to get the width of the drawing in inches, which is 43%".

2. Take one-quarter of the height, 120, to get the height of the drawing in inches, which
is 30".

3. A size-C sheet (see Table 5-3) is 22"x17", which is too small for a 43%4"x30" drawing.

4. Recalculate the drawing at %5"=1". Take one-eighth of 175 to get 21%. Take one-eighth of
120 to get 15".

5. The actual drawing space (minus the margins the printer requires) on a size-C sheet is
about 21"x16". The height of the drawing at this scale is adequate, but the width is 7"
too long. Therefore, the best bet is to simply make the drawing %" narrower because
the drawing has some extra room. This lets you fit the drawing on a size-C sheet.

6. To calculate the scale factor of a 14"=1" scale, multiply 1' by 8 to get 8 and convert it to
inches, which is 96 (8x12).

Rearranging the views, dimensions, and text on a drawing to fit a standard scale factor and
sheet size is a typical task. There is no actual setup step for setting the drawing scale, but you
use it when you insert text or dimensions and when you plot the drawing.

Inserting a Title Block

A title block is a rectangle that includes spaces for the drawing title, company name, drafter
name, and so on. It generally comes with a border that bounds your drawing. Many drawings
require title blocks. You can insert an existing title block in two ways:

4+ When creating a new drawing, choose File => New to open the Select Template dialog
box. Choose one of the templates that includes a title block. For example, ANST
A -Named Plot Styles.dwt includes a title block and border that fit on an A-size
sheet. The title block and border appear on a layout tab. (Chapter 17 covers layouts.)

4 After you open a drawing, you can insert a drawing of a title block into it. Choose Insert =>
Block. (Chapter 18 covers blocks.) In the Insert dialog box, type the name of the drawing
or block or click Browse to find it. Most of the templates have a corresponding drawing
that you can insert. You can find them in the \Template folder. To insert the file or block
at 0,0 with no scaling or rotation, uncheck all the Specify On-Screen check boxes. Check
Explode if you expect to edit the inserted title block after it’s in your drawing. Click OK.
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New '\ To find the location of the templates and their corresponding drawings, choose Tools <>

Feature Options and click the Files tab. Double-click Drawing Template Settings and then double-
click Drawing Template File Location. You see the path to the location displayed. (The path is
very long!) This folder may be hidden in Windows Explorer. For instructions on displaying
hidden folders, go to Windows Help and enter hidden folders in the search box.

¢ Cross- As explained in Chapter 2, you can create your own title block, make a template from it, and
Reference then start a drawing based on that template.

Common Setup Options

A few other items are generally set up in advance and are included in a template. Other chap-
ters of this book cover the following:

4+ Layers (covered in Chapter 11) enable you to organize your drawing into meaningful
groups. In an architectural drawing, for example, you might create a layer for walls,
another for doors, one for electrical fixtures, and so on.

4 Text styles (covered in Chapter 13) enable you to format the font and other text
characteristics.

4+ Dimension styles (covered in Chapter 15) format the dimensions that measure your
objects.

System Variables

When you change settings in AutoCAD or AutoCAD LT, such as the unit type, angle type, drawing
limits, blip marks, snap mode (on or off), grid mode, or ortho mode, you're actually changing sys-
tem variables. These are simply settings that are stored in each drawing or in the Windows reg-
istry (which stores settings that apply to all drawings). Usually, you don't need to pay any direct
attention to them, but they're the nuts and bolts behind the dialog boxes you use to change the
settings. When you start customizing AutoCAD, you need to learn about them because program-
ming code and script files (macros) cannot access dialog boxes. Also, a few system variables are
accessible only by typing them directly on the command line. Bonus Chapter 1 on the CD pro-
vides more information on system variables. Throughout this book, | occasionally mention sys-
tem variables when using them directly is useful. Some system variables store information about
a drawing or the drawing environment, such as the drawing name and path. These are read-only,
meaning that you cannot change them. They exist to provide information and are often used in
AutoLISP programs. (AutoLISP works in AutoCAD only.)

Information about each system variable, where it is stored, its default, and whether it is read-only
is in the Help system. Choose Help = Help and double-click Command Reference on the Con-
tents tab. Then double-click System Variables. You can type system variables on the command
ling, just like regular commands. The Express Tools (AutoCAD only) contain an editor (choose
Express = Tools => System Variable Editor) that enables you to edit system variable values in a dia-
log box; it also provides helpful supporting information.
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If you know you’ll be using snap, grid, and ortho a lot in certain drawings, and you know the
suitable settings for snap and grid, you can set these and save them in a template because
these settings are saved with the drawing. In other cases, you might want to leave them off
and turn them on only when you need them.

Many settings, such as running object snaps, the type of snap (grid or polar), and the polar
distance when you’re using PolarSnap are saved in the Windows registry, not in your drawing.
As a result, when you open AutoCAD or AutoCAD LT, they’re automatically set to the same
setting you had when you last closed the program, regardless of the setting in the drawing.
Therefore, you cannot save these settings in a template.

In this exercise, you practice specifying the drafting settings and creating a template.

The drawing used in the following Step-by-Step exercise on setting drawing aids and creat-
ing a template, ab05-02.dwg, is in the Results folder on the CD-ROM.

STEP-BY-STEP: Setting Drawing Aids and Creating a Template

1.

10.

11.
12.

If you did the exercise on drawing limits, use that drawing or open ab05-02.dwg from
the Results folder of the CD-ROM.

. Save the drawing as ab05-03.dwg in your AutoCAD Bible folder.
. Choose Tools = Drafting Settings.

. On the Snap and Grid tab, the snap spacing is set to %4". In the Grid section, change the

X spacing to 1". Make sure the Snap Type is set to Grid Snap and Rectangular Snap.
Click OK.

. Click SNAP and GRID on the status bar to turn them on. Make sure OSNAP is turned off.
. Choose Format = Units. Change the Angle Type back to decimal degrees. Click OK.

. Using the coordinate display as your guide, start the LINE command and draw line seg-

ments from 2%, 1% to <270 to 11"<0 to %<90. End the LINE command.

. Start the LINE command again. Again use the coordinate display to draw line segments

from 2,2 to %<270 to 1'0"<0 to %<90. End the LINE command.

. Save your drawing. It should look like Figure 5-4. Notice how the grid and snap settings

facilitate the drawing process.

The architectural units create a different drawing experience than decimal units would.
Setting up a drawing creates a drawing environment suited to your work needs.

Choose File=> Save As. In the Save Drawing As dialog box, click the Files of Type drop-
down list box and choose AutoCAD Drawing Template or AutoCAD LT Drawing
Template (*.dwt). Notice that you're automatically in the \Template folder.

In the File Name text box, change the name to archroof.dwt. Click Save.

In the Template Description dialog box, type Arch units, 16,10 limits, snap & grid and
click OK.
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Figure 5-4: The final architectural drawing.

13. Choose File=> New. Choose the archroof template and click Open. A new drawing
opens, using the template.

14. Move the cursor around and look at the coordinate display to confirm that the grid is
set is set to 1" although the snap is set to }4".

Do not save this new drawing.

The MVSETUP Command

The MVSETUP command is used in two different ways: to set up a drawing and to create view-
ports for paper space layouts. This command does not exist in AutoCAD LT.

 Cross- Paper space layouts are a way of laying out your drawing in preparation for printing or plot-
\ Reference ting. Chapter 17, which covers laying out a drawing as well as plotting, discusses paper space
layouts.
MVSETUP provides a command-line routine to walk you through some of the basic setup func-
tions discussed in this chapter. You can use MVSETUP when you start to customize AutoCAD to
set up a drawing from a script file or AutoLISP program (topics covered in Parts VI and VII of

this book). To use MVSETUP, type mvsetup - on the command line. AutoCAD responds with the
following prompt:

Enable paper space? [No/Yes] <Y>:
Type n . to use MVSETUP without entering paper space.
The next prompt lets you enter the units type:
Enter units type [Scientific/Decimal/Engineering/Architectural/Metric]:

Choose the option you want. Then AutoCAD displays a list of scale factors appropriate to the
units option you chose. At the Enter the scale factor: prompt, type in a numeric scale
factor.
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Finally, AutoCAD prompts you to set the drawing limits with the following two prompts:

Enter the paper width:
Enter the paper height:

After each prompt, enter a number based on the size of the paper you plan to plot on. AutoCAD
draws a rectangle of the size you indicated for the drawing limits.

Using the Setup Wizards

There are two wizards to help you set up a drawing. You need to activate the Startup dialog
box to find them:

1. Choose Tools = Options and click the System tab. In the General Options section, choose
Show Startup Dialog Box from the Startup drop-down list. Click OK.

2. Choose File=> New. You see the Startup dialog box.

3. Click the Use a Wizard button. Choose Quick Setup for fewer options or Advanced
Setup for more options.

4. Click OK and follow the prompts of the wizard.

Summary

This chapter explained setting up a drawing so that it behaves the way you want it to. You
read about:

4+ Setting the unit type

4+ Setting the angle type, measure, and direction

4 Drawing limits

4+ Using scales and calculating a scale factor

4+ Setting drawing aids and creating a template that includes the settings that you want
4+ Using MVSETUP (AutoCAD only) or the setup wizards to set up your drawing

This chapter ends Part I, “AutoCAD Basics.” Now that you know the basics, you can go on to
Part I, “Drawing in Two Dimensions.” The next chapter covers drawing simple lines, polygons,
rectangles, and infinite construction lines.
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Drawing in Two
Dimensions

N ow that you have the basics under your belt, it’s time to draw!
In Part II, you learn the techniques for basic drawing and edit-
ing in AutoCAD and AutoCAD LT. After chapters on drawing simple
lines and curves, I explain how to control the display of your draw-
ings. You can also find chapters on creating text, drawing dimensions,
and creating dimension styles. Separate chapters cover getting infor-
mation from your drawing and drawing complex objects. Part Il winds
down with a chapter on plotting and printing. This part contains all
the basic information you need for two-dimensional drawing and
design.
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Chapter 7
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Drawing
Simple Lines
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In This Chapter

Lines are the most commonly drawn object —you’ll use the LINE Using the LINE
command a lot! Related commands for drawing rectangles, poly-

gons, and construction lines are also important, so you should have
all these commands in your arsenal. This chapter explains how to
draw all these types of objects.

command
Drawing rectangles

Drawing polygons

USing the I.INE command Creating construction

lines
Part I included several exercises in which you drew lines. However,
the LINE command has several options, and you can still learn a few Creating rays
tricks of the trade by focusing on the LINE command itself.
+ + + +

/ To draw a line, choose Line from the Draw toolbar. At the

Specify first point: prompt, specify any point. Continue
to specify points until you're finished. Press Enter to end the com-
mand. You can also right-click and choose Enter from the shortcut
menu. The LINE command assumes you will continue to use it over
and over. For this reason, the command continues to prompt you
until you press Enter.

If you continue to draw line segments, the subsequent prompts are
different. Here’s how to use them:

4 The command displays the Specify next point or [Undol:
prompt for the next two segments. Right-click and choose Undo
(or type u J) to undo only the last line segment you created —
without exiting the LINE command.

4 After creating at least two line segments, the command displays
the Specify next point or [Close/Undo]: prompt. Right-
click and choose Close (or type ¢ J) to automatically draw a
line from the endpoint of the last segment to the original start
point, thereby creating a closed figure. You can continue to use
the Undo option as well.

If you previously drew a line, press Enter at the Specify first
point: prompt to start the line at the endpoint of the last line. If you
most recently drew an arc, press Enter to start the line at the endpoint
of the arc and draw it tangent to the arc.
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STEP-BY-STEP: Using the LINE Command
1. Start a new drawing by using the acad.dwt template.
2. Save the drawing in your AutoCAD Bible folder as ab06-01.dwg.

3. Start the LINE command. At the Specify first point: prompt, choose any point in
the center of your drawing.

. Click ORTHO on the status bar.

. Move the cursor to the right in the 0-degree direction and type .4667 .
. Type @.7341<129 .

. Move the cursor to the right in the 0-degree direction and type .4668 .

. That was a mistake. Type u .

© X NS G

. The Specify next point or [Close/Undo]: prompt reappears. With the cursor still
in the 0-degree direction, type .4667 ..

10. Type ¢ - to close the figure. This ends the LINE command.
11. Start the LINE command again.

12. At the Specify first point: prompt, press Enter. The line starts at the previous
endpoint.

13. Type @.8071<270 4 and press Enter to end the LINE command.
14. Save your drawing. It should look like Figure 6-1.

Figure 6-1: The completed gate valve symbol.

¢ Cross- Other aspects of lines are covered elsewhere in the book. Chapter 11 explains how to draw

\ Reference dashed and dotted lines. Chapter 16 explains how to create polylines, which combine line
segments and curves into one object. Chapter 16 also covers multilines — sets of parallel lines
that you draw all at once.

Drawing Rectangles

The RECTANG command draws rectangles. Rectangles are used in all disciplines. The RECTANG
command has a number of options that specify how the rectangle appears.

e | Use the RECTANG command to create a rectangle by specifying the two diagonal corners.
Choose Rectangle from the Draw toolbar.
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The RECTANG command prompts you for the two corner points. Specify these two points to
create the rectangle. You can use any method of specifying coordinates. For example, if you
know the rectangle should be 6 inches wide and 3 inches high, you can specify the second
point as @6,3.

After you specify the first corner, you can specify the length and the width of the rectangle
instead of the second corner. Here are the prompts for specifying the length and width of a
rectangle:

Specify other corner point or [Dimensions]: Choose the Dimensions
option.

Specify length for rectangles <0.0000>: Type the length and press
Enter.

Specify width for rectangles <0.0000>: Type the width and press Enter.
Specify other corner point or [Dimensions]:Pick a point to specify
where you want the rectangle.

As soon as you specify the length and width, four possible rectangles are possible, as shown
in Figure 6-2. As you move your mouse cursor around the first corner you specified, AutoCAD
or AutoCAD LT displays these rectangles. Click when you see the one that you want.

First corner point

Figure 6-2: After you specify the first
corner, a length, and a width, choose
which of four possible rectangles you
want.

'Note After you set the dimensions, they remain as defaults for future rectangles that you draw. As
~  aresult, you can use the Dimensions option to quickly draw a number of identical rectangles.

« Cross- You can chamfer and fillet the corners as you create the rectangle. Chapter 10 covers cham-
\ Reference fering and filleting. You can specify a width for the rectangle’s line (see Chapter 16). You can
also create a 3D box by using the elevation and thickness options (see Chapter 21). The

RECTANG command creates a polyline, meaning that all four sides of the rectangle are one
object, instead of four separate line objects. Chapter 16 covers polylines.
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Drawing Polygons

G The POLYGON command enables you to draw multisided closed figures with equal side
lengths. You can draw polygons that have from 3 to 1,024 sides. To draw a polygon,
choose Polygon from the Draw toolbar.

First specify the number of sides. Then choose one of three methods of defining the polygon,

as described in Table 6-1.

Table 6-1: POLYGON Command Options

Option

Description

Edge

Inscribed in circle

Circumscribed about circle

Right-click and choose the Edge option. Specify the two endpoints of any
edge of the polygon to complete the polygon.

After specifying the center, right-click and choose Inscribed in Circle. Then
specify the radius from the center to a vertex (point). This defines the
polygon with reference to an imaginary circle whose circumference
touches all the vertices of the polygon.

After specifying the center, right-click and choose Circumscribed about
Circle. Then specify the radius from the center to the midpoint of a side.
This defines the polygon with reference to an imaginary circle whose
circumference touches all the midpoints of the polygon's sides.

If you type a number for the radius, the bottom edge of the polygon is horizontal. However, if
you pick a point for the radius with your mouse, you can specify the orientation of the poly-
gon. Rotate the mouse cursor around the center, and you see the polygon rotate. Pick when

you like what you see.

« Cross- When you type a number for the radius, the bottom edge actually aligns with the snap rota-
\ Reference tion angle, which is usually 0. Chapter 8 explains how to change this angle.

The POLYGON command creates a polyline, meaning that the entire polygon is one object,
rather than a series of line segments.

In the exercise that follows, I indicate inches with a double-prime (") and feet with a prime ().
You may find this notation clearer when a measurement has both feet and inches, but you do
not actually need to type the double-prime for inches. When you have a measurement that is
only in inches, it saves time to leave out the double-prime.

On the""'\ The drawing used in this Step-by-Step exercise on drawing rectangles and polygons, ab06-a.

CD dwg, is in the Drawings folder on the CD-ROM.

STEP-BY-STEP: Drawing Rectangles and Polygons
1. Open ab06-a.dwg from the CD-ROM.



10.

11.

12.
13.

14.

15.

16.

17.
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. Save the drawing in your AutoCAD Bible folder as ab06-02.dwg. Verify that snap and

grid are on, set at 1". OSNAP should be off.

1 Choose Rectangle from the Draw toolbar.

. At the Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/

Width]: prompt, move the cursor to 0-1",0-1" and click. At the Specify other corner
point or [Dimensions]: prompt, type @2'1",1'9" 1.

. Start the RECTANG command again. At the Specify first corner point or

[Chamfer/ Elevation/Fillet/Thickness/Width]: prompt, Shift+right-click and
choose the From object snap. Shift+right-click again and choose the Endpoint object
snap. Pick the bottom-left corner of the rectangle. At the <Offset>: prompt, type
@2,2 1 to start the second rectangle 2 inches up and 2 inches to the right of the first
rectangle.

. At the Specify other corner point or [Dimensions]: prompt, type @1'9",1'3" ..
. Right-click and choose Repeat Rectangle to start the RECTANG command again. At the

prompt, find 0'8",1'7" (on a snap point) and click. At the Specify other corner point
or [Dimensions]: prompt, type @11,2 . (You don’t need to type the double-prime
for inches.)

. Again, start the RECTANG command. At the prompt, find 1'1",1'8" and click. At the

Specify other corner point or [Dimensions]: prompt, type @1,-5 .

. C}' Start the POLYGON command. At the Enter number of sides <4>: prompt,

type 5 4. At the Specify center of polygon or [Edge]: prompt, type 10,1'8
to indicate the center.

At the Enter an option [Inscribed in circle/Circumscribed about circlel]
<I>: prompt, press Enter to accept the default. This means you indicate the radius
from the center to the vertices. (If your prompt shows <C> as the default, type i .)

At the Specify radius of circle: prompt, type .5 d. AutoCAD or AutoCAD LT
draws the pentagon.

Repeat Steps 9 through 11 using a center of 1'5,1'8.

Start the POLYGON command again. At the Enter number of sides <5>: prompt,
type 3 .

At the Specify center of polygon or [Edge]: prompt, right-click and choose the
Edge option.

At the Specify first endpoint of edge: prompt, choose the top-left corner of the
faucet rectangle (1'1",1'8"), which is on a snap point.

At the Specify second endpoint of edge: prompt, choose the top-right corner of
the faucet rectangle to complete the triangle.

Turn off the grid to get a better look at the drawing. You have completed the sink,
which should look like Figure 6-3. Save your drawing.

101
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Figure 6-3: The completed sink, drawn
with rectangles and polygons.

Thanks to Bill Wynn of New Windsor, Maryland,
for this drawing, which he created in his AutoCAD
class as part of a plan drawing of an entire house.

Creating Construction Lines

Sometimes you want to create a line that is used solely for the purpose of reference. For
example, you might want to do the following:

4+ Draw two lines from the midpoints of two perpendicular lines so that you can use their
intersection as the center for a circle.

4+ Draw a line from one object to another to visually indicate the relationship between the
two objects.

4+ Show the relationship between equivalent parts of a model shown in front and right-side
views.

4+ Draw a line through the center of an object shown in cross-section so that you can
show dimensions from the centerline to the edge of an object.

You could use regular lines for these purposes. However, construction lines (also known as
xlines) are unique in that they extend infinitely in both directions. This makes them especially
useful for seeing the relationships among various objects in your drawing.

Of course, construction lines are not actually infinite. However, they extend to the edge of the
drawing area on your screen, and if you zoom out to see more of your drawing, they expand
so that they always extend to the edge of the screen. The object snap tracking feature some-
times eliminates the need for construction lines; nevertheless, sometimes you can work more
easily having a line visible for several commands and then erasing it.

If you zoom to show the extents of your drawing, AutoCAD or AutoCAD LT ignores the xlines
and shows you just the extents of the regular objects in your drawing. Chapter 8 covers the
ZOOM command.
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Construction lines are also helpful when working in 3D. See Part IV of this book.

The XLINE command offers several ways to create construction lines. Start the com-
mand by choosing Construction Line from the Draw toolbar. You see the following

prompt:

Specify a point or [Hor/Ver/Ang/Bisect/Offset]:

Table 6-2 lists the possible options. AutoCAD or AutoCAD LT continues to prompt you for
more points so that you can continue to draw construction lines —much like the LINE com-
mand. Press Enter to end the command.

Table 6-2: XLINE Command Options

Option

Description

Specify a point

Hor

Ver

Ang

Bisect

Offset

This option enables you to define the construction line with two points. At the first
prompt, specify a point. At the Specify through point: prompt, specify another
point. The first point becomes the base point for subsequent construction lines that
you can draw by specifying other through points.

To draw a construction line parallel to the X axis, type h . to specify the Horizontal
option. The command responds with the Specify through point: prompt.
Specify one point. Useful for drawing a series of horizontal construction lines.

To draw a construction line parallel to the Y axis, type v . to specify the Vertical option.
The command responds with the Specify through point: prompt. Specify one
point.

Type a . (for Angle). The command responds with the Enter angle of xline
(0) or [Referencel]: prompt. If you enter an angle, the command asks for a

through point. Or you can type r . and select a line as a reference, then provide an
angle and a through point. AutoCAD or AutoCAD LT then calculates the angle of the
construction line from the angle of the reference line. Useful for drawing a series of
construction lines at a specified angle.

To draw a construction line that bisects an angle (divides the angle in half), type b ..
The command responds with the Specify angle vertex point: prompt.
Choose any point that you want the construction line to pass through. Then, at the
Specify angle start point: prompt, choose a point that defines the base of
the angle. At the Specify angle end point: prompt, choose a point that
defines the end of the angle.

To draw a construction line parallel to a line, type o ... You can specify the offset
distance by typing in the number or using the Through option to pick a point through
which the construction line should pass. Either way, the next step is to select a line. If
you specified an offset distance, the command displays the Specify side to
offset: prompt. Respond by picking a point on the side of the selected line on
which you want the construction line to appear.
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Creating Rays

Tip

On the
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Rays are similar to construction lines, except that they start at a specific point and extend to
infinity in one direction only. If you need a line to extend only in one direction, using a ray
may be less confusing.

You can use most object snaps with construction lines and rays. (You can’t use endpoint for
), construction lines or midpoint for rays.) Construction lines and rays can be edited like any

<’} other object.

To draw a ray, choose Draw > Ray. At the Specify start point: prompt, specify the start
point for the ray. At the Specify through point: prompt, specify another point. AutoCAD
or AutoCAD LT continues to ask for through points. Press Enter to end the command.

\ The drawing used in this Step-by-Step exercise on drawing construction lines and rays,
ab06-b.dwg, isin the Drawings folder on the CD-ROM.

STEP-BY-STEP: Drawing Construction Lines and Rays
1. Open ab06-b.dwg from the CD-ROM.

2. Save the drawing as ab06-03.dwg in your AutoCAD Bible folder.

3. /.)' Choose Construction Line from the Draw toolbar.

4. At the Specify a point or [Hor/Ver/Ang/Bisect/Offset]: prompt, choose
point @), shown in Figure 6-4.

5. At the Specify through point: prompt, choose point @, shown in Figure 6-4.

Figure 6-4: A pipe with cross-section.

6. Press Enter to end the command. Notice that the drawing has been set up so that the
construction line is drawn in green and with a noncontinuous linetype. This is to distin-
guish it from the main drawing. (See Chapter 11 for details on how to set up a drawing
in this way.)
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7. Choose Draw => Ray.
8. At the Specify start point: prompt, choose point €, shown in Figure 6-4.

9. At the Specify through point: prompt, choose point @), shown in Figure 6-4. Press
Enter to end the command.

10. Save your drawing.

Summary

This chapter covered the ins and outs of lines. You read about:
4 Using the LINE command
4+ Drawing rectangles
4+ Drawing polygons

4+ Creating construction lines, including xlines that extend infinitely in both directions
and rays that extend infinitely in one direction

The next chapter explains how to draw curves and point objects. Curves include circles, arcs,
ellipses, and donuts.

+ o+ 0+
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In This Chapter

AutoCAD and AutoCAD LT offer a number of ways to create Drawing circles

curved objects. You can draw circles, arcs, ellipses, and

donuts (also called doughnuts). In this chapter, I also cover point Drawing arcs

objects that are neither curves nor lines but don’t deserve their

own chapter. Creating ellipses
r Cross- ‘\ Several complex objects —such as polylines, splines, regions, and Drawing donuts
\ Reference \  boundaries —involve curves. These are covered in Chapter 16.
e Creating points

Drawing Circles et

Circles are common objects in drawings. In mechanical drawings,
they often represent holes or wheels. In architectural drawings, they
may be used for doorknobs, trash baskets, or trees. In electrical and
piping schematics, they are used for various kinds of symbols.

Understanding the circle options

The CIRCLE command provides five ways to draw a circle. To

draw a circle, choose Circle from the Draw toolbar. The com-
mand responds with the Specify center point for circle or
[3P/2P/Ttr (tan tan radius)]: prompt. Table 7-1 describes how
to use these options.

Table 7-1: Five Ways to Draw a Circle

Option Description

Center Radius This option is the default. Specify the center and then
the radius. You can type the radius as a distance or pick
a point on the circumference.

Center Diameter  Specify the center. Type d J and type the length of the
diameter or pick a point to specify the diameter.

Continued
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Table 7-1 (continued)

Option Description

2P 2P stands for 2 point. Type 2p .J. Specify one point on the circumference,
and then an opposite point on the circumference. These two points define
the diameter of the circle.

3P 3P stands for 3 point. Type 3p ... Specify three points on the circumference.

Tangent, Tangent, Radius  Type t or ttr .i. The CIRCLE command prompts Specify point on
object for first tangent of circle: and provides an aperture
to let you pick a point. Then the command prompts Specify point on
object for second tangent of circle: and you pick a second
point. These points can be any points on the object(s) to which you want
your circle to be tangent. Finally, type a radius.

Tip You can also create a circle tangent to other objects by using the 2-point (2P) or 3-point (3P)
, method and picking those points with the Tangent object snap. Also, when you choose Draw =
/4 Circle (from the menu), AutoCAD and AutoCAD LT include a tan tan tan option, enabling you

to specify a circle tangent to three objects.

Drawing circles

Drawing circles is fairly straightforward. Often, you can use object snaps to define part of
the circle. In the following exercise, you practice using the most common methods of creating
a circle.

On theq'"\ The drawing used in the following Step-by-Step exercise on creating a circle, ab07-a . dwg, is
\ inthe Drawings folder on the CD-ROM.
% _
.4/‘.

o,
&
STEP-BY-STEP: Creating a Circle
1. Open ab07-a.dwg from the CD-ROM.

2. Save the file as ab07-01.dwg in your AutoCAD Bible folder. This is a drawing of an air
compressor from which all the circles have been removed. Make sure that OSNAP is on.
Set a running object snap for endpoints only.

3. Choose Circle from the Draw toolbar. Right-click and choose 2P from the shortcut
@ menu. At the Specify first end point of circle's diameter: prompt, pick
the endpoint at @ in Figure 7-1. At the Specify second end point of circle's
diameter: prompt, pick the endpoint at €.

4. Repeat the CIRCLE command by right-clicking and choosing Repeat Circle. Right-
click and choose 2P from the shortcut menu. Pick the endpoints at @ and @ in
Figure 7-1.
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Figure 7-1: The air compressor without its circles.

. Repeat the CIRCLE command by pressing Enter. At the Specify center point for

circle or [3P/2P/Ttr (tan tan radius)]: prompt, pick the endpoint at @. At
the Specify radius of circle or [Diameter]: prompt, pick the endpoint at @.

. Repeat the CIRCLE command. At the Specify center point for circle or

[3P/2P/Ttr (tan tan radius)]: prompt, pick the endpoint at @. At the Specify
radius of circle or [Diameter]: prompt, right-click and choose Diameter; then
type .25 .

. Repeat the CIRCLE command by right-clicking and choosing Repeat Circle. At the

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: prompt,
right-click and choose 3P. At the Specify first point on circle: prompt, pick the
endpoint at @ in Figure 7-1. At the Specify second point on circle: prompt, pick
the endpoint at @. At the Specify third point on circle: prompt, choose a mid-
point object snap and pick the midpoint at @).

. For the last circle on the right, choose any method you want to draw a circle. The circle

should be the same size and placement as the second circle from the left.

. Repeat the CIRCLE command. At the Specify center point for circle or [3P/

2P/Ttr (tan tan radius)]: prompt, choose the Center object snap . and pick @.
At the Specify radius of circle or [Diameter]: prompt, type .05 .

Repeat Step 9 to create a circle inside the circle whose center is at ) and whose radius
is 0.05.

Repeat the CIRCLE command. At the Specify center point for circle or
[3P/2P/Ttr (tan tan radius)]: prompt, pick the endpoint at ). At the Specify
radius of circle or [Diameter]: prompt, pick the endpoint at @.

Repeat Step 11, choosing the endpoint at @) for the center of the circle and the endpoint
at @ for its radius, as shown in Figure 7-1.
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13. Save your drawing. It should look like Figure 7-2.
%@ @)
mil

AR CUOMPRESSOR
Figure 7-2: The completed air compressor.

Thanks to the U.S. Army Corps of Engineers at Vicksburg,
Mississippi, for this drawing. They maintain a Web site of

drawings at http://cadlib.wes.army.mil.

- Cross-

Gr It may have occurred to you that this task would have been easier if you could simply have
eference

copied one circle to another location instead of creating each circle from scratch. I cover copy-
ing in Chapter 9.

Drawing Arcs

An arc is a portion of a circle. Therefore, to define an arc, you have to define not only a
circle— for example, by specifying a center and a radius — but also the start and endpoints
of the arc. You can do this in many ways. The ARC command offers several methods of
defining an arc. The method you pick depends on the information you have about the arc
you want to draw.

Understanding arc options

Arcs have many options. Making sense of them may seem overwhelming, but after you under-
stand the parts of an arc, you can choose the options that suit your needs. Figure 7-3 shows the
parts of an arc that you can use to draw an arc. Refer to this figure as you read through the arc
options.

Figure 7-4 shows the flow of the arc options. When you start the ARC command, you have
two options, Start Point and Center. Depending on which you choose, more options become
available.

You can also press Enter at the first arc prompt to draw a second arc starting from the end-
point of a previous arc, line, polyline, and so on. The new arc continues in the same direction
as the end of the first arc. The only other prompt is the endpoint.


http://cadlib.wes.army.mil
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Figure 7-3: The parts of an arc.
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Figure 7-4: The ARC command options.

Drawing arcs

"ﬁ To draw an arc, choose Arc from the Draw toolbar and follow the prompts. As with
circles, object snaps are often helpful when drawing arcs.

When drawing an arc by using the Start, End, and Radius options, the three specifications
actually define two possible arcs, one minor and one major. The ARC command draws the
minor arc by default, in the counterclockwise direction. (A minor arc is less than half a circle.)
If you enter a negative number for the radius, the command draws the major arc (which is more
than half a circle). The options requiring an angle also define two possible arcs, one drawn
counterclockwise and one drawn clockwise. AutoCAD and AutoCAD LT draw the counterclock-
wise arc by default. If you type a negative number for the angle, the arc is drawn clockwise.
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On thew"\ The drawing used in the following Step-by-Step exercise on drawing arcs, ab07-b.dwg, is in
‘ \  the Drawings folder on the CD-ROM.
\

CD-

A
STEP-BY-STEP: Drawing Arcs
1. Open ab07-b.dwg from the CD-ROM.

2. Save the file as ab07-02.dwg in your AutoCAD Bib1le folder. ORTHO is on and units are
set to Fractional. Choose Tools => Drafting Settings (clicking the Object Snap tab, if nec-
essary) and set running object snaps for intersection, center, and endpoint. Make sure
OSNAP is on. In this exercise, you draw part of the sealing plate shown in Figure 7-5.

3. For a change of pace, start the LINE command by choosing Line from the Command
Tools tab of the tool palette. (Press Ctrl+3 to open the tool palette.) Start at 2,3 and
use Direct Distance Entry to create a 7-unit horizontal line to the right. End the LINE
command.

 Cross- See Chapter 4 for a full explanation of how to use Direct Distance Entry.
\ Reference
4. Draw another line starting at 5-1/2,1-5/8 and draw it 2-3/4 units long in the 90-degree
direction. These two lines are center lines and would ordinarily appear in a different
color and linetype than the object you're drawing.

« Cross- You can read about colors and linetypes in Chapter 11.
\ Reference
5. Draw a circle with its center at the intersection of the two lines (use the Intersection

object snap) and a radius of /.

s 37/8 -
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Figure 7-5: The dimensioned sealing plate for a valve.
Thanks to Jerry Bottenfield of Clow Valve Company in Oskaloosa, lowa, for this drawing.
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Use the Center object snap to draw another circle with the same center as the first
circle and a radius of 1.

Draw a third circle, using the From object snap (Shift+right-click to open the object
snap menu, and then choose From). For the base point, use the Center object snap
and pick either of the first two circles you drew. The offset is @-1-15/16,0 (this means
1-15/16 units to the left of the center of the first two circles). Its radius is %.

Draw a fourth circle. Use the From object snap again. For the base point, use the Center
object snap and pick either of the first two circles. The offset is @1-15/16,0. The radius
is %.

",. Choose Arc from the Draw toolbar. Follow the prompts:

Specify start point of arc or [Center]: Choose the From object snap.
Base point: Use the Center object snap to pick the center of the
leftmost circle.

<Offset>: @-5/8,0 J

Specify second point of arc or [Center/End]: Right-click and choose
Center. Use the Center object snap to pick the center of the Teftmost
circle.

Specify end point of arc or [Angle/chord Lengthl: Right-click and
choose Angle.

Specify included angle: 67.23 d

Start the LINE command. At the Specify first point: prompt, press Enter to con-
tinue the line in the same direction as the end of the arc. At the Length of Tine:
prompt, type 1-13/16 . End the LINE command.

Choose Arc from the Draw toolbar. Follow the prompts:

Specify start point of arc or [Center]: Use the Endpoint object snap
to pick the end of the line you just drew.

Specify second point of arc or [Center/End]: Right-click and choose
Center. Use the Center object snap and pick any point on one of the
large central circles.

Specify end point of arc or [Angle/chord Lengthl: Use Endpoint object
snap to pick the lower end of the vertical construction line.

Repeat the ARC command. Follow the prompts:

Specify start point of arc or [Center]: Right-click and choose
Center. Use the Center object snap and pick any point on one of the
large central circles.

Specify start point of arc: Use the Endpoint object snap to pick the
endpoint of the arc you just completed.

Specify end point of arc or [Angle/chord Lengthl]: Right-click and
choose Angle.

Specify included angle: 22.77 4

Start the LINE command. At the Specify first point: prompt, press Enter to con-
tinue the line in the same direction as the end of the arc. At the Length of Tine:
prompt, type 1-13/16 . End the LINE command.
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14. Start the ARC command. Follow the prompts:

Specify start point of arc or [Center]: Use the Endpoint object snap
to pick the endpoint of the Tine you just drew.

Specify second point of arc or [Center/End]: Right-click and choose
End.

Specify end point of arc: Choose the From object snap.

_from Base point: Use the Center object snap to pick the center of
the rightmost circle.

<0ffset>: @5/8,0

Specify center point of arc or [Angle/Direction/Radius]: r dJ
Specify radius of arc: 5/8 d

15. Save your drawing. Your drawing should look like Figure 7-6. You can complete this
drawing in Chapter 10 by creating a mirror image.

[
\/

S\ o
JU

Figure 7-6: The partially completed sealing plate,
created by using lines, circles, and arcs.

b

Creating Ellipses and Elliptical Arcs

You can create ellipses (ovals), and you can also create elliptical arcs, which are partial
ellipses. Like a circle, an ellipse has a center. The difference, of course, is that an ellipse
has a longer radius along its major axis and a shorter radius along its minor axis, as shown

in Figure 7-7.
Center
>§Major axis

Minor axis

Figure 7-7: The parts of an ellipse.

Understanding ellipse options

You can draw ellipses by defining a center first. Another option is to define the axis endpoints
first. If you want to draw an elliptical arc, you must specify the start and end angle.
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Ellipses

The default option is to specify endpoints 1 and 2 of the first axis. Then you specify the sec-
ond axis distance, which is the distance from the first axis line to the circumference along
the second axis. Instead of specifying a second axis distance, you can choose the Rotation
option.

The Rotation option defines the minor axis by defining an angle from 0 degrees to 90 degrees,
which is the ratio of the major axis to the minor axis. (Actually, the command only accepts up
to 89.4 degrees.) When the angle is 0, you get a circle. As the angle increases, the ellipse gets
flatter and flatter until you reach 89.4 degrees. A 45-degree angle results in a minor axis whose
length is the square root of the major-axis length.

Instead of specifying endpoints, you can type c to specify the center of the ellipse. Then specify
the endpoint of the first axis, which can be either the major or the minor axis. Finally, specify
the other axis distance, which is the radius from the center to the circumference along the
second axis. Again, instead of specifying the second axis distance, you can define the ellipse
by using the Rotation option.

Elliptical arcs

To draw an elliptical arc, use the Arc option of the ELLIPSE command. In AutoCAD only, there
is an Ellipse Arc button on the Draw toolbar. (This button is equivalent to choosing the Arc
option of the ELLIPSE command and offers no additional functionality.) The first prompts

are the same as for an ellipse because you must first define the ellipse. Then the command
continues with the Specify start angle or [Parameter]: prompt, offering the following
options:

4+ Start angle: This option is the default. Specify the start angle, which the command
redefines to start along the major axis. The command responds with the Specify
end angle or [Parameter/Included angle]: prompt.

4+ End angle: Specify the end angle to complete the ellipse arc.

4+ Included angle: After specifying the start angle, you can complete the arc by specifying
the included angle from the start point to the endpoint, going counterclockwise.

4+ Parameter: Choose this option to define the arc portion by the ellipse’s area rather
than its included angle (which defines the arc portion by its circumference). The
command responds with the Specify start parameter or [Angle]: and Specify
end parameter or [Angle/Included angle]: prompts. By typing in angles, you
define the percent of the full ellipse’s area that you want to include. (For example,
starting at 15 degrees and ending at 105 degrees includes 90 degrees and therefore
draws one-quarter of an ellipse.) The options in brackets let you return to regular
angle specification.

Drawing ellipses

To draw an ellipse, choose Ellipse from the Draw toolbar. In addition to the information
o the command explicitly requests in the prompts, you need to know the angle of the first
axis that you define. Not all ellipses are horizontal or vertical. You control this when you stip-
ulate the second point of the first axis. The second axis is automatically perpendicular to the
first axis.
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To draw an elliptical arc, choose Ellipse Arc from the Draw toolbar (in AutoCAD) or use
> the Arc option of the ELLIPSE command. When you draw an elliptical arc, the command
introduces a helpful but sometimes confusing feature: While you’re defining the arc angles,
the command redefines 0 degrees along the major axis. This helps you define the included
angle in an orientation that relates to the ellipse, rather than the usual orientation where 0
degrees is to the right.

In this exercise, you practice drawing ellipses and elliptical arcs.

On thew'\ The drawing used in the following Step-by-Step exercise on drawing ellipses and elliptical
CD \ arcs, ab07-c.dwg, is in the Drawings folder on the CD-ROM.
L

N
STEP-BY-STEP: Drawing Ellipses and Elliptical Arcs
1. Open ab07-c.dwg from the CD-ROM.

2. Save the file as ab07-03.dwg in your AutoCAD Bible folder. The drawing shows an
empty conference room. Snap is on, set to 6". Check that OSNAP is on with a running
object snap set for endpoint only.

3. Choose Ellipse from the Draw toolbar. At the Specify axis endpoint of
o ellipse or [Arc/Center]: prompt, right-click and choose Center. At the
Specify center of ellipse: prompt, choose 8',10', which is a snap point. At the
Specify endpoint of axis: prompt, move the cursor to the right until the coordi-
nates read 3'<0 and click. (If necessary, press F6 until you see polar coordinates.) At the
Specify distance to other axis or [Rotation]: prompt, move the cursor up
until the coordinates read 6'6"<90 and click. This completes the conference table.

4. Choose Ellipse from the Draw toolbar. Follow the prompts:

Specify axis endpoint of ellipse or [Arc/Centerl: Right-click and
choose Arc.

Specify axis endpoint of elliptical arc or [Center]: Right-click and
choose Center.

Specify center of elliptical arc: Pick 8',3', a snap point.
Specify endpoint of axis: Move the cursor to the right until the
coordinates read 1'<0 and pick.

Specify distance to other axis or [Rotation]: Move the cursor up
until the coordinates read 6"<90 and pick.

Specify start angle or [Parameter]: 162 dJ

Specify end angle or [Parameter/Included angle]l: 18 .

5. Turn off ORTHO. Start the LINE command. At the Specify first point: prompt, use
the Endpoint running object snap and pick the right side of the elliptical arc. At the
Specify next point or [Undo]: prompt, press F6 to change to dynamic absolute
coordinates (if necessary) and pick the snap point 8'6",3". (You may have to turn off
OSNAP in the middle of the command to pick this point and avoid getting an endpoint.)
End the LINE command.

6. Start the LINE command. At the Specify first point: prompt, choose the Endpoint
object snap and pick the left side of the ellipse arc. At the Specify next point or
[Undo]: prompt, pick the snap point 7'6",3". End the LINE command.

7. Choose Ellipse again. Follow the prompts:
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Specify axis endpoint of ellipse or [Arc/Centerl: Right-click and
choose Arc.

Specify axis endpoint of elliptical arc or [Center]: Use the Endpoint
object snap to pick the free endpoint of the line on the right.
Specify other endpoint of axis: Use the Endpoint object snap to pick
the free endpoint of the line on the Teft.

Specify distance to other axis or [Rotation]: @3<90 .

Specify start angle or [Parameter]: Use the Endpoint object snap to
pick the free endpoint of the line on the right.

Specify end angle or [Parameter/Included anglel]: Use Endpoint object
snap to pick the free endpoint of the line on the left.

8. Choose Ellipse from the Draw toolbar. At the Specify axis endpoint of ellipse
or [Arc/Center]: prompt, pick point 2',18', a snap point. At the Specify other
endpoint of axis: prompt, pick point 2',16', also a snap point. At the Specify
distance to other axis or [Rotationl]: prompt, move the cursor to the right
until the coordinates read 6"<0. (Press F6 twice if necessary.) This is also a snap
point. Click the mouse button to complete the small side table.

9. Save your drawing. It should look like Figure 7-8.

0

N

\

{

Figure 7-8: The conference room with a
conference table, a chair, and a side table.

Making Donuts

A donut is a wide polyline that looks like two concentric circles. You define a diameter for the
inner and outer circles. AutoCAD and AutoCAD LT accept both DONUT and DOUGHNUT if you
type in the command. Donuts are often used in electrical drawings to create symbols. If the
inner circle’s radius is zero, you create a filled-in circle.
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Tip

Note

The setting of the FILL command determines whether the donut is filled. Type fill J and type

on .l or off . FILL is on by default. Turning FILL off displays a radial pattern of lines, as shown
in Figure 7-9. Type regen .J or choose View => Regen to update existing donuts to the new FILL
setting.

—Outside diameter

Inside diameter —Center

Figure 7-9: The parts of a donut, shown with FILL off.

If you have many filled objects in your drawing, your drawing may take some time to display.
., You can save time by turning FILL off while you draw. Then turn FILL on just before you need
“7# to print or plot the drawing.

Understanding DONUT options

The DONUT command has the following prompts:

4 Specify inside diameter of donut <0.5000>: Type the diameter of the inside
circle or pick two points to specify the inside diameter. The number in brackets is the
last inside diameter that you defined or 0.5 if you haven’t previously used the DONUT
command in this drawing session.

4 Specify outside diameter of donut <1.0000>: Type the diameter of the outside
circle or pick two points to specify the outside diameter. The outside diameter must be
larger than the inside diameter. The number in brackets is the last outside diameter
that you defined or 1.0 if you haven’t previously used the DONUT command in this
drawing session.

4+ Specify second point: If you define the inside or outside diameter by picking a
point, the command asks for a second point. Use this technique if you’re using object
snaps to define the diameters.

4+ Specify center of donut or <exitd>: Specify the center of the donut. Pressing
Enter ends the command.

Drawing donuts

Drawing donuts is relatively easy. Choose Draw &> Donut. Then specify the inner and outer
diameters and the center. The DONUT command continues to prompt for centers so you can
place additional donuts. Press Enter to end the command.

You can use the hatch feature to fill in any object with a solid fill, with a great deal more flex-
- ibility in the shape of your objects. (Chapter 16 discusses hatching.) As a result, the DONUT
command is not as essential as it once was.
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You draw some donuts in the next exercise.

Placing Points

Points are generally used for reference. It is sometimes helpful to mark a point that you use
later as a guide to place an object or to help you return an object to its original position.

When it’s no longer needed, you may erase the point. This is a typical construction method.
In some cases, the From object snap or object snap tracking can be used instead of a point.

- Cross-

g The DIVIDE and MEASURE commands place point objects along an object. Chapter 12 covers
eierence

these commands.

Changing the point style

Different disciplines have different conventions for drawing point objects. As a result, AutoCAD
and AutoCAD LT provide 20 types of point styles that you can use in your drawing. Before you
draw a point, you should set the point style. You can save this setting in your template.

Choose Format => Point Style to open the Point Style dialog box, shown in Figure 7-10.

i Point Style Figure 7-10: Choosing a point style.
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Point Size:  5.0000 %
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) Set Size in Sbsolute Units

l aK I[ Cancel ][ Help

To set the point style, click the box showing the style that you want. Then set the point size,
which has the following options:

4+ Set Size Relative to Screen: Use this option if you want the point to always appear the
same size, no matter how much you zoom in and out — for example, when you'’re using
the point as a reference. The size is set as a percentage of the screen. This option is the
default, with the size set to 5 percent of the screen.

4+ Set Size in Absolute Units: Use this option if you want the point to have a real size, just
like any other object. The size is set in units. Use this option when you want the point
to stay the same size relative to other objects in your drawing.

Click OK to close the dialog box.

Note

When you change the point style, previously drawn points automatically and immediately
~—  change to the new style.
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Creating points

After you determine the point style, you're ready to create points. Choose Point from
the Draw toolbar.

You see the following on the command line:

Current point modes: PDMODE=0 PDSIZE=0.0000
Specify a point:

Specify the point you want, either by picking a point on the screen or by typing coordinates.
(You can specify a Z coordinate to create a point in 3D space.) You can use object snaps to
specify the point. (PDMODE and PDSIZE are system variables for the point style and size,
respectively.)

When you choose the POINT command from the Draw toolbar, the command automatically

repeats the prompt so that you can continue to specify points. To end the command, press

Esc. When you choose Draw = Point, you can choose Single Point or Multiple Point from the
submenu. The command line version draws single points.

If BLIPMODE is on and you're using the first point style—a small dot—you cannot see the
point until you use the REDRAW command to remove the blips.

Tip If you're using the points for temporary reference, instead of erasing them, you can set the
., point style to the second style in the Point Style dialog box (no dot) before plotting. Then
/ the points do not appear on your plot.

After you create a point, use the Node object snap to snap to the point.

On the""'\ The drawing used in the following Step-by-Step exercise on drawing donuts and points,
\  ab07-d.dwg, is in the Drawings folder on the CD-ROM.
5

CD-

&
STEP-BY-STEP: Drawing Donuts and Points
1. Open ab07-d.dwg from the CD-ROM.

2. Save the file as ab07-04.dwg in your AutoCAD Bib1le folder. The drawing contains a
rectangle and connecting wires for an electrical switch. Make sure that OSNAP is on.
Set running object snaps for endpoint, quadrant, center, and node.

3. Choose Format => Point Style. The Point Style dialog box opens. Choose the third point
type, the plus sign. The radio button Set Size Relative to Screen should be marked. The
Point Size should be 5.0000%. Choose OK.

4. Choose Point from the Draw toolbar. Follow the prompts:

Specify a point: Use From object snap. (Shift+right-click to open the
Object Snap shortcut menu.)

Base point: Use the Endpoint object snap to pick the top-left corner
of the rectangle.

<Offset>: @.08,-.09 4

Specify a point: Press Esc to complete the command.



Chapter 7 + Drawing Curves and Points

5. Choose Draw = Donut. Follow these prompts:

Specify inside diameter of donut <0.5000>: .04 4

Specify outside diameter of donut <1.0000>: .06

Specify center of donut or <exit>: Use the Node object snap to pick
the point you drew.

Specify center of donut or <exit>: @.19,0 4

Specify center of donut or <exit>: 4

6. Start the POINT command again. Follow the prompts:

Specify a point: Right-click and choose the Mid between 2 points
option from the shortcut menu.

First point of mid: _ Use the Center object snap to pick the center
of the right-hand donut.(You may have to press Tab until you get the
center object snap, and not a quadrant object snap.)

Second point of mid: _Use the Perpendicular object snap and pick the
lower horizontal Tine of the rectangle.

Specify a point: Press Esc.

7. Start the LINE command. Follow the prompts:

Specify first point: Use the Quadrant object snap to pick the right
(0 degrees) quadrant of the left donut. If you don't see the Quadrant
SnapTip, press Tab until it appears.

Specify next point or [Undo]l: Use the Node object snap to pick the
point you just drew. End the LINE command.

8. Save your drawing. It should look like Figure 7-11.

Figure 7-11: The completed electrical switch. The points

_ @ E | show as plus signs.

Summary

In this chapter, you learned how to draw curved objects and points in AutoCAD and AutoCAD
LT. You discovered:

4+ All the ways to draw circles
4+ How to define and draw an arc
4+ How to define an ellipse and an elliptical arc
4+ How to draw a donut
4+ How to set the point style and draw points
In the next chapter, you read how to display your drawing for the greatest ease and comfort.

+ 0+ 0+
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Viewing Your
Drawing

Often you may wish you could zoom in to see a particular part of
a drawing more closely or move the display in a certain direc-
tion to reveal an area that was hidden. You may also want to save a
view so that you can return to it some other time. In this chapter, you
read about controlling the display of your drawing to meet all your
drawing needs and increase productivity.

Regenerating and Redrawing
the Display

AutoCAD and AutoCAD LT are vector programs, which means that
they store information about objects in your drawing in terms of
coordinates and equations. To display your drawing on your com-
puter screen, the programs convert the vector information to pixels.
Occasionally, you may need to redisplay the objects on your screen.
You can recalculate the entire drawing — called regenerating—

or access a virtual screen in your computer’s memory that can

be accessed very quickly — called redrawing. A redraw is much
quicker than a regeneration.

When should you use REDRAW and when REGEN?

4 Use the REDRAW command to remove blips or to quickly refresh
the screen. (The REDRAWALL command redraws the display in
all viewports. Viewports are covered later in this chapter.) To
redraw the screen, choose View > Redraw (which actually exe-
cutes the REDRAWALL command).

4+ Use the REGEN command whenever you want to recalculate
the entire drawing. In common usage, the word regen refers
to the REGEN command as well as regenerate or regeneration.
To regenerate the entire drawing, type regen .! at the command
line. (REGENALL regenerates all viewports.)

Certain zooms and pans may require a regeneration, which AutoCAD
does automatically.

CHAPTER

¢+ 4+ 0+
In This Chapter

Panning and zooming

Using Aerial View fo
pan and zoom

Working with views
Creating tiled viewports

Creating User
Coordinate Systems

Drawing isometrically

+ 0+ e
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In recent releases, the mechanics behind the display of drawings have significantly improved.
It is now rarely necessary to regenerate a drawing.

Panning

Tip

Note

Often you cannot see the entire drawing on your screen. You therefore need a way to see the
parts of your drawing that are not currently visible.

To pan means to move the display without changing the magnification. The word refers to the
expression of panning a camera across a scene or view. You pan to view a different part of your
drawing.

Using the PAN command

The PAN command moves the display in the direction and distance you indicate without
changing the magnification. Real-time panning moves the drawing as you move the cursor.

e To pan the drawing, choose Pan Realtime from the Standard toolbar. The cursor

““a& changes to a hand. Place the cursor anywhere in your drawing, click, and drag in the
direction you want the objects to go. Press Shift as you pan to constrain panning to vertical
or horizontal directions. Pan can be used transparently, while you're in the middle of another
command.

You can pan past the edge of the screen (actually the viewport) in Windows XP. This means
., that, when the cursor reaches the edge of the screen, you can continue moving your mouse
# in the same direction to continue the pan.

To leave Pan mode, press Esc or Enter or start any command via a menu or toolbar. You can
also right-click to open the shortcut menu shown in Figure 8-1. Use the shortcut menu to exit
Pan mode, switch to real-time Zoom or 3D Orbit (AutoCAD only), or to choose one of the zoom
options listed.

Exit Figure 8-1: The Pan shortcut menu.

v Pan
Zoom
3D Orbit

Zoom Window
Zoom Original
Zoom Extents

You can use Microsoft IntelliMouse pointing devices for panning. To pan, click and hold down

~—  the wheel and move your mouse. You see the same panning cursor, the hand, as you do

when you pan by clicking the Pan Real-Time button on the Standard toolbar. However, you
don't need to press Esc or Enter to leave Pan mode.
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Using the scroll bars

You can use the scroll bars to pan vertically and horizontally as you would with any Windows
program. However, you can'’t easily predict just how much the drawing view will move.
Therefore, the scroll bars are less useful than the PAN command.

You can use the scroll bars in three ways:

On the )

CD‘VI

4+ Drag the scroll box in the desired direction and in the desired amount.
4 Click the scroll bar between the scroll box and the up or down arrow.

4 Click the up or down arrow to move the drawing view slightly.

The drawing used in the following Step-by-Step exercise on panning and scrolling, ab08-a.
dwg, is in the Drawings folder on the CD-ROM.

STEP-BY-STEP: Panning and Scrolling

1. Open ab08-a.dwg from the CD-ROM. This is an air compressor, as shown in Figure 8-2.

tiny

Figure 8-2: The air compressor is zoomed in so that you can see only part of the
drawing.

g Choose Pan Realtime from the Standard toolbar. Move the cursor to @ in Figure 8-2,

“La click, and drag to @. The air compressor moves up and to the right. (Note that by
the time you get to @), the display of the air compressor has moved — but you should
drag to where @ was on the screen.) Press Esc.

. The scroll box of the horizontal scroll bar is all the way to the left. Click anywhere in

the scroll bar to the right of the scroll box. The air compressor moves to the left.

. Click anywhere in the vertical scroll bar between the scroll box and the down arrow at

the bottom of the scroll bar. The air compressor moves up as you scroll down.

. Click the right arrow on the horizontal scroll bar three times. The drawing moves to

the left slightly each time. Your drawing should look something like Figure 8-3. You may
have a different view if you chose slightly different pan points.

Do not save this drawing.
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QISR

Figure 8-3: The final view. Your view may be somewhat different.

The ZOOM Command

- Cross-
Reference

Tip

The ZOOM command enables you to zoom in and out of your drawing, like the zoom lens of a
camera. When you zoom in, everything is magnified so that you can see it more easily, but
you see less of the entire drawing. When you zoom out, objects look smaller, but you can see
more of the drawing. The ZOOM command has several options that make it easy to see just
what you need at an appropriate size.

Zooming does not affect the actual size of objects, just as zooming with a camera lens does
not affect the size of the scene you're viewing. Chapter 9 covers changing the actual size of
objects (known as scaling).

-+ When you use real-time zoom, the drawing zooms in and out as you move the cursor.
To use real-time zoom, choose Zoom Realtime from the Standard toolbar. The cursor
changes to a magnifying glass with a plus sign on one side and a minus sign on the other side.
You determine whether you zoom in or out depending on the movement of the cursor:

4 To zoom in, click and drag up in the direction of the plus sign.
4+ To zoom out, click and drag down in the direction of the minus sign.

A movement from the middle of the screen to the top edge zooms in 100 percent. A movement
from the middle of the screen to the bottom edge zooms out 100 percent.

You can zoom past the edge of the screen (actually the viewport) in Windows XP. As you
, move the mouse up or down to zoom, when you reach the edge of the viewport, continue
+ to move the mouse in the same direction to continue the zoom in or out.

You can zoom with Microsoft IntelliMouse pointing devices. Rotate the wheel up to zoom in
and down to zoom out. There is no Zoom Realtime cursor, and you don’t need to press Esc or
Enter to leave zoom mode. You can also double-click the wheel to do a Zoom to the extents of
the drawing.
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To control how much you zoom for each incremental movement of the wheel, change the

, ZOOMFACTOR system variable. The default is 60.

)
Right-click to open the shortcut menu to exit Zoom mode, switch to real-time pan or 3D Orbit
(AutoCAD only), or to choose one of the zoom options listed. To end real-time zoom, you can
also press Esc or Enter or start any command via a menu or toolbar.

Understanding ZOOM options

The Zoom flyout on the Standard toolbar has eight options. The Standard toolbar also has a
separate Zoom Previous button. Table 8-1 outlines these Zoom options.

Table 8-1: Zoom Options

Button  Option Description

= Window  This button lets you define a rectangular window as the boundaries of the new
IEI\ display. The command prompts you for the two corners of the window. Use
Window to zoom in on any area already displayed in your drawing. When you use
Zoom Window, the command displays everything in the window you specify but
reshapes the display to fit your screen. As a result, you may see objects that were
outside the specified window. You can move the mouse past the drawing area to
define the window past the edge of the screen.

Dynamic  Enables you to zoom and pan in one operation. This option is covered in the next
section of this chapter.

Scale Enter a number to scale the display relative to the drawing limits (a kind of absolute
scaling). Enter a number followed by x to scale the display relative to the current
view (relative scaling). Enter a number followed by xp to scale the display relative
to paper space units (discussed in Chapter 17). A number less than 1 (such as 0.5)
reduces the size of the objects on the screen (such as by half). A number greater
than 1 (such as 2) increases the size of the objects on the screen (such as by 2).

2 O

Center Lets you specify a new center for the display, and then a new magnification/height.
The current magnification/height is shown in brackets for your reference. Type a
smaller number to increase the magnification, making the objects larger. Type a
larger value to decrease the magnification, making the objects smaller.

Object Lets you zoom in to selected objects. This option is new for AutoCAD 2005 and
AutoCAD LT 2005.

In Uses the Scale option with a value of 2x. See the Scale option.

Out Uses the Scale option with a value of 0.5x. See the Scale option.

All Zooms the display to the greater of the drawing extents or the drawing limits.

Extents Zooms to the outer extents of the drawing. You can also double-click the wheel of
an IntelliMouse pointing device.

Previous  Redisplays the most recent display of your drawing. This option has its own button
on the Standard toolbar.

A8 L OE L 8L
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ZOOM Dynamic

The Dynamic option of ZOOM enables you to pan and zoom in one operation. The Aerial View
(discussed in the next section) offers more sophisticated options, but the simplicity of ZOOM
Dynamic is sometimes just what you need.

When you start ZOOM Dynamic, you see the virtual screen area of the drawing in a blue
dashed rectangle —the drawing extents or limits, whichever is greater. Your current view is
bounded in a green, dashed rectangle. Your mouse cursor changes based on the two modes
of ZOOM Dynamic. Each time you click the left mouse button, you switch modes. Here’s how
the two modes work:

4+ Pan mode: The box contains an X and can move freely around any displayed area of
the drawing.

4 Zoom mode: The box has an arrow. The left side of the box is fixed at the point where
you changed to Zoom mode. As you move the cursor, the box expands or shrinks, let-
ting you zoom to any magnification.

When the view box displays the view that you want, click the right mouse button and choose
Enter (or press Enter). The command pans and zooms to show that view. Figure 8-4 shows
the screen during a ZOOM Dynamic operation.

\ The drawing used in the following Step-by-Step exercise on using ZOOM Dynamic, ab08-b.
dwg, is in the Drawings folder on the CD-ROM.

§<—Generated area of drawing

View box in Zoom mode

l

% <~——Current

8ii6

N

AlR COMPRESSOR

=1 |

Figure 8-4: Using ZOOM Dynamic.
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STEP-BY-STEP: Using ZOOM Options

1. Open ab08-b.dwg from the CD-ROM. This is a drawing of a warehouse, as shown in

Figure 8-5.
% g

e
A

Figure 8-5: A drawing of a large warehouse, with shelving and conveyor belts.
Thanks to Bryan Kelly of ATl Corporation, Fairfield, lowa, for this drawing.

W IR

|

2. = Toread the text in the lower-right corner, choose Zoom Window from the Zoom
flyout of the Standard toolbar.

3. At the Specify first corner: prompt, pick @), as shown in Figure 8-5. At the
Specify opposite corner: prompt, pick @. AutoCAD or AutoCAD LT zooms in
to display the window you specified, as shown in Figure 8-6.

4, @ Choose Zoom All from the Zoom flyout of the Standard toolbar.

SCALE: 3/647 =1

iV

| ..

Figure 8-6: Your display should look approximately like this figure after using ZOOM
Window.
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10.

11.

12.

13.

Drawing in Two Dimensions

. Choose Zoom Previous from the Standard toolbar. You quickly return to the previ-
@ ous display.

Choose Zoom Extents from the Zoom flyout of the Standard toolbar. The drawing
fills the screen. In this drawing, the drawing extents are similar to the drawing lim-
its, so that you see little difference between using Zoom All and Zoom Extents.

. Choose Zoom Center from the Zoom flyout. At the Specify center _ point:
@ prompt, pick @ in Figure 8-5. At the Enter magnification or height
<5315.176>: prompt, type 500 . You zoom in on the office.

.+ Choose Zoom Realtime from the Standard toolbar. Place the cursor at the top of
L:E the drawing, click, and drag to the bottom of the screen. The display zooms out
about 200 percent.

Choose Zoom Scale from the Zoom flyout of the Standard toolbar. Type _2x .. The
display zooms in, doubling the scale of the view and returning you approximately
to the previous view of the office.

Choose Zoom Dynamic from the Zoom flyout. You now see the entire drawing.

The current view is shown with a green dashed line. The mouse cursor is a box
with an X in it. You are now in Pan mode. To zoom in on the right side of the warehouse,
move the Pan box to the lower-right corner of the warehouse and click with the pick
(left) button.

You are now in Zoom mode. The Zoom box contains an arrow. Move the mouse to the
left to shrink the Zoom box. Notice that the Zoom box is fixed at its left side. When the
Zoom box is about half its original size, left-click again.

You are back in Pan mode again. Move the Pan box to the bottom-right corner of the
warehouse. Right-click and choose Enter to zoom in on this new view. Your display
should look approximately like Figure 8-7.

Choose Zoom All from the Zoom flyout. Do not save your drawing. If you're con-
tinuing to the next exercise, leave the drawing open.

H——=_ X

Figure 8-7: The new view of the drawing after using Zoom Dynamic.
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Aerial View

Aerial View functions like a souped-up version of ZOOM Dynamic. You can use Aerial View to
pan and zoom. If you need to pan and zoom often, you can leave the Aerial View window open
and use it whenever you need to. Aerial View is most useful in large maps or floor plans, or
any drawing with lots of detail. You can use it transparently.

To open Aerial View, choose View = Aerial View. The Aerial View window opens, as shown in
Figure 8-8.The Aerial View window can be active or inactive. When active, its title bar is shown
in color (usually blue). When inactive, the title bar is gray. Inside the window, you see your
entire drawing. To close Aerial View, click the Aerial View window’s own Close button. Aerial
View has its own toolbar and menu.

While you work in your drawing, the drawing window is active and the Aerial View window is
inactive. To pan and zoom by using Aerial View:

1. Click anywhere inside the Aerial View window to activate Aerial View. You see a pan/
zoom box that looks like the box you see when you use ZOOM Dynamic. It has an X in
it, indicating that you can pan.

2. Move the pan/zoom box over the part of the drawing you want to zoom in on. The dis-
play in the main screen pans as you move your mouse.

3. Click to switch to Zoom mode. You see the arrow in the box, indicating that you can
zoom. Move your mouse to resize the window so that it covers the area you want to
see. In the main drawing window, you immediately see the new zoomed view.

4. Continue to click to switch between Zoom and Pan modes as necessary.
5. Right-click or press Esc to fix the new view.

To quickly zoom out in the Aerial View display, click Zoom Out on the Aerial View toolbar. To
quickly zoom in, click Zoom In on the toolbar. To see your entire drawing in the Aerial View
display only, click Global on the toolbar.

Zoom In
Zoom Out
Global
' =
=H Aqrial Wiew - di\drawings\ab8-b.... =/0E
\uliew\i Qptions Help
LOREC ;)
=

Figure 8-8: The Aerial View window.
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The Aerial View Options menu contains two options that affect how Aerial View works. Both
features are also available by right-clicking the Aerial View window shortcut menu.

4 Auto Viewport applies only when you have more than one viewport. [ discuss viewports
later in this chapter. If this option is checked, the view in the Aerial View window changes
as you change the active viewport in the main drawing area.

4+ Dynamic Update determines whether the view in the Aerial View window is continually
(dynamically) updated as you edit your drawing. If you find that Aerial View slows
down your computer (but you don’t want to close it entirely), choose this option to
turn Dynamic Update off. Choose the option again to turn it on.

Named Views

New
Feature

After you've done a lot of panning and zooming in a drawing, you may find that you return to
the same part of your drawing again and again, especially if the drawing undergoes a lot of
changes. In a large drawing, it can take some time to display the part of the drawing that you
want, especially if AutoCAD or AutoCAD LT needs to regenerate the drawing. You can speed
up the process by saving views.

A view is simply a display of a drawing on your screen. A view can show any part of your
drawing at any magnification. After you have the display, you give the view a name and save
it. AutoCAD or AutoCAD LT then lets you retrieve that view at any time, without zooming or
panning.

\ You can also turn a view into a floating viewport, which you use to lay out your drawing for
plotting. For example, if you have a top view, a side view, and a section view, you can easily use
these views for your final plot. You turn a view into a viewport using the Sheet Set Manager,
which | cover in Chapter 26. For now, you should be aware that you can use views both for the
purpose of facilitating drawing and editing as well as for the final layout of your design for
plotting. (AutoCAD only.)

Saving a view

First display the view that you want to save on the screen. You can use the ZOOM and

PAN commands or Aerial View. Then choose View=> Named Views to start the VIEW
command. (You can also choose Named Views from the View toolbar.) The View dialog box
opens with the Named Views tab active, as shown in Figure 8-9.

i@ View [2]%]

Mamed Views Dithographic & lsometic Views

Current View: Cument

Nare Category | Location | WP | Lagers | UCS | Perspective Set Cuent

ML Cunent Layoct off

Mew.

[ ok ][ Cancel | [_Hel

Figure 8-9: The View dialog box.
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The View dialog box has the following columns:

4+ Name: Displays the name of saved named views. You can click the name of a selected
view to change its name.

4+ Category: You can assign categories for views for the purpose of organizing sheets in
the Sheet Set Manager. Typical categories might be elevation and plan or top and
section. (AutoCAD only.) For more information, see Chapter 26.

4+ Location: You can place views on the Model tab, where you usually draw, or on a layout
tab. I explain layouts in Chapter 17.

4+ VP: You can associate a view with a floating viewport on a sheet in a sheet set.
(AutoCAD only.) I explain floating viewports briefly in this chapter and cover them
thoroughly in Chapter 17. Sheet sets are covered in Chapter 26.

4+ Layers: You can save layer visibility settings with the named view so that every time
you display the view, you see the same layer settings. | explain layers in Chapter 11.

4+ UCS: You can save a UCS (User Coordinate System) with the view, so that each view can
have its own UCS. I explain UCSs later in this chapter.

4+ Perspective: This column states whether the named view is a perspective view. You can
create a perspective view using the DVIEW command in both AutoCAD and AutoCAD LT,
covered in this chapter. In AutoCAD only, you can also use the 3DORBIT command (see
Chapter 22).

When you first open this dialog box, it shows only one view, called Current, which is the cur-
rent display. Click New to open the New View dialog box, shown in Figure 8-10. Type a name
for your view in the View Name text box.

i New View @@| Figure 8-10: The New View dialog box.

iew name: |

WView categary: ~

Boundan

(=) Current display () Define window

Settings
Stare Curent Layer Settings with Yiew
Save UCS with view

UICS name: ® world w

[ 0K } [ Cancel ] [ Help

View names can be up to 255 characters and can include spaces. As | explained in the previ-
ous discussion of the View dialog box, you can save a User Coordinate System, a category,
and layer visibility settings with a view. Select the Current Display option button to use the
current display as the view. Otherwise, choose Select Window, click the Define View Window
button, and specify a window around the view that you want.

Choose OK to return to the View dialog box, where you see your new view listed. Click OK to
return to your drawing.
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Tip

In a very large drawing, you can create views as soon as you create the title block —for exam-
ple, one for each quadrant of the drawing, and another for the title block lettering. This helps
you move quickly from one section of the drawing to another. As you determine the need for
more specific views, you can add them.

You can use the New View dialog box to define several views at once. Here’s how:

S U e W N -

IN|

9.
10.

. Choose View => Named Views.

. Click New.

. Type the name of the first view in the View Name text box.

. Choose the Define Window radio button.

. Click the Define View Window button to return to your drawing.

. If necessary, adjust the display by zooming and panning. The display change is done

transparently.

. At the Specify first corner: prompt, pick one corner of a rectangular window.

. At the Specify opposite corner: prompt, pick the diagonally opposite corner of the

window to return to the New View dialog box.
Click OK to return to the View dialog box.

Repeat Steps 2 through 8 for all additional views.

Displaying a view

The View dialog box enables you to easily display any view you have saved. Follow these steps:

1.
2.
3.
4.

Choose View &> Named Views.
Choose the view you want to restore.
Click Set Current.

Click OK.

For quick access to named views, open the View toolbar and choose a named view from the
drop-down list.

Using other View control functions

You can use the View dialog box to manage named views. Choose View => Named Views to
open the View dialog box. You can also find these features by right-clicking inside the View
dialog box.

4 To delete a view, choose the view you want to delete and press the Delete key on your

keyboard.

4+ To rename a view, click it once and then a second time, but without double-clicking.

Type a new name and press Enter.
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4+ To change the layer states that you saved with the view, change the states of any layers
before opening the dialog box. Then open the View dialog box, choose a named view,
and click Update Layers. The view now uses the current layer states.

4+ To edit the boundaries of a view, choose the Edit Boundaries button. You are now back
in your drawing and the current view boundaries are shown in black or white (depend-
ing on the color of your background). At the prompts, specify the two opposite corners
that you want to bound the view and press Enter.

4+ To see a description of a view, choose the view for which you want to see a description
and click Details. The View Details dialog box opens, which provides some statistics
about the view.

On the""'\ The drawing used in the following Step-by-Step exercise on working with views, ab08-b. dwg,
\ isinthe Drawings folder on the CD-ROM.
L y

CD-

N
STEP-BY-STEP: Working with Views

. Open ab08-b.dwg from the CD-ROM if it is not already open from the previous exercise.

. Save the file as ab08-01.dwg in your AutoCAD Bib1e folder.

. Choose View &> Named Views to open the View dialog box.

. Click New to open the New View dialog box.

. In the View Name text box, type top left.

S U1 e W N -

. In the Category text box, type quarter-sections if you are using AutoCAD. If you use the
Sheet Set Manager to define sheets (as explained in Chapter 26), this category could be
used for a series of layout sheets that display quarters of the building.

7. Click the Define Window option button or the Define View Window button. This action
returns you to your drawing temporarily.

8. At the Specify first corner: prompt, pick the top-left corner of your screen. At the
Specify opposite corner: prompt, pick somewhere around the center of the ware-
house. You are now back in the New View dialog box.

9. Click OK once.
10. Click New. Type bottom left in the text box of the New View dialog box.

11. Select Define Window and then click the Define View Window button. At the Specify
first corner: prompt, pick the bottom-left corner of your screen. At the Specify
Opposite corner: prompt, pick again around the center of the warehouse. Back in
the New View dialog box, click OK. The View dialog box should list both of your views.
Click OK to close the View dialog box.

12. Choose View=> Named Views. Choose bottom Teft from the View dialog box. Click Set
Current and then click OK. AutoCAD or AutoCAD LT displays the view.

13. Save your drawing. The views you created are now part of the drawing database.



136  Partll + Drawing in Two Dimensions

Using named views to manage a drawing
Using named views provides three additional advantages:

4+ You can use named views when you open a drawing so that one of its views is immedi-
ately displayed.

4 You can open only the part of a drawing contained in a view.

4 You can turn a named view into a floating viewport for plotting purposes. (AutoCAD only.)

A drawing with a view

After you've saved views, you can use them to open a drawing so that a view is immediately
displayed. Click Open on the Standard toolbar. In the Select File dialog box, choose the file
that you want to open and check the Select Initial View check box. Then click Open. In the
Select Initial View dialog box, choose the view that you want to display and click OK.

Partially opening a drawing

You may have a very large drawing that is slow and cumbersome to work with when it is com-
pletely opened. For example, if you have a surveyor’s drawing of an entire county, but you need
to work only with one plat, you might want to open a named view containing only that plat.

A You can open only the part of a drawing contained in a named view.

AutoCAD
Only

4

To partially open a drawing from within AutoCAD, follow these steps:
1. Choose File Open to open the Select File dialog box.

2. Choose a drawing and then click the Open button’s drop-down box. Choose Partial
Open to open the Partial Open dialog box, shown in Figure 8-11.

E] Partial Open [B]=]
Wigw geomety to load Laper geometry to load
*Extents” Layer Mame Load Geometry
*Exterts™ g
“Last i
Tap View 19
Bottom YWiew 50
g
COLUMNS
FIXTURES
FLOWRACK
SHLYING
STRUCT
Index status
Load Al Clear &l
Layer index; Mo
(] Unload all #refs on open l Open ] [ Cancel ] [ Help ]

Figure 8-11: Use the Partial Open dialog box to open only the
part of a drawing contained in a named view.
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3. Choose a view from the list of named views.

4. Choose one or more layers. To include all the layers, click Load All. (If you don’t include
at least one layer, no objects are loaded. Chapter 11 covers layers.) Click Open.

After you've partially opened a drawing, you can open more of the drawing. Choose File >
Partial Load. This item is only available if the current drawing has been partially opened.
AutoCAD opens the Partial Open dialog box. You can change the view. To display the entire
drawing (from whatever is loaded), choose the default view, *Extents*. To define a new view
on the fly, click the Pick a Window button and define the two diagonal corners of the view you
want to see. Check what layers you want to include or click Load All. Click OK to open the
drawing with the new view and layers specifications.

Using named views with sheet sets

Sheet sets are a new feature of AutoCAD 2005. (AutoCAD LT doesn’t include this feature.) You
can combine layouts from more than one drawing into a sheet set. Sheet sets are a powerful
way to organize many layouts. I cover them in detail in Chapter 26. However, at this point
you should know that named views have a value beyond helping you display an area of your
drawing. They can also turn into your final layout for plotting.

Suppose that you're drawing a mechanical model with a top view, a side view, and a section
view. In the final plot, you want to display these three views on one sheet of paper. Without
sheet sets, you would create three floating viewports and individually pan and zoom to get
the three views. (For more information on floating viewports, see the “Floating viewports”
sidebar in this chapter, as well as Chapter 17.) Using the sheet-set feature, as you work you
can create named views of the three parts of the drawing. Then you can use those same
views to create the floating viewports for plotting.

Tiled Viewports

Tiled viewports enable you to divide up the screen into rectangular bounding boxes. You can
then show a different view of your drawing in each viewport. The purpose of tiled viewports
is to help you draw. For example:

4 You can see the whole drawing in one viewport and a zoomed-in portion of that drawing
in another viewport.

4+ You can see widely separated views of a large drawing at one time.
 Cross- There are two types of viewports —tiled and floating. For more information on floating view-
\ Reference ports, see the sidebar of that title in this chapter. For a detailed discussion, turn to Chapter 17.
Actually, you're already using a tiled viewport because the regular single view of your drawing
that you’ve been working with represents the default of a one-tile viewport.

Tiled viewports have the following characteristics:

4+ No matter how many viewports you have, they always collectively take up the entire
screen. They are not separate entities but a way of dividing up the screen.

4+ Only one viewport can be active at a time. The active viewport has a bold border.
4 The crosshairs only appear in the active viewport.

4 The UCS (User Coordinate System) icon (if set to On) appears in each viewport.
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4+ Any change you make to your drawing in one viewport automatically appears in every
other viewport (or in viewports that show the part of the drawing where you made the
change).

4 You can create up to 96 viewports — but you’ll never want to create that many!

4 You can begin a command in one viewport and finish it in another. For example, you
can start a line in one viewport, switch to a second viewport, and end the line there.

4+ You can save and restore viewport configurations.

Figure 8-12 shows a drawing divided into three tiled viewports. Each viewport shows a differ-
ent view of the same drawing.
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Figure 8-12: A drawing showing three tiled viewports with a different view in each viewport.
Thanks to Jerry Bottenfield of Clow Valve Company, Oskaloosa, lowa, for this drawing.

Configuring tiled viewports

Creating tiled viewports involves deciding how you want to divide up the screen. A set of
tiled viewports is called a configuration. There are a few simple configurations, but you can
create your own by further dividing up any of the viewports. You can also join two viewports.
Finally, you can always return to the default of one viewport.

Creating tiled viewports
To add viewports, choose View = Viewports. This opens a submenu from which you can
choose from the preset configurations, as shown in Figure 8-13.

You can choose to create up to four tiled viewports from the submenu, at which point you
respond to the options that appear on the command line. For example, if you choose 2
Viewports, the command responds with the Enter a configuration option [Horizontal/
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Vertical] <Vertical>: prompt. Right-click and choose Horizontal or Vertical to create two
horizontal or vertical viewports. If you choose 4 Viewports, you get four equal viewports, one
in each corner. However, if you choose 3 Viewports, you can choose from several options to
configure the three viewports.

Named Viewports... Figure 8-13: The Viewports submenu.

New Viewports...
1 Viewport

2 Viewports

3 Viewports

4 Viewports

Join

An easier way to configure viewports is to choose New Viewports from the submenu. The
Viewports dialog box opens with the New Viewports tab on top, as shown in Figure 8-14.
Here you choose the configuration that you want. You see a preview of the configuration.

El Viewports (A}

New Viewpors | Named Viewports

New name:

Standard wiewpaorts: Previgw

“fetive Model Configuration”
Single:

Two: Vertical

Twao: Horizontal “Cument*
Three: Right
Three: Left
Three: Ahove
Three: Below
Three: Yertical
Three: Horizontal
Four: Equal
Four: Right “Curent* “Cument”
Four: Left

Apply to: Setup: Change view ta:

Dizplay | |20 w “Curent™ v

[ 0Ok I[ Cancel ][ Help ]

Figure 8-14: The Viewports dialog box makes it easy to choose
a configuration.

If you have named views in your drawing, you can specify a view for each viewport to display.
Click a viewport in the Preview pane and choose a named view from the Change View To drop-
down list box at the bottom of the dialog box. If your drawing is in 3D, you can choose 3D from
the Setup drop-down list box, and AutoCAD creates standard orthogonal views in the view-

ports. When you've specified your viewport configuration, click OK to return to your drawing.
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The Viewport dialog box is usually the best place to start creating viewports. However, if the
standard configurations do not meet your needs, you can use one of them as a starting point
and then use the other options.

Notice the Apply To drop-down list at the bottom-left corner of the Viewports dialog box
(New Viewports tab) in Figure 8-14. By default, the tiled viewport configurations apply to the
entire display, meaning that they replace your current configuration. You can also choose to
apply the configuration to the current viewport. The active viewport has a bold border and
crosshairs. To make a viewport active, click anywhere inside that viewport. Then choose
View > Viewports = New Viewports, choose Current Viewport from the Apply To drop-down
list, and choose the configuration you want for that viewport.

Let’s say you have four equal viewports, and the top-left viewport is active. If you choose the
Four: Equal configuration from the Viewports dialog box while the top-left viewport is active
and apply it to the current viewport, the top-left viewport is divided into four viewports. Now
you have seven viewports in the drawing.

Removing tiled viewports

One way to remove a tiled viewport is to join it to another viewport. To join one viewport to
another, choose View ©> Viewports = Join. At the Select dominant viewport <current
viewport>: prompt, click the viewport you want to retain or press Enter if you want to retain
the current viewport. At the Select viewport to join: prompt, click the adjacent viewport
that you want to join into the dominant viewport. When the two viewports merge, you lose
the display in this second viewport. The adjacent viewports must together form a rectangle.

The only other way to remove all tiled viewports in one step is to return to the single viewport
configuration — choose View = Viewports => 1 Viewport. The display in the current viewport
remains.

Floating viewports

AutoCAD and AutoCAD LT have two types of viewports, tiled viewports, which are discussed here,
and floating viewports, which | cover in Chapter 17. These two types of viewports have many sim-
ilarities, but they have different purposes. Whereas the purpose of tiled viewports is to help you
draw and edit your drawing, floating viewports are used to lay out your drawing for plotting.

Floating viewports create layouts, which enable you to treat your screen like a sheet of paper. You
create floating viewports and perhaps a title block on this electronic sheet of paper. You can cre-
ate one or more layouts. Each floating viewport can show a different view of your drawing — just
like tiled viewports. But floating viewports then let you plot all those views on one sheet of
paper. You can't do that with tiled viewports, which are just devices to let you temporarily display
your drawing in a way that helps you draw and edit. However, you can also draw and edit using
floating viewports.

Tiled viewports are covered here because they are appropriate for learning how to draw and edit
your drawing. Floating viewports are covered in Chapter 17 because you use them to lay out your
drawing for plotting.
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Using tiled viewports
After you've created the viewport configuration that you want, you’re ready to use it. The

first step is to create the views you need in each viewport.

Creating viewport views
Creating views in each viewport involves two steps:

1. Make a viewport current by clicking anywhere inside it.
2. Zoom and pan until you have the view that you want.

Many users commonly use one viewport to display the entire drawing and the others to display
. zoomed-in views of smaller sections.

\

Drawing from viewport to viewport

After you have the viewport configuration and views you need, you can start to draw.

One of the great advantages of viewports is that you can draw from one viewport to another.
In a large drawing, you may need to draw a line from one end of the drawing to another,

but when you display the entire drawing you can’t see the detail well enough to specify
where to start and end the line. The basic steps to draw from one viewport to another are
as follows:

1. Click the viewport where you want to start. This might be a small detail of one corner
of your drawing.

2. Start the command and specify any options you need. Specify any necessary coordi-
nates as you usually would.

3. To continue the command in a second viewport, click to activate that viewport.
Continue the command, specifying coordinates as necessary.

4. You can continue the command in a third viewport by clicking it. Do this until you've
completed the command. If you have a viewport displaying the entire drawing, you
immediately see the results in that viewport as well.

You can also use viewports to edit your drawing. Chapters 9 and 10 cover the commands
used to edit your drawing.

All commands except those that change the display — such as zooming, panning, and creating
views — can be started in one viewport and continued in another.

Saving and restoring viewport configurations

You can save a tiled viewport configuration. If you find yourself creating a particular configu-
ration over and over, you should save it. Saving a configuration is just a matter of giving it a
name. You can then restore it when needed. Viewport configuration names can be up to 255
characters and can include spaces.
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Saving a viewport configuration
After you create a viewport configuration that you like, follow these steps to save it:

1. Choose View = Viewports => New Viewports if you aren’t already in the Viewports

dialog box.

2. Type a name in the New name text box.

3. Click OK.

Restoring a viewport configuration

After returning to one viewport or using a different configuration, you can restore a named

viewport configuration, as follows:

1. Choose View = Viewports => Named Viewports to open the Viewports dialog box with
the Named Viewports tab on top, shown in Figure 8-15.

El Viewports

B[]

Mew Wiewports | Mamed Viewports
Current name: side four

Mamed viewports:

“hetive Model Configuration”
3 wiew O Ring
side four

Preview

[

0k I[ Cancel ][ Help ]

Figure 8-15: The Named Viewports tab lists saved viewport

configurations.

2. Choose the viewport that you want to restore.

3. Click OK.

On the“"\ The drawing used in the following Step-by-Step exercise on creating, naming, and
CD |\ restoring tiled viewport configurations, a08-c.dwg, is in the Drawings folder on the
\\ / CD-ROM.

STEP-BY-STEP: Creating, Naming, and Restoring
Tiled Viewport Configurations

1. Open ab08-c.dwg from the CD-ROM.

2. Save the file as ab08-02.dwg in your AutoCAD Bible folder.
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3. Choose View = Viewports = New Viewports to open the Viewports dialog box.

4. In the listing at the left of the dialog box, choose Three: Above. Click OK. You see three
tiled viewports.

5. Click the bottom-right viewport. Choose Zoom Window on the Zoom flyout of the
Standard toolbar and choose a window around the left portion of the threaded model
(the upper part of the drawing).

6. Click the bottom-left viewport. Choose Zoom Window on the Zoom flyout of the Standard
toolbar and choose a window around the bottom-left portion of the drawing (not includ-
ing the title block).

7. Click the top viewport. Choose Zoom Extents from the Zoom flyout of the Standard
toolbar. Figure 8-16 shows the results.
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Figure 8-16: The three tiled viewports now display three different views.

8. Choose View > Viewports => New Viewports. In the New Name text box, type 3 view O
Ring and click OK.

9. With the top viewport still active, choose View > Viewports > 1 Viewport to display the
view shown in the last active viewport.

10. Choose View = Viewports => Named Viewports.

11. Choose 3 view O Ring and click OK to restore the viewport configuration, including the
views in each viewport.

12. Save your drawing.

Snap Rotation

Not all 2D drawings are vertical and horizontal. In some drawings, a significant portion of
your objects are drawn at nonorthogonal angles. One example is an auxiliary view to show
the “true size” of an inclined surface. Sometimes it helps to rotate the crosshairs to match the
major angles of the drawing.
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Consider Figure 8-17. A great deal of this drawing is at an angle. You could handle this in
four ways:

4+ Draw as normal, specifying the necessary angles.
4+ Rotate the snap, which also rotates the grid and crosshairs.
4+ Create a new UCS (User Coordinate System).

4+ Draw the entire model vertically and rotate it afterward.

Figure 8-17: In 2D drawings such as this, you should consider various
options, such as rotating the snap or creating a new UCS.
Thanks to Robert Mack of The Dexter Company, Fairfield, lowa, for this drawing.

Creating a new UCS is covered later in this chapter.

If you need to draw several objects at a certain angle, such as 45 degrees, you can rotate the
snap to that angle. The grid and crosshairs rotate to follow suit. This technique works best
when the decimal point accuracy required lets you draw using snap points. You can also use
this technique to guide the cursor at an appropriate angle for direct distance entry, although
polar tracking is another way to accomplish the same task.

To change the snap rotation angle, choose Tools &> Drafting Settings (or right-click SNAP on
the status bar and choose Settings) to open the Drafting Settings dialog box. In the Snap sec-
tion, type an angle in the Angle text box.

Note that you can also set an X base and a Y base. This simply ensures that the grid goes
through a point of your choice, which is very important if you're using Snap mode to draw. If
you're just starting to draw an object, use the 0,0 base and draw to the existing snap points.
However, if you have an existing object and need to add to it, changing the base can be very
helpful. Setting X and Y bases does not change the coordinates, which are tied to the UCS.
(The UCS is discussed in the next section.)

« Cross- You can use the ID command to get the coordinates of a point. Then use these coordinates
\ Reference \ a5 the X and Y bases. Chapter 12 covers the ID command.
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Click OK to return to your drawing. Make sure that the grid is on. The crosshairs and grid
now reflect the new snap angle. Figure 8-18 shows the same drawing with a snap angle of
45 degrees. Notice how the crosshairs now match the angle of the drawing. The crosshairs
have been set to 100 percent of screen size, which is useful when rotating the snap angle.
(To reset the crosshairs size, choose Tools &> Options and click the Display tab.)

.

Figure 8-18: The snap angle in this drawing has been changed to
45 degrees. Note that the grid follows the snap.

Tip The grid does not have to be on, but it helps you get your bearings when working with an
, unusual snap angle.
]
You can create a new UCS (User Coordinate System) rather than rotate the snap angle. The
results are similar, except that when you create a UCS, you also affect the X,Y coordinates.
The UCS is much more flexible when you start drawing in three dimensions.

User Coordinate Systems

By default, a drawing is set up by using a World Coordinate System. This sets the origin of the
X,Y points at 0,0 and the angles using the familiar East (right-facing) equals 0 degrees system.
Figure 8-19 shows the UCS icon in its default display.

A Figure 8-19: The UCS icon in its default display.

A

You can easily create your own UCS and even save it for future use in the drawing. Creating a
UCS is essential for 3D drawing but often useful for 2D drawing as well.
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To define a UCS in a 2D drawing, you indicate the angle of the X and Y axes and an origin
point. The origin point then becomes the new 0,0 coordinate. You have several options for
specifying the UCS.

Understanding UCS options

Understanding the UCS options will help you create a new UCS more easily, based on the
information you have available. To create a UCS, choose Tools => New UCS. A submenu opens
offering the options listed in Table 8-2.

Choose Tools &> Move UCS to leave the orientation of the X and Y axes the same but move
the origin. This option is similar to the Origin option. You can specify a new origin or, for
a 3D drawing, move the origin along the Z axis by a positive or negative number of units
(called the Z depth).

Choose Tools => Orthographic UCS to open a submenu with several preset views. These views
are used only in 3D drawings. See Chapter 21 for details on 3D coordinates.

Table 8-2: UCS Options

Option Meaning

World Specifies the default UCS, with the X axis horizontal, the Y axis vertical, and the origin at
the initial 0,0 location.

Object Enables you to align the UCS with an object. In general, this option uses the most
obvious object snap as the origin and aligns the X axis with the object. For example,
when you choose a line, the endpoint nearest your pick point becomes the origin and
the X axis aligns with the angle of the line. When you choose a circle, the X axis points
toward the point you pick on the circumference.

Face Aligns the UCS with the face of a 3D solid.

View Aligns the X and Y axes with the current view. Used in 3D drawing. This option arbitrarily
sets the origin.

Origin Specifies a new 0,0 point of your choice relative to the current origin.

Z Axis Vector  Specifies which way the Z axis points. This option is not used in 2D drawing.

3 Point Enables you to specify three points. The first point is the origin, the second point indicates
the positive direction of the X axis, and the third point indicates the positive direction of
the Y axis.

X Keeps the current origin and rotates the Y and Z axes around the current X axis. You

specify the angle. This is used in 3D drawing.

Y Keeps the current origin and rotates the X and Z axes around the current Y axis. You
specify the angle. This is used in 3D drawing.

z Keeps the current origin and rotates the X and Y axes around the current Z axis. You
specify the angle. This option can be used in 2D drawing.
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Saving and restoring a custom UCS

After you create a UCS, you can save it so that you can easily switch back and forth between
the World Coordinate System and your UCS. To save a UCS, follow these steps:

1. Specify the UCS as described in the previous section.

2. Choose Tools => Named UCS to open the UCS dialog box with the Named UCSs tab on
top, as shown in Figure 8-20. If your current UCS is not named, it is listed as Unnamed
and highlighted. Previously named UCSs are also listed. You can also use this dialog
box to return to the previous UCS or the World Coordinate System (WCS).

Eucs B%]
Hamed UCSs | Onthographic LICSs | Settings
Current UCS: arc base
@ o
' Previous
¥ arc base H Details

[ (u] 8 I [ Cancel ] [ Help I

Figure 8-20: Use the UCS dialog box to save
and restore a UCS.

3. Click Unnamed. Type a name for the UCS and press Enter. The name can be up to
255 characters and can include spaces.

4. Click OK.

To restore a saved UCS, choose Tools => Named UCS. Choose the UCS that you want to use
and click Set Current. Then click OK. You can use the same dialog box to return to the previ-
ous UCS you used. You can also choose UCS Previous from the UCS toolbar. Using this button,
you can quickly switch back and forth between two UCSs. To delete a saved UCS, select it in
the UCS dialog box and press the Del key. You can also select a UCS, right-click, and choose
one of the options from the shortcut menu.

Controlling the UCS icon

When you start a new drawing, the UCS icon is at the bottom-left of your drawing at 0,0. By
default, the icon remains at 0,0 even if you pan around the drawing. The icon may, therefore,
end up in the middle of your drawing. If 0,0 is not displayed, then the icon reverts to the
bottom-left of your drawing.

You can turn off the UCS icon completely. If you aren’t working with customized UCSs, you
often have no reason to see the UCS in a 2D drawing. If you want the UCS icon on, you can
also display it only at the bottom-left of your drawing — to keep the icon out of the way so
that it does not obstruct your drawing.
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If you create a new UCS, keeping the UCS icon at the 0,0 point (the origin) of your new UCS
helps you get your bearings. A plus sign appears in the icon to indicate the origin. However,
if the origin is out of the current display or so close to the edge that the icon won't fit, the
UCS icon appears at the lower-left corner of your drawing anyway.

To control the UCS icon, choose View o> Display &> UCS Icon. (Don’t confuse this with Tools =
New UCS, which creates a custom UCS.) A submenu opens with the following items:

4+ On: Toggles the display of the UCS icon on and off.
4 Origin: Toggles the placement of the UCS icon at the origin on and off.

You can customize the look of the UCS icon. To customize the look of the UCS icon, choose
View = Display = UCS Icon => Properties to open the UCS Icon dialog box, shown in Figure 8-21.
As you make changes, you can see the result in the preview box.

EJ UCS Icon 2] ]

UCS icon style Freview

[OFD)] /\

O3 Lire width: A
UCS icon size

12 J + ><
LICS izon color

Model space icon color: Layout tab icon color:

M Black v M Blue w

[ 0K ] [ Cancel ] [ Help ]

Figure 8-21: Use the UCS Icon dialog box to
customize the look of the UCS icon.

Choose between 2D and 3D styles. The 3D style shows the Z axis, but you won'’t see it when
you're looking at your model from the top (called Plan view). If you choose the 3D style, you
can check the Cone box to display a cone effect for the arrows of the X and Y axes. Either way,
the Z axis has no arrow, so that you can distinguish it from the X and Y axes. You can also
choose a line width from 1 to 3, 1 being the default.

You can change the size of the icon. Just drag the slider up and down to get the result you like.
Finally, you can change the color of the icon both in model space and in paper space layouts.
Click OK to close the dialog box.

Using a custom UCS

Although it seems confusing at first, after you try creating your own UCS it’s easier to under-
stand how the process works.

In this exercise, you practice drawing with a custom UCS to create the basic framework for the
drawing shown previously in Figures 8-17 and 8-18, a bearing housing for a commercial dryer.
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\ The drawing used in the following Step-by-Step exercise on drawing with a custom UCS,
ab08-d.dwg, is in the Drawings folder on the CD-ROM.

cD-,
N

On the

STEP-BY-STEP: Drawing with a Custom UCS
1. Open ab08-d.dwg from the CD-ROM.

2. Save the file as ab08-03.dwg in your AutoCAD Bib1le folder. ORTHO should be on. If
necessary, turn on OSNAP. Set a running object snap for endpoints only.

w

. Choose Tools => New UCS > Z. Because no objects exist in the drawing, you cannot easily
use the 3 Point or Object options that might otherwise be useful.

4. At the Specify rotation angle about Z axis <90>: prompt, type 45 4. The UCS
icon and crosshairs are displayed at a 45-degree angle.

5. Choose Rectangle from the Draw toolbar. At the prompt, pick a point at the bottom
center of your screen. At the Specify other corner point or [Dimensions]:
prompt, type @3-15/16,31/32 .. The command creates the rectangle at the proper
angle.

6. Start the LINE command. At the Specify first point: prompt, choose the From
object snap. At the Base point: prompt, use the Endpoint object snap to pick point @
in Figure 8-22. At the <Offset>: prompt, type @1/8,0 . At the Specify next point
or [Undo]: prompt, type @5-3/16<93.3 . End the LINE command.

Figure 8-22: Starting to draw the framework for the bearing housing
drawn by using a customized UCS.
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7.

9.

10.

Start the LINE command again. Follow the prompts:

Specify first point: Choose the From object snap.

Base point: Use the Endpoint object snap to pick point @ in Figure
8-22.

<Offset>: @1/16,0

Specify next point or [Undo]l: Move the cursor in the 90° direction
relative to the UCS. 35/64 Jd. (Remember that the UCS has been rotated
45 degrees so that 90 degrees looks like 135 degrees.)

Press F6 twice for polar coordinates (if necessary) to confirm the
90° direction as you move the cursor.

Specify next point or [Undol: Move the cursor in the 180° direction.
3-9/64 4

Specify next point or [Close/Undol: Move the cursor in the 270°
direction. 35/64 .

Specify next point or [Close/Undo]: ¢ J (to close the figure)

. Start the LINE command. At the Specify first point: prompt, choose the From

object snap. At the Base point: prompt, use the endpoint object snap to pick @ in
Figure 8-23. At the <Offset>: prompt, type @1/16,0 .

V\/X

Figure 8-23: The completed framework for the bearing housing.

At the Specify next point or [Undo]: prompt, again choose From. At the
Base point: prompt, use the endpoint object snap to pick @. At the <0ffset>:
prompt, type @1/8,0 . to complete the model, as shown in Figure 8-23. End the
LINE command.

Because you would normally continue working on this drawing, you should save the
UCS. Choose Tools &> Named UCS. In the UCS dialog box, click Unnamed. Type Rotated
45 and press Enter.
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11. Still in the dialog box, choose World, click Set Current, and click OK to return to your
drawing. The UCS icon and crosshairs return to their familiar angle.

12. To return to the Rotated 45 UCS, choose Tools = Named UCS to open the UCS
dialog box. Choose Rotated 45 and click Set Current. Click OK to restore the Rotated
45 UCS.

13. Save your drawing.

Tip After creating a new, rotated UCS such as the one in the previous exercise, type plan (to start

,.  the PLAN command) and use the Current UCS option to remove the rotation. Now you aren’t

7 working at an angle in your UCS. To return to the World UCS, type plan again and choose the
World option to return to your drawing's previous state.

Isometric Drawing

An isometric drawing is a 2D drawing drawn to look like a 3D drawing. Every child learns how
to draw a box that looks three-dimensional. By drawing parallelograms instead of squares,
the drawing gives the impression of being in three dimensions. AutoCAD and AutoCAD LT
enable you to do the same thing.

Understanding isometric planes

The ISOPLANE (short for isometric plane) command rotates the crosshairs to the special
angles required for isometric drawing. You then toggle the ISOPLANE setting from left to right
to top to draw on each of the three “planes.” As you do so, the angles of the crosshairs, snap,
and grid change to the appropriate angles.

These angles are 30 degrees for the X axis, 90 degrees for the Z axis, and 150 degrees for the Y
axis. As you toggle among the planes, you see the crosshairs take on various configurations
of these angles. Figure 8-24 shows the standard isometric cube. You can see three sides —left,
right, and top. In the figure, the crosshairs are set to the right isometric plane.

Left plane Top plane Right plane

-
| &~
i_D T -/:Jj%———; B

- b

Figure 8-24: The isometric cube.
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Tip

Isometric drawing is not often used for precise drawing because specifying the exact points
that you need can be difficult. Also, true 3D drawing has mostly supplanted isometric drawing.
It is, however, used for piping work as well as for illustrations.

Use snap points and object snaps as much as possible in an isometric drawing. Also, set the
), cursor to 100 percent of the screen to better visualize the isometric planes. (Choose Tools =

/7 Options and click the Display tab.) The grid is also a helpful aid.

Drawing in isometric mode

To start isometric mode, choose Tools = Drafting Settings to open the Drafting Settings
dialog box. On the Snap and Grid tab, in the Snap Type & Style section, choose Grid Snap
(if it is not already selected), and then Isometric Snap. While you're there, turn on Snap and
Grid if you want them on. Click OK. After you're in isometric mode, press F5 to toggle from
plane to plane.

Drawing lines in isometric mode is fairly straightforward if the lines are parallel to one of
the isometric plane angles. Circles and arcs in isometric mode must be drawn as ellipses
and elliptical arcs. When you're in isometric mode, the ELLIPSE command has an Isocircle
option.

STEP-BY-STEP: Drawing in Isometric Mode

1. Start a new drawing by using the acad.dwt template.
2. Save the drawing in your AutoCAD Bible folder as ab08-04.dwg.

3. Right-click the SNAP button on the status bar and choose Settings. On the Snap and
Grid tab, in the Snap Type & Style section, choose Grid Snap (if it is not already selected),
and then Isometric Snap.

4. In the Snap section, ensure the Snap Y spacing is set to 0.5 and click Snap On. In the
Grid section, ensure the Grid Y spacing is set to 0.5 and click Grid On. Click OK to
return to your drawing.

5. Choose Tools = Options and click the Display tab. In the Crosshair Size text box,
change the cursor size to 100. Click OK.

6. Press F5 until you see the <Isoplane Left> prompt.
7. Do a Zoom Window to zoom into the area covered by the grid.
8. Start the LINE command. Follow the prompts:

Specify first point: Use the coordinate display to choose 3.4641,2,
which is a snap point. (It may take you a while to find the point.)
Specify next point or [Undol: Choose 6.4952,0.25. (Press F6 if
necessary to get dynamic absolute coordinates.)

Specify next point or [Undol: Choose 6.4952,1.25.

Specify next point or [Close/Undo]: Choose 3.4641,3.

Specify next point or [Close/Undo]: Right-click and choose Close to
close the left side of the model. A1l these points are snap points.
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The results are shown in Figure 8-25.

T
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Figure 8-25: The left side of the iron plate. The cursor has been
changed to extend to 100 percent of the screen.

9. Press F5 twice until you see <Isoplane Right> on the command line.

10. Start the LINE command again. At the Specify first point: prompt, pick 6.4952,1.25.
Press F6 twice to get dynamic polar coordinates. At the Specify next point or
[Undo]: prompt, pick when the coordinates show 2.0000<30. At the Specify next
point or [Undo]: prompt, use the polar coordinate display to draw a line of
1.0000<270. At the Specify next point or [Close/Undo]: prompt, draw a line
of 2.0000<210. End the LINE command.

11. Press F5 twice until you see <Isoplane Top> on the command line.

12. Start the LINE command. Start the line at 8.2272,2.25, which is a snap point. Draw a line
of 3.500<150 and continue another line of 2.000<210. End the LINE command. This com-
pletes the box.

13. Choose Ellipse from the Draw toolbar. Right-click and choose Isocircle from the short-
cut menu. At the Specify center of isocircle: prompt, choose 5.1962,3. At the
Specify radius of isocircle or [Diameter]: prompt, type .5 . to draw the
ellipse. Your drawing should look like Figure 8-26.

14. Change the cursor size back to 5 (%). Save your drawing.

Polar coordinate display is very helpful while drawing isometrically. The coordinates are easier
to understand than the unusual absolute snap point coordinates created by ISOPLANE.
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Figure 8-26: The completed iron plate with a hole in

it, drawn isometrically.

Summary

In this chapter, you read how to contro

1 the display of your drawing. You learned about:

4 The PAN and ZOOM commands, including real-time pan and zoom and the many ZOOM

options

4 Using Aerial View to pan and zoo

m

4+ Saving several views of your drawing so that you can retrieve them quickly

4+ Creating tiled viewports for drawing and editing, as well as how to name and display

useful viewport configurations
4+ Rotating the snap and grid

4+ Creating a User Coordinate Syste
as current at any time

4+ Setting the snap style to isometri

m, including how to save a useful UCS and then set it

c to create isometric drawings, which are 2D drawings

that give the appearance of three dimensions

In the next chapter, you discover how t

+

o start editing your drawings.

+ 0+
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In This Chapter

Erasing objects

Copying and moving

N o drawing project is ever completed without changes. You make objects
changes in a drawing for many reasons. Some editing processes ; ;
are simply part of the drawing process, such as copying an object Rotating objects

instead of drawing it a second time from scratch. Other types of edit-
ing involve making changes to many objects at once, such as moving
an entire section of a drawing to make room for newer added objects.
You often need to erase, move, rotate, and resize objects.

Scaling objects
Selecting objects

Without knowing how to edit, working on a drawing would become Customizing obiject-
repetitive. To avoid drawing the same object a second time, you draw selection features
an object once and then copy it to a new location.

+ + + +

Editing a Drawing

Making changes to a drawing is called editing. In order to edit an
object, you need to select it. AutoCAD and AutoCAD LT offer numer-
ous techniques for selecting objects. In this chapter, I cover basic
editing commands as well as most of the ways to select objects. The
rest of the 2D editing commands, as well as additional selection and
editing methods — grips, the Properties palette, selection filters, and
groups — are covered in the next chapter.

Most of the editing commands are on the Modify toolbar. In most
cases, you can do one of the following:

4 Start the command first and then select the objects to which
the command applies.

4+ Select the objects first and then start the command.

The question of which comes first, the command or the object, is
fully covered later in this chapter.

Understanding object-selection basics

When you start editing drawings, the main new skill to learn is how to
select objects. The selection options are covered later in this chapter.
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The simplest selection technique is to place the pickbox—the box at the intersection of the
crosshairs — over the object and click with the pick button on the mouse. This is known as
picking an object. If you start an editing command before selecting an object, the command
responds with the SeTect objects: prompt. When you pick an object, AutoCAD or AutoCAD
LT highlights it, usually by making it dashed, as shown in Figure 9-1.

[ T — () Figure 9-1: The selected line is dashed.

The command continues to provide Select objects: prompts so that you can select other
objects. Continue to select objects until you have selected all the objects that you want to
edit. Then press Enter or right-click to end the Select objects: prompt.

When you select an object first, the selected object becomes dashed and you also see one or
more small boxes, called grips, as shown in Figure 9-2. The next chapter covers grips. In the
next few exercises, you use this picking technique to select objects.

(y———(m = o) Figure9-2: The selected line is dashed and also
displays grips.

Erasing objects

Somehow, no drawing is ever completed without erasing an object. The ERASE command
wf is very simple —it has no options. To erase an object, select the object and choose Erase
on the Modify toolbar or press Del on the keyboard. Alternatively, choose Erase and then select
the object.

\ The drawing used in the following Step-by-Step exercise on erasing objects, ab09-a . dwg, is
in the Drawings folder on the CD-ROM.

STEP-BY-STEP: Erasing Objects
1. Open ab09-a.dwg from the CD-ROM.

2. Save the file as ab09-01.dwg in your AutoCAD Bib1e folder. This drawing is a
schematic of a gas extraction well, shown in Figure 9-3.

3. To erase the line at point @ of Figure 9-3, move the mouse until the pickbox at the
intersection of the crosshairs is anywhere over the line and click. Notice that the line
is dashed and displays grips.

4. f__..-" Choose Erase from the Modify toolbar. The line is erased.

5. Right-click and choose Repeat Erase.
6. At the Select objects: prompt, pick the line at point @ in Figure 9-3.

7. The command responds with 1 found and repeats the Select objects: prompt.
Right-click to end the Select objects: prompt. The line is erased.
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Figure 9-3: The gas extraction well schematic.
Thanks to the Army Corps of Engineers for this drawing. The COE
maintains a Web site of drawings at http://cadlib.wes.army.mil.

8. Save your drawing.

{gr?ss- ‘\ The OOPS command restores the most recently erased object and is covered in Chapter 18.
eference

jo =
Moving objects

Use the MOVE command to move objects in your drawing. Moving an object is more complex
than erasing one because you need to tell AutoCAD or AutoCAD LT the distance and direction
that you want the object to move.

To move an object, select it and choose Move on the Modify toolbar. Alternatively,
+ choose Move and then select the object.

When you choose the MOVE command and after you have selected an object, the command
responds with the following prompt:

Specify base point or displacement:


http://cadlib.wes.army.mil
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You now have two ways of specifying how to move the object or objects:

4+ Displacement method: At the Specify base point or displacement: prompt,
state the entire displacement as an X,Y coordinate such as 2,3 or a polar coordinate
such as 2<60. Because the word displacement already implies the relative distance from
the object, you do not use @. (This method actually uses 0,0 as the relative point.) The
command responds with the Specify second point of displacement or <use
first point as displacement>: prompt. Because you've already specified all the
necessary information, press Enter. AutoCAD or AutoCAD LT uses the first point you
indicated as the displacement (the default) and moves the object.

4+ Base point/second point method: At the Specify base point or displacement:
prompt, pick a base point. This can be anywhere in your drawing. At the Specify
second point of displacement or <use first point as displacement>:
prompt, specify the distance and angle of movement either by picking a second
point on the screen or by typing a relative coordinate by using @.

The displacement method requires less input and is simpler when you know the exact dis-
placement so that you can type it in. The only disadvantage is that, as soon as you type in the
displacement, you sometimes see a confusing drag line and copy of your object or objects.
Ignore this display, press Enter, and your object or objects move as you specified.

The base point/second point method works best when you want to move an object relative to
another object on the screen.

When you move an object, choose an object snap on the object or a nearby-related object as
,.  the base point for exact results.

%

On the
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You can use PolarSnap to move an object. Turn on PolarSnap and, if necessary, use the
Drafting Settings dialog box to set the increment. You can set the polar distance; if the polar
distance is 0. AutoCAD and AutoCAD LT use the Snap X spacing value. Use PolarSnap with the
base point/second point method. At the first prompt, pick a point such as an object snap on
the object. At the second prompt, drag the object in the desired direction. Use the tooltip to
guide you and then click.

You can use object drag-and-drop to move objects if you aren’t too particular about where
they end up. Here’s how it works:

1. Pick an object.
2. Continue to pick as many objects as you want to move. They all show grips.

3. Pick any of the objects, but not on a grip. Keep the mouse button pressed until the cur-
sor changes to an arrow with a small rectangle.

4. Drag the object(s) to any other location in your drawing.

For a little more control over the placement of your objects, use the Windows Clipboard. Pick
the object(s) that you want to move. Right-click and choose Cut from the shortcut menu. Right-
click a second time and choose Paste. At the prompt for an insertion point, you can pick with
an object snap or by typing coordinates. However, you can’t control the base point (which is
0,0) as you can with the MOVE command.
\ The drawing used in the following Step-by-Step exercise on moving objects, ab09-b. dwg, is
in the Drawings folder on the CD-ROM.

/.
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STEP-BY-STEP: Moving Objects

1

. Open ab09-b.dwg from the CD-ROM.
2.

Save the file as ab09-02.dwg in your AutoCAD Bible folder. This drawing shows the
plan of a bathroom. Each object is a block, a set of objects that you can select as one
object. (Chapter 18 covers blocks.) Make sure that OSNAP is turned on. Set a running
object snap for intersection only.

. .*' Pick anywhere on the tub to select it. Notice the grip and dashed lines. Choose

Move on the Modify toolbar. Follow the prompts:

Specify base point or displacement: Move the cursor to the
Intersection at @ in Figure 9-4 and click.

Specify second point of displacement or <use first point as
displacement>: Move the cursor to the Intersection at @ in Figure
9-4 and click.

The tub moves to the bottom-right corner of the bathroom.

"o
Q

Figure 9-4: The bathroom plan.
Thanks to Bill Wynn of New Windsor, Maryland, for this drawing.

. Choose Move on the Modify toolbar. Follow the prompts:

Select objects: Pick the sink.

Select objects: 4 Specify base point or displacement: 4'<0
Specify second point of displacement or <use first point as
displacement>: J

The sink moves 4 feet to the right.

. Click SNAP on the status bar to turn it on. Now, right-click SNAP. Choose PolarSnap On

(unless it is already on, in which case it is unavailable). Click POLAR on the status bar.

. Pick the toilet and choose Move on the Modify toolbar. At the Specify base point

or displacement: prompt, pick the intersection at the bottom-left corner of the toilet
tank. At the Specify second point of displacement or <use first point as
displacement>: prompt, move the toilet to the left until you see 0'-6"<180° on the
tooltip and click. The toilet moves 6 inches to the left. (If you can’t get a 180° tooltip,
check your polar angle settings.)

. Save your drawing.

159
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Copying objects
Copying is very similar to moving. In fact, the only difference is that AutoCAD or AutoCAD LT

does not remove the object from its original spot, so you end up with two objects instead
of one.

3 To copy an object, select it and choose Copy Object on the Modify toolbar.
&5 Alternatively, choose Copy Object and then select the object.

\ The COPY command now defaults to continue to prompt you for additional copies. This
default is equivalent to the previous Multiple option. Press Enter whenever you want to end
the command. However, scripts and other routines use the earlier functioning, in which the
command ended after creating one copy.

When you choose the COPY command and have selected an object, the command responds
with the following prompt:

Specify base point or displacement:
You now have two ways of specifying where to copy the object or objects:

4+ Displacement method: At the Specify base point or displacement: prompt, state
the entire displacement as an X,Y coordinate such as 2,3 or a polar coordinate such as
2<60. Because the word displacement already implies the relative distance from the
object, you do not use @. (This method actually uses 0,0 as the relative point.) The
command responds with the Specify second point of displacement or <use
first point as displacement>: prompt. Because you've already specified all the
necessary information, press Enter. The command uses the first point you indicated as
the displacement (the default) and copies the object.

4+ Base point/second point method: At the Specify base point or displacement:
prompt, pick a base point. This can be anywhere in your drawing. At the Specify sec-
ond point of displacement or <use first point as displacement>: prompt,
specify the distance and angle of movement either by picking a second point on the
screen or by typing in a relative coordinate, using @.

As explained in the previous section on moving objects, you can use PolarSnap to copy objects.
You can also use drag-and-drop to copy objects. Follow the steps in the previous section, but
press and hold the Ctrl key as you drag the object. Notice the plus sign in the cursor’s rectan-
gle. In the same way, you can use the Clipboard to copy and paste objects from one location
in a drawing to another.

\ The drawing used in the following Step-by-Step exercise on copying objects, ab09-c.dwg, is
in the Drawings folder on the CD-ROM.

STEP-BY-STEP: Copying Objects
1. Open ab09-c.dwg from the CD-ROM.

2. Save the file as ab09-03.dwg in your AutoCAD Bible folder. This drawing shows part
of an electrical schematic. Make sure that OSNAP is turned on. Set a running object
snap for endpoint only.
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3. Use ZOOM Window to zoom into the area of the drawing marked @ in Figure 9-5. This

shows a 24-volt transformer.

"
 CNE-—=
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Figure 9-5: The electrical schematic.
Thanks to Robert Mack of the Dexter Company, Fairfield,

lowa, for this drawing.

4. o3 Note that three of the arcs that make up the right side of the transformer are miss-
&5 ing. Pick the arc at @ in Figure 9-6. Choose Copy Object from the Modify toolbar.

Follow the prompts:

Specify base point or displacement: Pick the endpoint at the top of
the arc at @ (see Figure 9-6).

Specify second point of
displacement>: Pick the
(see Figure 9-6).
Specify second point of
displacement>: Pick the
O (sce Figure 9-6).
Specify second point of
displacement>: Pick the
(see Figure 9-6).
Specify second point of
displacement>: J

displacement or
endpoint at the

displacement or
endpoint at the

displacement or
endpoint at the

displacement or

<use first point as
bottom of the first arc at @

<use first point as
bottom of the second arc at

<use first point as
bottom of the third arc at @

<use first point as

5. Choose ZOOM Previous from the Standard toolbar to return to your previous view.
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Figure 9-6: Close-up of the transformer.

6. Pick the circle at @ in Figure 9-5 (which shows the entire schematic section). Note the
grips. You also want to select the text inside the circles, but it’s hard to see because of
the grips. Press Esc to remove the grips.

7. Choose Copy Object from the Modify toolbar. Now select the circle at @ in Figure 9-5
again. This time no grips obscure the text. Separately pick both lines of text inside the
circle.

8. Continuing to select objects to copy, select the circle at @) in Figure 9-5. Also select the
two lines of text inside the circle. Right-click to end the Select objects: prompt.

9. At the Specify base point or displacement: prompt, use the Endpoint object
snap to pick point @ in Figure 9-5. At the Specify second point of displacement
or <use first point as displacement>: prompt, use the Endpoint object snap to
pick point @ in Figure 9-5. Press Enter to end the COPY command. This action copies
the two circles with the text.

10. Save your drawing.

Copying and moving objects
from one drawing to another

If you use other Windows programs, you usually use the Cut command to move and the Copy
command to copy objects. Then you use the Paste command to specify a new location. In
AutoCAD and AutoCAD LT, these commands are called CUTCLIP, COPYCLIP, and PASTECLIP.
(The CLIP refers to the Windows Clipboard.) Although the MOVE and COPY commands pro-
vide more accuracy within one drawing, you can use the Clipboard to move and copy objects
from one drawing to another.

You can copy objects from one drawing to another by using the drag-and-drop technique.
The easiest way is to open both drawings and then choose Window = Tile Vertically. Select
the object(s) that you want to copy, point to one of them, and drag to the second drawing.
However, you don’t have much control over the exact placement of the new objects. From
drawing to drawing, AutoCAD or AutoCAD LT copies the objects, instead of moving them.
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For more control over the placement of your objects, use the Windows Clipboard. A special
feature, Copy with Base Point, gives you control over the placement of your objects. Follow
these steps:

1. Pick the object(s) that you want to copy.
2. Right-click and choose Copy with Base Point from the shortcut menu.

3. At the Specify base point: prompt, specify a base point. An object snap is a good
idea here. This action copies the object(s) to the Clipboard, including the base point.

4. Switch to the second drawing.

5. Right-click in the drawing area and choose Paste (or click Paste on the Standard tool-
bar). At the prompt for an insertion point, specify the insertion point by picking, using
an object snap, or typing coordinates. This action pastes the object.

To copy the object(s) to the same coordinates as the original drawing, in Step 5 choose
Paste to Original Coordinates from the shortcut menu. AutoCAD or AutoCAD LT pastes the
object(s) in the second drawing, matching the coordinates. Depending on your drawing, you
may need to ZOOM and PAN to see the pasted copy.

You cannot specify a base point for moving (cutting) an object, but you can specify the inser-
tion point when you paste it. The lower-left extent of the selected object(s) is the base point.

¢ Cross- You can drag objects from a drawing into another application, such as a word processing
Reference document. For more information on working with AutoCAD or AutoCAD LT and other appli-

cations, see Chapter 27.

In the following exercise, you practice copying objects from one drawing to another.

\ The drawing used in the following Step-by-Step exercise on copying objects from one draw-
| ing to another, ab09-c.dwg, is in the Drawings folder on the CD-ROM.

CD-
%

On the

STEP-BY-STEP: Copying Objects from One Drawing to Another

1. Close any open drawings. Open ab09-c.dwg from the CD-ROM. Save the file as
ab09-04.dwg in your AutoCAD Bible folder. Then choose Open from the Standard
toolbar and open ab09-03.dwg from your AutoCAD Bib1e folder. If you didn’t do the
previous exercise, open ab09-03.dwg from the Results folder on the CD-ROM.

2. Choose Window = Tile Vertically. This displays the drawings side by side, as shown in
Figure 9-7.

3. In ab09-03.dwg, which should be active, make sure that OSNAP is turned on. Set a run-
ning object snap set for endpoint only.

4. Pick the circle at @ and the two lines of text inside it.

5. Move the cursor off the selected objects and right-click. Choose Copy with Base Point
from the shortcut menu.

6. At the Specify base point: prompt, pick the endpoint at @ in Figure 9-7.
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Figure 9-7: To copy objects from one drawing to another, display them both on the
screen together. (The drawings may appear reversed on your screen.)

. Click anywhere in ab09-04. dwg to make it the current drawing. Right-click and choose

Paste from the shortcut menu. At the Specify insertion point: prompt, pick the
endpoint at @) in Figure 9-7 to paste the objects.

. Click in ab09-03.dwg. Press Esc to clear any grips. Pick the circle at @) in Figure 9-7.

(Don’t include the text this time.) Click again and hold the mouse button on the circle,
but not on the grips, until you see the pointer arrow with the rectangle. Drag the circle
to @ in Figure 9-7. As you can see, you have no way to precisely place the circle.

. Click in ab09-03. dwg again. This time pick both lines of text inside the circle at @).

Right-click and choose Copy with Base Point. At the Specify base point: prompt,
pick the endpoint at the left quadrant of the circle.

Click in ab09-04 . dwg. Right-click and choose Paste to Original Coordinates to paste
the two lines of text inside the circle (depending on how accurately you dragged the
circle).

. Save ab09-04.dwg. Click in ab09-03.dwg and click its Close box. Don’t save changes to

ab09-03.dwg.

Rotating objects

You can easily rotate an object or objects around a base point that you specify. The base
point is usually an object snap point on the object. To indicate the rotation, specify an angle

of rotation. As explained in Chapter 5, zero degrees is generally to the right, and degrees
increase counterclockwise, although you can change this convention. (To do so, choose
Format => Units.) By specifying a negative angle, you can turn objects clockwise.
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To rotate an object, choose Rotate from the Modify toolbar and select an object.

Alternatively, select an object and then choose Rotate from the Modify toolbar. At
the Specify base point: prompt, indicate the point around which you want to rotate.
At the Specify rotation angle or [Referencel]: prompt, type an angle at the
command line.

The Reference option lets you specify an absolute existing rotation angle and the desired
angle. At the Specify the reference angle <0>: prompt, you type in an angle or specify
an angle by picking two points. These can be object snap points on the object that specify
the object’s current angle. At the Specify the new angle: prompt, type or pick a new
angle. You can also pick an object snap on another object in the drawing to indicate this
new angle. You can use the Reference option to align the object with the X or Y axis or with
another object in your drawing.

On the \ The drawing used in the following Step-by-Step exercise on rotating objects, ab07-03. dwg,

is in the Results folder on the CD-ROM.

o,
<
STEP-BY-STEP: Rotating Objects

1. Open ab07-03.dwg from the Results folder of the CD-ROM. If you did the Step-by-Step
exercise on ellipses in Chapter 7, you can open this drawing from your AutoCAD Bible
folder.

2. Save the file as ab09-05.dwg in your AutoCAD Bible folder. This drawing shows a con-
ference room, as shown in Figure 9-8.

Figure 9-8: The conference room.



166

Partll +

- W

@

10

11.

Drawing in Two Dimensions

. Click GRID on the status bar to remove the grid.

. Choose Tools = Drafting Settings. On the Object Snap tab, choose Center, Quadrant,
and Perpendicular. Click OK. OSNAP should be on.

Pick the small elliptical table at the top-left corner of the conference room.
Choose Rotate from the Modify toolbar.

. At the Specify base point: prompt, pick the top quadrant of the ellipse. At the
Specify rotation angle or [Reference]: prompt, type 90 . This action rotates
the small table 90 degrees around the base point.

. Click SNAP on the status bar to turn off snap.

. Start the COPY command. At the Select objects: prompt, pick the arc that makes
the back of the chair. The command responds 1 found. Continue to pick the two lines
that make the armrests and the arc that makes the front of the chair, making sure that
each time you see the response 1 found. Right-click to end the Select objects:
prompt.

. At the Specify base point or displacement: prompt, locate the Center object
snap to pick the center of the arc that makes up the back of the chair. (Press Tab to
cycle through the object snaps if necessary or move the cursor over the arc itself, or
its center.) At the Specify second point of displacement or <use first point
as displacement>: prompt, pick point @ in Figure 9-8. This point doesn’t have to be
exact. Press Enter to end the command.

. Start the ROTATE command. Follow the prompts:

Select objects: Pick all four objects that make up the new chair you
Jjust created and press Enter to end object selection.

Specify base point: Use the Center object snap to select the center
of the arc that makes up the back of the new chair.

Specify rotation angle or [Reference]: 180 ..

Start the COPY command and select the four objects in the new chair. Right-click to
end object selection. Follow the prompts:

Specify base point or displacement: Use the Center object snap to
select the center of the arc that makes up the back of the chair.
Specify second point of displacement or <use first point as
displacement>: Pick a point about a third of the way around the right
side of the conference table.

Specify second point of displacement or <use first point as
displacement>: Pick a point about halfway around the right side of
the conference table.

Specify second point of displacement or <use first point as
displacement>: Pick a point about two-thirds of the way around the
right side of the conference table.

Specify second point of displacement or <use first point as
displacement>: J
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12. Start the ROTATE command and select the four objects in the first of the three
chairs (the top one) you just created. Right-click to end object selection. (If Polar
Tracking or Object Snap is on, turn them off for better control.) At the Specify
base point: prompt, pick the center object snap of either arc of the chair. At the
Specify rotation angle or [Reference]: prompt, move the cursor around,
watch the image of the chair rotate, and click when the chair faces the angle of the
table.

13. Repeat Step 12 for the second chair.

14. Start the ROTATE command and select the four objects in the last chair you created by
using the COPY command. Follow the prompts:

Specify base point: Choose the Center object snap of either of the
chair arcs.

Specify rotation angle or [Referencel: Right-click and choose
Reference from the shortcut menu.

Specify the reference angle <0>: Use the Quadrant object snap to pick
the back arc of the chair.

Specify second point: Use the Quadrant object snap to pick the front
arc of the chair.

Specify the new angle: Use the Perpendicular object snap to choose
the conference table next to the chair.

15. Save your drawing.

Scaling objects

Scaling, or resizing, objects is another common editing task in AutoCAD or AutoCAD LT. As
with rotating objects, you specify a base point, usually an object snap on the object. The base
point is the one point on the object that does not move or change as you scale the object. The
most common way to resize an object is to specify a scale factor. The current object has a scale
factor of 1. Therefore, to increase the size of the object, type in a number greater than 1. For
example, a scale factor of 2 doubles the size of the object. To decrease the size of the object,
type in a number less than 1. A scale factor of 0.25 creates an object one-quarter of its previ-
ous size.

As with the ROTATE command, you can scale by using the Reference option. You specify the
reference length, usually the current length of the object, by typing it in or using object snaps
on the object. At the Specify new length: prompt, you can type a new length or pick a
point. The option measures this point from the base point you specified to determine the
new length.

To scale an object, choose Scale from the Modify toolbar and select the object.
Alternatively, select the object and choose Scale from the Modify toolbar.

The drawing used in the following Step-by-Step exercise on scaling objects, ab09-d . dwg, is
in the Drawings folder on the CD-ROM.
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STEP-BY-STEP: Scaling Objects
1. Open ab09-d.dwg from the CD-ROM.

2. Save the file as ab09-06.dwg in your AutoCAD Bib1e folder. This drawing, shown in
Figure 9-9, shows part of a valve that is manufactured in several sizes. In this exercise,
you scale both views to represent a different-size valve piece. Ensure OSNAP is on. Set
running object snaps for quadrant and endpoint.

Figure 9-9: The valve piece in two views.
Thanks to Jerry Bottenfield of Clow Valve Company,
Oskaloosa, lowa, for this drawing.

Choose Scale from the Modify toolbar. At the Select objects: prompt, pick

i.il both circles in the top view (they’re actually arcs because they’re broken at the
bottom) and the two short lines at the bottom of the circles. Press Enter to end object
selection. Follow the prompts:

Specify base point: Use the Quadrant object snap to pick the left
quadrant of the inner circle.

Specify scale factor or [Referencel: Right-click and choose
Reference.

Specify reference length <1>: Use the Quadrant object snap to pick
the left quadrant of the inner circle again.

Specify second point: Use the Quadrant object snap to pick the right
quadrant of the inner circle.

Specify new length: 1 J

Because the distance between the two quadrants you chose is 2.5 units, the SCALE
command scales the objects to 40 percent (1 divided by 2.5).

4. Right-click and choose Repeat Scale. Select all eight lines in the bottom view including
the green dashed lines. Be sure that you see 1 found each time. If necessary, use ZOOM
Window to zoom in. Right-click to end object selection after you finish selecting the
lines. Follow the prompts:

Specify base point: Use the Endpoint object snap at point @ 1in
Figure 9-9.
Specify scale factor or [Referencel: .4 4

5. Save your drawing. It should look like Figure 9-10.
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Figure 9-10: The valve piece has now been scaled down.

O

T 7

Using the CHANGE command

The CHANGE command changes the endpoint of a line and the radius of a circle. This com-
mand can also be used to change text (see Chapter 13) and the location of blocks (covered
in Chapter 18), but other newer commands do the job better. You can also use grips and the
Properties palette, both covered in the next chapter, to change line endpoints and circle radii
(among other object properties).

To change an object, select it and type change .J on the command line. Alternatively, type
change ./ on the command line and select the object.

Caution The CHANGE command works differently depending on whether you select lines or circles.
For this reason, it can give unexpected results if you choose lines and circles at the same time.
Use the command for either lines or circles but not for both at once.

Changing lines

If you select one line, the CHANGE command changes the endpoint closest to where you
picked the line. The command prompts you for a change point. When you pick the point, the
command brings the endpoint of the line to that change point, as shown in Figure 9-11. You
can use an object snap to specify the change point. If ORTHO is on, the line becomes orthogo-
nal, bringing the endpoint of the line as close as possible to the change point you specify, as
shown in Figure 9-11.

Original line

,— Change point

—New line with ORTHO off
— New line with ORTHO on

Figure 9-11: Using the CHANGE command on one line.
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If you select more than one line, CHANGE works differently —it moves the nearest endpoints of
all the lines to the change point so that all the lines meet at one point, as shown in Figure 9-12.

Change point

Figure 9-12: Using the CHANGE command on
several lines. The original lines are shown as
continuous. The new lines, after using the
CHANGE command, are dashed.

Changing circles

Changing the radius of a circle has the same result as scaling it. When you select a circle, the
command prompts you for a change point. If you pick one, AutoCAD or AutoCAD LT resizes
the circle so that it passes through the new point. You can also press Enter. You then get a
prompt to enter a new radius.

If you select more than one circle, the command moves from circle to circle, letting you spec-
ify a new radius for each, one at a time. You can tell which circle is current because of its drag
image, which lets you drag the size of the circle.

If you select more than one circle and try to pick a change point, the command responds with
Change point ignored. At that point, one circle becomes active, and you can then pick a
change point.

Selecting Objects

If you've been following through this chapter’s exercises, you’'ve probably thought it tedious
to pick several objects one at a time. Imagine trying to individually pick every object in a
drawing just to move all the objects one-half unit to the left! Of course, there is a better way.
In fact, AutoCAD and AutoCAD LT offer many ways of selecting objects.

Selected objects are also called the selection set of objects.

Selecting objects after choosing a command

When you choose an editing command, you see the Select objects: prompt. This prompt
has 16 options —all you could ever want for selecting objects —but these options are not
shown on the command line. To specify an option, type the option abbreviation. Because the
Select objects: prompt repeats until you press Enter, you can combine options to select
objects for any command.
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In the following list of options, the capitalized letters of the option are the abbreviation you
type (uppercase or lowercase letters work) at the Select objects: prompt.

4+ Window: The Window option lets you pick two diagonal corners that define a window.
All objects entirely within the window are selected. Figure 9-13 shows the process of
picking the window. Figure 9-14 shows the result —the selected objects are highlighted
by appearing with dashed instead of continuous lines.

Tip You can drag past the edge of the screen (actually the viewport) to specify a window. Hold

), down the mouse button and continue to move the mouse in the same direction. The display

/7 automatically pans so that you can see objects that were off the screen. When you see all the
objects you need to select, pick the second corner of the window.

Selection window

—

R

oY

Bl [H
— [ ] —— [ | —
Figure 9-13: Selecting objects with a window. The window selects only objects
that lie entirely within the window.

Selecte;j\objects
A -
\

Y

) Y B —
— [ ] R — oA —

Figure 9-14: The selected objects are highlighted.
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4+ Last: The Last option selects the last object that was created and is visible within the
current view. Often you create an object and then want to move or copy it. In this situa-
tion, the Last option is an easy way to select the object that you just created.

4+ Crossing: Crossing enables you to pick two diagonal corners that define a window.
All objects entirely or partly within the window are selected. Figure 9-15 shows the
process of picking the window. Figure 9-16 shows the result —the selected objects
are highlighted.

Tip You can drag past the edge of the screen (actually the viewport) to specify a crossing window.
Hold down the mouse button and continue to move the mouse in the same direction. The
“4 display automatically pans so that you can see objects that were off the screen. After you see

all the objects you need to select, pick the second corner of the crossing window.

Crossing window

—

— [ ] — [ —
Figure 9-15: Selecting objects with a crossing window. The crossing window
selects any objects that lie within or partly within the window.

—

R

1

Selected gbjects i

) Y B —
— [ ] R — oA —

Figure 9-16: The selected objects are highlighted.
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4+ BOX: BOX is a combination of Window and Crossing. If you pick the two window cor-
ners from left to right, the selection functions as if you used the Window option. If you
pick the two points from right to left, the selection functions as if you used the Crossing
option. By default, you can select objects this way without specifying the BOX option.
See the description of implied windowing later in this chapter.

4+ ALL: The ALL option selects all objects on thawed and unlocked layers in the drawing.
(I discuss layers in Chapter 11.) Use the ALL option when you want to select every-
thing, including objects that you can’t currently see on the screen.

4+ Fence: The Fence option enables you to specify a series of temporary lines to select
any object crossing the lines. Figure 9-17 shows the process of defining a selection
fence. Figure 9-18 shows the result —the selected objects are highlighted.

4+ WPolygon: The Window Polygon option (WPolygon) is like Window except that you
create a polygon instead of a rectangular window. This option selects all objects that lie

entirely within the polygon.

i

=

Fence
1 B [H NI
— [ ] — — [N | —

Figure 9-17: Using a fence to select objects.

Selected objects

1 BT W B
— [ [~ —— [ —

Figure 9-18: The selected objects are highlighted.
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Tip

4+ CPolygon: The Crossing Polygon option (CPolygon) is like Crossing except that you
create a polygon instead of a rectangular window. This option selects all objects that lie
entirely or partly within the window.

4 Group: The Group option selects a named group of objects. (Chapter 10 covers groups.)
If you need to work regularly with a certain set of objects, you can place them in a group
and then easily select them with one click.

4+ Remove: The Remove option enables you to deselect objects. After you use this option,
all objects you select are deselected and are therefore removed from the selection set.
Use the Add option to once again select objects.

An alternative to using Remove to deselect objects is to press Shift and deselect objects by
'Y picking or implied windowing. Implied windowing is discussed later in this chapter.

4 Add: The Add option sets the selection mode to add options to the selection set. Use
Add after using Remove to start selecting objects again.

4 Multiple: The Multiple option turns off highlighting as you select objects. However, you
cannot visually determine which objects are in the selection set.

4+ Previous: Previous automatically selects all objects you selected for the previous com-
mand. Objects selected and edited by using grips are not remembered for this option.
(The next chapter covers grips.)

4+ Undo: Undo deselects the object(s) selected at the last Select objects: prompt.
(If you removed objects from the selection set at the last Select objects: prompt,
Undo reselects them.)

4+ AUto: AUto combines picking with the BOX option. By default, you can select objects
this way without specifying this option. See the description of implied windowing later
in this chapter.

4 Single: When you specify this option, you get another Select objects: prompt. You
select objects by using any option, and then AutoCAD immediately ends the selection
process. You don’t have to press Enter.

4+ CLass: CLass allows you to select certain objects that were created in another applica-
tion. Certain applications, such as Autodesk Map, can add a feature classification to an
object. Doing so creates an associated classification (XML) file. If you have such an
object and the XML file is present, you can select objects by classification property.
(AutoCAD only.)

Cycling through objects

It may happen that you have many objects close together in a drawing, making it hard to
select the object or point you want. You could always zoom in, but in a complex drawing this
can take quite a bit of time. Another trick is to use object cycling. At the Select objects:
prompt, hold down Ctrl and pick at the area where more than one object overlaps. The com-
mand line displays the <Cycle on> message. One object is highlighted. If it is not the one you
want, continue to hold down Ctrl and pick. AutoCAD or AutoCAD LT cycles through the objects.
After you have the one you want, release Ctrl. Press Enter to turn object cycling off. You can
continue to select other objects or end object selection by pressing Enter.
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Selecting objects before choosing a command

If you select objects before choosing a command, your options are more limited than if you
choose a command first. Nevertheless, you have enough flexibility for most situations. The
reason for the limitation is that the Command: prompt is active and anything you might type
at the keyboard to indicate a selection option could be confused with a command. You can
pick the object to highlight it, use implied windowing, or use the SELECT command to select
objects in advance.

The purpose of the SELECT command is simply to select objects. This command then saves
these objects for use with the Previous selection option. Choose an editing command and
type p - at the Select objects: prompt to select the objects you selected with the SELECT
command.

Implied windowing

Implied windowing is equivalent to the Auto selection option listed earlier in this chapter.
By default, implied windowing is always active. As a result, implied windowing is useful for
selecting objects before or after choosing a command. By carefully choosing which way you
create a selection window, you determine how you selects objects:

4+ From right to left: If the first window corner is to the right of the second one, you create
a crossing window. The crossing window selects all objects that lie entirely or partially
within the window.

4+ From left to right: If the first window corner is to the left of the second one, you create
a regular selection window. The window selects all objects entirely within the window.

You can drag past the edge of the screen (actually the viewport) to specify a window. Hold
) down the mouse button and continue to move the mouse in the same direction. The display

/7 automatically pans so that you can see objects that were off the screen. After you see all the

objects you need to select, pick the second corner of the window.

\ The drawing used in the following Step-by-Step exercise on selecting objects, ab09-e . dwg,
is in the Drawings folder on the CD-ROM.

STEP-BY-STEP: Selecting Objects
1. Open ab09-e.dwg from the CD-ROM, as shown in Figure 9-19.

2. Save the file as ab09-07.dwg in your AutoCAD Bible folder. Make sure that OSNAP is
on. Set running object snaps for endpoint and perpendicular.

3. Draw a line from @ to @ in Figure 9-19. You will use this later to illustrate the Last
selection option.

4. Type select ..

5. To select the six-burner stovetop, pick a point near @), being careful that the pickbox at
the intersection of the crosshairs doesn’t touch any object. Transparently zoom in and
back out if necessary. Then move the mouse to @ and pick again. The objects chosen
appear dashed to indicate that they have been selected.
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Q-

Figure 9-19: A kitchen floor plan.

6. To select the last object created, the line drawn in Step 1, type 1 ... It now appears
dashed.

7. Turn off OSNAP. To select the interior lines on the kitchen'’s island by using a fence,
type f .. Then pick points @, @, and @. Press Enter to end the fence.

8. Typer J at the Select objects: prompt (the prompt changes to Remove objects:)
and pick the line at @ to remove the external island line picked in Step 7. At this point,
all the selected items should be dashed, as shown in Figure 9-20.

Figure 9-20: Kitchen floor plan with all
selected items shown dashed.
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9. Press Enter to complete the command.

10. Turn on OSNAP. Start the MOVE command. At the Select objects: prompt, type p <
and then press Enter again to end object selection. At the Specify base point or
displacement: prompt, pick the endpoint at @ in Figure 9-20. At the Specify second
point of displacement or <use first point as displacement>: prompt, pick
the endpoint at ). All the objects move.

11. Save your drawing.

Customizing the selection process

You can customize the way you select objects. To do so, choose Tools => Options and click the
Selection tab, as shown in Figure 9-21.

E] Options (2%
Current profile: ellen Current drawing: fg9-1.dwg
Files | Display | Open and Save || Plotting | System | User Preferences | Drafting | Selection | Profiles
Pickbox Size Grip Size
- J . J
Selection Modes Grips
MNoundverb selechion Unzelected grip calar:
[[] Use Shift to add to selection [ Color 160 w
L Press and drag Selected grip color:
Imn.lied wimda.wimg B Fed -
Obijgct grouping
[ Associative Hatch Haver grip color:
[ Green v
Enable arips
[[] Enatle grips within blocks
Enable grip tips
100 Obiject selection limit for dizplay of grips

Figure 9-21: The Selection tab of the Options dialog box.

Noun/verb selection

As you already know, the editing process consists of two parts —using a command, such as
COPY or MOVE, and selecting objects. In AutoCAD/AutoCAD LT lingo, noun means an object
in your drawing. Verb refers to a command, because a command acts on an object. This option
lets you decide whether you want to be able to select objects before starting a command.

In Windows programs, you typically select objects before starting a command. For example, if
you’re using Microsoft Word and want to erase a sentence, you select the sentence first, and

then press Del.
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By default, noun/verb selection is available, as shown in the first option in the Selection
Modes section of the Selection tab in Figure 9-21. With this option enabled, you can select
objects first —without giving up the ability to choose commands first. This gives you maxi-
mum flexibility.

The advantage of selecting objects first is that, when you switch between Windows programs,
you don’t have to change habitual ways of selecting objects. The disadvantage of selecting
objects first is that some AutoCAD and AutoCAD LT commands don’t let you select objects
first, which can be confusing. Also, when you select objects first, grips appear — sometimes
obscuring the objects you need to select.

Use Shift to add to selection

Use Shift to Add to Selection is the second option on the Selection tab of the Options dialog
box. By default, this option is not checked. In AutoCAD and AutoCAD LT, you often select
more than one object at a time for editing. Therefore, the default is to simply let you select
object after object —when you select a second object, the first object stays selected —so
that you can easily select any number of objects you want.

However, Windows programs typically enable you to select only one object at a time. To
select multiple objects, you need to hold down Shift as you select. Similarly, if you check the
Use Shift to Add to Selection option, after selecting one object, you must hold down Shift to
select any additional object.

Press and drag

One of the ways to select objects is to create a window that includes a number of objects.
You're already familiar with creating a similar window from using ZOOM with the Window
option. If the Press and Drag option is checked, you need to pick at one corner of the window
and, without releasing the pick button, drag the cursor to the diagonally opposite corner.
This type of action is typical of Windows programs.

By default, this option is not checked, which means that to create a window you pick at one
corner of the window, release the mouse button, and pick again at the diagonally opposite
corner.

This setting does not affect ZOOM Window, which always requires two separate picks.

Implied windowing

By default, this option is on. Implied windowing means that, if you pick any point not on an
object, AutoCAD or AutoCAD LT assumes you want to create a selection window. You can
then pick the opposite corner to select objects. If you pick the corners from right to left, you
get a crossing window. If you pick the corners from left to right, you get a standard selection
window. If implied windowing is not on when you pick a point not on an object, the program
assumes you missed some object and gives you this message on the command line:

0 found

This option applies only when you have started a command and see the Select objects:
prompt. If you turn this option off, you can still enter the Crossing or Window selection options
manually (by typing ¢ 4 or w ). When selecting objects before starting the command, implied
windowing is always on.
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Commands and object selection

Certain commands require you to choose objects in a specific order or require objects that have
a certain relationship to each other. For example, the TRIM command (covered in the next chap-
ter) requires that you first select an object to trim to (the cutting edge), and then the object to
trim. If you selected the objects in advance, the program wouldn't know which object to trim.
Only after you start the TRIM command does AutoCAD or AutoCAD LT know to prompt you
exactly for the objects it needs to complete the command. Other commands require that you
select objects that are related in some way. The FILLET command (also covered in the next chap-
ter) joins objects that meet — or would meet if extended — by drawing an arc to create a rounded
corner. Here again, the command would be meaningless if, say, you selected three or more
objects, so the command requires that you use the command first and then specifically prompts
you to select the first object and then the second object.

Many commands allow you to select objects first, but the following are some of the most
common:

4+ ARRAY 4+ ERASE 4+ MOVE

4+ BLOCK 4+ EXPLODE 4+ ROTATE
4+ CHANGE + HATCH 4+ SCALE

4+ CHPROP 4 LIST 4 STRETCH
+ COPY 4+ MIRROR 4+ WBLOCK
+ DVIEW

These commands enable you to select any number of objects without restriction, so that select-
ing the objects first and the command second works well.

Object grouping

Creating groups of objects is discussed in the next chapter. Groups are sets of objects that
you name. If object grouping is on (the default) when you select one object in a group, all the
objects in a group are automatically selected. Object grouping is a global setting; you can also
set object grouping on or off for individual groups.

Associative hatch

If checked, Associative Hatch selects boundary objects when you select a hatch within the
boundary. This option is off by default. Checking this option is equivalent to setting the PICK-
STYLE system variable to 2. Chapter 16 covers hatches.

Pickbox size

In Chapter 4, you read about the aperture, which is the little box at the crosshairs that you use
to pick object snaps, such as endpoint or intersection. The pickbox is the box that you see at
the intersection of the crosshairs when selecting (or picking) objects. The Pickbox Size area
lets you set the size of the pickbox.
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Note If Noun/Verb Selection is off and grips are disabled, no pickbox appears at the intersection of
~  the crosshairs until you start an editing command and the command line displays the Select
objects: prompt. However, if either Noun/Verb Selection or grips are on, the pickbox is

always at the crosshairs, letting you select objects at any time.

Summary

All drawings need to be edited, either as part of the drawing process or to make corrections.
In this chapter, you read about:

4+ Erasing objects
4+ Moving objects
4+ Copying objects
4+ Rotating objects
4+ Scaling objects
4 Using the CHANGE command on lines and circles
4+ The many ways of selecting objects
4+ Customizing the object-selection features
The next chapter covers the more-advanced editing commands and options.
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Editing
Your Drawing:
Advanced Tools

This chapter completes the discussion of geometric editing com-
mands — covering the more-complex commands used to refine
the details of your drawing. I also discuss grips, which make it easy
to move, mirror, rotate, scale, and stretch objects. I explain how to
use the Properties palette to edit objects. I end the chapter with a
discussion of three ways to control the selection of objects — groups,
filters, and the Quick Select feature.

Copying and Moving Objects

Three commands enable you to copy objects in very specific ways.
MIRROR creates a mirror image. ARRAY copies objects in a rectangular
or circular pattern. OFFSET creates parallel objects. Although these
commands make copies of objects, they produce a result that would
be difficult or impossible to produce simply by using the COPY com-
mand. The ALIGN command moves objects by aligning them with
other objects in the drawing.

Using the MIRROR command

Many drawings have symmetrical elements. Often, especially in
mechanical drawing, you can create one-half or one-quarter of a
model and complete it simply by mirroring what you have drawn.

| To mirror, select an object or objects and then choose Mirror
Al from the Modify toolbar. Alternatively, choose Mirror from the
Modify toolbar and then select an object or objects.

The command prompts for the first and second points of the mirror
line. This is an imaginary line across which the command creates the
mirrored object. The length of the line is irrelevant — only its start
point and direction are important.

C HHA P T E R

¢+ 4+ 0+
In This Chapter

Using advanced
copying commands:
MIRROR, ARRAY,
and OFFSET

Using advanced resizing
commands: TRIM,
EXTEND, STRETCH,
and LENGTHEN

Using construction
commands: BREAK,
CHAMFER, and FILLET

Creating a revision
cloud and a wipeout

Double-licking to edit
objects

Editing objects
with grips and the
Properties palette

Using selection filters
and Quick Select

Creating groups
of objects

+ 0+ o+
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Tip

s

Most mirror lines are orthogonal. Therefore, after you specify the first mirror point, turn on
ORTHO and move the mouse in the direction of the second point. You can then quickly pick
the second point. Polar tracking can also easily guide you to specify an orthogonal mirror line.

The command then asks if you want to delete the source objects. The source objects are the
objects you have selected to mirror. If you want to keep them, type n J or press Enter. You
keep the source objects when you're building a symmetrical model and want the mirror image
to be added to the original object(s). Type y 1 when you want to edit an object (change its
orientation) so that only the mirror image is retained in the drawing.

On the |

| cn |

L

e

\

The drawing used in the following Step-by-Step exercise on mirroring objects, ab07-02 . dwg,
is in the Results folder on the CD-ROM.

STEP-BY-STEP: Mirroring Objects

1.

Open ab07-02.dwg from the Results folder of the CD-ROM. If you completed the exer-
cise on arcs in Chapter 7, you can open this drawing from your AutoCAD Bib1e folder.

. Save the file as ab10-01.dwg in your AutoCAD BibTe folder. Make sure OSNAP is on.

Set a running object snap for intersections only.

. Choose Erase on the Modify toolbar. At the Select objects: prompt, pick the line and

two arcs to the bottom-right of the two centerlines and then press Enter. The resulting
model should look like Figure 10-1.

. .ﬂlﬁ Choose Mirror from the Modify toolbar. At the Select objects: prompt, pick

the remaining exterior line and two arcs and press Enter.

. At the Specify first point of mirror line: prompt, pick the intersection @ in

Figure 10-1. At the Specify second point of mirror line: prompt, pick the inter-
section @.

o () o
.

Figure 10-1: A partially completed mounting plate

. The command prompts: Delete source objects? [Yes/No] <N>: Press Enter to

accept the default, No.

. Again choose Mirror from the Modify toolbar. At the Select objects: prompt, type

p - to pick the original lines. Then pick the new exterior line and two arcs and then
press Enter.
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8. At the Specify first point of mirror line: prompt, pick the intersection @. At
the Specify second point of mirror Tine: prompt, pick the intersection €. Press
Enter again at the Delete source objects? [Yes/No] <N>: prompt.

9. The command completes the mounting plate. Save your drawing. It should look like
Figure 10-2.

SN

Figure 10-2: The completed mounting plate.

Using the ARRAY command

The ARRAY command creates a rectangular or circular (polar) pattern by copying the object(s)
you select as many times as you specify. The ARRAY command is a powerful drawing tool. It
can quickly create large numbers of objects —saving a huge amount of time and effort.

Rectangular arrays
A rectangular array creates a grid of rows and columns of one or more objects. Figure 10-3
shows an example of a rectangular array. To create a rectangular array, follow these steps:

1. g Select the object or objects and choose Array from the Modify toolbar.
OO Alternatively, choose Array from the Modify toolbar and select the object
or objects. The Array dialog box opens, as shown in Figure 10-4.

¢ ¥

Figure 10-3: The garage door was drawn with one panel, as shown on the
left side. A rectangular array created the rest of the door panels, as shown
on the right.

Thanks to Henry Dearborn, AlA, Fairfield, lowa, for this drawing.
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i Array zd
(%) Rectangular &mray () Polar Anay Select objects
1 objects selected
Rows: 4 Columng: 4
Offzet distance and direction
cooo
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Riow offset: 1.0000 Sooo
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Colum offset: 1.0000
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i
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Figure 10-4: The Array dialog box.

. Click Rectangular Array at the upper-left corner of the dialog box (if it is not already

selected).

. If you've already selected one or more objects, the dialog box indicates the number of

selected objects. If you haven’t selected any object, click Select Objects to return to
your drawing and select objects. Press Enter to end object selection and return to the
dialog box.

. Type the number of rows and columns you want in the Rows and Columns text boxes.

Press Tab after the last number you type to see the new result in the preview panel.

. Type the row offset (the distance between the rows). The preview panel doesn’t display

any change when you change the row or column offsets.

. Type the column offset (the distance between the columns).

. If you want to specify the offsets by picking points on your screen, click one of the fol-

lowing buttons:

. Pick Both Offsets

. —)ﬂ- Pick Row Offset
. _,ﬂ Pick Column Offset

If you want to change the angle of the array, type an angle. The preview panel dis-
plays the results of this value. To specify the angle by picking, click the Pick Angle
of Array button.

. To preview the array, click Preview. Then choose Accept to create the array, Modify to

return to the Array dialog box, or Cancel to end the command.

To create the array, click OK.

If you change the Snap angle or the UCS (as explained in Chapter 8), AutoCAD and AutoCAD
LT create the rectangular array at the angle of the snap or UCS.
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If you need to create a number of copies of an object along a straight path, use a one-column
or one-row array instead of the COPY command. It's faster and easier.

Polar (circular) arrays
A polar array creates copies of one or more objects arrayed in a circle around a center point.
An example of a polar array is shown in Figure 10-5.

Figure 10-5: The pulley was drawn with one spoke, as shown on the
left. A polar array created the additional spokes.
Thanks to Robert Mack of the Dexter Company, Fairfield, lowa, for this drawing.

To create a polar array, follow these steps:

1.

OO Select the object or objects and choose Array from the Modify toolbar.
OO0 Alternatively, choose Array from the Modify toolbar and select the object
or objects. The Array dialog box opens.

. Click Polar Array at the top of the dialog box (if it is not already selected).

. If you've already selected one or more objects, the dialog box indicates the number of

selected objects. If you haven’t selected any object, click Select Objects to return to
your drawing and select objects. Press Enter to end object selection and return to the
dialog box.

. _,ﬂ Specify the center point by typing X and Y coordinates or click the Pick Center

Point button. If you selected an object first, check that the center point displayed
is what you want.

. Select the two items that you want to specify from the Method drop-down box. You can

choose any two from the three choices:

¢ Total Number of Items: Sets the total number of items in the resulting array,
including the one you're arraying.

¢ Angle to Fill: Sets the number of degrees the polar array covers. For example, to
array around half a circle, specify 180°.

¢ Angle Between Items: Specifies the number of degrees between each item in the
polar array.
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6. Complete the values of the two items you specified. You can click the buttons to pick
the angle to fill or the angle between items on the screen.

7. Check the Rotate Items as Copied check box to rotate the objects that you're arraying.
Uncheck the box to leave them unrotated.

8. Click Preview to preview the array. Then choose Accept to create the array, Modify to
return to the dialog box or Cancel to cancel the command.

9. Click OK to create the array.

You can specify which point on the last object selected AutoCAD and AutoCAD LT uses to
array the objects. The command makes a calculation of the distance from the center point of
the array to a base point on the last object selected. Otherwise, the command uses a default
point based on the type of object selected. Table 10-1 lists the default base points. If you're
arraying more than one object, you may not get the result you want without specifying the
base point. Even for one object, you may want to change the base point used.

To specify the base point, click the More button at the bottom of the dialog box. The dialog
box opens up to display the Object Base Point section. Uncheck Set to Object’s Default and
either type in coordinates or, more likely, click the Pick Base Point button and use an object
snap to pick the desired point on an object. The preview box adjusts according to your choice
but, because the preview only shows rectangles in the place of your object, the display may
not be very helpful.

You can use the Express Tools COPYM command to enhance your copying options. Choose

Au(t]o(I:AD Express > Modify => Multiple Copy. You can create evenly spaced copies between two points,
nly

V

copy objects according to a specified measurement, and create arrays. For information on
installing the Express Tools, see Appendix A.

Table 10-1: Object Base Points for Arrays

Type of Object Default Base Point
Arc, circle, or ellipse Center point
Polygon or rectangle First corner

Line, polyline (2D or 3D), ray, spline, or donut Starting point

Text (single-line or paragraph), block Insertion point
Construction line (xline) Midpoint

Region Grip point

The drawing used in the following Step-by-Step exercise on arraying objects, ab10-a.dwg,
is in the Drawings folder on the CD-ROM.

STEP-BY-STEP: Arraying Objects
1. Open ab10-a.dwg from the CD-ROM.
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11.

12.

13.

14.
15.
16.
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Save the file as ab10-02.dwg in your AutoCAD BibTe folder. It looks like Figure 10-6.
OSNAP should be on. Set center and intersection running object snaps.

> O

‘e | ‘o

Figure 10-6: A partially completed mounting bracket.

. OO Choose Array on the Modify toolbar. The Array dialog box opens.

oo

. Click the Select Objects button of the Array dialog box. In the drawing, pick the hori-

zontal centerline @ in Figure 10-6 and then press Enter. You return to the dialog box.

. Make sure that Rectangular Array is selected at the top of the dialog box.
. In the Rows text box, type 4. In the Columns text box, type 1.

. In the Row Offset text box, type 1. (You don’t need to specify the column offset because

you are only creating one column.)

. Click Preview. You should see a total of four horizontal lines, as shown in Figure 10-7.

Click Accept in the small dialog box that appears. (If you don’t see the four lines, click
Modify and recheck the settings in the Array dialog box.)

. To add the holes to the pattern, again choose Array from the Modify toolbar.
10.

Click the Select Objects button in the Array dialog box. In the drawing, pick the circle @
in Figure 10-6 and then press Enter.

Back in the Array dialog box, type 4 in the Rows text box and type 2 in the Columns
text box.

m Click the Pick Both Offsets button. In the drawing, pick the center of circle @ and
the intersection of centerlines near @ in Figure 10-6. (You can also pick the inter-
section of centerlines at the center of circle @. If necessary, press Tab until you get the

object snap that you want.)

Click Preview to preview the array. If the circles look like Figure 10-7, click Accept.
Otherwise, click Modify and check your settings. After you're done, the command
arrays the holes to fit the centerlines.

To create a six-hole bolt circle, pick the hole @ in Figure 10-6.
Choose Array from the Modify toolbar.

In the Array dialog box, choose Polar Array.
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17. Next to the Center Point text boxes, click the Pick Center Point button. In the
& drawing, pick the center of the large circle at @ in Figure 10-6.

18. The Method should read "Total number of items and Angle to fill."Inthe
Total Number of Items text box, type 6. In the Angle to Fill text box, type 360.

19. Click Preview to see the array. It should look like Figure 10-7. If it does, click Accept.
Otherwise, click Modify and recheck the settings in the Array dialog box. AutoCAD
or AutoCAD LT completes the mounting bracket.

20. Save your drawing. It should look like Figure 10-7.

=+
T o e
MR SR
b4

Figure 10-7: The completed mounting bracket.

Offsetting objects

The OFFSET command creates lines or curves parallel to one existing object. The beauty of
this command is apparent when you start to create complex objects, such as polylines, cov-
ered in Chapter 16. Polygons and rectangles are polylines, which means they’re treated as one
object. Using OFFSET, you can create concentric polygons, for example, in one step. Figure 10-8
shows two concentric polygons. The outside polygon was created with the POLYGON com-
mand, and the inside polygon was created by using OFFSET.

Figure 10-8: Use OFFSET to create concentric polygons.

@ To offset an object, choose Offset from the Modify toolbar. You cannot select objects
before choosing the command.

The command responds with the Specify offset distance or [Throughl <1.0000>:
prompt. OFFSET offers two slightly different ways to specify the offset:
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4+ If you type an offset distance, the command responds with the Select object to
offset or <exit>: prompt. You can select one object. Then the Specify point on

side to offset: prompt appears. Pick a point to indicate on which side of the object

you want to create the offset copy. The command creates the offset and continues to

show the Select object to offset or <exit>: prompt so that you can offset other

objects by using the same offset distance. Press Enter to exit the command.

4+ If you want to indicate a through point (a point that the offset passes through, such
as an object snap on another object), type t J or right-click and choose Through from
the shortcut menu. Then the command displays the Select object to offset or
<exit>: prompt. Pick one object. At the Specify through point: prompt, pick a
point through which you want the offset to go to create the offset.

Use the Express Tools EXOFFSET command for expanded offset options. You can specify the
layer of new objects and create multiple offsets. Choose Express => Modify &> Extended Offset.
For information on installing Express Tools, see Appendix A.

The drawing used in the following Step-by-Step exercise on using the OFFSET command,
ab10-b.dwg, is in the Drawings folder on the CD-ROM.

STEP-BY-STEP: Using the OFFSET Command
1. Open ab10-b.dwg from the CD-ROM.

2. Save the file as ab10-03.dwg in your AutoCAD Bib1e folder. It looks like Figure 10-9.
Set a running object snap for center and turn on OSNAP.

3. Choose Offset on the Modify toolbar. Follow the prompts:

Specify offset distance or [Through] <Through>: 4

Select object to offset or <exit>: Pick 1) in Figure 10-9.
Specify through point: Pick the center of @.

Select object to offset or <exit>: 4

This action copies the centerline through the upper circles.

®) %
.

f_\o\_ _
e )

Figure 10-9: A tension arm for a commercial dryer.
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4. Choose Offset from the Modify toolbar again. At the Specify offset distance or
[Through] <Through>: prompt, type 4-19/64 .I. Pick the centerline @) at the Select
object to offset or <exit>: prompt, and near @) at the Specify point on side
to offset: prompt. Press Enter to end the command. The vertical centerline appears
4-19/64 units to the right of the original.

5. Save your drawing. It should look like Figure 10-10.

N N
Y e— 0

Figure 10-10: The completed tension arm.

Aligning objects

The ALIGN command lets you move and rotate an object or objects in one procedure. It is
especially useful in 3D work. By specifying which points on an object move where, you can
align the object with other objects in your drawing, as shown in Figure 10-11. See Chapter 24
for the use of the ALIGN command in 3D editing.

1st source point

1st destination point

2nd destination point
2nd source point

Before After
Figure 10-11: Aligning a door with a wall.



A

AutoCAD

CD

Only

A4

Chapter 10 4+ Editing Your Drawing: Advanced Tools

AutoCAD LT doesn't include the ALIGN command. Instead, you would need to use a combi-
nation of the MOVE and ROTATE commands. The Reference option of the ROTATE command
would be helpful to align objects. I discuss the MOVE and ROTATE commands in Chapter 9.

Aligning requires several steps. Even so, it can save time when you need to move and rotate
at the same time, especially if you don’t know the rotation angle that you need. To align an
object, choose Modify = 3D Operation = Align and select an object or objects. Alternatively,
select the object or objects first and then choose Modify = 3D Operation => Align. Then follow
these steps:

1.

On tew"\

The prompt asks for the first source point. Specify a point, usually an object snap on
the object that you want to move.

. The prompt asks for the first destination point. Specify the point where you want the

first source point to end up.

. The prompt asks for the second source point. If you press Enter, AutoCAD simply

moves the selected objects. To continue to align, specify another point, usually an
object snap on the object that you want to move.

. The prompt asks for the second destination point. Specify the point where you want

the second source point to end up.

. The prompt asks for the third source point. You use this for 3D alignment, to specify

how you want to rotate the object in the third dimension. For 2D alignment, press Enter
to continue the command.

. The prompt displays the Scale objects based on alignment points? [Yes/No]

<N>: prompt. If the distances between the source and destination points are not the
same, type y if you want to scale the original object so that the source and destination
points match exactly.

The drawing used in the following Step-by-Step exercise on aligning objects in two dimen-
sions, ab10-c.dwg, is in the Drawings folder on the CD-ROM.

STEP-BY-STEP: Aligning Objects in Two Dimensions

1.
2.
3.

Open abl0-c.dwg from the CD-ROM.
Save the file as ab10-04.dwg in your AutoCAD Bible folder. It looks like Figure 10-12.
Choose Modify = 3D Operation => Align and follow the prompts:

Select objects: Select the horizontal angle by using a window,
picking near @ then @. Press Enter to end object selection. This
angle needs to be aligned with the long, diagonal support angle.
Specify first source point: Pick the endpoint at @ in Figure 10-12.
Specify first destination point: Pick the endpoint at @

Specify second source point: Pick the endpoint at @.

Specify second destination point: Pick the endpoint at @

Specify third source point or <continue>: 4

Scale objects based on alignment points? [Yes/No] <N>: 4
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This action aligns the horizontal angle with the support angle.
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Figure 10-12: A base assembly for a commercial washing machine.
Thanks to Robert Mack of the Dexter Company, Fairfield, lowa, for this drawing.

4. Save your drawing. It should look like Figure 10-13.
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Figure 10-13: The washing machine base.
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Resizing commands

Four additional commands resize objects. The TRIM and EXTEND commands bring the end-
point of an object to another object. LENGTHEN lets you lengthen or shorten a line, polyline,
arc, or elliptical arc. STRETCH is used to stretch (larger or shorter) a group of objects, letting
you change their direction at the same time.

Trimming objects

As you edit a drawing, you may find that lines or arcs that once perfectly met other objects
now hang over. To trim an object, you must first specify the cutting edge, which defines the
point at which to cut the object you want to trim. You define the cutting edge by selecting an
object. You can select several cutting edges and several objects to trim at one time, as shown
in Figure 10-14. When you select an object to trim, you must pick the object on the side that
you want trimmed (not on the side that you want to remain). A common use for the TRIM
command is to create intersections of walls in architectural floor plans.

While using the TRIM command, you can switch to extending objects by pressing the Shift key

) as you select objects to trim.

< <

.
Cutting Edges

)
/L

Pick points

on lines - -

Before trimming After trimming
Figure 10-14: Trimming two objects by using two cutting edges.

Generally, you pick the objects to be trimmed individually. You cannot use Windows to select
,.  them.However, you can use the Fence object-selection method. The command trims the side
7 of the object that the fence line crosses. You can also press Enter at the Select cutting
edges: prompt. Then, when you select the objects you want to trim, AutoCAD or AutoCAD
LT automatically uses the cutting edge nearest your pick point. You can use this feature to
trim to multiple cutting edges without having to specify each cutting edge.

The object you want to trim does not have to actually intersect the cutting edge. You can trim
an object to a cutting edge that would intersect the object if extended. This is called trimming
to an implied intersection, shown in Figure 10-15.

You can trim arcs, circles, ellipses, elliptical arcs, lines, polylines, xlines, rays, and splines.
You can use polylines, arcs, circles, ellipses, elliptical arcs, lines, rays, regions, splines, text,
or xlines as cutting edges. An object can be used as both a cutting edge and an object to be
trimmed in the same trimming process. You can also trim to objects within blocks. (Chapter 18
covers blocks.)
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Pick points on arc

Before trimming After trimming
Figure 10-15: Trimming two arcs to an implied intersection.

e To trim an object, choose Trim from the Modify toolbar. You cannot select objects

before starting the TRIM command. The command displays the Current settings:
Projection=UCS, Edge=None Select cutting edges . . . Select objects: prompt.
The prompt lets you know the values of the two system variables that affect trimming. The
Projection setting is used only for 3D models. The Edge setting is used for implied intersections.
When Edge is set to Extend, the command trims to the implied intersection of the cutting edge
and the object to be trimmed. At this prompt, pick the object(s) that you want to use as a cut-
ting edge. Press Enter to end object selection.

If the object you want to use for the cutting edge is already selected before you start the TRIM
), command, the command deselects it. At the Select cutting edges . . . prompt, you
/ can type p I to reselect that object.

You can trim to an actual or an implied intersection (an intersection that would exist if
objects were extended):

4+ If you want to trim to an actual intersection, at the Select object to trim or
shift-select to extend or [Project/Edge/Undo]: prompt, select objects to
trim. Be sure to pick each object between the cutting edge and the end you want to
trim off. Press Enter to end object selection. This action trims the object(s).

4+ If you want to trim to an implied intersection, at the Select object to trim or
shift-select to extend or [Project/Edge/Undo]: prompt, type e .. The Extend
option responds with the Enter an implied edge extension mode [Extend/No
extend] <No extend>: prompt. Type e .. Then select the objects that you want to
trim at the Select object to trim or shift-select to extend or [Project/
Edge/Undo]: prompt. Be sure to pick each object at or near the end that you want to
trim. Press Enter to end object selection and trim the object(s).

Use the Undo option if the results of the trim are not what you want. You can then continue to
select objects to trim.

\ The drawing used in the following Step-by-Step exercise on trimming objects, ab10-d.dwg,
is in the Drawings folder on the CD-ROM.
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STEP-BY-STEP: Trimming Objects

1

. Open ab10-d.dwg from the CD-ROM.
2.
3.

Save the file as ab10-05.dwg in your AutoCAD Bib1e folder. It looks like Figure 10-16.

Start the TRIM command. At the Select objects: prompt, pick lines at @ and @ in
Figure 10-16 and then press Enter.

. Atthe Select object to trim or shift-select to extend or

[Project/Edge/Undo]: prompt, again pick lines at @ and @ in Figure 10-16. Be sure
to pick them outside the intersection, as shown. Press Enter to end the command.

The command trims the lines. Each line is used as the cutting edge for the other line.

b SuPPLY —
o0—
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v TYPE
D TRAP

DRAIN -0

Figure 10-16: A schematic of an air compressor.

. Choose Trim on the Modify toolbar again. At the Select objects: prompt, pick the

line at @ in Figure 10-16 and press Enter.

. Atthe Select object to trim or shift-select to extend or [Project/

Edge/Undo]: prompt, right-click and choose Edge. Then right-click and choose Extend
atthe Enter an implied edge extension mode [Extend/No extend] <Extend>:
prompt.

7. Pick the line at @ in Figure 10-16 to trim the line. Press Enter to end the command.

. Start the TRIM command again. At the Select objects: prompt, pick @ and press

Enter. At the Select object to trim or shift-select to extend or [Project/
Edge/Undo]: prompt, pick the lines at @ and @.Press Enter to end the command.
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9. Save your drawing. It should look like Figure 10-17.

N\ Express Tools contains a command, EXTRIM, available on the command line. EXTRIM can use

AutoCAD a polyline, line, circle, arc, ellipse, image, or text as the cutting line. You specify one side of the

nly cutting object, and EXTRIM trims everything on that side. For example, if you choose a closed
s polyline and pick inside it, every object inside the polyline is timmed.

/ N

SUPFLY

TYPE
TRAP

Figure 10-17: The completed clamp in two views.

-

Extending objects

The EXTEND command has the same prompts as the TRIM command, but instead of trimming
objects to a cutting edge, it extends them to a boundary edge (see Figure 10-18). As with TRIM,
when you select an object to extend, you must pick the object on the side that you want
extended (not on the side that you want left as is).

Pick points

onﬁnes\§:q<:::::::q
Boundary edge — @ !

Figure 10-18: Extending two lines by using an
arc as the boundary edge.
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The object you want to extend does not have to actually intersect the boundary edge
after its extension. You can extend an object to a boundary edge that would intersect
the extended object if it were longer. This is called extending to an implied intersection,
shown in Figure 10-19.

You can extend arcs, elliptical arcs, lines, open polylines, and rays. You can use polylines,
arcs, circles, ellipses, elliptical arcs, lines, rays, regions, splines, text, or xlines as boundary
edges. An object can be used as both a boundary edge and an object to be extended in the
same extending process.

While using the EXTEND command, you can switch to trimming objects by pressing the Shift

, key as you select objects to trim.
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Figure 10-19: Extending a line to an implied intersection.
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To extend an object, choose Extend from the Modify toolbar. You cannot select objects
_"-"'r before the EXTEND command. The command displays the Current settings:
Projection=UCS, Edge=Extend Select boundary edges ... Select objects: prompt.
The prompt lets you know the values of the two settings that affect extending. Projection is
used only for 3D models. Edge is used for implied intersections. When Edge is set to Extend,
the command extends to the implied intersection of the boundary edge and the object to be
extended. At this prompt, pick the object(s) that you want to use as the boundary edge(s).
Press Enter to end object selection. You can extend to an actual or implied intersection:

4+ If the extension will result in an actual intersection, at the Select object to extend
or shift-select to trim or [Project/Edge/Undo]: prompt, select objects to
extend. Be sure to pick each object at the end that you want to extend. Press Enter to
end object selection and extend the object(s).

4+ If you want to extend to an implied intersection, at the prompt, right-click and choose
Edge. The option responds with the Enter an implied edge extension mode
[Extend/No extend] <Extend>: prompt. Right-click and choose Extend. Then select
the objects that you want to extend at the Select object to extend or shift-
select to trim or [Project/Edge/Undo]: prompt. Be sure to pick each object
at the end that you want to extend. Press Enter to end object selection. This action
extends the object(s).

Use the Undo option if the results of the extension are not what you want. You can then con-
tinue to select objects to extend.

You can use the Fence object selection method to select objects to extend the side of the
object that the fence line crosses.

is in the Drawings folder on the CD-ROM.

On theq"'\ The drawing used in the following Step-by-Step exercise on extending objects, ab10-e.dwg,
.-/'.

STEP-BY-STEP: Extending Objects
1. Open ab10-e.dwg from the CD-ROM.
2. Save the file as ab10-06.dwg in your AutoCAD Bib1e folder. It looks like Figure 10-20.

3. Choose Extend on the Modify toolbar. At the Select objects: prompt, pick the
ol line at @ in Figure 10-20 and then press Enter.
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Figure 10-20: An electrical schematic.
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4. At the Select object to extend or shift-select to trim or [Project/Edge/
Undo]: prompt, pick the line at @ in Figure 10-20. Press Enter to finish selecting objects.
The command extends the line.

5. Repeat the EXTEND command. At the Select objects: prompt, pick the lines at €
and @ in Figure 10-20 and then press Enter.

6. At the Select object to extend or shift-select to trim or [Project/Edge/
Undo]: prompt, right-click and choose Edge. Right-click and choose Extend at the
Extend/No extend <No extend>: prompt.

7. Pick lines @ and @ in Figure 10-20 again at the points shown. The lines extend to meet.
Press Enter to end the command.

8. Save your drawing. It should look like Figure 10-21.
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Figure 10-21: The completed electrical schematic.

Lengthening objects

The LENGTHEN command both lengthens and shortens. It works on open objects, such as
lines, arcs, and polylines and also increases or decreases the included angle of arcs. (You can
both change the length of an arc and change its included angle by using LENGTHEN.) AutoCAD
and AutoCAD LT offer several ways of defining the new length or included angle. Use LENGTHEN
when you want to lengthen or shorten an object, but there is no available intersecting edge or
boundary to use with TRIM or EXTEND.

In the LENGTHEN command, the length of an arc is measured along its circumference. Don’t
confuse this with the Length of Chord option of the ARC command, which refers to the length
of a line stretched from one endpoint of the arc to the other endpoint.

_# To lengthen (or shorten) an object, choose Modify => Lengthen. You cannot select objects
+  before the LENGTHEN command. The command responds with the Select an object
or [DElta/Percent/Total/DYnamic]: prompt. Choose one of the following options:

4+ Select object: This is the default. However, its purpose is to display the current measure-
ments of the object. This can help you to decide how to define the final length or angle
of the object. The current length is displayed at the command line, and the previous
prompt is repeated.

199



200

Part Il + Drawing in Two Dimensions

4+ DElta: Right-click and choose DElta. Delta means the change, or difference, between the
current and new length or included angle. The option responds with the Enter delta
length or [Angle] <0.0000>: prompt. If you want to change an included angle,
right-click and choose Angle. Then type the change in the included angle. Otherwise,
simply type in the change in the length of the object. A positive number increases the
length or included angle. A negative number decreases the length or included angle.

4+ Percent: Right-click and choose Percent. At the Enter percentage length
<100.0000>: prompt, type in what percent of the original object you want the final
object to be. Amounts over 100 lengthen the object. Amounts under 100 shorten the
object. You cannot change an included angle using this option.

4+ Total: Right-click and choose Total. At the Specify total length or [Anglel]
<1.0000)>: prompt, you can either choose the Angle suboption, as described for the
Delta option or use the default total-length option. Either way, you enter the total angle
or length you want.

4+ DYnamic: Right-click and choose DYnamic. This option lets you drag the endpoint of
the object closest to where you picked it. You can use an object snap to specify the
new endpoint.

After you've used an option to specify the length you want, you see the Select an object
to change or [Undo]: prompt. Here you select the object you want to change. Be sure to
pick the endpoint of the object for which you want to make the change.

The same prompt continues so that you can pick other objects by using the same length
specifications. Choose Undo to undo the last change. Press Enter to end the command.

On the’ \ The drawing used in the following Step-by-Step exercise on lengthening and shortening
CD objects, ab10-f.dwg, is in the Drawings folder on the CD-ROM.

STEP-BY-STEP: Lengthening and Shortening Objects
1. Open ab10-f.dwg from the CD-ROM.

2. Save the file as ab10-07.dwg in your AutoCAD Bib1e folder. It is a capacitor symbol
from an electrical schematic, as shown in Figure 10-22.

f

Figure 10-22: A poorly drawn capacitor symbol.
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3. = Choose Modify = Lengthen and follow the prompts:
/

Select an object or [DElta/Percent/Total/DYnamic]l: Pick the Iine at
© in Figure 10-22.

Current length: 0.200

Select an object or [DElta/Percent/Total/DYnamic]l: Right-click and
choose Delta.

Enter delta Tength or [Angle] <0.000>: .07 4

Select an object to change or [Undol: Pick the Tine at @ in Figure
10-22.

Select an object to change or [Undo]: o

This action lengthens the line.
4. Start the LENGTHEN command again and follow the prompts:

Select an object or [DElta/Percent/Total/DYnamicl: Pick the arc at @
in Figure 10-22.

Current length: 0.407, included angle: 150

Select an object or [DElta/Percent/Total/DYnamic]: Right-click and
choose Total.

Specify total length or [Angle] <1.000)>:)>: Right-click and choose
Angle.

Specify total angle <57>: 120

Select an object to change or [Undol: Pick the arc at @ in Figure
10-22.

Select an object to change or [Undo]l: 4

This action shortens the arc.

5. Save your drawing. It should look like Figure 10-23.

Figure 10-23: The completed capacitor symbol.

Stretching objects

The STRETCH command is generally used to stretch groups of objects. It can be used to enlarge
aroom in a floor plan, for example. You can also shrink objects. You can change not only the
length of the objects but the angle as well. You use a crossing window to choose the objects
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to be stretched. All objects that cross the boundaries of the crossing window are stretched.
All objects that lie entirely within the crossing window are merely moved. Successful stretch-
ing involves precise placement of the crossing window. Figure 10-24 shows the process of
stretching a garage. Note that the walls that cross the boundaries of the crossing window are
stretched. However, the dormer that is entirely within the crossing window is just moved.
This maintains the integrity of the model.

Crossing window

_____________________
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Figure 10-24: Stretching a garage.

You cannot stretch circles, text, or blocks. You can stretch arcs, although the results may not
be what you expect.

The real power of the STRETCH command is in stretching a number of objects at once.
However, you can also stretch one line. The results are similar to using the CHANGE com-
mand to change the endpoint of a line.

[5. To stretch objects, choose Stretch from the Modify toolbar. The command responds

;4 with the Select objects to stretch by crossing-window or crossing-
polygon . . . instruction and then the Select objects: prompt. Create the crossing
window and select the objects that you want to stretch. (You can also use a crossing polygon.)
After completing the crossing window, check to see which objects are highlighted. This helps
you avoid unwanted results. You can use the object selection Remove option (type r J at the
command prompt) to remove objects by picking the objects you don’t want to stretch or move.

To allow you to use multiple crossing windows or polygons to select the objects that you want

AutoCAD to stretch, use the Express Tools MSTRETCH command. Choose Express = Modify <> Multiple
Only Entity Stretch. For information on installing Express Tools, see Appendix A.

You then see the Specify base point or displacement: prompt. This step is just like
moving objects. You can respond in two ways.

4 Pick a base point. At the Specify second point of displacement or <use first
point as displacement>: prompt, pick a second point. Object snap and PolarSnap
are helpful for picking these points.
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4+ Type a displacement, without using the @ sign. For example, to lengthen the objects by
6 feet in the 0-degree direction, type 6'<0 . Then press Enter at the Specify second
point of displacement or <use first point as displacement>: prompt.

Tip Usually, you want to stretch at an orthogonal angle. If you're going to stretch by picking, turn
. ORTHO on. Object snaps, polar tracking, and snap mode are other helpful drawing aids for
"4 stretching.

When specifying a displacement by typing at the keyboard, you can use both positive and
negative distances. For example, 6'<180 is the same as -6'<0. Both would stretch the objects
6 feet to the left.

In this exercise, you practice stretching objects.

On theq"'\ The drawing used in the following Step-by-Step exercise, ab10-g.dwg, is in the Drawings
.-/'.

CD \  folder on the CD-ROM.
L y

STEP-BY-STEP: Stretching Objects
1. Open ab10-g.dwg from your CD-ROM.

2. Save the file as ab10-08.dwg in your AutoCAD Bible folder. This drawing is the plan
view of a garage, as shown in Figure 10-25. Turn on polar tracking by clicking POLAR on
the status bar. Click SNAP on the status bar and then right-click SNAP to make sure
PolarSnap is on (the PolarSnap item will be unavailable if it is already on); otherwise,
choose PolarSnap. Turn on OSNAP and set a running object snap for endpoints.

3. [5. Choose Stretch from the Modify toolbar. At the Select objects: prompt, pick @
% in Figure 10-25. At the Specify opposite corner: prompt, pick @. The prompt
notifies you that it found 32 objects. Press Enter to end object selection.

Figure 10-25: A plan view of a garage.
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4. At the Specify base point or displacement: prompt, pick the endpoint at the
bottom-right corner of the garage. At the Specify second point of displacement
or <use first point as displacement>: prompt, move the cursor to the right
until you see the polar tracking tooltip. Click when the tooltip says 6-0"<0. (If you can’t
find it, type @6',0 1) This action stretches the garage by 6 feet.

5. Save your drawing. It should look like Figure 10-26.

Figure 10-26: The longer garage.

Using Construction Commands

Three additional commands are commonly used in the process of constructing models. The
BREAK command removes sections of objects at points you specify. CHAMFER creates corners,
and FILLET creates rounded corners.

Breaking objects

Drawing a long line and then breaking it into two or more shorter lines is often much easier. A
common use for BREAK is to break a wall at a door or a window in an architectural floor plan.
You specify two points on the object, and the command erases whatever is between those
two points. Typically, you use object snaps to specify the points. Sometimes, you can use
TRIM to break an object, but if you have no convenient cutting edge, you may find BREAK
more efficient.

You can break lines, polylines, splines, xlines, rays, circles, arcs, elliptical arcs, and ellipses.

I:I To break a line, choose Break from the Modify toolbar. You cannot select the object first.
The command responds with the Select object: prompt. (Notice that you can only
select one object to break.) At this prompt, you have two choices:

4+ Select the object at one of the break points that you want to create. You then see the
Specify second break point or [First point]: prompt. Because you have
already specified the first point, you can now specify the second point. The command
breaks the object between the two points.
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4+ Select the object by using any method of object selection. You then see the Specify
second break point or [First point]: prompt. Right-click and choose First
point. At the Specify first break point: prompt, pick the first break point. At the
Specify second break point: prompt, pick the second break point. The command
breaks the object between the two points.

Tip I—_-I Sometimes you may want to break an object into two pieces at a point, without eras-
) ing any part of the object. Use the Break at Point button on the Modify toolbar to help
7 you easily break an object at a point. After selecting the object, pick where you want to break
the object at the Specify second break point or [First point]: prompt. The two
new objects look the same as before on the screen — until you select one of the objects. To
break objects at a point, AutoCAD and AutoCAD LT use @, which always signifies the last
point entered, to specify the second break point. Thus, the first and second break points are
the same.

You can use BREAK to shorten an object. Pick one point on the object where you want the
new endpoint to be. Pick the other point past its current endpoint to cut off the object at the
point you picked on the object.

On theq"'\ The drawing used in the following Step-by-Step exercise on breaking objects, ab10-h.dwg, is
\ inthe Drawings folder on the CD-ROM.
L /
.-/'.

CD-

A
STEP-BY-STEP: Breaking Objects
1. Open ab10-h.dwg from your CD-ROM.

2. Save the file as ab10-09.dwg in your AutoCAD Bible folder. This is a site plan, as
shown in Figure 10-27. Turn on OSNAP and set running object snaps for endpoint and

intersection.
X S
o5 /$ . T
Py iy = )
~~
24 * DlA MAFLE TREES -
7
/0 i
Qo 5
i
&
5
6/t i
310-9* | 10,4~
=
K
—
AL LINITS— = z
a CHURCH BUILDING Q
1 —
o i
g 5
o 88'-10 /4% |
5 o &

Figure 10-27: A site plan.
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3. I:I Choose Break from the Modify toolbar. At the Select object: prompt, pick the
line at @. At the Specify second break point or [First point]: prompt,
pick @. This action shortens the line.

4. Repeat the BREAK command. At the Select object: prompt, pick the circle (it’s a
maple tree) anywhere along its circumference. At the Specify second break point
or [First point]: prompt, right-click and choose First point. At the Specify first
break point: prompt, pick the intersection at €. At the Specify second break
point: prompt, pick the intersection at @) to break the circle.

'/Note AutoCAD and AutoCAD LT break circles counterclockwise. If you had picked @), and then @,
~—  only the smaller arc would have remained.

5. Turn on Object Snap Tracking by clicking OTRACK on the status bar.
6. Start the BREAK command again. Follow the prompts:

Select object: Pick the line at @.

Specify second break point or [First pointl: Right-click and choose
First point.

Specify first break point: Move the cursor to @ to acquire it as a
tracking point. Then move the cursor to the right onto the line you
are breaking. When you see the Endpoint: Intersection tooltip, click.
(You have no visual confirmation yet that you picked the right
point.)

Specify second break point: Move the cursor to @ to acquire it as a
tracking point. Then move the cursor onto the line you are breaking.
At the Endpoint: 4'-2 3/4"<0.0000 tooltip, click.

This action breaks the line.

7. Save your drawing. It should look like Figure 10-28.
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Figure 10-28: The edited site plan.
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On the \ For AutoCAD only: Two AutoLISP programs on the CD-ROM can help you with breaking and
CD | unbreaking objects. Pend puts a break line at the end of a pipe. See \Software\Chapl0\
5 / Pend. Br draws a line with a break symbol. See \Software\Chapl10\Br. The Express Tools
& A contain a command, BREAKLINE, to create a break symbol. Choose Express > Draw > Break-
Line Symbol. Another Express Tools command, OVERKILL (available on the command line)
deletes objects that are on top of other objects. For information about installing Express
Tools, see Appendix A.

Creating chamfered corners

The CHAMFER command creates corners from two nonparallel lines. You can also chamfer
xlines, rays, and polylines. You can simply extend the lines to meet at an intersection (a
square corner), or create a beveled edge. If you create a beveled edge, you define the edge
by either two distances or one distance and an angle relative to the first line you're chamfer-
ing. Figure 10-29 shows the elements of a chamfered corner.

. Second chamfer distance
Second line

=
=

First chamfer

|
Chamfer angle N |
| distance

l«— First line

Figure 10-29: A chamfered corner.

Chamfering is a two-step process. First you define how you want to chamfer the corner, speci-
fying either two distances from the corner or a distance and an angle. Then you select the two
lines you want to chamfer. This action chamfers them by using the information you specified.

#3— To chamfer, choose Chamfer from the Modify toolbar. You cannot select objects before the

CHAMFER command. The command responds with the (TRIM mode) Current chamfer
Distl = 0.0000, Dist2 = 0.0000 Select first line or [Polyline/Distance/
Angle/Trim/Method/mUTtiple]: prompt. The command starts by listing the current set-
tings. You can define two distances from a corner or one distance and an angle:

4+ To define two distances from the corner, right-click and choose Distance. At the Specify
first chamfer distance <0.0000>: prompt, type the first chamfer distance or press
Enter to accept the default (which is the last distance you defined). At the Specify sec-
ond chamfer distance <0.0000>: prompt, type the second distance. The default for
this is always the first chamfer distance because equal chamfer distances are so common.

4+ To define a distance (from the corner) and an angle, right-click and choose Angle. At
the Specify chamfer Tength on the first Tine <1.0000>: prompt, enter a dis-
tance. This is the same as the first chamfer distance. At the Specify chamfer angle
from the first line <0>: prompt, type the angle between the first line and the
chamfer line.
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To extend two nonparallel lines to make a corner, set the chamfer distances to zero and then
chamfer the lines. The command extends them to meet. If they already intersect, the com-
mand trims them to create a corner. The pick points on intersecting lines should be on the
part of the lines that you want to keep (not on the part of the lines you want to trim off).

Now that you specified the settings that you want, you're ready to chamfer. Your distances or
distance and angle are displayed as you just specified them. The command repeats the Select
first line or [Polyline/Distance/Angle/Trim/Method/mUltiple]: prompt. Select
the first line. If you aren’t creating a chamfer with equal distances, the order in which you
select the lines is important. The command trims the first line selected by the first distance
and the second line selected based on either the second distance or the angle. At the Select
second line: prompt, select the second line to chamfer the lines.

¢ Cross- Choose the Polyline option to chamfer an entire polyline at once. Chapter 16 covers polylines.
\ Reference Chapter 24 discusses chamfering 3D models.

By default, CHAMFER trims the original lines that it chamfers. If you want to keep the full orig-
inal lines when you add the chamfer line, choose the Trim option and choose No Trim.

Tip Use the muUltiple option to continue the prompts and chamfer several corners in one
, ~ command.

N/

\ The drawing used in the following Step-by-Step exercise on chamfering lines, ab10-1 .dwg,

\ isinthe Drawings folder on the CD-ROM.

CD-
%

On the

STEP-BY-STEP: Chamfering Lines
1. Open ab10-1.dwg from your CD-ROM.

2. Save the file as ab10-10.dwg in your AutoCAD Bib1e folder. This drawing is a very
small section of a “porcupine” mixer, as shown in Figure 10-30.

? o
o

A
| | —

I\—‘i_‘—'_i
H—'_i

HEd

A
V

L.,
Figure 10-30: A mechanical drawing showing a small section of a “porcupine”
mixer.




Chapter 10 4+ Editing Your Drawing: Advanced Tools

3. rz— Choose Chamfer from the Modify toolbar. CHAMFER states the current mode and
distances. If the distances are not zero, follow these prompts. If they are already
zero, skip to Step 4.

Select first line or [Polyline/Distance/Angle/Trim/Method/mUltiple]:
Right-click and choose Distance from the shortcut menu.

Specify first chamfer distance <1/2>: 0 d

Specify second chamfer distance <0>: 4

4. At the Select first line or [Polyline/Distance/Angle/Trim/Method/
mUTtiple]: prompt, pick @ in Figure 10-30. At the Select second 1ine: prompt,
pick @. The command chamfers the two lines to make a corner. (If this doesn’t work,
you may have the Trim option set to No Trim. Change the setting to Trim and try
again.)

5. Repeat the CHAMFER command. Follow the prompts:

Select first line or [Polyline/Distance/Angle/Trim/Method/mUltiple]:
Right-click and choose Angle.

Specify chamfer length on the first line <1>: 9/16 J
Specify chamfer angle from the first Tine <0>: 45 4

6. At the Select first line or [Polyline/Distance/Angle/Trim/Method/
mUltiple]: prompt, pick @ in Figure 10-30. At the Select second Tine: prompt,
pick @. The command chamfers the two lines, as shown in Figure 10-31.

7. Save your drawing.

L.

Figure 10-31: The edited drawing after using the CHAMFER command.

Creating rounded corners

The FILLET command creates rounded corners, replacing part of two lines with an arc. Fillets
are often used in mechanical drawings. In certain cases, you can use FILLET instead of the ARC
command to create arcs. As with CHAMFER, you can fillet lines, xlines, rays, and polylines —
they can even be parallel. You can also fillet circles, arcs, elliptical arcs, and ellipses.
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The FILLET command defines the fillet arc by its radius, as shown in Figure 10-32.

) «—Filletarc  Figure 10-32: A fillet consisting of two lines and an arc.
Radius———

Arc center

Like chamfering, filleting is a two-step process. First you define the radius of the fillet arc.
Then you select the two lines that you want to fillet. You cannot select objects before the
FILLET command.

To fillet, follow these steps:

1. 5 Choose Fillet from the Modify toolbar. The command responds with the Current
r)._ settings: Mode = TRIM, Radius = 0.0000 Select first object or
[PolyTine/Radius/Trim/mUTtiple]: prompt.

2. Right-click and choose Radius.

3. Atthe Specify fillet radius <0.0000>: prompt, type the radius you want. The
default is either 0.0000 or the last radius you specified.

4. The command repeats the Select first object or [Polyline/Radius/Trim/
mUltiple]: prompt. Select the first object you want to fillet.

5. Atthe Select second object: prompt, select the second object you want to fillet.
This action creates the fillet.

By default, FILLET trims the original lines that it fillets, but the FILLET command recalls the
last setting you used. If you want to keep the full original lines when you create a fillet, right-
click and choose the Trim option, and then choose No Trim.

Cross- Choose the Polyline option to fillet an entire polyline at once. Chapter 16 covers polylines.
Reference Chapter 24 discusses filleting 3D models.

Filleting with a zero radius gives the same results as chamfering with distances set to zero.
(See the previous section on chamfering.)

The order in which you select the two objects to be filleted is not important. However, where
you pick the objects is quite important. If two objects intersect, the command keeps the objects
on the same side of the intersection as your pick point and fillets them. Those parts of the
objects on the far side of the intersection are erased.

When you fillet arcs and lines, if more than one fillet is possible, FILLET connects the end-
points closest to your pick points. Filleting circles and lines can result in unexpected results.
Sometimes you need to experiment to find the proper pick points.
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Tip Use the mUltiple option to continue the prompts and fillet several corners in one command.
On the | The drawing used in the following Step-by-Step exercise on filleting objects, ab10-1 . dwg,
CD‘“ is in the Drawings folder on the CD-ROM.
'\

STEP-BY-STEP: Filleting Objects
1. Open ab10-1.dwg from your CD-ROM.

2. Save the file as ab10-11.dwg in your AutoCAD Bible folder. This is the same drawing
used in the previous exercise. It is shown in Figure 10-33.
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Figure 10-33: A mechanical drawing showing a small section of a “porcupine”
mixer.

3. & Choose Fillet from the Modify toolbar. At the Select first object or
[Polyline/Radius/Trim/mUltiple]: prompt, right-click and choose Radius.
At the Specify fillet radius <1/2>: prompt, type 5/8 .

4. At the Select first object or [Polyline/Radius/Trim/mUltiple]: prompt,
pick the line at @ in Figure 10-33. At the Select second object: prompt, pick the
line at @ to fillet the two lines.

5. Repeat the FILLET command. At the Select first object or [Polyline/Radius/
Trim/ mUltiple]: prompt, right-click and choose Radius. At the Enter fillet radius
<5/8>: prompt, type 1/4 .

6. At the Select first object or [Polyline/Radius/Trim/mUltiple]: prompt,
right-click and choose mUltiple. Pick the line at € in Figure 10-33. At the Select sec-
ond object: prompt, pick the line at @ to fillet the two lines. The prompts continue.
This time pick at @ and @.
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7. If you want, you can connect the two loose lines that the fillets created and create some
more fillets in the drawing.

8. Save your drawing. It should look like Figure 10-34.
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Figure 10-34: The filleted drawing.

Creating a Revision Cloud

You may need to mark areas of your drawings that contain revisions, to draw attention to
these revisions. A common method is to draw a revision cloud around the revised objects.
Figure 10-35 shows a drawing with a revision cloud, which is a series of arcs that indicate that
an area of the drawing has been revised.
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Figure 10-35: The revision cloud shows where the drawing has been modified.



' Note

Chapter 10 4+ Editing Your Drawing: Advanced Tools

To create a revision cloud, follow these steps:
1. Choose Revcloud from the Draw toolbar.

2. At the Specify start point or [Arc length/0bject/Style] <Object>: prompt,
you can choose three options:

¢ To change the length of the arc, right-click and choose Arc Length. Then specify a
new arc length. You can specify a minimum arc length and a maximum arc length
that is up to three times the length of the minimum, for a variable, hand-drawn look.

¢ To change a closed object into a revision cloud, right-click and choose Object.
Then pick a circle, ellipse, closed polyline, or closed spline. You can choose to
reverse the direction of the revision cloud. The object is converted to a revision
cloud and the command ends.

¢ To choose from two available cloud styles, right-click and choose Style. At the next
prompt, choose either the Normal or Calligraphy option. A calligraphy revision
cloud has a variable line width so that it looks as if you drew it with a calligraphy
pen. The calligraphy style is a new feature of AutoCAD and AutoCAD LT 2005.

3. Click where you want the revision cloud to start. You also see an instruction, Guide
crosshairs along cloud path. . ., which means that you don’t have to pick to cre-
ate the arcs. You just have to move the crosshairs along the path of the desired cloud.

4. Move the crosshairs counterclockwise to create a circular or elliptical shape. When you
approach the start point, the command ends automatically. (You can end the cloud at
any time by pressing Enter.)

If you want, you can pick each arc endpoint to control the size of the arcs. However, if you

T move the crosshairs farther than the arc length, an arc is created automatically. REVCLOUD

multiplies the arc length by the Overall Scale factor (see Chapter 15) to adjust for different
scale factors.

Hiding Objects with a Wipeout

A wipeout covers existing objects in order to clear space for some annotation or to indicate
that the covered objects will be changed and should, therefore, be ignored. A wipeout is a
polygonal area with a background that matches the background of the drawing area. The
WIPEOUT command creates a polygon the same color as the background of your drawing area.

To create a wipeout, follow these steps:
1. Choose Draw = Wipeout.

2. At the Specify first point or [Frames/Polyline] <Polyline>: prompt, specify
the first point of a shape that will cover existing objects. To use a polyline as the shape,
right-click and choose Polyline. Then select the polyline and choose whether to erase
the polyline or not.

3. At the Specify next point or [Undo]: prompt, if you specified a point, specify the
next point.

4. At the Specify next point or [Close/Undo]: prompt, specify another point or use
the Close option to close the wipeout shape. You can also press Enter to end the com-
mand and use the shape you specified.
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By default, the wipeout has a frame around it, using the current layer’s color. You can hide
the frames of all wipeouts. Start the WIPEOUT command, choose the Frames option, and
choose Off.

« Cross- You can create a background mask especially for text. This mask covers a rectangle around your
\ Reference text so that you can read the text more easily. For more information, see Chapter 13.

Double-Clicking to Edit Objects

You can double-click objects to edit them. What happens after you double-click depends on
the type of object. In most cases, double-clicking an object just opens the Properties palette
where you can change the object’s properties. For example, double-clicking a polyline does

not start the PEDIT command, a command for editing polylines. For more information about
using the Properties palette, see “Editing with the Properties Palette” later in this chapter.

When you double-click certain types of objects in a drawing, you see a dialog box that is spe-
cific to these objects:

4 Attribute definition: Opens the Edit Attribute Definition dialog box (the DDEDIT com-
mand). See Chapter 18 for more information.

4+ Attribute within a block: Opens the Enhanced Attribute Edit dialog box (the EATTEDIT
command). See Chapter 18 for more information.

4+ Block: Opens the Reference Edit dialog box (the REFEDIT command). See Chapter 18
for more information.

4+ Hatch: Opens the Hatch Edit dialog box (the HATCHEDIT command). See Chapter 16
for more information.

4 Mline: Opens the Multiline Edit Tools dialog box (the MLEDIT command). See Chapter 16
for more information.

4+ Mtext or leader text: Opens the Multiline Text Editor (the MTEDIT command). See
Chapter 13 for more information.

4+ Text (TEXT or DTEXT commands): Opens the Edit Text dialog box (the DDEDIT com-
mand). See Chapter 13 for more information.

4+ Xref: Opens the Reference Edit dialog box (the REFEDIT command). See Chapter 19 for
more information.

The DBLCKLEDIT command specifies if double-clicking opens a dialog box in these instances.
To turn off double-clicking to edit objects, type dblclkedit and choose the Off option.

Grips

Grips offer a way to edit objects without choosing commands. By using grips, you can quickly
stretch, move, rotate, scale, copy, and mirror objects.

When you select an object without first choosing a command, the object appears highlighted
with grips — small boxes at preset object snap points. (If you don’t see grips, they may be
turned off. See the “Customizing grips” section later in this chapter to find out how to turn
them back on.) You can continue to select more objects in this way.
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You then activate a grip by clicking it and use the grip to manipulate the object. When the grip
is activated, it turns red (by default). An activated grip is also called a hot grip, as shown in
Figure 10-36. In some cases, you activate more than one grip at a time. To activate more than
one grip, hold down Shift and then click the grips. If you activate a grip in error, click it again
to deactivate it. Grips are so called because you can “hold on to” the object by dragging the
grips with the mouse.

Hot grip (red)

Crosshairs |

—<——Grip (blue)
Line's original —
position :
«—Line's new
position

— Grip (blue)

— -

Figure 10-36: Moving a line. Grips appear
at preset object snaps. A hot grip is used to
manipulate an object.

After you activate a grip, right-click with the mouse to open the Grip shortcut menu listing all
the grip options.

You can also press the Spacebar or Enter to cycle through five possible commands on the
command line. As long as you’re familiar with the STRETCH, MOVE, ROTATE, SCALE, and
MIRROR commands, you can easily learn how to accomplish the same edits by using grips
because the prompts are so similar. After you complete the edit, the object remains high-
lighted and the grips remain, so that you can further edit the object. If you want to edit
another object, press Esc once to remove the grips. Then select another object or objects
or choose another command.

Stretching with grips

Stretching with grips involves understanding how the grip points relate to the object. For
example, you cannot stretch a line from its midpoint —if you think about it, there’s no way to
define in which direction to stretch the line. Also, you cannot stretch a circle. (You can only
scale it.) Aside from these types of limitations, anything goes.



216

Part Il + Drawing in Two Dimensions

Stretching one line

You can stretch one line. The result is similar to using the CHANGE command to change a
line’s endpoint. To stretch a line, select it. Click the grip at the endpoint you want to stretch.
The prompt on the command line responds with

*% STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]:

STRETCH is the first grip editing command on the command line. Simply specify the new end-
point for the line, using any method of specifying a coordinate, to stretch the line. The other
options work as follows:

4+ Base point lets you define a base point —other than the activated grip—and a second
point. Right-click to open the Grip shortcut menu and choose Base Point. The option
displays the Specify base point: prompt. Define a base point. Again you see the
original Specify stretch point or [Base point/Copy/Undo/eXit]: prompt.
Define the second stretch point to stretch the line.

4+ Copy puts you in Multiple mode. Right-click to open the Grip shortcut menu and
choose Copy. Again you see the original Specify stretch point or [Base point/
Copy/Undo/eXit]: prompt. Specify a new point to keep the original line and create a
new line stretched to the new point. You can continue to create new stretched lines.

4+ Undo undoes the last edit. Right-click to open the Grip shortcut menu and choose Undo.

4 eXit returns you to the Command prompt. Right-click to open the Grip shortcut menu
and choose Exit. Esc also returns you to the Command prompt.

Stretching multiple lines

Stretching more than one line at a time is similar to the most common use of the STRETCH
command. However, it can also be somewhat confusing.

As explained earlier in this chapter for the STRETCH command, objects that cross the crossing
window are stretched while objects entirely within the crossing window are moved. When you
stretch multiple lines, you should activate endpoint grips to stretch lines and activate midpoint
grips to move lines. Picking all those grips accurately can be difficult and time-consuming. Also,
small objects close together create a lot of overlapping grips that are hard to select. For this
reason, stretching multiple lines works best with simple models.

To stretch multiple lines, follow these steps:

1. Choose the objects that you want to stretch. The objects are highlighted and display
grips. You can use any method of choosing objects —you aren’t limited to crossing
windows.

2. Hold down Shift and pick each grip that you want to stretch. If there are internal objects
that you want to move with the stretch, select their grips, too—the midpoints of the
lines and arcs, and the centers of the circles.

3. Release Shift and pick a grip to use as a base point. You see the prompt:

**% STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]:

4. Specify a new stretch point. You can also use any of the other options.

At the end of this section on grips, you have the opportunity to try them out in an exercise.
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Moving with grips

Moving objects is easy by using grips. Choose all the objects that you want to move. Click any
grip to activate it. This becomes the base point. Right-click to open the Grip shortcut menu
and choose Move.

You can also press the Spacebar to cycle through the grip editing modes. For example, to move
)\, an object, press the Spacebar once.
)
After you choose Move editing mode, you see the prompt:
*% MOVE **
Specify move point or [Base point/Copy/Undo/eXit]:

Use any method to specify the second point. Be sure to use @ if you're typing in relative coor-
dinates. The selected objects move. The other options work as follows:

4+ Base point lets you define a base point —other than the activated grip. Right-click
to open the Grip shortcut menu and choose Base Point. You see the Specify base
point: prompt. Define a base point. The original Specify move point or [Base
point/Copy/Undo/eXit]: prompt returns. Define the second move point to move the
objects.

4+ Copy puts you in Multiple mode and lets you copy objects. Right-click to open the Grip
shortcut menu and choose Copy (or type ¢ .I_). You see the original Specify move
point or [Base point/Copy/Undo/eXit]: prompt. Specify a new point to keep the
original object and create a new object where you specify. You can continue to create
new objects.

4+ Undo undoes the last edit. Right-click to open the Grip shortcut menu and choose Undo.

4 eXit returns you to the Command prompt. Right-click to open the Grip shortcut menu
and choose Exit. Esc also returns you to the Command prompt.

Rotating with grips
Rotating with grips is very similar to using the ROTATE command. Choose all the objects that

you want to rotate. Click any grip to activate it. This becomes the base point. Right-click to
open the Grip shortcut menu and choose Rotate. You see the prompt:

** ROTATE **
Specify rotation angle or [Base point/Copy/Undo/Reference/eXit]:

Type in a rotation angle or pick a point to rotate the objects. The other options work as follows:

4+ Base point lets you define a base point — other than the activated grip. Right-click to
open the Grip shortcut menu and choose Base Point. You see the Specify base
point: prompt. Define a base point. The original Specify rotation angle or
[Base point/Copy/Undo/Reference/eXit]: prompt returns. Specify the rotation
angle to rotate the objects.

4+ Copy puts you in Multiple mode and lets you copy objects. Right-click to open the Grip
shortcut menu and choose Copy. Again you see the original Specify rotation angle
or [Base point/Copy/Undo/Reference/eXit]: prompt. Specify a rotation angle to
keep the original object and create a new rotated object where you specified. You can
continue to create new objects.
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4 Undo undoes the last edit. Right-click to open the Grip shortcut menu and choose Undo.

4+ Reference lets you specify a reference angle and a new angle. Right-click to open the Grip
shortcut menu and choose Reference. You see the Reference angle <0>: prompt.
Type an angle or pick two points to specify an angle. The Specify new angle or
[Base point/Copy/Undo/Reference/eXit]: prompt appears. Type an angle or pick
a point. This works like the Reference option for the ROTATE command. (See Chapter 9.)

4+ eXit returns you to the Command prompt. Right-click to open the Grip shortcut menu
and choose Exit. Esc also returns you to the Command prompt.

Scaling with grips
Scaling with grips is very similar to using the SCALE command. Choose all the objects that

you want to scale. Click any grip to activate it. This becomes the base point. Right-click to
open the Grip shortcut menu and choose Scale. You see the prompt:

** SCALE **
Specify scale factor or [Base point/Copy/Undo/Reference/eXit]:

Type a scale factor to scale the objects. The other options work as follows:

4+ Base point lets you define a base point —other than the activated grip. Right-click to
open the Grip shortcut menu and choose Base Point. You see the Specify base point:
prompt. Define a base point. The original Specify scale factor or [Base point/
Copy/Undo/Reference/eXit]: prompt appears. Define the scale factor to scale the
objects.

4+ Copy puts you in Multiple mode and lets you copy objects. Right-click to open the Grip
shortcut menu and choose Copy. You see the original Specify scale factor or
[Base point/Copy/Undo/Reference/eXit]: prompt. Specify a scale factor to keep
the original object and create a new scaled object. You can continue to create new
scaled objects.

4 Undo undoes the last edit. Right-click to open the Grip shortcut menu and choose Undo.

4+ Reference lets you specify a reference length and a new scale. Right-click to open the Grip
shortcut menu and choose Reference. You see the Reference Tength <0>: prompt.
Type a length or pick two points to specify a length. You see the Specify new length
or [Base point/Copy/Undo/Reference/eXit]: prompt. Type a length or pick a
point. This works like the Reference option for the SCALE command. (See Chapter 9.)

4+ eXit returns you to the Command prompt. Right-click to open the Grip shortcut menu
and choose Exit. Esc also returns you to the Command prompt.

Mirroring with grips
Mirroring with grips is similar to using the MIRROR command. Choose all the objects that

you want to mirror. Click any grip to activate it. This becomes the first point of the mirror
line. Right-click to open the Grip shortcut menu. Choose Mirror. You see the prompt:

** MIRROR **
Specify second point or [Base point/Copy/Undo/eXit]:
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Specify the second point of the mirror line to mirror the objects.

Caution By default, AutoCAD and AutoCAD LT erase the original objects. To keep the original objects,
you must use the Copy option. This feature is the opposite of the MIRROR command, where
the default is to keep the original objects.

The other options work as follows:

4+ Base point lets you define a base point —other than the activated grip—and a second
point. Right-click to open the Grip shortcut menu and choose Base Point. You see the
Specify base point: prompt. Define a base point —that is, the first point of the mir-
ror line. The original Specify second point or [Base point/Copy/Undo/eXit]:
prompt appears. Define the second point of the mirror line to mirror the objects.

4+ Copy puts you in Multiple mode and lets you keep the original objects. Right-click to
open the Grip shortcut menu and choose Copy. You see with the original Specify
second point or [Base point/Copy /Undo/eXit]: prompt. Specify the second
point to keep the original objects and create new mirrored objects. You can continue
to create new mirrored objects.

4 Undo undoes the last edit. Right-click to open the Grip shortcut menu and choose Undo.
4+ eXit returns you to the Command prompt. Right-click to open the Grip shortcut menu

and choose Exit. Esc also returns you to the Command prompt.

The drawing used in the following Step-by-Step exercise on editing with grips, ab10-j . dwg,
is in the Drawings folder on the CD-ROM.

STEP-BY-STEP: Editing with Grips
1. Open ab10-j.dwg from the CD-ROM.

2. Save the file as ab10-12.dwg in your AutoCAD Bib1e folder. This is a small section of a
drive block, seen from above, as shown in Figure 10-37. Make sure ORTHO and OSNAP
are on.

3. Use a selection window to select the entire model. Now hold down Shift and place a
selection window around the small circles and rectangle at the center of the model to
deselect them.

4. Pick the grip at @ in Figure 10-37 to activate it. You see the following prompt:

** STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]:

5. Right-click and choose Mirror from the shortcut menu. You see the following prompt:

** MIRROR **
Specify second point or [Base point/Copy/Undo/eXit]:

6. Right-click and choose Copy so that the original objects that you mirror are not
deleted.
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7.

10.

11

12.

At the Specify second point or [Base point/Copy/Undo/eXit]: prompt, move
the cursor to the right. You can see the mirror image of the model. Pick any point to the
right (in the 0-degree direction) of the activated grip.

I ]

Figure 10-37: This small section of a drive block, seen from
above, can easily be edited with grips.

. Right-click and choose Exit to return to the command line. The original objects are still

highlighted.

. Use a large selection window to select all the new objects including the small rectangle

and circles in the middle. Everything (old and new) should be highlighted and display
grips.
Pick the grip at @ in Figure 10-37 to activate it. Right-click and choose Rotate from the

shortcut menu. At the Specify rotation angle or [Base point/Copy/Undo/
Reference/eXit]: prompt, type 90 .. This action rotates the model.

. Pick the bottom-right grip to activate it. Right-click and choose Scale from the shortcut

menu. At the Specify scale factor or [Base point/Copy/Undo/Reference/
eXit]: prompt, type .5 . This action scales the model.

Pick the grip at the midpoint of the bottom line. Right-click and choose Move from the
shortcut menu. At the Specify move point or [Base point/Copy/Undo/eXit]:
prompt, type @0,-3 1. The model should look like Figure 10-38.

Figure 10-38: The drive block section, after
| | several grip edits, looks a little like a cookie jar.
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13. Press Esc to remove all grips. Define a crossing window by picking first at @), and then
at @ (see Figure 10-38).

14. Hold down Shift and pick all the grips along the bottom three lines. Release Shift and
pick the grip at the middle of the bottom line. At the Specify stretch point or
[Base point/Copy/Undo/eXit]: prompt, type @0,1 . to shrink the model.

If the stretch does not come out right (it might be hard to see and activate all the
grips), choose Undo from the Standard toolbar to undo the stretch and try again.

15. Save your drawing.

Customizing grips

You can turn grips on and off and customize their size and color. Choose Tools => Options and
click the Selection tab to open the dialog box shown in Figure 10-39.

i Optiens (B[]
Current profile: Ellen Current drawing: Drawingl.dwg

Files || Display | Open and Save | Plot and Publish| System || User Preferences | Drafing Selection | Profiles

Pickbox Size Grip Size

] J ] J
Selection Modes Grips
Noundverb selection Unselected arip color:
[ Use Shit ta add to selection I Color 180 v
[ Press and drag

Selected arip color,
Implied windowing

B Red ")
Object grouping
[] sssociative Hatch Hower grip color:

[ Gieen -

Enable grips
[ Enable grips within blacks
Enable grip tips

100 Object selection limit for display of grips

Figure 10-39: Use the Selection tab of the Options dialog box to
customize grips.

By default, grips are enabled (that is, turned on). Also by default, grips are turned off for
blocks. (Chapter 18 covers blocks.) When grips are off for blocks, you see only one grip
when you select a block—its insertion point. When grips for blocks are on, you see all the
grips you would normally see for objects.

In the Grip Colors section, you can choose the colors you want for unselected and selected
(hot) grips. Click the drop-down lists to choose a color.

The Grip Size section lets you drag the slider bar to set the size of the grips. Click OK after
you've made the desired changes.
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Editing with the Properties Palette

Tip

The Properties palette displays the properties of selected objects. You can also use the
Properties palette to change the properties of objects.

m:= To open the Properties palette, click Properties on the Standard toolbar. (You can also
= A choose Tools = Properties or press Ctrl+1.) The Properties palette, shown in Figure 10-40,
opens on your screen.

x
Line vl T
General
Color B BylLayer
Layer 0
Linetype ByLayer
Linetype scale 1.0000
Plotstyle ByColor
Lineweight ByLayer
Hyperlink
Thickness 0.0000
o Geometry
|~ Start X 6.2630
& Start Y 17.7061
=)
&
| M
i= /

Figure 10-40: Use the Properties palette to
edit objects and their properties.

Managing the Properties palette

The new auto-hide feature of the Properties palette makes it easy to work with the palette
open all the time. Whenever the cursor is off the palette, it collapses to just the title bar. To
auto-hide the palette, right-click the title bar and choose Auto-hide.

The Properties palette has its own undo function. Right-click the item that you changed in the
Properties palette and choose Undo. Multiple levels of undo are available. For more informa-

'} tion about palettes, see Chapter 26.

You can dock the Properties palette. Drag the window to the left or right of your screen. To
resize the window, point to its edge until you see the double-headed arrow cursor, and then
click and drag. You can also resize the two columns by pointing to the column dividing line
until you see the double-headed arrow and then clicking and dragging. If the Properties
palette has too many rows for its size, use the scroll bar to see the undisplayed rows.
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Using the Properties palette

The Properties palette can be used to directly edit objects and to edit other object properties
as well:

4+ You can change the layer, color, linetype, linetype scale, and lineweight of objects.
(See Chapter 11.)

4 You can edit text and text properties. (See Chapter 13.)
4 You can edit plot styles. (See Chapter 17.)
4+ You can edit hyperlinks. (See Chapter 28.)
To change values in the Properties palette, do one of the following:
4+ Click a value, select the text, type a new value, and press Enter.
4+ Click a value, click the down arrow at its right, and choose from the drop-down list.

+ Click a value, click the Pick a Point button, and specify a new point by picking on
the screen.

In Figure 10-40, you see the result of opening the Properties palette with one line selected. To
change either endpoint of the selected line, type new coordinates in the Properties palette
and press Enter. Of course, this method of editing a line is only useful when you know the
absolute coordinates that you want. When you select a geometric property, such as Start X,
the X coordinate of the line’s start point, you can also use the Pick a Point button that appears.
You can click this button and then pick a new start point directly on your screen. The new
point becomes the new start point of the line, changing both the X and Y coordinates of the
start point if your pick point requires it.

The information you see in the Properties palette depends on the objects selected:

4+ If no object is selected, you see only properties that apply to the entire drawing, such
as UCS, current layer, and viewport data. You can select an object while the window is
open to display data on that object.

4+ If one object or one type of object (such as all lines) is selected, you see both general
information and geometrical information on that object or object type.

4 If more than one type of object is selected, you see general information, such as layer,
color, and linetype data, but no geometry data.

4+ If more than one object is selected and you choose one type of object from the drop-
down list at the top of the window, you see information applying only to that type
of object. This drop-down list provides a quick way to filter the type of objects you
can edit.

The Properties palette has three buttons at its upper-right corner.

= . Quick Select opens the Quick Select dialog box covered in the next section. The Quick
ﬁ:" Select dialog box lets you create a selection set according to specified criteria (for
example, all green lines). You can then change the properties of these green lines.
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j} Select Objects enables you to select objects for editing in the Properties palette. After

4 you select the objects you want, you can change their properties. If you're going to pick
objects or use implied windowing, the Select Objects button is no advantage. You can just
select the objects and apply changes in the Properties palette. However, if you want to use a
fence or polygon method of selection, the Select Objects button is helpful. Follow these steps:

1. Click the Select Objects button.

2. On the command line, type the selection method that you want (such as f for
fence) as you would if a command were active or you had started the SELECT
command.

3. Select the objects that you want.
4. Press Enter to end object selection.

5. Use the Properties palette to make the desired changes. (You can also start an editing
command to use with the selected objects.)

Toggle Value of PICKADD Sysvar turns PICKADD on and off. PICKADD changes how you select
more than one object. When it’s on (set to 1), the default, you can continue to select objects
and they’re added to the selection set. When it’s off (set to 0), you need to press Shift to add
objects to the selection set; otherwise, selecting an object deselects previously selected
objects.

Here’s how to change the PICKADD variable:
: When you see the 1, PICKADD is off. Click the button to turn PICKADD on.

: When you see the plus, PICKADD is on. Click the button to turn PICKADD off.

Click the Properties palette’s close box to close the window. I further cover the Properties
palette in the next chapter and in later chapters as appropriate.

Selection Filters

Sometimes you need a more powerful way to select objects. For example, you may
want to:

4 Select all the lines in your drawing to change their color
4 Check the arc radii of all your fillets
4+ Find short line segments that should be erased

Before selection filters, you had to write an AutoLISP program to accomplish these functions.
(Sometimes an AutoLISP program is still the easiest way to go. See Chapters 34 through 36.)
Now you can create fairly complex filters that select only the objects you want.

g @ Don't confuse object selection filters with point filters. Chapter 4 covers point filters.
\ eference
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Using Quick Select to select objects

Quick Select, as its name suggests, is a quick, flexible, and simple way to create object selec-
tion filters. Use the FILTER command, covered in the following sections, to create more-complex
filters and when you want to save filtering criteria for future use.

Start Quick Select in one of these ways:
4 Choose Tools => Quick Select.
4+ With no command active, right-click in the drawing area and choose Quick Select.
4 Click the Quick Select button in the Properties palette.
4+ Type gselect - on the command line.

The Quick Select dialog box opens, shown in Figure 10-41.

i Quick Select @@ Figure 10-41: Use the Quick Select dialog box to
quickly create a selection set of objects based on
Apply to: | Enkie diawing hd specified criteria.
Object type: | Multiple -
Froperties: | Color
Layer
Linetype
Linetype scale
Plat style
Lineweight
Hyperlink.
Operator: | =Equals v
Walue: | Il ByLayer -
How to apply:
(%) Include in new selection set
() Exclude from new selection st
[ Append to current selection set
[ (K. ] [ Cancel ] l Help

To create a filter, start at the top of the dialog box and work your way down. Here’s how it works:

4+ Apply to: By default the filter applies to the entire drawing, but you can use the Select
Objects button to return to your drawing and select objects. The rest of the filter will
then apply only to selected objects, called Current Selection in the drop-down list. If
you use this feature at all, you would usually use a window to select an area of your
drawing. (The Select Objects button is unavailable if Append to Current Selection Set
is checked at the bottom of the dialog box.)

4+ Object type: By default, the filter lists Multiple as the object type. Click the drop-down
list to choose from the object types available in your drawing (or in your selection set
if you created one), such as line, circle, ellipse, polyline, and so on. You can choose
only one type of object. To create a filter that includes more than one type of object
(but not all types), use the FILTER command, which I describe in the next section.
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New

<+

\

Feature

+

Properties: Here you choose the properties that you want to filter. (Most of these prop-
erties are covered in the next chapter.) The drop-down list includes all properties in
the drawing’s database —these depend on the object type you chose. You can choose
only one property. The values in the next two sections depend on your choice in the
Properties section. If you want to create a filter that specifies criteria for more than one
property, use the FILTER command.

Operator: After you’'ve chosen a property, you can set it equal to or not equal to a cer-
tain value. You can set certain properties as greater than or less than a value. You can
use wildcard matching characters (such as * and ?) for editable text. Choose the desired
operator from the drop-down list.

Value: Here you finally choose the value for your property. For example, you can set
the color equal (or not equal) to green or the linetype equal to DASHED. Choose the
desired value from the drop-down list or enter a value in the text box.

You can now choose Block Reference as the object type, Name as the property, and the name
of a block as the Value to select all instances of that block.

How to apply: As soon as you create a filter, you can use it to create a selection set.

To do this, check Include In New Selection Set. You can also use Quick Select to select
everything except objects that meet your selection criteria—to do so, choose Exclude
From New Selection set.

Append to current selection set: Check this box to add to an existing selection set
objects meeting your criteria.

Click OK to select the objects meeting your criteria and close the dialog box. You can start a
command and use the selection set. If the command must be started before selecting objects,
you can use the Previous option (type p ) at the Select objects: prompt to select the
objects selected by using Quick Select.

N

AutoCAD
Only

N4

' Note

The Express Tools include two commands to create filtered selection sets. FASTSELECT creates
a selection set of objects that touch the object you pick. You can create chains of objects to
include objects that touch other touching objects. Choose Express = Selection Tools = Fast
Select. GETSEL creates a selection of objects of the layer and object type that you select.
Choose Express < Selection Tools > Get Selection Set. For information on installing Express
Tools, see Appendix A.

Using the FILTER command

The advantage of using the FILTER command over Quick Select is that you can create more-
complex filters and save them.

To create a filter, type filter - on the command line to open the Object Selection Filters dialog
box, as shown in Figure 10-42. If you've already chosen a command, type 'filter at the Select
objects: prompt to create the selection filter transparently. The box at the top of the dialog
box lists the filters you specified.

el

The selection filter only finds colors and linetypes of objects that have been specifically set as
such, rather than as part of a layer definition. Chapter 11 covers layers, colors, and linetypes.
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il Object Selection Filters

< »

Select Filter

Mamed Filters:
Current: *unnamed -
[ Delete Current Filter List ]
o List:
[ Add Selected Object < ] l Apply ] [ Cancel ] [ Help ]

Figure 10-42: The Object Selection Filters dialog box.

Creating a single filter

Use the Select Filter section of the dialog box to specify a filter. The drop-down box lists all
the possible filters. Click the arrow to drop the list down. You can choose from several types
of items:

4+ Objects
4+ Object properties such as color or layer
4+ Object snaps such as arc center or circle radius

4+ Logical operators such as AND, OR, and NOT (these logical operators combine filter spec-
ifications in various ways)

The first step is to choose a filter. In Figure 10-43, Line was chosen from the drop-down list. If
the item chosen does not need any further clarification, click Add to List. The filter appears in
the box at the top of the dialog box. Notice that the filter appears as Object = Line.

il Object Selection Filters
Object = Line
< >
Select Filter
-E|EEIL\S[
Line “ =
Named Filters
Current: “unnamed v
- = [ Delete Current Filter List ]
tAdd ta List:
[ Addd Selected Dbiject ¢ | Coow | [(cowa ] [ v

Figure 10-43: A filter that chooses all lines.
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Many filters require a value. You have two ways to enter a value:

4+ If you choose an object that can be listed, the Select button becomes active. Click it
and choose the value you want. For example, if you choose Color or Layer, you choose
from a list of colors or layers.

4+ If you choose an object that can have any value, the boxes below the drop-down list
box become active. They are labeled X, Y, and Z, but this is misleading. These boxes are
used for X, Y, and Z coordinates only when you choose a filter requiring coordinates,
such as Viewport Center. In most cases, you use the X box to give the filter a value. In
this situation, the Y and Z boxes are not used. For example, if you choose Text Height,
you type the height in the X box.

However, you don’t always want to specify that a filter equals a value. Let’s say you want to
create a filter that selects all circles with a radius less than 0.75. When you choose Circle
Radius, the X box becomes active. Click the arrow to drop down the list of relational opera-
tors and choose one. Table 10-2 lists the relational operators.

Table 10-2: Relational Operators in the Object Selection Filters Dialog Box

Operator Definition

= Equal to

1= Not equal to

< Less than

<= Less than or equal to

> Greater than

>= Greater than or equal to

Equal to any value

Adding a second filter

To add a second filter, you first decide on the relationship between the first and the second
filter and then assign a logical operator. Logical operators always come in pairs —when you
begin one, you must also end it. The logical operators are at the end of the drop-down list of
filter objects.

' Note When two or more filters are listed without logical operators, the filter calculates them as if
— they were grouped with the AND operator. This means that the filter only selects objects that
meet all the criteria specified.

Table 10-3 explains the four logical operators (called grouping operators because they group
filter specifications together). The Example column explains the results of two filter specifica-
tions: Color = 1-Red and Object = Circle.
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Table 10-3: Logical (or Grouping) Operators Used for Selection Filters

Operator  Explanation Example

AND Finds all objects that meet all criteria Finds red circles

OR Finds objects that meet any of the criteria Finds all red objects and all circles

XOR Finds objects that meet one criterion or the  Finds red objects that are not circles and
other but not both. Requires two criteria circles that are not red
between Begin XOR and End XOR

NOT Excludes objects that meet the criteria. If the NOT operator groups the Object = Circle

May only have one criterion between

filter, finds all red objects that are not circles

Begin NOT and End NOT

Click Substitute and choose a saved filter to insert a saved filter into the filter you're cur-
rently defining. To add filters based on existing objects, choose Add Selected Object. This
action adds all the properties of the object to the filter definition — which is often more than
you want.

Figure 10-44 shows a filter that selects all lines and all polylines. The XOR operator was used
because it finds objects that meet one criterion or the other but not both. Obviously, no object
can be both a line and a polyline. This is a good example of a filter that you cannot create
using Quick Select.

jEl Object Selection Filters
= Begin OR A
Object = Palyline
Object = Line
*End OR -
< >
Select Filter
Clear List
F— -
Named Filters
Current: *unnamed -
l Delete Current Filter List ]
[ Add Selected Object < | Camr ) (o) e

Figure 10-44: A filter that selects all lines and all
polylines.

Naming and editing filters

After you've completed the filter, you should save it. Even if you don’t think you’ll use it again,
you may make an editing error in the drawing while using it and have to go back to it. To save
a filter, type a name in the Save As text box and click Save As.
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You edit a listed filter by using three buttons:

4+ Edit Item: Choose the line containing the item and click this button to edit the item.
The object name is now in the drop-down box and you can specify new values for it.

4 Delete: Choose Delete to delete a chosen item in a filter.
4 Clear List: Choose Clear List to clear all the items in a filter and start over.

To choose a named filter to edit, choose it from the Current drop-down list.

Using filters

You can use filters in two ways. Most often, you choose a command first and then realize
that you need a filter to select the objects. Follow these prompts:

Select objects: 'filter 4

Define the filter in the 0Object Selection Filters dialog box. Click
Apply.

Applying filter to selection.

Select objects: Type all Jd or use a large selection window to select
all the objects you want to consider in the filter.

x found

y were filtered out

Select objects: o

Exiting filtered selection. x found

Select objects: o

The command’s usual prompts then continue.

Alternatively, you can start the FILTER command and define the filter. Click Apply. At the
Select objects: prompt, type all or use a selection window. Press Enter to end object
selection. Then start the editing command and use the Previous selection option to select
the filtered objects.

On the \ The drawing used in the following Step-by-Step exercise on using selection filters, ab10-k.
\  dwg, isin the Drawings folder on the CD-ROM.
5 J

CD-

.
STEP-BY-STEP: Using Selection Filters
1. Open ab10-k.dwg from the CD-ROM.

2. Save the file as ab10-13.dwg in your AutoCAD Bib1e folder. Notice that two lines of
text appearing in the middle of the drawing plus the text at the bottom of the drawing
are black/white rather than blue like all the other text. You want to check the color of
all the text and correct it if necessary.

3. Right-click the drawing area and choose Quick Select. In the Quick Select dialog box,
click the Object Type drop-down list and scroll down until you see Text. Choose it.

4. In the Properties section, Color should be selected. If not, select it. In the Operator sec-
tion, choose Not Equal. In the Value section, choose ByLayer. Include In New Selection
Set should be chosen. Append to Current Selection Set should not be checked. Click OK
to select three items of black/white text.
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. Press Esc to deselect the objects and remove the grips. Now you’ll try the same thing
using the FILTER command, but add a level of complexity.

. Type filter .. The Object Selection Filters dialog box opens.

. In the Select Filter drop-down list, choose Text. Click Add to List. At the top, the filter
reads Object = Text.

. From the Select Filter drop-down list, choose **Begin AND (this is toward the bottom
of the list) and click Add to List.

. From the Select Filter drop-down list, choose Color. In the drop-down list next to X:
choose ! = (not equal). Choose Select. In the Select Color dialog box, choose BYLAYER.
Click OK. In the Object Selection Filters dialog box, choose Add to List. The BYLAYER
color number displays as 256. (Layers and colors are covered in the next chapter.)

Say that you want to select only the smaller text, not the heading at the bottom of the
drawing, and you know that the larger text’s height is greater than .1 but the smaller
text’s height is smaller than .1. From the Select Filter drop-down list, choose Text Height.
From the X: drop-down list choose < (less than). In the text box to the right of X:, type .1.
Choose Add to List.

From the Select Filter drop-down list, choose **End AND and click Add to List.

In the Save As text box, type bad text. Click Save As. The Object Selection Filters dialog
box should look like the following:

Object = Text

**Begin AND

Color !=256 - Bylayer
Text Height < 0.100000
**End AND

Click Apply.

At the Select objects: prompt, type all 1. The prompt tells you that 469 objects were
found, and 467 were filtered out. Press Enter until you get the Command prompt.

Choose Color Control from the Object Properties toolbar. Choose ByLayer from the
drop-down list. The two text objects change to the BYLAYER layer — they turn blue like
all the other text.

. Save your drawing.

As you can see, Quick Select is much easier to use than the FILTER command for all but quite
complex filters, but the FILTER command offers more control.

Groups

Grou

ps let you save a selection set of objects so that you can easily select them whenever

you need to edit them. If you have a certain set of objects that you need to edit as a group,
and a busy drawing that makes their selection time-consuming, groups are for you. After you

setu

p the group, you pick any object in the group to automatically select all the objects in

the group.
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Note Although both AutoCAD and AutoCAD LT include the group feature, the dialog box for creating

~  and managing groups is different for AutoCAD and AutoCAD LT. Over the next few sections,
be sure to note which program I'm discussing.

Creating and modifying groups in AutoCAD

To create or modify a group, type group . on the command line to open the Object Grouping
dialog box, as shown in Figure 10-45.

Object Grouping

Group Mame Selectable

Graup |dentification

Group Name: “ |

Description: | |

[ Include Unnamed

Create Graup

Selectable ] Unnamed

Change Group

[ 0k } [ Cancel ] [ Help ]

Figure 10-45: The Object Grouping
dialog box.

Creating a hew group
To create a new group in AutoCAD, follow these steps.

1. Type a name in the Group Name text box. You can use a maximum of 31 characters with
no spaces. You can use the hyphen (-) and underscore (_) anywhere in the name.

2. If you want, type a description of up to 448 characters. The description can include
spaces.

3. Click New. AutoCAD returns you to your drawing with the Select objects: prompt.
Select the objects you want to be in the group. Press Enter to end object selection.
AutoCAD returns you to the dialog box.

4. Click OK.

You can now use your group.
Note An object can belong to more than one group.
The Group Identification section of the Object Grouping dialog box also has a Find Name

button. Use this to find the name of the group to which an object belongs. AutoCAD lets
you select an object and then lists the group’s name or names.
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The Highlight button highlights a group. First choose a group from the list in the Object
Grouping dialog box. Click Highlight and AutoCAD returns to your drawing and highlights all
the objects in your group. Click Continue to return to the dialog box. Use this when you aren’t
sure which group you want to work with.

Changing a group

The Change Group section of the Object Grouping dialog box gives you a great deal of flexibil-
ity in managing groups. To change a group in AutoCAD, click any existing group in the Group
Name list at the top of the dialog box. The buttons in the Change Group section all become
active. You can do the following:

4+ Remove: AutoCAD switches to the drawing area with the Select objects to remove
from group . . . prompt. Select objects to remove and press Enter to end object
removal. AutoCAD returns you to the dialog box. Click OK.

4 Add: AutoCAD switches to the drawing area with the Select objects to add to
group . . . prompt. Select objects to add and press Enter to end object selection.
AutoCAD returns you to the dialog box. Click OK.

4+ Rename: Choose the group you want to rename. Change the name in the Group Name
text box. Click Rename. The name changes in the Group Name list at the top of the dia-
log box. Click OK.

4+ Re-Order: Each group in the object has a number, starting from zero. In rare cases, the
order may be important to you—for example, if you're running a program that processes
the members of a group. Choose the group you want to reorder. Click Re-Order. AutoCAD
opens the Order Group dialog box. If you simply want to reverse the order of all the
objects, click Reverse Order. Otherwise, click Highlight. AutoCAD opens a small Object
Grouping message box with Next and Previous buttons. At the bottom-right corner, the
box displays Object: 0, and one of the objects in the group is highlighted. Click Next
to move from object to object. If you're going to reorder the objects, you probably need
to write down the number of each object. Click OK to return to the Order Group dialog
box. Complete the following text boxes:

¢ Remove from position: This text box is the position number of the object you
want to move.

* Replace at position: This text box is the new position number you want for the
object.

e Number of objects: This text box is the object number or range of numbers you
want to reorder.

4+ Description: Updates a description for the group. Type a new description in the Group
Identification section of the dialog box. Then click Description.

4+ Explode: Removes the group entirely. All the objects remain in your drawing, but they
are no longer grouped.

4+ Selectable: Toggles the selectability of the group. If a group is selectable, selecting one
object of the group selects the entire group. If a group is not selectable, selecting one
object of the group does not select the entire group. This option lets you temporarily
work with one object in the group without having to explode the group. You can also
press Ctrl+Shift+A to toggle the selectability of the group.
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Tip When you choose Highlight from the Order Group dialog box, the Object Grouping message
, box opens in the middle of the screen, covering your objects. Drag it to one corner of the
/  screen so that you can see which objects are being highlighted.

Creating and modifying groups in AutoCAD LT

To create or modify a group in AutoCAD LT, choose Tools => Group Manager to open the Group
Manager window, as shown in Figure 10-46. You can dock this window by dragging to the top
or bottom of the drawing area.

Group Manager %
Group Selectable Description [include Unnamed Groups
B 7|

Select objects & click Create Group

Figure 10-46: Use the Group Manager window to create
and manage groups in AutoCAD LT.

Creating a new group
To create a new group in AutoCAD LT, follow these steps.

1. With the Group Manager open, select the objects that you want to include in the group.
(An object can belong to more than one group.)

2. =, Click the Create Group button. An empty box appears under the Group column of
iE" the Group Manager.

3. Type a name for your group and press Enter. You can use a maximum of 31 characters
with no spaces. You can use the hyphen (-) and underscore (_) anywhere in the name.

4. If you want, click in the Description column and add a description for your group.

A light bulb appears in the Selectable column to indicate that the group is selectable
& (that is, functioning as a group). To close the Group Manager, click its Close button at
the upper-right corner of the window. You can now use your group.

Changing a group in AutoCAD LT

Use the Group Manager toolbar to manage your groups. To work with your groups, click any
existing group. You can then do the following:

4+ Ungroup: Deletes the group. All the group’s objects become individual objects again.

4 Add to Group: Select an object or objects not in the group and click this button to add
the selected object or objects to the group.

4+ Remove from Group: To remove an object from a group, click the Selectable icon. You
can now choose individual objects in the group without selecting the entire group. Click
in your drawing and pick the object that you want to remove. Then click the Remove
from Group button.
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4+ Select Group: To select the group from the Group Manager, select the group name and
click the Select Group button.

4+ Deselect Group: Deselects the group.

To toggle a group from selectable to not selectable, click the group’s icon in the Selectable
column. When a group is not selectable, you can individually select its objects.

Using groups

Using a group is very simple. If a group is selectable, just pick any object in the group to select
all the objects in a group. You can then edit the objects in the group as a whole. If you need to
temporarily edit one object in a group, turn off the group’s selectability, as described in the
previous sections.

You can change the selectable status of all groups in your drawing by choosing Tools => Options
and clicking the Selection tab. Deselect Object Grouping in the Selection Modes section to
disable object grouping entirely.

Summary

This chapter covered all the more-advanced editing commands. You read about:
4+ Mirroring objects
4 Creating rectangular and polar arrays
4+ Creating an offset of an object
4+ Aligning objects
4 Trimming and extending objects
4+ Stretching objects
4+ Lengthening (and shortening) objects
4+ Breaking objects
4+ Creating chamfered corners and fillets for square, beveled, and rounded corners
4+ Using grips to stretch, move, mirror, rotate, and scale objects
4 Double-clicking objects to edit them
4+ Using the Properties palette to see the properties of objects and to edit objects

4+ Creating filtered sets of selected objects with the Quick Select feature and the FILTER
command

4+ Creating and using named groups of objects
In the next chapter, I cover layers, colors, linetypes, and lineweights.

+ o+ 4






Organizing
Drawings with
Layers, Colors,
Linetypes, and
Lineweights

U ntil now, you have drawn everything in black or white. Drawing
everything in one color is not a very good way to draw — besides,
it’s boring! If everything is the same color, it’s hard to distinguish the
various elements of a drawing. If you've followed the exercises through-
out this book, you've opened some drawings from the CD-ROM that
used various colors and linetypes (such as dashed lines). For example,
in some of the architectural drawings, you may have noticed that the
walls are a different color than the fixtures (refrigerator, sink, and so
on) in the kitchen. When you start to create text and dimensions, cov-
ered in Chapters 13, 14, and 15, you will almost always use a color that
stands out from the main model you're drawing. You can also create
objects with varying widths, called lineweights. This use of color, line-
type, and lineweight helps to organize your drawings, making them
easier to understand.

In AutoCAD and AutoCAD LT, black and white are the same color. If
you use the default background of black, the default color is white.
If you change the background to white, the same objects appear as
black.

Most often, you assign color, linetype, and lineweight to a layer. A
layer is simply an organizational tool that lets you organize the dis-
play of objects in your drawing. Every object must have a layer, and
every layer must have a color, a linetype, and a lineweight. You define
layers that meet your drawing needs. Layers, colors, linetypes, and
lineweights are called object properties. You can easily change any
object’s properties. This chapter explains how to create and change
these object properties to organize your drawing.

CHAPTER

¢+ 4+ 0+
In This Chapter

Organizing your
drawing

Working with layers

Changing obiject color,
linetype, and lineweight

Working with linetype
scales

Importing layers and
linetypes from other
drawings

Matching properties
+ + + +
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Working with Layers

The best way to organize your drawing into colors, linetypes, and lineweights is to use layers.
Layers offer powerful features that enable you to distinguish all the various elements of your
drawing. In an architectural drawing, for example, common layers are walls, doors, windows,
plumbing, electrical, fixtures, structural elements, notes (text), dimensions, and so on.
Mechanical drawings might use center, hidden, hatch, object, and title block layers. Each dis-
cipline has its own conventions, and you might have specific conventions where you work.

Creating layers is an important part of setting up a drawing, in addition to the setup features
covered in Chapter 5. Layers should be created and saved in your templates so that they're
available to you when you start to draw.

Layers give you many ways to organize your drawing. For example, you can
4+ Assign different colors, linetypes, and lineweights to layers.

4 Assign the various colors to different pens in a pen plotter, resulting in a drawing with
varying colors or line widths.

4+ Control the visibility of layers. Making a layer invisible lets you focus on just the
objects that you need to draw or edit.

4+ Control which objects are plotted.

4+ Lock a layer so that objects on that layer cannot be edited.

Cross- You can also assign a plot style to a layer. A plot style is a group of settings that affects how your
Reference drawing is plotted. Chapter 17 covers plot styles.

Understanding layers

Besides having a color, linetype, and lineweight, every layer must have a name. All drawings
come with a default layer, called layer 0 (zero). Its color is Black/white, its linetype is Con-
tinuous, and its lineweight is Default. (The lineweight for Default is 0.010 inch or 0.25 mm.) All
the exercises in this book up to this point have used layer 0. To create a new layer, you must
give it a name, a color, a linetype, and a lineweight. You can then start drawing on that layer.

Layers also have four states. These states control visibility, regeneration, editability, and plot-
tability of layers:

4+ On/Off: On layers (the default) are visible. Off layers are invisible and are regenerated
with the drawing.

4+ Thawed/Frozen: Thawed layers (the default) are visible. Frozen layers are invisible and
are not regenerated with the drawing. However, when you thaw a frozen layer, the draw-
ing regenerates. If you have floating viewports (covered in Chapter 17), you can also
freeze a layer just in the current viewport, or only for new viewports that you create.

4+ Unlocked/Locked: Unlocked layers (the default) are visible and editable. Locked layers
are visible but cannot be edited.

4+ Plottable/Not Plottable: Plottable layers are plotted. Not plottable layers are not plot-
ted. This setting affects only layers that are on or thawed because off and frozen layers
are not plotted anyway.
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Creating new layers

... To create a new layer, choose Layer Properties Manager from the Layers toolbar. The
=== Layer Properties Manager dialog box opens, as shown in Figure 11-1. From this point on,
I'll just call this dialog box, the Layer Properties Manager. This dialog box lists all current lay-
ers and their properties. You can also create new layers and modify current ones. The left
panel allows you to filter the list of layers. For more information, see “Filtering the layer list”
later in this chapter.

i Layer Properties Manager B[]
S8 B X ¥ Curertlayer TEXT
= 5z Al Stal Name Linetype | Lineweight | Plot Style | Plot| Descriptior
<Z AlUssdLapers (|20 Continuous — Default =
- CENTER CENTERZ —— Default &
~e Defpoints Continuous — Default
<& dim Continuous — Default &
& dim-ps Continuous — Default &
~& HATCH Continuous — Default &
~& HID HIDDEN ~ — Default Y
~& NP Continuous —— Default Y
~ 0BJ Continuous —— Default &
- T8 Continuous —— Default &
& TEXT Continuous — Default &
.‘ A >
All Used Layers: 11 layers displayed of 13 total layers
[irrvet fiter [2] Apply to lapers toolbar [ ok ][ camcel | [ ey ][ Hew |

Figure 11-1: The Layer Properties Manager is the place to
manage all your layers.

Table 11-1 explains the columns in the dialog box. For a description of the icons in most of
the columns, see Table 11-2.

Table 11-1: Columns in the Layer Properties Manager

Column Name Description
Status Shows the status of each layer.
Used layer.

Unused layer.

J Current layer.

Name Shows the name of the layer. To change the layer, click once to display a border
and click again to type a new name.

On Shows the current on/off state of a layer. Click to turn the layer on or off.

Freeze Shows the current freeze/thaw state of a layer. Click to freeze or thaw a layer.

Lock Shows the current locked/unlocked state of a layer. Click to lock or unlock a layer.

Color Shows the current color of the layer. Click to change the color.

Continued
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Table 11-1 (continued)

Column Name Description

Linetype Shows the current linetype of the layer. Click to change the linetype.

Lineweight Shows the current lineweight of the layer. Click to choose a new lineweight.

Plot Style Shows the current plot style of the layer. Click to select a new plot style. (Chapter

17 covers plot styles).

Plot Shows the current plottable/not plottable state of the layer. Click to make the layer
plottable or not plottable.

Current VP Freeze  Shows the freeze/thaw state of the layer in the current floating viewport. Click to
freeze or thaw the layer in active floating viewports. This column is displayed only if
you have floating viewports and a layout tab is active. (Chapter 17 covers floating
viewports.)

New VP Freeze Shows the current freeze/thaw state of the layer in new floating viewports that you
create. Click to freeze or thaw the layer in new viewports. This column is displayed
only if you have floating viewports and a plot layout is active. (Chapter 17 covers
floating viewports.)

Description Provides a place to enter a description of a layer.

To adjust the display in the Layer Properties Manager, you can do the following:

4 Change the width of any column in the Layer Properties Manager by placing the cursor
over the line dividing two column headings and dragging.

4+ Double-click the line dividing two columns to minimize the column width.

4+ Click any column head to sort the layers by that column. Click again to sort in the
opposite order.

4+ Resize the entire dialog box by dragging on any side.

Naming the layer

3 Click the New Layer icon. A new layer appears, named Layerl, as shown in Figure 11-2.
The name is highlighted so that you can immediately type in a new name for the layer.
Press Enter after you type the name.

Tip To create several new layers at once, click New and type all the layer names you want, sepa-
), rated by commas. Press Enter after the last layer that you want. If you want a new layer to have
7 the same color and/or linetype as an existing layer —which is very common — choose that
existing layer and click New. The new layer inherits the properties of the selected layer. You

can then make any changes you want.

Layer names can be up to 255 characters long and may include spaces. Layer names retain the
uppercase/lowercase characters that you type. Layer names may not include the following
symbols: < > / \ " ; ? * | )
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Stat Na On | Fre | Loc| Colar Linetype Lineweight Plot Styl | Plot| Description
4 0 Y O 75 M white Continuous —— Default =y
Layer] |, (U U1 M white Continuous —— Default =

Figure 11-2: The new layer appears as Layer1 and is highlighted
so that you can enter the new layer name.

Assigning a color

To change the default color, move the cursor to the color box in the same row as the new
layer. Click to open the Select Color dialog box, as shown in Figure 11-3 with the Index Color
tab displayed. (The AutoCAD LT Select Color dialog box doesn’t have any other tabs.)

i Select Color @@| Figure 11-3: The Select Color dialog box.

Index Color True Calor Color Books
AutaCAD Color Indes [ACI):
[ |

Index color: 246 Red, Green, Blue: 78019

] EEEN
EEEN
Calar
white]
aK ” Cancel ][ Help ]

Click the color that you want. At the bottom of the dialog box, the color’s name or number
appears along with a sample of the color. Click OK to close the dialog box and return to the
Layer Properties Manager.

Note that the Index Color tab offers you a choice of standard colors, gray shades, and a fuller
palette of colors. The standard colors are the original colors that AutoCAD (and then AutoCAD
LT) offered, and they’re the ones most often used, even today. Their advantage is that each
color is easily distinguishable from the others. These colors have both a name and a number,
whereas other colors have only a number (an index). The standard colors are red (1), yellow
(2), green (3), cyan (4), blue (5), magenta (6), and white (7).

You have the choice of using many different colors for the background color of a drawing, but
commonly it is a black or a white screen. The default screen is black and the default color for
7 is white. When you work on a white screen, the default color for 7 appears black, but it is
still called white. Therefore, if you choose the black color tile in the Select Color dialog box,
the color is listed as white. To change the screen color, choose Tools &> Options = Display =

Colors.
N\ AutoCAD offers two other tabs in the Select Color dialog box. The True Color tab lets you
AutoCAD define any color and the Color Books tab lets you use special files that define colors.

Only

A
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Installing color books

You can install additional color books. Color book files must have an . ach file extension. In addi-
tion to Pantone color books, you may be able to find DIC or RAL color specification files.

The default location for color books is in the Support\Color subfolder of your AutoCAD 2005
program folder. If you copy color-book files there, you can find them on the Color Books tab of the
Select Color dialog box. Another default location is in the Documents and Settings\username\
Application Data\AutoCAD 2005\R16.0\enu\Support\Color folder. You use this folder for
color books that you install. To use color books from another location, follow these steps:

1. Choose Tools => Options to open the Options dialog box.

2. Choose the Files tab.

3. Double-click the Color Book Locations item.

4. Click Add and then click Browse. Locate the color book file and click OK.

If you have the Select Color dialog box open while you copy a new color-book file to a location,
close the dialog box and re-open it to access the new colors.

For more color choices, click the True Color tab, shown in Figure 11-4.

i Select Color @&| Figure 11-4: The True Color tab of the Select
indes Calor Trae Coler Color Bosks Color dialog box offers a more precise way to
Hue: Saturation: Luminance:  Color model deﬁne COIOr.
mEEE s &

True Color Stored

as RGA:

Red: 52

Gresn: 123
i Blue: 197

B -

52123197
0K ] [ Cancel I [ Help ]

To define a color, first choose the color model from the Color Model drop-down list. You have
two choices:

4 HSL (Hue, Saturation, Luminance): Hue is the actual wavelength of light that defines
the color. Saturation is the purity or intensity of the color. Luminance is the brightness
of the color.

4+ RGB (Red, Green, Blue): Defines a color according to the intensity of red, green, and
blue in the color.



Chapter 11 4+ Organizing Drawings with Layers, Colors, Linetypes, and Lineweights

If you choose the HSL color model, specify the color as follows:

1. Specify the hue by dragging the crosshairs horizontally across the colors or type a
value from 0° to 360° in the Hue text box.

2. Specify the saturation by dragging the crosshairs vertically over the colors or type a
value from 0% to 100% in the Saturation text box.

3. Specify the luminance by

dragging the bar on the color slider or type a value from 0%

to 100% in the Luminance text box.

' Note When you define a color using the HSL color model, you also see the RGB values displayed
il in the Select Color dialog box.

If you choose the RGB color model, specify the red color by dragging the color bar or type a
value from 1 to 255 in the Red text box. Do the same for the green and blue color values.

You can also choose a color using the Color Books tab, shown in Figure 11-5.

i Select Color

@] Figure 11-5: The Color Books tab of the Select

Index Colar True Calor Calor Books
Color bock.
PANTONE(R) a & Footton "

-PANTDNE 154010 TC

PANTONE 13-5004 TC

-PANTDNE 151626 TC|

PANTOME 13-5708 TC

-F'ANTDNE 1531111 TC.

Blue:

-F'ANTDNE 1592118 TC
-F‘ANTUNE 19-4005 TC

Colar:
PAMTOMNE 151825 TC

<N 0T 0 >

RGE Equivalent:
Red:
Green: 48

Color dialog box.

o4

51

0k ” Cancel ][

Help ]

The Color Books tab of the Select Color dialog box displays colors in color books. Color books
are files that define colors. AutoCAD includes several Pantone color books. Pantone is a com-
monly used system of matching colors often used for printing on paper and fabric.

To use a color from a color book, follow these steps:

1. On the Color Books tab of the Select Color dialog box, choose a color book from the
Color Book drop-down list.

2. Drag the color slider or use the up and down arrows to choose a “page” of the color

book. On the left, you see

the colors for that page. A page can hold up to ten colors.

3. Choose one of the colors on the left side of the dialog box.

4. Click OK.
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Assigning a linetype

The default linetype is a continuous line, but you can also use many other linetypes, which
are repeating patterns of dashes and/or dots and spaces. Linetypes can also include text and
shapes. Linetypes are covered more fully later in this chapter.

To change the default linetype, move the cursor to the linetype in the new layer’s row. Click
to open the Select Linetype dialog box, as shown in Figure 11-6.

il Select Linetype (B[]
Loaded linetypes
Linetype Appearance Drescription
Continuous —— Soldline
< ¥
[ Ok 1 [ Cancel ] [ Load. ] l Help ]

Figure 11-6: The Select Linetype dialog box
as it appears before you have loaded any
linetypes.

If the linetype that you want appears on the list, click the linetype and choose OK to close the
dialog box. If the linetype does not appear, you need to load the linetype. Click Load to open
the Load or Reload Linetypes dialog box, shown in Figure 11-7.

Linetypes are stored in text (or ASCII) files with the filename extension . 1in. The standard
linetypes are stored in acad.1in in AutoCAD and in ac1t.11in in AutoCAD LT. You can create
your own linetypes and store them in acad.1in or aclt.1in. You can also store them in
another file that you create with the extension . 11in. Click File at the top of the dialog box if
you want to load a linetype from a file that you created. Choose the linetype that you want to
load and click Open.

i Load or Reload Linetypes =a
Available Linetypes
Linetype Description ~
ACAD_ISO0ZwW100 150 dash

ACAD_|S003w100
ACAD_|S004%100
ACAD_|S005%100
ACAD_|S006w100
ACAD_|S007w100
ACAD_|S008700
ACAD_|S00%700
ACAD_IS07000
ACAD 15071100
<

150 dash space
150 long-dash dat

150 long-dash double-dot ____ ..
150 long-dash tiple-dat ____ ...
150 dat

150 long-dash shotdash ___
150 long-dash double-short-dash
150 dash dot

150 double-dash dat ¥

I

Ok

1 [ Cancel ] [ Help ]

Figure 11-7: The Load or Reload Linetypes

dialog box.
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 Cross- See Chapter 31 for a full discussion of creating your own linetypes.
\ Reference

To choose a range of linetypes to load, click the first linetype in the range, press Shift, and
click the last linetype in the range. To choose more than one noncontiguous linetype, press
Ctrl for each additional linetype you choose. To select all or clear all of the linetypes, right-
click in the dialog box and choose the desired option from the shortcut menu.

As soon as you load a linetype and click OK, you return to the Select Linetype dialog box. The
loaded linetype now appears on the list. Choose it and click OK. You’re now back in the Layer
Properties Manager dialog box.

Assigning a lineweight

A lineweight assigns a width to a line. When you give a layer a lineweight, every object on
that layer has the same lineweight. A lineweight can help to distinguish various elements of
your drawing, both on-screen and on paper. For example, you could use a thicker lineweight
to indicate planned construction changes, for dimension lines, or to represent the true width
of an object. The LWT button on the status bar turns on and off the display of lineweights. By
default, LWT is off.

To set a lineweight for a layer, click the Lineweight column of that layer to open the Lineweight
dialog box, shown in Figure 11-8. Choose a lineweight and click OK.

& Lineweight @) Figure 11-8: When you click the Lineweight column of
Linewsights: the Layer Properties Manager, the Lineweight dialog box
——— Defau ~ opens so that you can choose a lineweight.

0.00 mm
0.05 rarm
0.09 mm
0.13 rm
0.15 mm
0.18 rm
0.20 mm
0.25 mm
0.30 rormn
0.35 mm -
Orniginal:  Defaulk
New: Drefault
0Ok ] [ Cancel ] [ Help

Lineweights have the following features:

4 The default lineweight value for layers and objects is called DEFAULT, which has a value
of 0.010 inch or 0.25 mm.

4+ On the Model tab, where you draw, lineweights are displayed in relation to pixels, the
unit of measurement for computer screens. A lineweight of 0 is displayed with a width
of one pixel. Wider lineweights are calculated proportionally to the actual width of the
lineweight. The lineweight display on the Model tab does not change as you zoom in
or out.
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4+ On Layout tabs (covered in Chapter 17), lineweights are displayed in real-world units as
they will be plotted. Lineweights act like other objects in your drawing and look bigger
or smaller as you zoom in and out.

4+ By default, lineweights are measured in millimeters. You can format lineweights by
choosing Format = Lineweight. The Lineweight Settings dialog box opens, shown in
Figure 11-9. The Lineweights section lists available lineweights. Choose a default
lineweight from the Default drop-down list. The default is 0.01 inch or 0.25 mm. The
Adjust Display Scale slider determines how lineweights are displayed on the Model
tab. Adjust this setting if you use several closely related lineweights but can’t distin-
guish them on your screen. The Display Lineweight check box turns the display of
lineweights on and off. (See the next bullet for an easier way to do this.)

4 You can turn the display of lineweights on and off —just click the LWT button on the
status bar.

If you don’t want to use lineweights, you can just ignore them and display every object using
the default lineweight.

i Lineweight Settings (B[]
Lineweights Units for Listing

ByLayer ~ (&) Millmeters [rmm) () Inches [in)

ByBlock

Diefault [ Display Lineweight

0.00 ram

0.05 rm Default — 0.25mm ~

0.09 mm Adjust Display Scale

0.13 mm A

tiny J Max
Current Lineweight:  Bylayer
[ ok 1 [ Cancel ] [ Help ]

Figure 11-9: The Lineweight Settings dialog
box lets you format how lineweights are
measured and displayed.

After you've set your new layer’s color, linetype, and lineweight in the Layer Property
Manager, you're ready to use the layer. You can click Apply after any change to apply the
change without closing the dialog box. Click OK to close the Layer Properties Manager.

On theh"'\ The drawing used in the following Step-by-Step exercise on creating layers, abl1-a.dwg, is
in the Drawings folder on the CD-ROM.
v '
.4/‘.

CD-)
STEP-BY-STEP: Creating a New Layer
1. Open abl1-a.dwg from the CD-ROM.
2. Save the file as ab11-01.dwg in your AutoCAD Bible folder.

3. ... Choose Layer Properties Manager from the Layers toolbar to open the Layer
“% Properties Manager.

4. ;. Click the New Layer icon. A new layer named Layerl appears, highlighted. Type
Walls .! as the name for the new layer.
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5. Click the color square in the Color column to open the Select Color dialog box. Choose
the blue square from the Standard Colors and click OK.

6. Choose the New Layer icon again to create another new layer. Type Hidden .
7. Click the color square in the Color column to open the Select Color dialog box.
8. If you have AutoCAD, do the following:

In the Select Color dialog box, click the True Color tab. From the Color Model drop-down
list, choose RGB. In the Color text box, type 141, 218, 189. Press Tab. You should see a
teal (blue-green) color. Click OK.

If you have AutoCAD LT, do the following:
Find Index Color 121 (a teal color) and click. Then click OK.

9. In the main layer listing, click Continuous in the same row as the Hidden layer to open
the Select Linetype dialog box. Click Load to open the Load or Reload Linetypes dialog
box. Scroll down until you see the HIDDEN linetype. Choose it and click OK. In the Select
Linetype dialog box, choose HIDDEN and click OK.

10. Click the Description column for the Hidden layer. Click again so that a text cursor
appears. Type teal, hidden lines ..

11. Click OK to close the Layer Properties Manager.

12. Click the Layer Control drop-down box on the Layers toolbar to see the two layers you
just created listed there. Click again to close the box.

13. Save your drawing.

Using layers

9‘ To use a layer you have just created, click the Set Current icon in the Layer Properties

Manager or double-click the layer’s name. Then click OK to return to your drawing.
Objects you create now are drawn on that layer and display with the layer’s color, linetype,
and lineweight. (The lineweight only shows if the LWT button on the status bar is on.)

All objects that you draw go on the current layer. After you have the layers you need, you
need to switch from layer to layer as you draw. You can continue to choose Layers in the
Layer Properties Manager, click the name of a layer, click Set Current, and then click OK. But
there is an easier way — the Layer Control drop-down list on the Layers toolbar, shown in
Figure 11-10.

Figure 11-10: The Layer Control drop-down list.
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The Layer Control drop-down list has two display modes:
4+ If no object is selected, it displays the current layer.
4+ If one or more objects are selected, it displays the layer of the selected object(s).

To check the current layer, make sure no object is selected. If necessary, press Esc to deselect

any objects.
'Note When objects on varying layers are selected, the Layer Control list goes blank, indicating that
- more than one layer is included in the selection.

To open the Layer Control drop-down list, click its arrow. You see a list of all your layers,
including their states and colors. Pass the mouse over the items, and a tooltip tells you what
they mean. The Layer Control drop-down list has three functions:

4+ It switches the current layer so that you can draw on a new layer.
4+ It changes the following states of any specific layer on the list:

e On/Off

® Frozen/Thawed

¢ Frozen in Current Viewport/Thawed in Current Viewport

¢ Locked/Unlocked
4+ It changes the layer of a selected object.

Take the time to learn how to use this drop-down list; it can save you a great deal of time. To
change other states of a layer (such as plottable/not plottable), click Layers Properties
Manager on the Layers toolbar to open the Layer Properties Manager.

Switching the current layer

To switch the current layer, make sure that no object is currently selected, click the Layer
Control drop-down list arrow and click the name of the layer that you want to be current. Be
careful to click only the name — otherwise, you may change the layer’s state. You may need
to press Esc first to deselect all objects. After you click a new layer name, the drop-down list
automatically closes.

N\ .45 The Layer Previous button on the Layers toolbar switches you to the last layer you used.
AutoCAD = (lick it another time and you're in the layer before that. Use Layer Previous as a shortcut
Only to finding and choosing the last layer you used on the Layer Control drop-down list.

V
Changing a layer's state

After you create a layer, you can manage that layer —and all the objects on that layer — by
changing its states. You can change some layer states through the Layer Control drop-down
list; others must be changed in the Layer Properties Manager. The layer states each have dif-
ferent properties and uses:

4+ On/Off: Turn layers off when objects on those layers interfere with the drawing pro-
cess. For example, if you want to edit only objects on your Object layer, but objects
exist on other layers nearby, you can turn off the other layers and easily select the
objects on the Object layer with a window. Then turn the other layers back on. The
on/off state is available on the Layer Control drop-down list.
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4+ Thaw/Freeze: You can freeze layers for reasons similar to those that lead you to turn

off layers. In general, freeze layers when you want to work without those layers for a
longer period of time. The thawed/frozen state is available on the Layer Control drop-
down list.

Thaw/Freeze in Current Viewport: You may want to freeze or thaw layers in some
floating viewports but not in others. For example, you may want to display dimensions
in one viewport but not in others; to do so, freeze your dimensions layer in all the view-
ports except one. You can change this state on the Layer Control drop-down list if you're
working on a layout. You can also click the Current Viewport Freeze icon in the Layer
Properties Manager.

Thaw/Freeze in New Viewports: You can also freeze or thaw layers in future viewports
that you create. For example, after you display dimensions or text in one viewport, you
may want to make sure they won’t appear in any new viewports that you create. This
state is available in the New Viewport Freeze column of the Layer Properties Manager.

See Chapter 17 for an explanation of floating viewports and layouts.

Unlock/Lock: Lock a layer when you want to ensure that objects on that layer are not
changed. You can still use objects on locked layers for reference (for example, you can
use their object snaps). Click the lock/unlock icon on the Layer Control drop-down list.

Plot/No Plot: Make a layer not plottable when you want to create reference text or revi-
sion marks on your drawing but don’t want to plot them. Another example: If you have
a drawing that contains both actual and planned structures, you could plot showing only
the actual structures. Being able to change a layer’s plottable state makes it possible
for you to create variations on your drawing, perhaps for different users, such as elec-
tricians, plumbers, and roofers. The plot/no plot state is available in the Plot column of
the Layer Properties Manager.

Both the off and frozen states make layers invisible. The purpose of frozen and thawed layer
states is to reduce regeneration time —and that's the main difference between On/Off and
Thawed/Frozen layer visibility options. However, today’s computers are faster, and recent
releases of the software have reduced the need for regeneration. Also, remember that thaw-
ing a layer causes a regeneration, whereas turning a layer back on only causes a redraw. As
a result, you might actually save a regeneration by using On/Off instead of Thawed/Frozen.

Click any of the state icons to toggle a layer’s state. For example, if you want to freeze a layer,
click its sun and it switches to a snowflake. Table 11-2 shows the icons for each state.

Table 11-2: Layer State Icons

State Icon State Icon
On Off -
. o
Thawed (in all viewports) — Frozen (in all viewports) Py
] e
- ==
Thawed (in current viewport) Frozen (in current viewport) =

Continued
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Table 11-2 (continued)

State Icon State Icon
Thawed (in new viewports) Frozen (in new viewports)

| |
Unlocked = Locked

‘i ]
Plottable o Not plottable =

When you change a layer’s state, the drop-down list stays open so that you can change the
state of more than one layer at a time. Click the top of the list to close it.

Caution Be careful when editing a drawing with frozen or off layers — it's easy to forget about them. For
example, you could move a whole section of your drawing and inadvertently leave the frozen
objects in that section behind.

Saving layer states

Often you work with sets of layer states. For example, you may lock certain layers during part
of the editing process to avoid changing objects on those layers. You may also set some lay-
ers as not plottable just before final plotting but want them plotted for a draft plot. You may
also want to temporarily change the properties of certain layers — color, linetype, lineweight,
and plot style—and then change them back.

You could spend a lot of time adjusting all these layer states and properties over and over.
Instead, you can save and restore sets of layer states —the properties and states of all the
layers in a drawing. You can save layer states to automate the process of restoring layer
states and properties by saving the set of all layer states and properties. After you save this
set, you can restore it at any time. The term layer states includes the set of all layer states as
well as their properties.

You can also export layer-state settings to a file. You can then use the layer-state settings in
another drawing with the same or similar layers.

To save a layer state, follow these steps:

1. Set all the layer states and properties the way you want them. Usually, you've already
done this and should save the state before making changes that you plan to reverse
later on.

2. Choose Layer Properties Manager from the Layers toolbar.

3. ... Inthe Layer Properties Manager, click the Layer States Manager icon to open the

; Layer States Manager dialog box, shown in Figure 11-11.

4. Click New and type a name for your layer state in the New Layer State Name text box of
the New Layer State to Save dialog box. If you want, type a description. Click OK.
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i Layer States Manager (6] =]
Layer states
MName Space Description
additions off tods! all layers representing ne..
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Clear All
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[[] Current %P Frozen / Thawed [ Hew VP Frozen / Thawed

[ Tum off layers not found in laper state

[ Restare ][ Cloze H Help

Figure 11-11: The Layer States Manager dialog box.

5. Back in the Layer States Manager, choose which of the layer states and properties you
want to save in the Layer Settings to Restore section.

Caution States and properties that you do not save are not affected later when you restore the layer
state. For example, if you save only the on/off state and then change both a layer's on/off state
and its color, when you restore the layer state, only the on/off state is returned to its original
setting; the layer retains its new color.

6. If you want your drawing to look exactly as it did when you saved the layer state (in
terms of layers), check the Turn Off Layers Not Found in Layer State check box. Any
new layers that you create after saving the layer state are then turned off when you
restore your layer state.

7. Click OK.

- Torestore a layer state, open the Layer Properties Manager and click the Layer States
T Manager button to open the Layer States Manager. Choose the layer state and click
Restore. Then click OK to close the Layer Properties Manager.

The Layer States Manager enables you to manage layer states in the following ways:
4+ Restore: Restores a saved layer state.
4+ Delete: Deletes the layer state.

4+ Import: Imports a layer state that has been previously exported as a . 1as file.
Importing a layer state gives you access to layer states that others have saved.

4+ Export: Saves the settings of a layer state in a . 1as file. Exporting a layer state gives
others access to your layer state settings.

You can also change the properties and states that you save by checking or unchecking any
of the check boxes at the bottom of the Layer States Manager. To rename a layer state, click
its name, type a new name, and press Enter. After you finish using the Layer States Manager,
click Close to close the dialog box.
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The Express Tools contains many layer-related tools that you can add to your arsenal. Many
of these layer tools can save you considerable time over the course of creating a drawing.
Table 11-3 explains them briefly. See Appendix A for information on installing Express Tools.

Table 11-3: Express Tools Layer Commands

Layer Name Menu Description

LAYWALK Express > Layers > Layer Walk A full-featured command that helps you see
which objects are on which layers. You can
list the number of objects on each layer,
count the total number of layers, save layer
states, and purge unused layers, using the
dialog box and the shortcut menu.

LAYMCH Express = Layers > Layer Match Changes the layer of selected objects to
match that of a selected object.

LAYCUR Express > Layers > Changes the selected object’s layer to the

Change to Current Layer current layer.
COPYTOLAYER  Expressc Layers Copies objects while changing the copy to
Copy Objects to New Layer the layer you specify.

LAYISO Express > Layers > Layer Isolate Turns off all layers except the layer of an
object you select, so that you can isolate a
specific layer.

LAYVPI Isolate Layer to Current Viewport Freezes all layers except the layer of an
object you select in all viewports except the
current one, isolating the selected layer in
the current viewport.

LAYOFF Express = Layers = Layer Off Turns the layer of the selected object(s) off.

LAYON Express > Layers > Turn All Layers On  Turns all layers on.

LAYFRZ Express = Layers = Layer Freeze Freezes the layer of the selected object(s).

LAYTHW Express > Layers = Thaw All Layers Thaws all layers.

LAYLCK Express = Layers = Layer Lock Locks the layer of the selected object(s).

LAYULK Express > Layers = Layer Unlock Unlocks all layers.

LAYMRG Express = Layers = Layer Merge Changes the layer of all objects on the first
layer selected to the second layer selected.
The first layer is purged.

LAYDEL Express = Layers = Layer Delete Deletes objects from the specified layer and

purges